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Introduction

Welcome to OpenTextTM Active Community. Our online solution accelerates 
communication and collaboration across your extended trading partner network. 
Many of the projects you used to complete manually via email or phone can be 
done quickly and easily in OpenText Active Community.

Audience
The audience for this guide is buyers and suppliers who use Active Community for 
their community management.

System Requirements
OpenText Active Community is certified to run in the following browsers:
■ Microsoft Internet Explorer 11
■ Mozilla Firefox 85
■ Google Chrome 89

Operating Systems 
OpenText Active Community supports the following operating systems:
■ Microsoft Windows
■ Mac OS X

Web Content Accessibility Guidelines (WCAG)
Active Community is undergoing updates with every release, in accordance with 
the Web Content Accessibility Guidelines (WCAG), to provide better accessibility to 
people with disabilities. For more information, see OpenText’s Accessibility policy.
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Accessing Product Documentation
Most documentation is delivered in Adobe Acrobat PDF format. To read and print 
the documents, you will need Adobe Acrobat Reader, a free product from Adobe 
Systems. For information about downloading and installing Acrobat Reader, see the 
section, “Installing Adobe Reader.”

Installing Adobe Reader
Since most OpenText product documentation is delivered in Adobe Acrobat PDF 
format, you will need Adobe Reader to read and print the documentation. Adobe 
Reader is a free product from Adobe Systems. 

To download and install Adobe Reader
1 Launch a Web browser and navigate to http://get.adobe.com/reader
2 Download and install Adobe Reader. Follow the screens, accepting the defaults.

You can now access OpenText product documentation by double-clicking the PDF 
file.

Contacting Technical Support
For assistance, contact Cloud Support Services (CSS) by sending an email to 
Activecommunitysupport@opentext.com 
Your email will automatically generate a support ticket in the ticketing system. You 
will receive an email notification that a support ticket has been created.

http://get.adobe.com/reader
mailto:Activecommunitysupport@opentext.com?subject=Feedback/issue
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Getting Started 1
This section provides an overview of the Active Community user interface and 
includes information about logging in and out, changing your password, navigating 
the application and menus, changing the language of the UI, and other general 
information.

Logging In to Active Community
Important: You need to have an account in Active Community before you can log 
in. Your account can be created by the Community Administrator or another user 
who has permission to create accounts.
Note: The first time you log in to Active Community, you must set your password 
using the reset password procedure. See “Resetting Your Password” on page 4 for 
instructions.

To log in
1 Access the Internet with a supported browser. Active Community is certified to 

run in the browsers listed in “OpenText Active Community is certified to run in 
the following browsers:” on page 1.

2 In the Address field, type the specific URL for your hub for Active Community 
(hubname.rollstream.com where hubname is the name of your hub). If you 
don’t know your hub URL, you can type the generic URL 
account.rollstream.com. 
The Community Login page opens.

3 Type your User ID and Password.
4 Click Go.

You are logged in to Active Community.
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Logging Out of Active Community
To log out of Active Community and return to the Login page
1 Move your cursor over your user name in the corner of the page, and click 

Logout.

You are logged out of Active Community and return to the Login page.

Resetting Your Password
If you have forgotten your password, use this procedure to reset it to a new one. If 
you want to change your password, see “Changing Your Password” on page 37.
Note: The first time you log in to Active Community, you must reset your 
password using this procedure.

To reset your password: 
1 Access the Internet with a supported browser. Active Community is certified to 

run in the browsers listed in “OpenText Active Community is certified to run in 
the following browsers:” on page 1.

2 In the Address field, type the specific URL for your hub for Active Community 
(hubname.rollstream.com where hubname is the name of your hub). If you 
don’t know your hub URL, you can type the generic URL 
account.rollstream.com.
The Community Login page opens.

3 Click Get Password. 



G E T T I N G  S T A RT E D
Resetting Your Password

OpenText Active Community CE 21.2 User Guide  5

1  

The Set a New Password page opens.

4 Type your User ID, and click Set My Password. 
A message indicates that you will be sent an email message with instructions to 
reset your password. This should occur within a few minutes.
Note: The instructions are sent to your Account Email. This is the email 
address associated with your User ID and is used to set a new password.

5 Check your account email. Passwords are not sent in emails; however, the 
email message contains a link which opens a page in Active Community and 
allows you to enter a new password. 

6 Click the link provided in the email. The Change Your Password window opens.

7 Type a password, and then type it again in the Confirm box. 
Passwords must be at least 8 characters and contain one character from 3 of 
these 4 types:

■ number
■ lowercase
■ uppercase
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■ special character (for example, %^&$#)
Note: Your password can include spaces, but spaces that occur before or 
after your password will be removed when it is saved.

8 Click Change My Password.
The Community Login page opens.

9 To log in, type your User ID and new Password.
10 Click Go.

You are logged in to Active Community.

Navigating in Active Community
Active Community functions are grouped into modules that are listed at the top of 
the user interface. When you click a module name, it opens to display tabs and 
links for its components.

Important: You will see only the modules, tabs, and links you can access based 
on your roles and permissions. If you cannot access a module you need, contact 
your system administrator to adjust your permissions.
Topics include:
■ “Using Modules, Components, and Tabs” on page 7
■ “Focus of UI when Editing a Company Field Group” on page 9
■ “Using Auto-Fill” on page 10
■ “Using the Functions Under Your User Name” on page 10
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Using Modules, Components, and Tabs
By selecting different modules, different tabs display so you can perform functions 
specific to that module. For example, in the screen shot, you have selected the My 
Company module. The tabs that display allow you to access all information related 
to your company, including its profile, summary information about it, its file library, 
and any divisions, contacts, items, projects, and subscriptions that are associated 
with it.

1

2

3

The parts of a page:
Key Description
1 Modules
2 Tabs
3 Page shows information about the selected module, including tabs and additional links.

See “About the Home Module” on page 7 and “Summary of Modules, Components, 
and Tabs” on page 8.

About the Home Module
Active Community opens to the Home module, which includes three tabs: 
Dashboard, Inbox, and Your Profile. You use the tabs to complete various functions 
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related to your work in Active Community and your profile. The Home module also 
uses graphics and charts to show the progress of projects and activities.

Charts on provide a quick view 
of project status.

Summary of Modules, Components, and Tabs
The table lists each Active Community module and its components and tabs. 
Within a module, the tabs group or collect all relevant information about the 
selected item, such as a contact, activity, or company.

Modules/Components Primary Tabs Sub-tabs
Home ■ Dashboard

■ Inbox
■ Tasks
■ Your Profile

None

Projects ■ Your Projects
■ All Projects
■ Default Project Permissions

For each project:
■ Overview
■ Activities
■ Team
■ Participants
■ Files
■ Web Forms
■ Permissions

Profiles
■ Companies

For each company:
■ Directory
■ Settings
■ Reports

For each company:
■ Summary
■ Profile
■ Division
■ Contacts
■ Projects
■ Files
■ Items
■ Audit Log
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Focus of UI when Editing a Company Field Group
When you edit a Company field group, the focus on the field group you are editing 
remains on that field group after you have saved your changes. This allows you to 

■ Contacts ■ All Contacts
■ Core Fields
■ Custom Fields
■ Alerts
■ Permissions
■ Freshness
■ Business Roles

For each contact:
■ Profile
■ Projects
■ Activities
■ Files
■ Web Forms
■ Audit Log

■ Items ■ Items
■ Custom Fields

None

My Company ■ Summary
■ Profile
■ Division
■ Contacts
■ Projects
■ Files
■ Items
■ Subscriptions

None

Applications (optional) ■

■ Registration ■ Registration Requests
■ Dashboard
■ Admin

None

■ Workspaces No tabs No tabs
■ Trading Grid Online No tabs No tabs

Admin ■ Community Settings
■ Security Settings
■ Security Roles
■ Profile Freshness
■ Alerts
■ Change Management
■ Usage Reports
■ Provisioning

None

Modules/Components Primary Tabs Sub-tabs
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easily verify that your changes were successful and additional changes can be 
made, if necessary.

Using Auto-Fill 
Some fields have an auto-fill feature. As you type a value in the field, a drop-down 
list displays and is automatically populated with choices (listed alphabetically) that 
match the values you are typing. A limited number of choices are displayed. If the 
choice you want is not displayed, enter more or different characters to narrow the 
choices. The more characters you type, the closer the match, and the less items 
that display in the drop-down list. You can select an item from this list.

Using the Functions Under Your User Name
Your user name is always visible in the corner of the user interface. You can access 
several important functions by moving your mouse cursor over your user name. 

2
3

1

The parts of the menu:
Key Description
1 Your user name.
2 Click to view online help.
3 Click to log out of Active Community.

The functions include:
■ “Changing Your Language” on page 11
■ “Contacting Support” on page 11
■ “Accessing Online Help” on page 12
■ “Logging Out of Active Community” on page 4



G E T T I N G  S T A RT E D
Changing Your Language

OpenText Active Community CE 21.2 User Guide  11

1  

Changing Your Language
You can select a different language in which to display the user interface (UI). 
English, French, German, Portuguese, and Spanish are available at this time.

To change your language
1 Move your cursor over your user name in the corner of the page, and click 

Change Language.

The Select a language dialog box opens.

2 From the list, select the language you want. 
The UI menus, buttons, and dialog boxes display in the language you selected.

Contacting Support
If needed, you can send an email to the Active Community support team.

To send the support team an email message
1 Move your cursor over your user name in the corner of the page, and click 

Support.

2 In the Get Support dialog, click the click here link.
A security warning opens.

3 Click Allow, then compose your message and describe the issue you are 
having. 

4 Click Send.
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Customizing a Support Message
Hubs can customize the support message that displays for all users of its 
community whenever a user selects Support from the drop-down menu in the 
corner of the page (move your cursor over your user name to display the menu).

To customize a support message
1 Click Admin > Community Settings tab > Edit Community.

The Edit Community Settings page opens.
2 Scroll down to the Support section.

3 Type your message in the content area.

Use the editor options to format your message including hyperlinks and links to 
email addresses.

4 Click Save.
5 To view the message, move your cursor over your user name in the corner of the 

page, and click Support.

The message displays.

Accessing Online Help
The Active Community online help provides the information you need to use Active 
Community effectively.
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To view the online help
1 Move your cursor over your user name in the corner of the page, and click 

Help.

2 Online help opens in a new window.

Using Breadcrumbs
Breadcrumbs are clickable links that show you where you are in Active Community 
and how you got there. They are available for the tabs in a selected module. 

To return to a previously selected page
■ Click a breadcrumb link.

Customizing Your Community’s Dashboard
As an administrator, you can customize the dashboard that displays as the home 
page of your community. You can choose to display up to three company custom 
fields (for example, partner credentials) on your Dashboard. Keep in mind that the 
Dashboard can only be seen by users in the hub community (employees).
Note: Data tables cannot be shown on the Dashboard. 
See also:
■ “Adding a Logo to Your Community” on page 14
■ “Adding Links to the Bottom of Your Dashboard” on page 15.

To customize your community dashboard
1 Click the Admin tab, and then click the Community Settings tab. 
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The Community Settings page opens, showing global community and 
communication preferences.

2 Click Edit Community and scroll down to Dashboard Preferences.
3 Select the custom fields that you want to display on the Dashboard.

Note: Fields that are data tables are not available for you to select; they 
cannot be displayed on the Dashboard. 

4 Click Save. 
The custom fields now display on your Dashboard.

5 Go to “Adding a Logo to Your Community” on page 14 or “Adding Links to the 
Bottom of Your Dashboard” on page 15.

Adding a Logo to Your Community
As an administrator, you can customize your community by adding a company 
logo. This logo will display on every screen in your Active Community community, 
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which can help your business contacts identify the community to which they 
belong. 

Important: The ideal size of your logo image should be 130 pixels wide by 67 
pixels high. If your logo is wider than 130 pixels, the width will be resized and 
scaled down. If your logo is more than 67 pixels high, it may appear cropped at the 
bottom. This may cause some distortion of the image.

To add a logo to your community
1 Click the Admin tab, and then click the Community Settings tab. 

The Community Settings page opens, showing global community and 
communication preferences.

2 Click Edit Community and scroll down to Communication Preferences. 

3 For Company Logo, click Browse.
The File upload dialog box opens.

4 Navigate to an image file on your hard drive (for example, a .GIF file), select it, 
and click Open. The logo is resized (if applicable) and displayed.
Note: The maximum file size is 50 MB.

5 Click Save.

Adding Links to the Bottom of Your Dashboard
In addition to updating the logo and dashboard in your community, you can also 
customize your community by adding links in the footer (at the bottom of your 
community pages) to display text in a pop-up window or to take users to other 
Web sites. 
For example, you can:
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■ Link to the privacy policy on your company's web site.

■ Link to your Support email address and have a blank email message display in a 
separate window.

■ Link to your terms and conditions of use and display them in a pop-up window.

To customize your community footer
1 Click the Admin tab, and then click the Community Settings tab. 

The Community Settings page opens, showing global community and 
communication preferences.

2 Click Edit Community and scroll down to Footer Preferences.
3 Do one of the following:

■ To add a new link in the footer, click Add Preference.
■ To edit an existing link, click the name of the link in the list.

Depending on whether you are adding or editing preferences, the Add Footer 
Preference or Edit Footer Preference page opens.
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4 Complete the fields as described in the following table.
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Field Description
Name Required. The name of the link, which is the information the user 

sees in the footer at the bottom of every community page. For 
example, “Legal Notice,” “Terms and Conditions,” or “Contact Us.”
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Category Required. The type of content for the link. Select one of the 
following:

■ Text—Select this option if you want a block of text to display 
in a pop-up window when the user clicks your link in the 
footer. Keep in mind that this text can also contain links to 
other Web sites, for example, in a Microsoft Outlook or chat 
message.

To insert links to Web sites within your text block, highlight 
the text, and click the Link icon to display a dialog box. 
Select the protocol and type the URL that you want to 
display. Click the Target tab to specify the target, such as 
New Window. Click the Advanced tab to specify other 
properties. Click OK.

■ URL—Select this option if you want to go directly to a Web 
site when the user clicks your link in the footer. For example, 
you might have a link called “Legal Notice” that opens a new 
window to show a page on your company Web site that 
contains all legal information.

Note: When the user clicks the link in the footer, a new 
window opens; they do not lose their place in your 
community. 

Field Description
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5 Click Save. Your links now display at the bottom of every page in your 
community.

IP Address Restrictions
Active Community access can be restricted to a specific IP address range and used 
as a means for a customer to control who of (and how) their hub users access 
Active Community. For example, by entering an IP address range which spans their 
VPN gateway access points, a customer can ensure that only users who are logged 
into the hub VPN can access Active Community.

To restrict access to a specific IP address
1 Click Admin > Community Settings tab > Edit Community.

Content Required. The text or Web site that your link will display. 
■ Text - Type the text you want to display in the pop-up 

window. Keep in mind that if you select Text, you can insert 
links to Web sites within your text block. Position your 
cursor, click the Link icon, and in the Link dialog box, select 
the protocol and type the URL that you want to display and 
link to.

■ URL (Web site) - Type the URL of the Web site you want to 
direct the user to.

Field Description
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The Edit Community Settings page opens.

2 Under Global Preferences, click the Configure IP Addresses link.
The Configure IP Addresses page opens.

3 Type a single IP address or a range of addresses.
4 Click Add IP Addresses.
5 Click Save.

Synchronizing Active Community with Trading Grid Online (TGO)
Hub customers who have both an Active Community community and a Trading Grid 
Online (TGO) community (for example, Intelligent Web Forms (IWF) or Active 
Orders (AO)) can take advantage of several features that are described in the 
following topics:
■ “Using Active Community/TGO Single Sign On” on page 21
■ “Using Active Community/TGO Profile Provisioning” on page 22
■ “Using Active Community/TGO Profile Synchronization” on page 22

■ “Enabling and Disabling Synchronization at the Profile Level” on page 22
■ “Synchronization Information for Administrators” on page 23
■ “Synchronization Information for Profiles” on page 23
■ “Ability to Manually Add/Import Bulk Company Profiles” on page 24

Using Active Community/TGO Single Sign On
Hub customers who have both an Active Community community and a Trading Grid 
Online (TGO) community (for example, Intelligent Web Forms (IWF) or Active 
Orders (AO)) can share SiteMinder user authentication, enabling their Trading 
Partners (spokes) to use their TGO credentials to access both Active Community 
and TGO. 
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Customers who access an Active Community community that has been enabled for 
SSO for TGO will be able to navigate to TGO from the Active Community 
Applications menu.

TGO will then open in a new browser tab or window. The TGO Operations Center 
displays.

Using Active Community/TGO Profile Provisioning 
Hub customers who have both an Active Community community and a Trading Grid 
Online (TGO) community with a subscription to Intelligent Web Forms (IWF) can 
approve new suppliers (spokes) through the registration process in Active 
Community and have the company and user(s) automatically set up in TGO and 
IWF.
This means that a company created in Active Community is automatically created 
in TGO as well. Single-Sign On (SSO) functionality (shared user authentication for 
TGO and Active Community) then allows these spokes to use their TGO credentials 
to access both Active Community and TGO.

Using Active Community/TGO Profile Synchronization
Hub customers who have both an Active Community community and a Trading Grid 
Online (TGO) community with a subscription to Intelligent Web Forms (IWF) can 
make updates to Companies and Contacts in Active Community and have their 
changes synchronized with TGO.
This means that any updates made to Companies or Contacts in Active Community 
are automatically updated in TGO as well. 

Enabling and Disabling Synchronization at the Profile Level
For communities that have TGO synchronization enabled, functionality is available 
to select the direction in which they want the synchronization to work (that is, TGO 
to Active Community, Active Community to TGO, or both directions). The direction 
is enabled by OpenText when the synchronization is enabled.
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Synchronization Information for Administrators
The synchronization direction is displayed in the user interface (UI) on the 
Community Admin page (Admin > Community Setting tab > Application 
Sync section). The direction cannot be changed using the UI.
Note: A direction is not displayed if Companies do not have synchronization 
enabled.

Synchronization Information for Profiles
For Companies that have synchronization enabled, the Overview section of both 
Company and Contact Profile pages indicates whether Trading Grid Online 
synchronization is enabled or disabled.
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Ability to Manually Add/Import Bulk Company Profiles
Communities that have synchronization enabled (that is, are integrated with TGO) 
can add companies via Registration, as well as through the ‘Manage Companies” 
functionality. 
The ‘Manage Companies’ option is available to users with the appropriate 
permissions so that they can manually create and import companies, as well as 
bulk edit companies using the Import functionality. 

Note: Any companies created in this manner (manually, and not via Registration) 
will not automatically synch with TGO. Furthermore, any users (Contact profiles) 
added to such a Company will not synchronize, and they cannot utilize SSO 
functionality. In some cases, synchronization may be turned on depending on the 
company’s and/or user’s status(es) in TGO, thus enabling SSO. Please email 
Support with specific inquiries.
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Profiles 2
There are two types of profiles in Active Community: company profiles for a 
company in an Active Community community and contact profiles, which represent 
you or another person.
A company or contact profile contains basic information in what are called core 
fields. It also contains custom fields which let the hub add more specific 
information to the profile.
■ Core fields represent basic information about the company or contact, such as 

mailing address or contact information. 
■ Custom fields are specific to each community. They add more information to a 

profile than is available in core fields.
To prevent profile information from becoming out-of-date, reminder emails can be 
sent to specified roles on a regular basis. See “Profile Update Reminders” on 
page 43.
Topics include:
■ “Company Profiles” on page 26

■ “Company Core Fields” on page 26
■ “Company Custom Fields” on page 27

■ “Contact Profiles” on page 27
■ “Contact Core Fields” on page 28
■ “Contact Custom Fields” on page 28

■ “Defining Required Core Fields for Contact and Company Profiles” on page 28
■ “Updating a Company Profile” on page 30
■ “Updating a Contact Profile” on page 31

■ “Updating Your Profile Photo” on page 36
■ “Deleting Your Profile Photo” on page 36
■ “Changing Your Password” on page 37
■ “Changing Your User ID” on page 38
■ “Changing Your Account Email” on page 40
■ “Changing the Communication Email” on page 41

■ “Merging User IDs” on page 41
■ “Profile Update Reminders” on page 43
■ “Responding to Reminder Emails” on page 43
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■ “Customizing Profile Reminder Messages” on page 44
■ “Setting Time Intervals for Profile Reminder Emails” on page 45
■ “Discontinuing Profile Reminder Email Messages” on page 47

Company Profiles
This graphic shows a company profile.

The profile opens to the Overview tab. Additional tabs let you view or add roles or 
custom field information about the company. The Last Updated date provides the 
date that the profile was last modified and is used to trigger when profile update 
reminder emails are sent.
For more information, see “Company Core Fields” on page 26, “Company Custom 
Fields” on page 27, and “Profile Update Reminders” on page 43.

Company Core Fields
Core fields represent basic information about a company, such as name, address, 
phone, and other contact information. Core fields are listed on the Overview tab.
A contact in the Community Administrator role can define which core fields are 
required and which are optional. A small number of fields are always required (see 
“Defining Required Core Fields for Contact and Company Profiles” on page 28).
For company profiles, core fields include:

■ Company Name ■ Address-3
■ Company ID ■ City
■ Website URL ■ State/Province/Region
■ Email ■ Postal Code
■ Phone ■ Country
■ Fax ■ # Employees
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Company Custom Fields
Custom fields are questions or input fields that help the hub categorize company 
information beyond the information that is available in core fields. A Community 
Administrator can create custom fields according to information that needs to be 
collected from its partners, customers, sales representatives, or contacts in a 
community. 
Custom fields can cover a number of areas such as sales, pricing, compliance, 
quality, and others. For example, custom fields can:
■ Indicate if your suppliers are compliant with an industry standard
■ Be used to upload a certificate file
■ Hold company information, such as average sales volume and inventory capacity
Custom field groups are listed as tabs on a company profile page. For details, see 
“Custom Fields” on page 221.

Contact Profiles
This graphic shows a contact profile.

The profile opens to the Overview tab. Additional tabs let you view or add roles or 
custom field information about the contact. The Last Updated date provides the 
date that the profile was last modified and is used to trigger when profile update 
reminder emails are sent.
For more information, see “Contact Core Fields” on page 28, “Contact Custom 
Fields” on page 28, and “Profile Update Reminders” on page 43.

■ Address-1 ■ Notes
■ Address-2
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Contact Core Fields
Core fields represent basic information about a contact, such as name, address, 
phone, and other contact information. Core fields are listed on the Overview tab.
The Community Administrator can define which core fields are required and which 
are optional. A small number of fields are always required (see “Defining Required 
Core Fields for Contact and Company Profiles” on page 28).
For contact profiles, core fields include:

Contact Custom Fields
Custom fields are questions or input fields that help the hub categorize contact 
information beyond the information that is available in core fields. A Community 
Administrator can create custom fields according to information the hub wants to 
collect at the individual user level. 
Custom fields can cover a number of areas such as communication preferences, 
duties and responsibilities, social media accounts, etc. 
Custom field groups are listed as tabs on a contact profile page. For details, see 
“Custom Fields” on page 221.

Defining Required Core Fields for Contact and Company 
Profiles

Security role: Community Administrator
Security permissions: 
■ Contact > Edit Contacts
■ My Company > Edit My Company
■ Company Core Fields > Manage Company Core Fields
■ Community > Manage Community
■ Company > Edit Companies
Use this procedure to define which core fields are required and which are optional 
for contact and company profiles. A small number of fields are always required and 
cannot be modified. 

■ Salutation ■ Fax
■ First Name ■ Address-1
■ Last Name ■ Address-2
■ Title ■ Address-3
■ Communication Email ■ City
■ User ID ■ State/Province/Region
■ Account Email ■ Postal Code
■ Phone ■ Country
■ Mobile ■ Notes
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To define required core fields for contact or company profiles
1 Perform the appropriate action:

The core fields page for contacts or companies opens:
■ Contact Core Fields

If you want to define 
required core fields for... Do this:
Contacts 1 Click the Profiles tab, and then click Contacts. 

The Contact page opens.
2 Click the Core Fields tab. 

Companies 1 Click the Profiles tab, and then click Companies. 
The Company page opens.

2 Click the Settings tab, and click the Core Fields 
link.
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■ Company Core Fields

2 Select the check boxes for the core fields you want to be required fields. If a 
check box is de-selected or cleared, it means the field is optional. Some fields 
cannot be cleared because they are always required.

3 Click Save to save your changes.

Updating a Company Profile
Security permissions: 
■ Company > Edit Company
■ My Company > Edit My Company
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To update a company profile
1 Perform the appropriate action:

The fields in the profile become editable.

2 Update the core profile fields as needed. Required fields are indicated by an 
asterisk (*).
For company field descriptions, see Step 3 in the topic “Adding a Company to 
Active Community” on page 122.

3 Use the tabs to update custom field groups for the company.
4 Click Save.

Updating a Contact Profile
Security permissions:
■ Company Permissions > Add, Edit Companies
■ Contact Permissions > Add, Edit Contacts
■ My Company Permissions > Edit My Company Contacts

If you want to update a 
company profile for... Do this:
Your company 1 On your Home page, click the My Company tab.

2 Click Manage Company, and then click Edit 
Company.
The Edit Profile page opens to the Overview tab.

A profile for another 
company

1 Click the Profiles tab, then Companies.
The Company Directory page opens.

2 Open the profile for the company you want to update, 
and then click Manage Company > Edit Company.
The Edit Profile page opens to the Overview tab.
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Depending on the permissions assigned to your security role, you might be able to 
edit another contact’s profile. For example, a Community Administrator can edit 
any profile in the community. 
For a profile to be considered 100% complete, the following fields must be filled in:
■ First Name
■ Last Name
■ Title
■ Communication Email
■ Phone
■ Address (first line)
■ City
■ State/Province/Region
■ Zip
■ Country
■ Profile photo
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To update your profile
1 Perform the appropriate action:

2 On the Overview tab, update core profile fields. Required fields are indicated by 
an asterisk (*). Do one or more of the following:

If you want to update... Do this:
Your own profile 1 On your Home page, click the Your Profile tab.

The Edit Profile page opens to the Overview tab.
2 Click Edit Profile.

The Edit Your Profile page opens to the Overview tab.
The fields in your profile become editable. Note that you can edit your User ID and 
Account Email.

A profile for someone else 1 Click Profiles > Contacts.
2 Select the contact, and then click Manage Profile > Edit Contact. 

The Edit Profile page opens to the Overview tab.
The fields in the profile become editable. Note that the contact’s User ID and Account 
Email do not display because you cannot edit someone else’s User ID and Account 
Email. 
See “Changing Your User ID” on page 38 and “Changing Your Account Email” on 
page 40 
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■ For contact field descriptions, see Step 4 in the topic “Adding a Contact to a 
Company” on page 124.

■ For the Communication Email description, see “Changing the 
Communication Email” on page 41.

■ For the User ID description, see “Changing Your User ID” on page 38. 
Note: Only the owning user is permitted to change the user ID. 
Community Administrators cannot change a user ID; they can only view it.

■ For the Account Email description, see “Changing Your Account Email” on 
page 40. 
Note: Only the owning user is permitted to change the Account Email. 
Community Administrators cannot change an Account Email; they can only 
view it. 

3 On the Business Role(s) tab, update user-defined business or functional roles 
assigned to this contact. Each contact can have multiple roles, but at least one 
is required. 
Note: A default role of “Contact” is assigned if you have not defined any 
roles. Required. 

4 On the Security Roles tab, update security roles assigned to this contact, such 
as a Manager role. If the optional Registration module is available, you can 
update registration roles.
Note: A default role of “Everyone” is assigned if you have not defined any 
roles. Required. 

The Security Roles page opens. 

a To update security roles, click Active Community.
1 From the Available Roles column, select a security role. 
2 Click Add to add the role to the profile.
3 Click Done.

b To update registration roles, click Active Community Registration. 
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The Configure Roles page opens.

c Make selections as needed in Approval Role, Approval Group, Approval 
Settings, and Administrative Role.

d Click Save.
Note: For more information, see “Registration Setup” on page 423 
and “Registration Requests” on page 477.

5 On a Custom Field Group tab, complete any custom field questions as 
necessary. For example, you might need to type text in a field, select one or 
more options, or choose Yes or No to answer a question.
Note: If questions are displayed in a table, perform the appropriate action:

6 Click Save.
7 To perform additional actions from the profile edit page, see:

■ “Updating Your Profile Photo” on page 36
■ “Deleting Your Profile Photo” on page 36
■ “Changing Your Password” on page 37
■ “Changing Your User ID” on page 38
■ “Changing Your Account Email” on page 40
■ “Changing the Communication Email” on page 41

To... Do this:
Answer the question 1 Click Add Row.

2 Type or select the answers.
3 Click Save. 

Edit an answer row 1 Select the row.
2 Click Edit Row. 

Delete an answer row 1 Select the row.
2 Click Delete Row.
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Updating Your Profile Photo
When uploading a photo, an image size of 114 pixels wide by 152 pixels high is 
recommended. If your photo is wider than 114 pixels, the width will be resized and 
scaled down. If your photo is higher than 152 pixels, it might be cropped at the 
bottom or appear to be distorted. 
Uploaded files should be less than 50 MB in size and be in .jpg format.

To update your profile photo
1 On your Home page, click the Your Profile tab.
2 Click Edit Profile.

The Edit Profile page opens to the Overview tab.
3 To add or change a photo in your profile, click Upload Photo. 

4 In the dialog that opens, click Browse and navigate to a .jpg file on your hard 
drive (less than 50 MB), select it, and click Save.
A message indicates the photo was uploaded successfully.

5 Click the X to close the dialog.
The new photo displays the next time you access your profile.

Deleting Your Profile Photo
Use this procedure to delete your profile photo.

To delete a profile photo
1 On your Home page, click the Your Profile tab.
2 Click Edit Profile.

The Edit Profile page opens to the Overview tab.
3 To delete a photo, click Delete Photo. 

A dialog box asks you to confirm your deletion. 
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4 Click OK.
Your profile photo is deleted.

Changing Your Password
Use this procedure to change your password from your profile. 
Note: If you have forgotten your password and need to reset it, or if you are 
logging in to Active Community for the first time, see “Resetting Your Password” on 
page 4.

To change your password from your profile
1 On your Home page, click the Your Profile tab.
2 Click Edit Profile.

The Edit Profile page opens to the Overview tab.

3 To change your password, click Change Password.
The Enter Password dialog opens.

4 Type your current password, and click OK.
The Change Your Password dialog opens.

5 Type a new password, and then type it again in the Confirm box. 
Passwords must be at least 8 characters and contain one character from 3 of 
these 4 types:
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■ number
■ lowercase
■ uppercase
■ special character (for example, %^&$#)

Note: Your password can include spaces, but spaces that occur before or 
after your password will be removed when it is saved.

6 Click Change My Password.
The Community Login page opens. You need to log back in.

7 To log in, type your User ID and new Password.
8 Click Go.

You are logged in to Active Community.

Changing Your User ID
The user ID is a unique identifier assigned to a contact and is used in conjunction 
with a password to authenticate a user when logging into Active Community. The 
user ID is automatically created for each new user by the system and must be 
unique across all communities.
The following rules apply:
■ Community Administrators cannot change a user ID; they can only view it.
■ Only the owning user is permitted to change the user ID.
■ The owning user can change the user ID to one that already exists only if they 

have access to both profiles (know the user IDs and passwords of both profiles) 
See “Merging User IDs” on page 41.

Note: You cannot edit the user ID if the profile is locked for re-registration.

To change your user ID
1 On your Home page, click the Your Profile tab.
2 Click Edit Profile.



P R O F I L E S
Updating a Contact Profile

OpenText Active Community CE 21.2 User Guide  39

2  

The Edit Profile page opens to the Overview tab.The fields in the profile 
become editable.

3 Type your new user ID.
4 Click Save.

You must re-authenticate your credentials any time you change you user ID. A 
dialog box asks you to enter your password. 

5 Type your password, and click OK.
One of the following occurs:

■ If the user ID is unique, your user ID is changed and you must log back in 
to Active Community.

■ If the user ID already exists, a dialog box asks if you want to merge the 
contacts. To merge the user IDs, see “Merging User IDs” on page 41.

The Community Login page opens. You must log back in.
6 To log in, type your User ID and Password.
7 Click Go.
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You are logged in to Active Community.

Changing Your Account Email
The Account Email is a private email address used only for account related 
notifications. It is associated with a contact’s user ID and is used when a contact 
has forgotten their password. When a user ID is changed or a password is reset, 
the confirmation email is sent to the Account Email. 
To reset your password, see “Resetting Your Password” on page 4. 
The following rules apply:
■ Community Administrators cannot change an Account Email if the user has 

already created a password; they can only view it.
■ Only the owning user is permitted to change the Account Email. 
Important: The following exception exists: If a user has not yet authenticated 
their profile (created a password), and the Communication Email is changed, the 
Account Email is automatically changed to match it.

To change your Account Email
1 On your Home page, click the Your Profile tab.
2 Click Edit Profile.

The Edit Profile page opens to the Overview tab.The fields in the profile 
become editable.

3 Type your Account Email.
4 Click Save.



P R O F I L E S
Merging User IDs

OpenText Active Community CE 21.2 User Guide  41

2  

You must re-authenticate your credentials any time you change you user 
Account Email. A dialog box asks you to enter your password. 

5 Type your password, and click OK.

Changing the Communication Email
The Communication Email is a public email address that a hub uses to 
communicate with spoke contacts. Hub or spoke users can change a 
Communication Email.
This email is used for communications such as:
■ Welcome emails
■ Message activities for Projects
■ Web Form activities for Projects
■ Profile Reminder emails

Merging User IDs
You can merge the user IDs of two contact profiles that have different user IDs if 
you own both user IDs (know the user IDs and passwords of both profiles). After 
the user IDs are merged, a user needs only one user ID to access both of the 
spoke company profiles.
For example, John is in a hub community representing two companies with two 
separate user IDs. He wants to merge the two user IDs so that he only needs to 
use one user ID to access both of the spoke company profiles.

User 1 in Spoke 1 User 2 in Spoke 2 Comments
User ID john@msys.com john_965@msys.com Since User 1 was already in the system with the 

user ID john@msys.com when User 2 was 
created, the system automatically created a 
random user ID.

Communication 
Email

john@msys.com john@msys.com

Account Email john@msys.com john@msys.com

To merge user IDs
1 Log in with the user ID and password of the profile whose user ID you want to 

change (in this example, the user ID for User 2, john_965@msys.com). This is 
the profile whose user ID is extraneous.

2 Click Home > Your Profile tab.
Your profile page opens.
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3 Click Edit Profile.
The Edit Your Profile page opens.

4 In the User ID field, type the user ID that you want to use (in this example, 
type the user ID for User 1, john@msys.com).

5 Click Save.
A dialog box asks you to enter the password for the user ID you wish to use 
(merge with).

6 Type your password, and click OK.
A dialog box indicates that the user ID already exists and asks you to confirm 
that you want to merge the contacts. 

7 Click OK.
8 A dialog box asks you to enter the password of the profile whose user ID you 

want to use.

9 Type the password of the profile whose user ID you want to use (in this 
example, type the password for User 1).

10 Click OK.
The user IDs of the profiles are merged. 
One of the following occurs:

■ If the two profiles for Spoke 1 and Spoke 2 are in the same community, the 
core fields are updated so that the core fields of User 2 are now the same 
as the core fields of User 1 (the core fields within the community are in 
sync).

■ If the two profiles for Spoke 1 and Spoke 2 are in different communities, 
the Account Email of User 2 is updated to be the same as that of User 1 so 
that the account fields are in sync. The core fields are not synced. Each 
spoke community retains the core fields that currently exist for that 
community.
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The Community Login page opens. You must log back in.

11 To log in, type your User ID and Password.
12 Click Go.

Active Community displays a list of the communities you belong to. 
13 Click on the link of the community you want to work with.

Profile Update Reminders
Because the information in company and contact profiles can become out-of-date, 
profile reminder emails can be sent 31 or more days after a profile was last 
updated. The update status of a profile is referred to as freshness. 
In addition, reminder emails can be sent based on the freshness of a particular 
part of the profile, such as contact information or custom field groups. Contacts 
receive a separate email reminder for each section of the profile.
Note: Reminder emails are sent to a contact’s Communication Email. This is the 
email address that hubs use to communicate with their spokes.
After the initial company or contact reminder email is sent (that is, after the 31 or 
more days specified as the reminder interval), contacts will receive a daily reminder 
email that asks them to update their profiles. 
The reminder emails will be sent until contacts log in to Active Community and 
update the information. After that, the reminder emails will be not be sent until the 
next reminder interval is reached (see “Setting Time Intervals for Profile Reminder 
Emails” on page 45).

Responding to Reminder Emails
Security permissions: None
You will receive emails that remind you to keep the information in your company or 
contact profile current. The emails provide a link to Active Community so you can 
login and update the information. Until you make the requested updates, you will 
receive daily emails.
Note: Reminder emails are sent to a contact’s Communication Email. This is the 
email address that hubs use to communicate with their spokes.

To respond to reminder emails
1 Click the link in the reminder email.

The Active Community login page opens.
2 Type your User ID and password, then click Login.
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3 Open the profile and update the requested fields.
4 Click Save.

Customizing Profile Reminder Messages
Security role: Community Administrator
Security permission: Community > Manage Community
Use this procedure to edit the default reminder email template for companies and 
contacts. Profile update reminders are community-wide. You cannot select 
particular companies to receive reminders and others to not receive them. 
Important: Updating an email template does not send the email message. It 
simply saves your changes to the template. Active Community sends the message 
only after the appropriate number of days has elapsed as described in “Setting 
Time Intervals for Profile Reminder Emails” on page 45.

To customize profile reminder messages
1 On the Home page, click Admin.
2 Click the Profile Freshness tab.

The Freshness Email Templates page opens. It contains a reminder email 
template for contact profiles and another for company profiles.

3 Click Edit for the email template you want to customize.
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The Freshness Email Template page opens. 

4 (Optional) Enter email addresses in the Email from and Reply to fields.
Note: If you do not provide email addresses, Active Community uses the 
From and Reply To addresses in the Communications Preferences part of the 
Community Settings tab (Admin > Community Settings) when it sends emails.

5 Modify the text in the body of the email as appropriate.
6 Click Update. 

A message indicates the email template updated successfully.

Setting Time Intervals for Profile Reminder Emails
Security role: Community Administrator
Security permissions: Community > Manage Community
Use this procedure to define the interval of time after which Active Community will 
send profile update reminder emails. The update status of a profile is referred to as 
freshness. 
Note: Reminder emails are sent to a contact’s Communication Email. This is the 
email address that hubs use to communicate with their spokes.
A freshness setting is on or off. The setting is:
■ On if there is a number in the Interval (days) field
■ Off if there is no number in the Interval (days) field
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As part of this procedure, you can define different reminders for core fields or 
custom field groups based on when they were last updated. 
Note: After freshness is set, and if the date a profile was last updated is more 
than the designated number of days, Active Community sends reminder emails 
immediately to contacts who have not updated their profile within the specified 
time period. 

To set profile update reminders
1 Click the Profiles tab, and then click Companies or Contacts. 

The Contacts (or Company) page opens.
2 Perform the appropriate action:

The Contact (or Company) Freshness Setting page opens. The page lets you 
define the freshness settings for company or contact core fields, as well as for 
specific custom field groups. 

Important: The number of days set for update profile reminder emails is 
listed in the Interval (days) column. 

■ If there is a number in the field, the freshness setting is on. Reminder 
emails will be sent at the appropriate interval for that set of fields.

■ If there is no number in the field, the freshness setting is off. No reminder 
email will be sent for that set of fields. 

3 Click Edit for the information you want to keep current.
The Edit Freshness Settings page opens.

4 In Interval (days), enter the number of days after the last profile update that 
you want a reminder email to be sent. For example, you enter 45 in the Interval 

If you clicked... Do this:
Companies Click the Settings tab, and then the Freshness link.
Contacts Click the Freshness tab. 
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(days) field for the Contact Core Fields group. If contact core fields in a profile 
are not updated in 45 days, Active Community automatically sends a profile 
update reminder email to the profile owner. 

5 Click Save. 
On the Freshness Setting page, you will see the number of days you set for 
update reminders. 

Discontinuing Profile Reminder Email Messages
Security role: Community Administrator
Security permissions: Community > Manage Community
Use this procedure to discontinue profile update reminders emails for company or 
contact profiles. Remember, you can choose to discontinue reminders for all of a 
profile or just part of a profile. For example, you might decide to discontinue profile 
update reminder emails for core fields, such as last name or address, but still send 
them for a custom field group, such as Role or Specialty.

To discontinue profile update reminders 
1 Click the Profiles tab, and then click Companies or Contacts. 

The Contacts (or Company) page opens.
2 Perform the appropriate action:

The Company (or Contact) Freshness Setting page opens. 

3 Click Edit for the appropriate field.
The Edit Freshness Settings page opens.

If you clicked... Do this:
Companies Click the Settings tab, and then the Freshness link.
Contacts Click the Freshness tab. 
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4 To turn the reminder setting off, delete the number of days in the Interval 
(days) box.

5 Click Save.
The freshness setting has been turned off. No reminder emails will be sent for 
that set of fields. 
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Roles and Permissions 3
User access to Active Community modules and components is determined by the 
roles that are assigned to a user’s contact profile. 
Each role is made up of a group of permissions. Permissions determine which 
modules users can access, the components they can use, and the actions they can 
perform.
■ Some roles have limited permissions and limited access to modules and 

components.

■ Other roles have more permissions and greater access to modules and 
components.

For example, a contact who has a role with limited permissions might only be able 
to view a company profile. A contact who has a role with additional permissions 
might be able to edit a company profile, add an activity to a project, and view a 
custom field. 
By changing the permissions for any role, you change the level of access for all 
contacts assigned to the role. 
Topics include:
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■ “Roles and Permissions Overview” on page 50
■ “Working with Security Roles” on page 55
■ “Working with Contact (Business) Roles” on page 75
■ “Optional Module Roles” on page 80
■ “Working with Workspace Roles” on page 84
■ “Working with Registration Roles” on page 88

Roles and Permissions Overview
Active Community includes several types of security roles and contact (business) 
roles. These roles can be assigned to all contact profiles. 

1

2

Key Description
1 Security Roles
2 Contact (Business) Roles

While default roles are provided, custom roles can be defined for security and 
contact roles. 
Optional Active Community modules include roles that control a contact’s access to 
those modules (see “Optional Module Roles” on page 80).
Overview topics include:
■ “Security Roles and Contact Roles” on page 50
■ “Community Security Roles” on page 51
■ “Project Security Roles” on page 52
■ “Contact (Business) Roles” on page 53
■ “General Role Guidelines” on page 54
■ “Default Security and Contact Roles” on page 55

Security Roles and Contact Roles
There are several types of roles: security roles and contact roles.
■ Security roles control the actions users can perform in a community. Security 

roles can be grouped into these categories:
■ Community security roles—Include permissions related to the community 

as a whole; for example, the Community Administrator or Everyone role. 
Default roles are available, and custom roles can be created. 
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■ Project security roles—Include permissions related to all projects or 
permissions for a specific project; for example, the Project Owner or 
Participant role.

For default role descriptions, see “Community Security Roles” on page 51 and 
“Project Security Roles” on page 52.

■ Contact (business) roles describe a contact's functional role in an organization. 
One default role is provided, Contact (see “Contact (Business) Roles” on 
page 53).

Community Security Roles
Community security roles include permissions that apply to the community as a 
whole, such as importing and exporting contacts, adding tags, managing profiles, 
and adding projects. 
Two default roles are provided: the Community Administrator and Everyone roles. 
Custom security roles can be defined. 

1

Key Description
1 Security Roles (Community)

The following topics describe the default roles and custom security roles:
■ “Community Administrator Role” on page 51
■ “Everyone Role” on page 52
■ “Custom Security Roles” on page 52
To edit permissions for community security roles and assign roles to contacts, see 
“Working with Security Roles” on page 55. For a list of available permissions, see 
“Security Role Permission Descriptions” on page 57.

Community Administrator Role
This role is assigned to the person responsible for setting up and maintaining the 
community. The role includes all permissions, which means contacts with this role 
can access all parts of Active Community. By default, only contacts with the 
Community Administrator role can edit the permissions associated with security 
roles. 
In theory, any role can have the same permissions as the Community Administrator 
role, but only if the Community Administrator assigns all permissions to that role. 
Note: Permissions cannot be removed from the Community Administrator role. 
This safeguard ensures at least one security role has full access to Active 
Community. 

■ Community Administrator Role (Default)
■ Everyone Role (Default)
■ Custom security roles
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Everyone Role
The Everyone role is the default role for all community members. It is typically 
used for spoke (vendor) contacts. The Everyone role has the fewest permissions, 
which means it has limited access to Active Community modules and components. 
Active Community automatically assigns the Everyone role to all contacts added to 
a community after a contact’s profile has been created. 

Custom Security Roles
A contact with the Community Administrator role can create custom security roles 
for a community and assign permissions to them (see “Adding a Custom Security 
Role” on page 65). 

Project Security Roles
Project security roles are made up of permissions that apply to specific projects 
within a community. The permissions include the ability to edit a project, maintain 
project activities, and set project permissions for other roles.

1

Key Description
1 Security Roles (Project)

Default project security roles include: 
■ “Project Owner Role” on page 52
■ “Team Role” on page 52
■ “Participant Role” on page 53
■ “Community Administrator Role” on page 53
To edit permissions for project security roles and assign roles to contacts, see 
“Working with Security Roles” on page 55. For a list of available permissions, see 
“Project Security Role Permission Descriptions” on page 62. 

Project Owner Role
Active Community automatically assigns the Project Owner role to a contact after 
the contact creates a project. The role includes permissions related to starting, 
editing, and maintaining a project.

Team Role
Active Community automatically assigns the Team role to a contact after a contact 
in the Project Owner role adds a contact as a team member in the project. A 

■ Project Owner Role (Default)
■ Team Role (Default)
■ Participant Role (Default)
■ Community Administrator Role (Default)
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contact in the Team role helps the Project Owner perform project-related 
administrative tasks. 

Participant Role
Active Community automatically assigns the Participant role to a contact after a 
contact in the Project Owner role adds a contact as a participant in an activity. A 
contact in this role provides input and receives communication about project 
activities.

Community Administrator Role
The Community Administrator role is assigned to the person responsible for setting 
up and maintaining the community. By default, only contacts in the Community 
Administrator role can view all projects. 

Contact (Business) Roles
A contact role is a business function or an area of responsibility for a contact in a 
company in your community. 
Important: No permissions are assigned to contact roles.

Here are sample contact roles:
■ Distribution Manager
■ Managing Director
■ Sales Director
■ Operations Supervisor
■ Financial Controller
■ Primary Contact
One default contact role is provided (see “Contact Role” on page 54).

Key Description
1 Contact (Business) Roles

■ Contact Role (Default)
■ Custom roles for business functions

1
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Contact Role
Active Community automatically assigns the Contact role to a contact after a 
contact profile is created. With the appropriate permissions, additional contact 
(business) roles can be assigned to a contact by editing a contact’s profile. 

Note: If your community has the Registration module enabled, contact (business) 
role information can be collected during the company registration process. The 
roles automatically become part of contact profiles after the company is approved 
and registered (see “Registration Setup” on page 423). 

General Role Guidelines
The following guidelines apply to security and contact (business) roles:
■ Every Active Community user is assigned a security role. Some roles are 

automatically assigned when performing an action in Active Community.
■ Role names can be changed.
■ Custom roles can be created.
■ Permissions can be assigned to each role. 
■ When setting up a community, a contact in the Community Administrator role 

can import and assign security roles to existing contacts when importing 
contacts using a .csv file. The roles must already exist in Active Community; the 
import file does not create them (see “Importing Company or Contact Data” on 
page 135).
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Default Security and Contact Roles
The following default roles are provided for security and contact roles:
■ Community security roles:

■ Community Administrator
■ Everyone

■ Project security roles:
■ Project Owner
■ Team
■ Participant
■ Community Administrator

■ Contact (business) role:
■ Contact

For information about default roles for optional modules, see “Default Optional 
Module Roles” on page 83.

Working with Security Roles
The graphic outlines the general process for working with security roles, assigning 
permissions to each role, and assigning roles to contact profiles. 

1 2 3

4

Key Description
1 Select Default Role or Create Custom Role
2 Define Role Permissions
3 Assign Role(s) to Contact Profiles
4 All Contacts in Role Can Do Same Tasks
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In the procedures, if a check box for a permission is selected, the permission is 
active for the role. If the check box for a permission is not selected, the permission 
is not active for the role. 

Topics include:
■ “Editing Permissions for Community Security Roles” on page 56
■ “Editing Permissions for Project Security Roles” on page 60
■ “Assigning Core Company Field Permissions to Security Roles” on page 63
■ “Assigning Custom Field Group Permissions to Security Roles” on page 64
■ “Adding a Custom Security Role” on page 65
■ “Managing Security Role Members Using Business Roles” on page 67
■ “Removing All Members Assigned to a Security Role” on page 71
■ “Assigning a Security Role to a Contact Profile” on page 73

Editing Permissions for Community Security Roles
Security role: Community Administrator

To edit permissions for a community security role
1 Click Admin.

The page opens to the Community Settings tab.
2 Click the Security Roles tab. 

A list page opens and lists the security roles for the community.
3 Select the name of the security role you want to edit.
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The Edit Security Role page opens.

4 To add or remove a permission for a security role, select or clear the check box 
in the Permissions column. For more information, see “Security Role Permission 
Descriptions” on page 57.

5 Click Save. 

Security Role Permission Descriptions
Important: A hub should assign most permissions to roles for the hub company. 
The permissions in the My Company permissions category should be assigned to 
spokes and the Everyone role.
Use the information in the table as you select or clear the permissions for a 
community security role. 

Select or clear this option... If you want a role to do this:
Community Permissions—Manage a Community

■ Manage Community ■ Manage overall settings of the community by 
enabling the Admin menu option.

■ Manage Alerts ■ Manage community alerts
■ Delete Active Profiles ■ Delete active profiles from a community

Note: Delete Active Profiles is the only 
permission that is not automatically selected for 
the Community Administrator role.

■ Add Sub-community ■ Create new sub-communities in the hub 
community
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■ Super Admin Edit ■ Edit companies and contacts without being 
required to enter mandatory custom field 
information.
Note: Does not apply to core fields for 
integrated communities.

Change Management Permissions—Manage a Change Management Process
■ Create/Edit/Delete Change 

Management Process
■ Manage the review process which requires 

approval or rejection of requested changes to 
selected company custom fields.

Sub-Community Permissions—Manage a Sub-community
■ Manage Sub-communities ■ Manage and edit the properties of a sub-

community
■ Add Companies ■ Add companies to sub-communities
■ Edit Companies ■ Edit companies in a sub-community
■ Delete Inactive Companies ■ Delete inactive companies from a sub-

community
■ View Companies ■ View companies in a sub-community
■ Import Companies ■ Import companies to a sub-community
■ Enable Companies ■ Enable companies in a sub-community
■ Disable Companies ■ Disable companies in a sub-community
■ Export Companies/Reports ■ Export company profile data and run reports

Company Permissions—Manage Companies in a Community
■ Add Companies ■ Add companies to a community
■ Edit Companies ■ Edit companies in a community
■ Delete Inactive Companies ■ Delete inactive companies from a community
■ View Companies ■ View companies in a community
■ Import Companies ■ Import companies to a community
■ Enable Companies ■ Enable companies in a community
■ Disable Companies ■ Disable companies in a community
■ Manage Alerts ■ Manage company alerts
■ Export Companies/Reports ■ Export company profile data and run reports
■ View Audit Log ■ View audit information about a company

My Company Permissions—Manage Spoke Companies
(These permissions should be assigned to the spoke or Everyone role)

■ Edit My Company ■ Edit My Company profile
■ View My Company ■ View information about my company, including 

masked fields
■ Add My Company Contacts ■ Add contacts for my company
■ Edit My Company Contacts ■ Edit contacts in my company
■ Export My Company Contacts ■ Export my company’s contacts
■ Edit My Company Divisions ■ Edit information in any of the divisions of a 

parent company
■ Delete My Company Contacts ■ Delete contacts from my company
■ View My Company Contacts ■ View contacts in my company

Select or clear this option... If you want a role to do this:
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■ Enable My Company Contacts ■ Enable contacts in my company
■ Disable My Company Contacts ■ Disable contacts in my company

Custom Field Permissions—Categorize Information about Companies and Contacts
■ Manage Custom Fields ■ Define custom field permissions
■ View Masked Fields ■ View data in fields outside my company when 

data masking is enabled for those fields. 
Company Core Field Permissions—Manage Basic Company Information

■ Manage Company Core Fields ■ Define core field permission
Contact Permissions—Manage Contacts

■ Add Contacts ■ Add contacts to a community
■ Edit Contacts ■ Edit contacts in a community
■ Delete Inactive Contacts ■ Delete inactive contacts in a community
■ View Contacts ■ View contacts in a community
■ Import Contacts ■ Import contacts to a community
■ Enable Contacts ■ Enable contacts in a community
■ Disable Contacts ■ Disable contacts in a community
■ Manage Alerts ■ Manage contact alerts
■ View Hub Company Contacts ■ View hub company contacts
■ Export Contacts ■ Export contact profile data
■ View Audit Log ■ View audit information about a contact

File Library Permissions—Manage Company Files and Folders
■ View Files and Folders ■ View files and folders in the Files tab in a 

company profile
■ Add Folders ■ Add new folders to the Files tab in a company 

profile
■ Edit Folders ■ Edit folders in the Files tab in a company profile
■ Delete Folders ■ Delete existing folders in the Files tab in a 

company profile
■ Add Files ■ Add files to a folder in the Files tab in a company 

profile
■ Delete Files ■ Delete files in a folder in the Files tab in a 

company profile
Public Report Permissions—Create Public Searches and Reports

■ Create Public Exports/Reports ■ Create a public report
■ Create Public Searches ■ Create public searches

Item Permissions (Item Management module only)
■ View Items ■ View item profiles
■ Add Items ■ Add item profiles
■ Edit Items ■ Edit item profiles
■ Delete Items ■ Delete item profiles
■ Enable Items ■ Enable item profiles

Select or clear this option... If you want a role to do this:
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Editing Permissions for Project Security Roles
Security role: Community Administrator
Use this procedure to edit role permissions for new and specific projects.

To edit permissions for project security roles
1 Click Projects.

■ Disable Items ■ Disable item profiles
■ View My Items ■ View item profiles I created
■ Add My Items ■ Add my item profiles
■ Edit My Items ■ Edit my item profiles
■ Delete My Items ■ Delete my item profiles
■ Enable My Items ■ Enable my item profiles
■ Disable My Items ■ Disable my item profiles
■ Export Items ■ Export item profiles

Project Permissions—Manage Projects in a Community
■ Add Projects ■ Add a project to a community
■ View Projects ■ View the Project tab. Contacts can view projects 

in which they are included. 
By default, a contact in the Community 
Administrator role can view all projects. 

Tag Permissions—Manage Keyword Tags
■ View Tags ■ View keyword tags
■ Update Tags ■ Update keyword tags

Workspace Permissions (Workspace module only)
■ View Workspace ■ View a workspace
■ Edit Workspace ■ Edit a workspace

Select or clear this option... If you want a role to do this:
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The Projects list page opens to the All Projects tab.

2 Perform the appropriate action:

Either the Default Permissions for New Projects or Permissions for Roles in the 
Project (shown) page opens. Project-related security roles are listed across the 
top of the page.

To edit permissions 
for... Do this:
New projects ■ Click the Default Project Permissions tab.
A specific project ■ Select the project for which you want to edit 

permissions, then click the Permissions tab.
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3 To add or remove a permission for a project security role, select or clear the 
check box in the Permissions column. For more information, see “Project 
Security Role Permission Descriptions” on page 62.

4 Click Save. 

Project Security Role Permission Descriptions
Use the information in the table as you select or clear the permissions for a project 
security role.

Select or clear this option... If you want a role to do this:
Projects

Files

Web Forms

Activities

■ Edit Projects ■ Edit projects
■ Delete Projects ■ Delete projects
■ View Projects ■ View projects
■ Add Participants ■ Add participants to a project
■ Delete Participants ■ Delete participants from a project
■ Edit Participants ■ Edit participants in a project
■ Delete Participants ■ Delete participants from a project
■ View Project Permissions ■ View project permission settings
■ Update Project Permissions. ■ Update project permission settings

■ Add Files ■ Add project-related files
■ Edit Files ■ Edit project-related files
■ Delete Files ■ Delete project-related files
■ View Files ■ View project-related files

■ Add Web Forms ■ Add web forms to gather survey data
■ Edit Web Forms ■ Edit existing web forms
■ Publish Web Forms ■ Publish web forms to contacts in a community
■ Delete Web Forms ■ Delete web forms
■ View Web Forms ■ View web forms
■ Export Web Form Results ■ Export the results of web form surveys

■ Add Activities ■ Add project activities
■ Edit Activities ■ Edit project activities
■ View Activities ■ View project activities
■ Delete Activities ■ Delete project activities
■ Start Activities ■ Start project activities
■ Stop Activities ■ Stop project activities
■ Suspend Activities ■ Suspend project activities
■ Reopen Activities ■ Reopen project activities
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Assigning Core Company Field Permissions to Security 
Roles

Security role: Community Administrator
Security permission: Company Core Field Permissions > Manage Company Core 
Fields

To define core company field permissions for a security role
1 Click Profiles > Companies > Settings tab.
2 Click the Core Field Permissions link.

The Edit Core Field Permissions page opens. Security roles are listed across the 
top of the page. Core company fields are listed down the side of the page.

3 To add or remove permission to view a company core field for a security role, 
select or clear the check box (see “Company Core Field Permissions” on 
page 63).

4 Click Save.

Company Core Field Permissions
Permissions to view or not to view company core fields can be defined for each 
security role. Company core fields include:

■ Company Name ■ Address-2
■ Company ID ■ Address-3
■ Parent Company ID ■ City
■ Website URL ■ State/Province/Region
■ Email ■ Postal Code
■ Phone ■ Country
■ Fax ■ # Employees
■ Address-1 ■ Notes
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Assigning Custom Field Group Permissions to Security Roles
Security role: Community Administrator
Security permission: Custom Field Permissions > Manage Custom Fields
Use this procedure to control which security roles can view or edit a custom field 
group (or individual fields within a group) in company and contact profiles. 
Note: 
■ A custom field is a question or input field that allows the community owner to 

gather and keep key information about its trading partners, customers, sales 
reps, or other contacts in a community.

■ A custom field group is a tab in a community member's profile. The tab contains 
custom fields. For example, a custom field group might display as a tab called 
Company Information. In the tab, it might include a custom field called Specialty 
where contacts can select a check box to indicate their specialty.

To assign custom field group permissions for a security role
1 Perform the appropriate action: 

The Custom Field Permissions page opens. Custom field groups are displayed in 
the Custom Field Group column. Security role names are listed in the column 
headings.

2 Select the custom field group for which you want to assign permissions. 

To define custom 
field permissions 
for... Do this:
Companies 1 Click Profiles > Companies.

The Companies list page opens.
2 Click the Settings tab > Custom Fields Permissions 

link.
Contacts 1 Click Profiles > Contacts.

The Contacts list page opens.
2 Click the Permissions tab.



R O L E S  A N D  P E R M I S S I O N S
Working with Security Roles

OpenText Active Community CE 21.2 User Guide  65

3  

The selected custom field group name displays.
3 For the appropriate security role column, select or clear the check boxes for 

Edit Group or View Group. Use the arrows following the column headings to 
display additional sets of security roles. 
Important: If you clear the View Group permission for a custom field group, 
Active Community does not display all custom fields in that group in the 
following areas.

■ Contact or company profiles
■ Custom fields available to be copied on a web form or imported or exported
■ Custom fields available using Advanced Search

4 To specify permissions for fields within the selected custom field group, click 
the Show Field Permissions link.

5 For a particular security role, select or clear the check boxes for Edit Field or 
View Field.

6 To close field permissions, click the Hide Field Permissions link.
7 Click Save.

You have defined which security roles can view or edit custom field groups in 
company and contact profiles. Your settings control which custom fields users 
can view if they have been assigned this security role.

Adding a Custom Security Role
Security role: Community Administrator
Security permission: Community Permissions > Manage Community
Use this procedure to create a custom security role and assign it to contact 
profiles. 

To add a custom security role and assign it to contact profiles
1 Click Admin > Security Roles tab.
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A list page opens and lists the security roles for the community.

2 Click Add Security Role.
The Create Security Role page opens.

3 In Name and Description, type the name and description of the new role.
4 In the Permission column, select the check boxes for the permissions you want 

to assign to the role (see “Security Role Permission Descriptions” on page 57). 
5 Click Continue.
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A message indicates the role has been created. The Available Contacts column 
lists Contacts that can be assigned to the new role.

6 Do one of the following:
■ To assign members to the security role using a business role, go to step 3 

in “Managing Security Role Members Using Business Roles” on page 67.
■ To assign members to the security role manually, select the contacts to 

whom you want to assign the new role from the Available Members column 
and click the arrow between the columns that points to the Current 
Members column.
The contact’s name moves to the Current Members column.

Note: If needed, in Search Members, type the name of the contact to 
whom you want to assign the role, then click Search.

7 Click Done.
You have created a new security role and assigned the role to contacts. 

Managing Security Role Members Using Business Roles
You can automatically assign members to a security role using a business role if 
you link the security role to the business role. 
Note: If the security role has members who were manually assigned to it, you 
must manually remove all members from the security role before proceeding. See 
“Removing All Members Assigned to a Security Role” on page 71.

To manage security role members using a business role
1 Click Admin > Security Roles tab.
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A list page opens and lists the security roles for the community.

2 Click Edit for the security role you want to edit, for example TestSecurityRole.
The Edit Security Role page opens.

3 Click the Manage Members Using Business Roles check box. The Business 
Roles drop-down list displays.
Note: The check box is unavailable until there are no members in the 
“Current Members” column. If there are any current members that have been 
manually assigned to this security role, you must remove them before assigning 
members using a business role. See “Removing All Members Assigned to a 
Security Role” on page 71.
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After you select the Manage Members Using Business Roles check box, 
the column header changes from “Current Members” to “Members From 
Business Role.” 
Note: You cannot manually add or remove members from this column.
“Current Members” column header.

“Members From Business Role” column header.
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4 From the Business Roles drop-down list, select the business role whose 
members you want to assign to this security role.
Note: The “Members From Business Role” column is empty the first time you 
select a business role from the drop-down list. After you click Done, the 
members are added and you see them the next time you view this page. 

5 Click Done.
You are returned to the Security Roles list screen.

6 If you want to view the members of the business role that have been assigned 
to the security role, on the list page, click Edit for the security role you just 
edited.
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The members display in the Members from Business Role column.

Removing All Members Assigned to a Security Role
To use the option to assign members to a security role using a business role, you 
need to ensure that members who were previously manually assigned to the 
security role are removed.

To remove all members assigned to a security role:
1 Click Admin > Security Roles tab.

A list page opens and lists the security roles for the community.

2 Click Edit for the security role you want to edit, for example “Hub User Security 
Role.”



72 OpenText Active Community CE 21.2 User Guide

R O L E S  A N D  P ER M I S S I O N S
Working with Security Roles

The Edit Security Role page opens.

3 Use the Select All check box in the “Current Members” column header to 
select all members.

4 Click the arrow between the columns that points to the “Available Members” 
column.
All members are moved from the “Current Members” column to the members 
“Available Members” column, leaving the “Current Members” column empty. 
The Manage Members Using Business Roles check box is now enabled. 

5 You can now select this check box to assign members to this security role using 
a business role. See “Managing Security Role Members Using Business Roles” 
on page 67

6 Click Done.
You are returned to the Security Roles list page. 
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Assigning a Security Role to a Contact Profile
Security permissions: 
■ Contact Permissions > Edit Contacts

or
■ My Company Permissions > Edit My Company Contacts
Use this procedure to assign one or more security role(s) to a contact by editing a 
contact’s profile. You can also click Admin > Security Roles tab. Under the 
Members column on the list page, click Edit, then search for members to assign to 
a security role.
Important: When setting up a community, a contact in the Community 
Administrator role can import and assign security roles to existing contacts using a 
.csv file. Security roles must already exist. They cannot be created using the import 
file. In addition, follow the guidelines in “Contact Requirements for Importing 
Data” on page 131 so the import file does not overwrite existing roles. 

To assign a security role to a contact profile
1 Click Profiles > Contacts.

The Contacts list page opens.
2 Use the search options to find the contact you want (see Chapter 4, “Find 

Information”).
3 Select the name of the contact to whom you want to assign a security role.

The Contact Profile page opens to the Overview tab. 

4 Click Manage Profile > Edit Contact.
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The Editing Contact Profile page opens.

5 Click Security Roles, then select the Active Community link.
The Edit Security Memberships page opens for the selected contact. It lists the 
contact’s current security roles as well as the available security roles. 

6 To assign additional security roles to the contact, select one or more available 
security roles and use the arrow keys in the center of the page to move the 
selected roles to the Current Roles column.

7 Click Done.
The selected security roles are now assigned to the contact. 
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Working with Contact (Business) Roles
The graphic outlines the general process for working with contact roles and 
assigning them to contact profiles. 

1 2

Key Description
1 Create Custom Contact Roles
2 Assign Roles to Contact Profiles

Active Community automatically assigns the default Contact role to a contact after 
a contact profile is created. Additional contact (business) roles can be created to 
categorize business functions within a community. 
Important: Permissions are not assigned to contact roles. 
Topics include:
■ “Adding a Contact (Business) Role” on page 75
■ “Assigning a Contact (Business) Role to a Contact Profile” on page 76
■ “Editing the Name and Description of a Contact (Business) Role” on page 79
■ “Deleting a Contact (Business) Role” on page 80

Adding a Contact (Business) Role
Security role: Community Administrator
Use this procedure to create roles that indicate a contact's business functions in 
their organization. Business roles can be configured as hub-only business roles for 
scenarios where it is necessary to have business roles assigned for hub use only.

To add a contact (business) role
1 Click Profiles > Contacts > Business Roles tab.
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The Manage Business Roles page opens. 

2 Click Add Business Role.
Additional fields display at the top of the page. 

3 In Role Name, type the name of the role; for example, “Controller.”
4 In Description, type information about the role, such as the department or a 

description of the role abbreviation.
5 To configure this business role for hub use only, select the For Internal Hub 

use only check box. If selected, the role is visible to hub contacts only.
Note: Hub-only business roles do not display under registration settings. 
(Registration > Admin >Registration Settings)

6 Click Save.
You can now assign the contact (business) role to a contact.

7 Go to “Assigning a Contact (Business) Role to a Contact Profile” on page 76.

Assigning a Contact (Business) Role to a Contact Profile
Security role: Community Administrator



R O L E S  A N D  P E R M I S S I O N S
Working with Contact (Business) Roles

OpenText Active Community CE 21.2 User Guide  77

3  

Use this procedure to assign multiple contact (business) roles to a contact. You 
must define contact roles before they can be assigned (see “Adding a Contact 
(Business) Role” on page 75). Active Community automatically assigns the default 
Contact role to a contact after a contact profile is created. 
Note: When setting up a community, a contact in the Community Administrator 
role can import and assign contact roles to existing contacts when using a .csv file. 
Be sure to include a Role column in the import file. The column should specify the 
roles you want to assign to each contact. In addition, follow the guidelines in 
“Contact Requirements for Importing Data” on page 131 so the import file does 
not overwrite existing roles. 

To assign a contact (business) role to a contact profile
1 Click Profiles > Contacts.

The Contacts list page opens.
2 Use the search options to find the contact you want (see Chapter 4, “Find 

Information”).
3 Select the name of the contact to whom you want to assign one or more 

contact roles.
The Contact Profile page opens to the Overview tab. 

4 Click Manage Profile > Edit Contact.
The Edit Contact Profile page opens.

5 Click the Business Roles tab.
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The available contact (business) roles display.

6 Select or clear the check boxes for the role(s) you want to assign to the 
contact. 

7 Click Save.
The selected business roles are now included in the contact’s profile. 
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Editing the Name and Description of a Contact (Business) 
Role

Security role: Community Administrator
Use this procedure to change the name and description of a contact role. After 
completing this procedure, your changes are reflected in all contact profiles 
assigned to the contact role. 

To change the name and description of a contact (business) role
1 Click Profiles > Contacts > Business Roles tab.

The Manage Business Roles list page opens.

2 Click anywhere in the row of the role you want to change.
The page refreshes with fields at the top of the page.

3 In Role Name, change the name of the role.
4 In Description, change information about the role.
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5 Click Save.
The name and description of the contact role is updated. Updates are reflected 
in all contact profiles to whom the role has been assigned. 

Deleting a Contact (Business) Role
Security role: Community Administrator
Use this procedure to delete a contact (business) role. You cannot delete a role if it 
has been assigned to one or more contacts. 

To delete a contact role
1 Click Profiles > Contacts > Business Roles tab.

The Manage Business Roles page opens. 

2 For the role you want to delete, click the Remove Role icon.
A dialog box opens and asks if you really want to delete the role. 

3 Click Delete.
As long as the role has not been assigned to a contact, the role is deleted. 

Optional Module Roles
Some roles are associated with optional Active Community modules, including the 
Workspace and Registration modules. 

1

Key Description
1 Optional Modules

Optional module roles include:

■ Workspace
■ Registration
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■ Workspace roles—Control the amount of access a contact has in a specific 
workspace. 

■ Registration roles—Control which contacts can perform actions on registration 
requests during the request approval process. Registration module only. 

Overview topics include:
■ “Workspace Roles” on page 81
■ “Registration Roles and Contacts” on page 82
■ “General Optional Module Role Guidelines” on page 83
■ “Default Optional Module Roles” on page 83

Workspace Roles
Important: The optional Workspace module must be set up and enabled before 
workspace roles can be activated. A workspace is a group-editable Web page 
where you and groups of contacts in your community can interact and share 
information. 
Workspace roles consist of a set of permissions that control the amount of access a 
contact has in a workspace. 

1

Key Description
1 Optional Module Roles - Workspace

The following topics describe the default workspace roles:
■ “Workspace Administrator Role” on page 81
■ “Editor Role” on page 82
■ “Observer Role” on page 82
■ “Community Administrator Role” on page 82
To edit permissions for workspace roles and assign roles to contacts, see “Working 
with Workspace Roles” on page 84. For a list of available permissions, see 
“Workspace Role Permission Descriptions” on page 86.

Workspace Administrator Role
Active Community automatically assigns the Workspace Administrator role to a 
contact after the contact creates a workspace. Contacts with this role can change 
the workspace name and description, add and remove members, start 
conversations, add events, and add files. 

■ Workspace Administrator Role (Default)
■ Editor Role (Default)
■ Observer Role (Default)
■ Community Administrator Role (Default)
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Editor Role
This role can be assigned to a contact who is an active participant in the 
workspace. Contacts who are assigned to this role can start and reply to 
conversations, add events, and upload files for sharing with other suppliers in a 
workspace.

Observer Role
This role can be assigned to contacts who need to view the workspace, but not 
participate in it. For example, an Observer might be a project team member who 
only wants to receive an informational copy of project-related email messages. 

Community Administrator Role
The Community Administrator role is assigned to the person responsible for setting 
up and maintaining the community. By default, this role automatically has all 
permissions to all workspaces, and can view and edit any workspace in the 
community. 

Registration Roles and Contacts
Important: The optional Registration module must be set up and enabled before 
registration roles can be activated.
Registration roles and contacts control the amount of information a person sees on 
a company registration request. The information in a request is based on a 
contact’s registration role or on the “part” a contact plays in the registration 
process. That is, the:
■ Pre-Approval and Approval roles can be assigned to contacts in the hub 

community. These registration roles are assigned to contacts in addition to 
security roles.

■ Requesters and Primary Contacts are contacts inside and outside the hub 
community. Registration roles cannot be assigned to them.

Important: While the default roles outlined in the following topics are provided, a 
contact in the Community Administrator role can rename the roles so they are 
appropriate to a community (see “Renaming Default Registration Roles” on 
page 90). 
The following topics describe the default registration roles:
■ “Requester” on page 83
■ “Pre-Approval Role” on page 83

1 Optional Module Roles - Registration
■ Requester (Default)
■ Pre-Approver Role (Default)
■ Primary Contact (Default)
■ Approval Role (Default)

1
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■ “Primary Contact” on page 83
■ “Approval Role” on page 83
To edit permissions for registration roles and assign roles to contacts, see “Working 
with Registration Roles” on page 88. For a list of available permissions, see 
“Registration Role Permission Descriptions” on page 89.

Requester
A Requester can be a contact inside or outside the hub community, such as a 
contact with a potential supplier. Requesters can be contacts with these business 
roles: buyer, sales representative, or supplier liaison.
Requesters create or submit registration requests to the hub community. 
Note: To submit registration requests, contacts outside the hub company must 
click the anonymous requester URL that is provided in an email. 

Pre-Approval Role
The Pre-Approval role can be assigned to such hub employees as category 
managers or buyers. Multiple Pre-Approval roles can be defined. 
Hub contacts in the role review registration requests and pre-approve them. The 
request then goes to the next stage in the registration process. 

Primary Contact
A Primary Contact is the primary contact for a company outside the hub 
community. Primary Contacts receive registration requests from the hub company 
and complete information in the request. 

Approval Role
Hub contacts in the Approval role validate that a Primary Contact completed all 
required details in a registration request. Multiple Approval roles can be defined.

General Optional Module Role Guidelines
The following guidelines apply to optional module roles:
■ Default roles are provided.
■ For the Workspace and Registration modules:

■ Permissions assigned to each role can be changed.
■ Roles can be assigned to contact profiles.

■ For the Registration module, default roles can be renamed.

Default Optional Module Roles
The following default roles are provided for optional modules:
■ Workspace roles

■ Workspace Administrator
■ Editor
■ Observer
■ Community Administrator
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■ Registration roles
■ Requester 
■ Pre-Approval
■ Primary Contact 
■ Approval

For information about default roles for security and contact (business) roles, see 
“Default Security and Contact Roles” on page 55.

Working with Workspace Roles
A workspace role consists of a set of permissions that control the actions a contact 
con perform in a workspace. For example, a contact with a workspace role of 
Editor can start and reply to conversations, add events, and upload files for sharing 
with other suppliers in a workspace. 
The graphic outlines the general process for working with workspace roles, 
defining permissions, and assigning roles to contact profiles. 

1 2 3

4

Key Description
1 Select Default Role
2 Define Role Permissions
3 Assign Role(s) to Contact Profiles
4 All Contacts in Role Can Do Same Tasks

In the procedures, if a check box for a permission is selected, the permission is 
active for the role. If the check box for a permission is not selected, the permission 
is not active for the role. 

Topics include:
■ “Editing Permissions for Workspace Roles” on page 85
■ “Assigning a Workspace Role to a Contact” on page 86
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Editing Permissions for Workspace Roles
■ Security role: Community Administrator
or
■ Workspace role: Workspace Administrator
Security permissions: 
■ Workspace Permissions > View Workspace and Edit Workspace
Use this procedure to control which contacts view and edit different areas of a 
workspace. Workspace areas include Conversations, Upcoming Events, etc. 

To edit permissions for a workspace role
1 Click Applications, and then Workspaces. 

The Workspaces page opens.
2 At the top of the page, click Menu > Workspace Settings. 

Note: If you do not see a Workspace Settings menu option, you are not a 
Community or Workspace Administrator. 

The Workspace Settings page opens.
3 Under the Permission heading, to add or remove a permission for a particular 

role, simply select or clear the check box (see “Workspace Role Permission 
Descriptions” on page 86). 
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4 Click Save. 
Note: Permissions cannot be removed from the Community Administrator 
security role. This safeguard ensures that at least one role has full access to the 
workspace. 

Workspace Role Permission Descriptions
Use the information in the table as you select or clear the permissions for a 
Workspace role.

Select or clear this option... If you want a role to do this:
Members

Documents

Events

Forums

Workspaces

Assigning a Workspace Role to a Contact
■ Security role: Community Administrator

or
■ Workspace role: Workspace Administrator
Security permissions: 
■ Workspace Permissions > View Workspace and Edit Workspace
Use this procedure to assign a role to a workspace member. 

To assign a workspace role to a workspace member
1 Click Applications, and then Workspaces. 

The Workspaces list page opens.
2 Select the workspace to which you want to add a team member.

■ Add Members ■ Add members to the workpace
■ Remove Members ■ Remove members from the workpace

■ Upload Documents ■ Upload documents to the workspace
■ Delete Documents ■ Delete documents from the workspace

■ Edit Events ■ Edit workspace events

■ Edit Forums ■ Edit workspace forums

■ View Workspace ■ View the workpace
■ Edit Workspace ■ Edit the workpace
■ Delete Workspace ■ Delete the workpace
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The main page for the workspace opens.

3 In the Members section, click View/Manage Members.
The Members page opens.

4 In Search for Contacts, type the name of the contact to whom you want to 
assign a workspace role, then click Search.

5 In the Community Directory column, select the check box for the contact(s) to 
whom you want to assign a role. 

6 In the drop-down list, select the role you want to assign to the contact.
7 Click Add.

The selected workspace role is assigned to the contact. The contact’s name 
moves from the Community Directory column to the Existing Members column.
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Working with Registration Roles
Important: The Registration module must be set up and enabled before 
registration roles can be activated.
Registration roles control which users can perform actions on registration requests 
during the request approval process.
The graphic outlines the general process for working with registration roles and 
assigning them to contact profiles. 

1 2 3

4

Key Description
1 Select Default Role
2 Define Role Permissions
3 Assign Role(s) to Contact Profiles
4 All Contacts in Role Can Do Same Tasks

In the procedures, if a check box for a permission is selected, the permission is 
active for the role. If the check box for a permission is not selected, the permission 
is not active for the role. 

Topics include:
■ “Defining Permissions for Registration Roles” on page 88
■ “Renaming Default Registration Roles” on page 90

Defining Permissions for Registration Roles
Security role: Community Administrator
Use this procedure to identify the request information you want people in different 
Registration roles to see and edit on Registration tabs. For example, you might 
want to include a Buyer Checklist tab that contains custom fields in a registration 
request. You only want the tab to be viewed and edited by contacts in the 
Requester role. 

To define permissions for registration roles
1 Click Applications > Registration > Admin tab.
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2 Click the Manage Permissions link.
The Registration Permissions page opens. Registration roles are listed across 
the top of the page.

3 To indicate which tabs you want to show or hide for each role, select or clear 
the check boxes in the Permissions column for each role.

4 To specify permissions for fields within a custom field group, click the Show 
Field Permissions link, then select or clear the fields you want registration 
roles to view or edit (see “Registration Role Permission Descriptions” on 
page 89).

5 Click Save.

Registration Role Permission Descriptions
Use the information in the table as you select or clear the permissions for a 
Registration role.

Select or clear this option... If you want a role to do this:
Company Details

Primary Contact Details

Contact Details

Custom Field Groups (Unique to a community)

■ View Details ■ View details of a company
■ Edit Details ■ Edit details of a company

■ View Details ■ View details of a primary contact
■ Edit Details ■ Edit details of a primary contact

■ View Details ■ View contact details
■ Edit Details ■ Edit contact details

■ Edit Group ■ Edit custom field groups or custom fields within a 
group

■ View Group ■ View custom field groups or custom fields within a 
group
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Renaming Default Registration Roles
Security role: Community Administrator
Use this procedure to rename default Registration roles so they are appropriate to 
a community. For example, the default:
■ Pre-Approval role might be renamed to Buyer
■ Requester role might be renamed to Potential Trading Partner
■ Approval role might be renamed to Supplier Relations Team

To rename default registration roles
1 Click Applications > Registration > Admin tab.
2 Click the Configure Approvals link.

The Configuration Approval page opens. 
3 Scroll to the Customize Approval Stage Labels part of the page. The default 

Registration role names are listed in the Approval stage column.

4 Under the Label column, type the new name(s) of the role(s). 
Note: There is multiple language support for the Primary Contact label. See 
more information on language support in “Language Options for Custom Field 
Groups, Questions, and Choices” on page 238. Also see “Changing Your 
Language” on page 11.

5 Select a default landing tab for the primary contact. This is the tab that you 
want the primary contact to land on when they receive a registration request 
and enter the registration module.

Note: Only tabs that are parent tabs are displayed in the drop-down list and 
can be selected. You cannot select a dependent tab (child tab).

6 Click Save.
A message indicates the configuration has been updated.
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Search options help you find the exact information you need. Use search options to 
find contacts, companies, participants in activities, or project team members in 
your community. 

Even though search options are available from many different parts of Active 
Community, this section describes how to use them from a general perspective 
using company and contact profiles. Specific procedures related to each module 
provide more detailed information.
Topics include:
■ “Quick (Simple) Searches” on page 91
■ “Advanced Searches” on page 93
■ “Saved Searches” on page 102
■ “Tagging Search Results” on page 106
■ “Acting on Search Results” on page 109

Quick (Simple) Searches
Use a quick search, sometimes called a simple search, for easy, single-word 
searches, such as for contacts with a last name of “Smith” or companies that 
contain the name “Acme.”
Active Community matches the search word or words you enter against common 
fields in contact or company profiles, such as Name, Company Name, and Email 
Address. For example, if you enter “Smith” as search criteria, the results might 
include a contact named “Matt Smith” and contacts who work for a company 
named “Smith Industries.”
Go to “Using Quick (Simple) Searches” on page 92.
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Using Quick (Simple) Searches
To use quick search
1 Click Profiles > Companies or Contacts.

The All Companies or Contacts page opens.
2 In the Search: or Search for Contacts box, type a person's name, company, 

or other search criteria.

3 (Optional) Select the Include Disabled check box if you want to include 
disabled contacts or companies in your search.

4 Click Search.
The search results display. 

5 Decide what you want to do with the search results:
■ To clear the search criteria and view all contacts or companies again, click 

Clear.
■ To view profile details, such as company or contact information, open the 

profile you want. To return to search results, click Return to Search on 
the profile page.
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■ To create a saved search based on the search results, see “Creating a 
Saved Search” on page 103.

■ To create tags, which allow you to quickly find company and contact 
profiles based on the search results, see “Tagging Search Results” on 
page 106.

■ To use the Actions drop-down list to perform an action on the results, such 
as disable contacts or export a list of companies, click the Actions drop-
down list and select the action you want to perform (see “Acting on Search 
Results” on page 109).

Advanced Searches
Use advanced searches to perform more complex searches for information. The 
more search criteria you use, the more specific the results of your search.
For example, use advanced search if you want to find:
■ All contacts who have been disabled since 1/1/2009
■ All companies with a name matching “Acme” and with a Revenue (Mil) of 5
■ All activity participants who have not responded to web form questions with an 

activity status of “Assigned” or “In Progress”
Topics include:
■ “Advanced Search Page” on page 93
■ “Advanced Search Examples” on page 94
■ “Commonly Used Advanced Searches” on page 97
■ “Creating Advanced Searches” on page 100

Advanced Search Page
The advanced search page contains many options that let you find the exact 
information you need. 

1

8

2 3

4
5 6

7

119
10



94 OpenText Active Community CE 21.2 User Guide

F I N D I N F O RM A T I O N
Advanced Searches

The parts of an advanced search page:
Key Description
1 ALL or ANY Attributes match the following—Match all search criteria or any of the 

search criteria in all rows.
2 Contact, company, or sub-community (only for company profiles) search box.
3 Options in the second search box change based on the selection in the first 

search box (contact, company, or sub-community (only for company profiles)). 
Note: If data masking is enabled for a company custom field, and you do not 
have permission to view the field, the field is unavailable in the drop-down list 
and cannot be selected.

4 Options vary based on selections in the second search box, including contains, 
does not contain, is equal to, is not equal to, is less than, is greater than, starts 
with, ends with, is on or before, is on or after, in last 24 hours, after, before, all, 
none.

Select the operator that describes how you want Active Community to search for 
information.

5 Fourth search box—Type the word, number, or date the operator is to be paired 
with

6 Click the + icon to add another row of search attributes
7 OR or AND Attributes match the following:

8 Options vary based on selections in the third search box (see 4). When you 
select the operator “Is On or Before” or “Is On or After,” a days or date search 
box displays (see 9). 

9 Type the numbers of days or select a date. The days or date search box displays 
when you select the operator “Is On or Before” or “Is On or After” (see 8). 

10 Click the icon to switch between the text box for days and date (see 9).
11 Click Add Condition Block to add more search conditions. 

See also “Advanced Search Examples” on page 94, “Commonly Used Advanced 
Searches” on page 97, and “Creating Advanced Searches” on page 100.

Advanced Search Examples
Advanced search provides many search options so you can find the data you need. 
The following examples show how to find the company or contact profiles by 
selecting different values and combining search criteria. 
Topics include:
■ “To find companies that support specific EDI transactions” on page 95

■ AND means Active Community matches both sets of search criteria. 
■ OR means Active Community matches either one or the other set of search 

criteria.
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■ “To find companies that support EDI, but have not specified transaction types” 
on page 95

■ “To find contacts with more than five years work experience who work for 
current suppliers” on page 96

To find companies that support specific EDI transactions
In this community, a custom field called EDI Transactions has been defined. It 
contains the EDI transaction numbers that trading partners support. 

Use the following search criteria to find companies that support specific EDI 
transactions:
■ ALL
First set of search attributes:
■ Company
■ EDI Transactions
■ Is Equal to
■ 832
Second set of search attributes:
■ Company
■ EDI Transactions
■ Is Equal to
■ 850
Note: ALL means Active Community matches both rows of search criteria. To find 
partners who support either EDI 832 or 850, select ANY instead of ALL.

To find companies that support EDI, but have not specified 
transaction types
In this community, the following custom fields have been defined:
■ EDI Capability—Indicates (True/False) if a trading partner has a VPN or the 

necessary infrastructure to support EDI communication
■ EDI Transactions—EDI transaction numbers that trading partners support
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You want to find all trading partners who have EDI capability but who have not 
specified the EDI transactions they support. After you pinpoint these partners, you 
want to send them an email reminder to update their EDI transaction types. 

Use these search criteria to find companies that support EDI, but have not 
specified EDI transaction types.
First set of search attributes:
■ Company
■ EDI Capability
■ Is Equal to
■ True
AND
Second set of search attributes:
■ Company
■ EDI Transactions
■ Is Equal to
■ Blank (find companies with no value specified)
Note: AND means Active Community matches both sets of search criteria. To find 
all partners who either have EDI Capability or have no EDI Transactions, select OR 
instead of AND.

To find contacts with more than five years work experience who work 
for current suppliers
In this community, the following custom fields have been defined:
■ Years Experience—Number of years of work experience for each contact in the 

community
■ Current Supplier of Acme—Indicates (Yes/No) if a contact's company is a current 

supplier for Acme, the hub owner
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You want to find all contacts in the community who have more than five years of 
work experience, but are only interested in contacts who work with current 
suppliers. 

Use these search criteria to find contacts with more than five years of work 
experience who work for current suppliers. 
Note: Both contact and company search attributes are included.
ALL
First set of search attributes:
■ Contact
■ Years Experience
■ Is Greater Than
■ 5
AND
Second set of search attributes:
■ Company
■ Current Supplier of Acme
■ Is Equal to
■ Yes
Note: The company search criteria in the second search box lets you to find all 
contacts based on company-level information. Because the AND button is enabled, 
Active Community matches both sets of search criteria. 

Commonly Used Advanced Searches
The following topics outline the criteria used for commonly used advanced 
searches. Modify the search criteria to meet your needs.
Topics include:
■ “To find disabled companies or contacts” on page 98
■ “To find company or contact custom fields” on page 98
■ “To find companies with long custom field names” on page 98



98 OpenText Active Community CE 21.2 User Guide

F I N D I N F O RM A T I O N
Advanced Searches

■ “To find contacts who are participating an activity” on page 99
■ “To find contacts based on their contact (business) role” on page 99
■ “To find companies or contacts based on created date or duration” on page 99
■ “To find companies” on page 100
■ “To find divisions in a company” on page 100

To find disabled companies or contacts
Use search to re-enable all disabled profiles in your community.
■ In the search box, select Disabled and specify a date in MM/DD/YYYY or 

MM/DD/YY format. 

■ Optional. Select ALL to view all disabled companies or contacts in your 
community. 

To find company or contact custom fields
■ In the search box, select the custom field and select the value you want to find. 

Note: For custom fields with predefined answers, such as multiple choice, 
yes/no, true/false, and radio button lists, the values to be searched display in 
the search box. 

■ To search for more than one value, add another search row by clicking the + 
icon. 

Note: Custom fields contained in groups to which you do not have View 
Question Group permission are not available in the selection list. 

To find companies with long custom field names
While the Company ID drop-down list displays up to 133 characters, which makes 
it easy to differentiate between fields with similar long names, custom field names 
can be longer than 133 characters. 
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■ Hover your cursor over a selection in the list, and the entire name displays.

Note: This functionality is available when using Chrome, Firefox, and Internet 
Explorer (IE) 9 or 10.

To find contacts who are participating an activity
Use to find all activity participants who have not completed a web form or updated 
their profile status.
■ In the participant search list of an activity, select Assigned, In Progress, or 

Completed. 

To find contacts based on their contact (business) role
■ In the search list, select the contact (business) role you want to match. 

Note: The search results list contacts profiles assigned to the selected role.

To find companies or contacts based on created date or duration
■ In the search list, select Created On and then select the appropriate duration.

You can type the number of days or a date. To switch between the days and 
date fields, click the icon for the days/date field.
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Days field

Date field

Note: If you select In Last 24 Hours the days/date field does not display.

To find companies
■ Select Parent-Company and Is Equal To from the drop-down lists. Add other 

conditions as needed.

To find divisions in a company
■ Select Parent-Company and Is Not Equal To from the drop-down lists. Add 

other conditions as needed.

Creating Advanced Searches
Use an advanced search when you want to include complex search criteria to find 
the data you need. 

To create an advanced search 
1 Click Profiles > Companies or Contacts.

The All Companies or Contacts page opens.
2 Click Advanced or Advanced Search.
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The Advanced Search page opens.

3 In the search boxes, select the search attributes you want to use (see 
“Advanced Search Examples” on page 94 and “Commonly Used Advanced 
Searches” on page 97). 
For example, if you want to locate all contacts with a company name of Acme, 
select the appropriate fields from the drop-down lists and type Acme in the last 
search box. 

4 (Optional) Select the Include Disabled check box if you want to search for 
disabled contacts or companies. 

5 To add additional search criteria, either:
■ Click the + icon to add another row of search attributes
■ Click Add Condition Block to add more search conditions

6 Do the following:
■ Specify the additional attributes or conditions in the search boxes.
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■ Indicate if you want to find results that match either condition, or both 
conditions. 

Note: By default, search results match both conditions. To match 
either condition, click OR for the condition. For example, you might 
want to locate all contacts with a company name of “Acme” OR a 
Country of “USA.” 

7 Click Search.
The search results display. 

8 Decide what you want to do with the search results:
■ To clear the search criteria and view all contacts or companies again, click 

Clear Search.
■ To view profile details, such as company or contact information, open the 

profile you want. To return to search results, click Return to Search on 
the profile page.

■ To create a saved search based on the search results, see “Creating a 
Saved Search” on page 103.

■ To create tags, which allow you to quickly find company and contact 
profiles based on the search results, see “Tagging Search Results” on 
page 106.

■ To use the Actions drop-down list to perform an action on the results, such 
as disable contacts or export a list of companies, click the Actions drop-
down list and select the action you want to perform (see “Acting on Search 
Results” on page 109).

Saved Searches
Saved searches are complex searches (such as searching for company custom 
fields, or searching for contacts in specific company divisions) that you can save 
and use again and again without having to re-create the initial search. 
When you run a saved search, the conditions for the original search display so you 
can modify them, if needed.

You create saved searches after performing an advanced search.
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Topics include:
■ “Creating a Saved Search” on page 103
■ “Running a Saved Search” on page 104
■ “Viewing Saved Search Details” on page 105
■ “Renaming or Deleting a Saved Search” on page 105

Creating a Saved Search
Security Permission: Public Reports > Create Public Searches
You can create saved searches for company or contact profiles. Use a saved search 
to run and re-run a report, thereby accessing the latest data for the report. 
For companies, three types of saved searches are available:
■ Private searches—Searches you create that only you can edit or run.
■ Public Searches by Current User—Public searches you create that others can run, 

but not edit. Only the creator of a search can edit it.
■ Public Searches by Other Users—Searches other users create that anyone can 

run.
For contacts, private saved searches can only be used by the person who created 
them; other users in the community cannot see private saved searches.

To create a saved search
1 Click Profiles > Companies or Contacts.

The All Companies or Contacts page opens.
2 Click Advanced or Advanced Search.

The advanced search fields display. 

3 Select the search attributes you want to use in the search boxes (see 
“Advanced Searches” on page 93). 

4 Click Search.
The search results display.

5 To save the search criteria, click Save. 
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A dialog box opens. 

6 In the text box, type a name for the search. 
7 To make the search public, select the Make Search Public check box. If the 

box is not selected, the search is private.
Note: The Make Search Public check box is available only for companies 
searches. 

8 Click Save As.
Active Community saves the search criteria so it can be used again.

Running a Saved Search
To run a saved search
1 Click Profiles > Companies or Contacts.

The All Companies or Contacts page opens.
2 Click the Saved Search link, and select the search you want to run.

Active Community displays the search results.
Note: If data masking is enabled for a company custom field that is included 
in the saved search, and you do not have permission to view it, an error 
message indicates that the search conditions will be automatically updated to 
exclude the masked field.
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Viewing Saved Search Details
To review the criteria for a saved search
1 Click Profiles > Companies or Contacts.

The All Companies or Contacts page opens.
2 Click the Saved Searches link.

The Saved Searches menu opens.

Note: You cannot view or run other users' private saved searches. You can 
only run saved searches that you have created in your community or that 
others have created and made public.

3 At the bottom of the list, click Manage Saved Searches.
The Saved Search page opens.

4 Click Show Search for the search whose criteria you want to view.
The search details display. 

Renaming or Deleting a Saved Search
To rename or delete a saved search
1 Click Profiles > Companies or Contacts.

The All Companies or Contacts page opens.
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2 Click the Saved Search link.

Note: You cannot view or run other users' saved searches. You can only run 
the saved searches that you have created in your community.

3 At the bottom of the list, click Manage Saved Searches.
The Saved Search page opens.

4 Perform the appropriate action:
■ To rename the search, click Rename and type a new name for the search 

in the dialog box that opens.

■ To remove the search from the list of saved searches, click Remove for 
the search, and confirm the deletion in the dialog box that opens.

Tagging Search Results
Tags allow you to quickly and easily find company and contact profiles in the 
community. Tags are used to group contacts by any user in your community. Tags 



F I N D  I N F O R M A T I O N
Tagging Search Results

OpenText Active Community CE 21.2 User Guide  107

4  

are made up of a single keyword or phrase (up to 256 characters), and are applied 
to search results. 

Two types of tags are available, My Tags and Popular Tags.
■ My Tags are tags you create in Active Community. The tags can be seen by 

anyone in the community, and anyone can use them to find a contact. Because 
you created a tag, you can delete it.

■ Popular Tags are created by anyone in the community, including you. Active 
Community lists Popular Tags in order based on the number of times the tag has 
been used. You cannot delete Popular Tags created by others. 

Go to “Tagging Search Results with Keywords” on page 107 and “Using Tags” on 
page 108.

Tagging Search Results with Keywords
Security Permissions: Tag Permissions > Update Tags
Tags allow you to quickly and easily find company and contact profiles in your 
community. Tags are not search-specific; they allow you to tag (or identify) 
contacts and companies based on different criteria.
Important: The easiest way to tag a set of contact profiles with the same 
keyword is to search for the profiles you want, then assign the keyword to the 
search results. 

To tag contacts with keywords 
1 Click Profiles > Contacts.

The Contacts page opens.
2 Perform a quick or advanced search to display the list of contact or company 

profiles that you want to tag.
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3 In the Apply tag to results box, type the keyword to assign to the profiles listed, 
such as Sales or Revenue

4 Click the arrow to tag the results.
Note: If the tag already exists in your community, the profiles are added to 
the existing group of profiles in search results. 

Using Tags
To use tags to find contact profiles
1 Click Profiles > Contacts.

The Contacts page opens.
2 Under Tags, click the tag you want to use. For example, if you want to display 

all profiles tagged with “sales,” click sales.

Active Community displays contact profiles “tagged” by the keyword.
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Acting on Search Results
After finding the information you need using the methods described in this section, 
use the options in the Actions drop-down list to apply actions to search results. For 
example, if you want to export all search results to a spreadsheet, select Actions > 
Basic Export and follow the prompts.

To act on search results
1 Click Profiles > Companies or Contacts.

The All Companies or Contacts page opens.
2 After finding the information you need using a quick or advanced search, on the 

search results page, click the Actions drop-down list.

3 Select the action you want to perform. 
4 To apply the action to:

■ All search results—Select All Search Results, and click OK.
■ Selected search results—Select the check boxes for the companies or 

contacts to which you want the action to apply, select Selected Rows, 
and click OK.

Active Community opens the action process you selected. 
5 Follow the prompts to complete the action.
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Active Community provides several ways to add companies and contacts to your 
community. They can be:
■ Added manually using the Companies and Contacts pages
■ Imported using comma-separated value (.csv) files
■ Created using:

■ The optional Registration module, where the completed registration 
process creates companies and contacts

■ The Active Community API
In addition, public web forms can be used to gather information about companies 
and contacts that are not yet part of a community. The data can be imported into 
Active Community as described in “Importing Companies and Contacts Using CSV 
Files” on page 128.
Note: If you have an Active Community community and a Trading Grid Online 
(TGO) community with a subscription to Intelligent Web Forms (IWF) or Active 
Invoices, you can make updates to companies and contacts in Active Community 
and have the changes automatically updated in TGO (see “Synchronizing Active 
Community with Trading Grid Online (TGO)” on page 21).
Topics include:
■ “Company and Contact Overview” on page 112
■ “Adding Companies and Contacts Manually” on page 122
■ “Importing Companies and Contacts Using CSV Files” on page 128
■ “Working with Sub-communities” on page 140

■ “Creating a Security Role for a Sub-Community” on page 141
■ “Creating a Sub-community and Assigning Contacts and Roles” on 

page 141
■ “Adding Companies to a Sub-community” on page 144
■ “Removing Companies from a Sub-community” on page 147
■ “Viewing Contacts Assigned to Sub-community Roles” on page 149
■ “Editing a Sub-community” on page 150
■ “Deleting an Inactive Sub-community” on page 150

■ “Working with Companies and Contacts” on page 151
■ “Moving Divisions Between Companies” on page 151
■ “Changing the Name of the Divisions Tab” on page 152
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■ “Deleting Companies or Contacts” on page 153
■ “Disabling Companies or Contacts” on page 155
■ “Enabling Companies or Contacts” on page 157
■ “Registering or Re-registering a Company” on page 159
■ “Downloading a PDF for Company or Contact Profiles” on page 164
■ “Sending a Company for TGO Provisioning” on page 166
■ “Viewing Company and Registration Audit Data” on page 168
■ “Viewing Contact Audit Data” on page 169
■ “Subscribing Your Company to AIC” on page 169

■ “Updating File Upload Custom Fields Using .Zip Files” on page 170

Company and Contact Overview
Active Community provides several ways to define companies and contacts. The 
method used depends on the situation. With the appropriate permissions, you can:
■ Create companies and contacts one at a time.
■ Import company or contact information using a comma-separated value (.csv) 

file. Active Community uses the imported company or contact data to populate 
values on the company or contact profile pages.
Important: You must import companies into your community before you 
import contacts.

■ Create public web forms that gather information about contacts who are not yet 
part of a community.

■ Use the optional Registration module, where the completed registration process 
creates companies and contacts.

■ Use the Active Community API to create companies and contacts.
Before beginning the procedures in this section, you should review how tabs are 
used to control company and contact information.
Topics include:
■ “Companies List Tabs”
■ “Company Tabs”
■ “Contacts List Tabs”
■ “Contact Tabs”
■ “About Sub-Communities”
■ “Integrated Communities - Restricted Characters for Core Fields”
■ “How Do I?”
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Companies List Tabs
Available by clicking Profiles > Companies, the tabs on the Companies list page 
let you define information that relates to all companies in your community.
Note: Based on the permissions assigned to your security role, you might not see 
all tabs referenced in the following topics.

Directory Tab
The Directory tab lists all companies in the Active Community community. Access 
this tab to perform searches, exports, and other company-related actions.

Settings Tab
The Settings tab lets you configure the company profile settings that apply to your 
community as a whole. The links on the tab let you define different types of 
information for all companies in your community. Links include:
■ Summary Page—Define widgets that display on the Summary tab for a company 

in your community.
■ Core Fields—Specify mandatory core fields that must be completed by each 

company in the community
■ Core Field Permissions—Define the security roles that can view and modify 

company core fields.
■ Custom Fields—Add, remove, or modify company profile custom fields and 

groups.
■ Custom Field Permissions—Configure the security roles that can view and modify 

company custom fields.
■ Alerts—Add and manage emails to companies in your community, including who 

to notify and when to notify them. 
■ Freshness—Configure how often company contacts are reminded to update their 

company profile information.

Reports Tab
The Reports tab lets you run or manage your reports, public reports created by 
others, and create new reports for your community.

Companies List 
Tabs

■ “Directory Tab”
■ “Settings Tab”
■ “Reports Tab”
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Company Tabs
The Company Profile page for each company in your community includes a set of 
tabs that let you define and manage all data related to the company. 

Company

Summary Tab
The Summary tab lets users view a high-level summary by seeing the widgets set 
up by the Community Administrator. In addition, links let you edit company 
information and add contacts to it.

Profile Tab

The Profile tab lists general information about a company, including its name, 
address, web URL, number of employees, and email address. It is the default tab 
for a company. Information is only visible if the fields are populated.

Divisions Tab
The Divisions tab lists child companies of a company, such as a sub-organization or 
account. Divisions are regular companies, but they provide a means of organizing 
companies within a community. Thus, any company that has divisions becomes a 
“parent company” and its divisions have a Parent Company ID. 
Community Administrators can customize the tab name and use a word that is 
meaningful to their company, such as the word Accounts instead of Divisions. The 
customized word displays everywhere the word Divisions displayed before the 
change (see “Changing the Name of the Divisions Tab” on page 152). 
Note: The Divisions tab is displayed only if Divisions are enabled in the 
community by the Community Administrator.

Contacts Tab
The Contacts tab lets you view, add, or search for contacts in the selected 
company.

Projects Tab
The Projects tab lists all projects in which the company participates, including the 
company’s status in each project.

■ “Summary Tab”
■ “Profile Tab”
■ “Divisions Tab”
■ “Contacts Tab”
■ “Projects Tab”
■ “Files Tab”
■ “Items Tab”
■ “Audit Log Tab”
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Files Tab
The Files tab lets you access folders and upload files that are relevant to the 
company.

Items Tab
The Items tab lets you search for and manage items for the company. The 
company must exist in Active Community before it can be associated with items. 
After being added to a company, the item is automatically viewable to users with 
View Items access. 
Note: The Items tab is displayed only if Item Management is enabled for the 
community. 

Audit Log Tab
The Audit Log tab lists all changes made to a company profile for the past 60 days, 
including a separate section that lists all registration requests related to the 
company profile. Users can download an Excel file of the company changes for up 
to a rolling 12 months as well as view details and print a report of the registration 
requests.

Contacts List Tabs
Available by clicking Profiles > Contacts, the tabs on the Contacts list page let 
you define information that relates to contacts in all companies in your community.

Contacts List Tabs

All Contacts Tab
The All Contacts tab lists all contacts in your community. You can search for, add, 
and manage contacts.

Core Fields Tab
The Core Fields tab lets you select mandatory core fields that must be completed 
by each contact in your community, such as Communication Email, title, phone 
number, etc.

Custom Fields Tab
The Custom Fields tab lets you add, remove, or modify contact profile custom 
fields and groups.

■ “All Contacts Tab”
■ “Core Fields Tab”
■ “Custom Fields Tab”
■ “Alerts Tab”
■ “Permissions Tab”
■ “Freshness Tab”
■ “Business Roles”
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Alerts Tab
The Alerts tab lets you add and manage emails to contacts in your community, 
including who to notify and when to notify them. 

Permissions Tab
The Permissions tab lists the custom field permission for each custom field group.

Freshness Tab
The Freshness tab lets you control the freshness settings, or update status of a 
profile, for contacts in your community.

Business Roles
The Business Roles tab lets you add and manage contact (business) roles in your 
community; for example, Legal or Primary Contact or Chief Financial Officer. 
Business roles help you identify functional contact types in a community.

Contact Tabs
The Contact Profile page for each contact in your community groups information 
about each contact into a series of tabs to let you manage all data related to the 
person.

Contact Tabs

Profile Tab
The Profile tab lists general information about the contact, including name, 
address, and security and contact (business) roles. It shows core and custom fields 
for the contact.

Projects Tab
The Projects tab lists the projects in which the contact participates, including the 
contact’s status in each project.

Activities Tab
The Activities tab lists all project activities assigned to the contact. Recent emails 
can be resent to the contact from the Activities tab.

Files Tab
The Files tab includes all files the contact uploaded to Active Community.

■ “Profile Tab”
■ “Projects Tab”
■ “Activities Tab”
■ “Files Tab”
■ “Web Forms Tab”
■ “Audit Log Tab”
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Web Forms Tab
The Web Forms tab includes all web forms the contact completed as part of project 
activities.

Audit Log Tab
The Audit Log tab lists all changes made to a contact profile for the past 60 days. 
Users can download an Excel file of the changes for up to a rolling 12 months.

About Sub-Communities
Sub-communities are mini-communities created inside a larger hub community. 
Sub-communities allow each department to work with a collection of companies, or 
a sub-community of companies, with which they interact on a regular basis. For 
example, contacts in supplier relations might want to work with a supplier sub-
community. Contacts in brand management might want to work with a sales sub-
community.

Integrated Communities - Restricted Characters for Core 
Fields

If you are integrated with TGO, you cannot use certain characters in your core 
fields. Refer to the following tables for the restricted characters. 

Restricted Characters for Company Core Fields
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Restricted Characters for Contact Core Fields

How Do I?
For companies and contacts, you need to understand the options that are 
available. The table lists a few options to consider.
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To... Choose (or use) the following options: When you are:
Add Companies or Contacts
Add companies and contacts 
individually

■ Profiles > Companies “Adding Companies and Contacts 
Manually” on page 122

Add multiple companies and 
contacts at the same time

■ Profiles > Companies > Manage 
Companies > Import Companies

■ Profiles > Contacts > Manage Contacts > 
Import Contacts

“Importing Companies and 
Contacts Using CSV Files” on 
page 128

Work with Sub-communities
Create a sub-community role Admin > Security Roles tab > Add Security Role “Creating a Security Role for a 

Sub-Community” on page 141
Add a sub-community ■ Profiles > Companies > New Sub-

community
“Creating a Sub-community and 
Assigning Contacts and Roles” on 
page 141

Add companies to a sub-
community

■ Profiles > Companies > Select the 
companies > Actions > Add to 
Sub-communities

■ Profiles > Companies > Select the 
company > Manage Company > Edit 
Company > Sub-communities tab

“Adding Companies to a Sub-
community” on page 144

Remove companies from a sub-
community

■ Profiles > Companies > Select the 
sub-community > Select the companies to 
remove > Actions > Remove from 
Sub-communities

■ Profiles > Companies > Select the 
company > Manage Company > Edit 
Company > Sub-communities tab

“Removing Companies from a 
Sub-community” on page 147

Define Custom Settings
Update a company or community ■ Profiles > Companies > Select a company 

> Divisions tab
“Moving Divisions Between 
Companies” on page 151

■ Admin > Community Settings > Edit 
Community

“Changing the Name of the 
Divisions Tab” on page 152

Delete Companies or Contacts
Delete a company or contact ■ Profiles > Companies > 

■ Select a company > Manage Company 
> Delete Company, or

■ Select multiple companies > Actions > 
Delete Companies

■ Profiles > Contacts > 
■ Select a contact > Manage Profile > 

Delete Contact, or
■ Select multiple contacts > Actions > 

Delete Contacts

“Deleting Companies or Contacts” 
on page 153
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Disable Companies or Contacts
Disable companies or contacts ■ Profiles > Companies > 

■ Select a company > Manage Profile > 
Disable Company, or

■ Select multiple companies > Actions > 
Disable Companies

■ Profiles > Contacts > 
■ Select a contact > Manage Profile > 

Disable Contact, or
■ Select multiple contacts > Actions > 

Disable Contacts

“Disabling Companies or Contacts” 
on page 155

Enable Companies or Contacts
Enable a company or contact ■ Profiles > Companies > 

■ Select a company > Manage Profile > 
Enable Company, or

■ Select multiple companies > Actions > 
Enable Companies

■ Profiles > Contacts > 
■ Select a contact > Manage Profile > 

Enable Contact, or
■ Select multiple contacts > Actions > 

Enable Contacts

“Enabling Companies or Contacts” 
on page 157

Register a Company
Register a previously created 
company (send a company for 
registration)

■ Profiles > Companies > 
■ Select a company > Manage Profile > 

Send for Registration, or
■ Select multiple companies > Actions > 

Send Companies for Registration

“Registering or Re-registering a 
Company” on page 159

Re-register a Company
Re-register a company ■ Profiles > Companies > 

■ Select a company > Manage Profile > 
Re-register Company, or

■ Select multiple companies > Actions > 
Re-register Companies

“Registering or Re-registering a 
Company” on page 159

Merge User IDs of Two Contact Profiles
Merge user IDs of two contact 
profiles

■ Home > Your Profile tab > Edit Profile “Merging User IDs” on page 41

Send a Company for TGO Provisioning
Send a company for TGO 
provisioning so that the 
registration workflow can resume.

■ Profiles > Companies > 
■ Select a company > Manage Profile > 

Send for TGO Provisioning, or
■ Select multiple companies > Actions > 

Send for TGO Provisioning

“Sending a Company for TGO 
Provisioning” on page 166

View Audit Data

To... Choose (or use) the following options: When you are:
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View company and registration 
audit logs

■ Profiles > Companies > Select a company 
> Audit Log tab > Company Audit Log 
section

■ Profiles > Companies > Select a company 
> Audit Log tab > Registration Audit Log 
section

“Viewing Company and 
Registration Audit Data” on 
page 168

View contact audit logs ■ Profiles > Contacts > Select a contact > 
Audit Log tab

“Viewing Contact Audit Data” on 
page 169

Subscribe to AIC
Subscription to Active Invoices 
with Compliance (AIC)

■ My Company> Legal Profiles tab “Subscribing Your Company to 
AIC” on page 169

Upload Multiple Files
Upload multiple files for file 
upload custom fields

■ Profiles > Companies > Manage 
Companies > Upload Files

“Updating File Upload Custom 
Fields Using .Zip Files” on 
page 170

To... Choose (or use) the following options: When you are:
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Adding Companies and Contacts Manually
These topics describe how to add companies and contacts to Active Community 
one at a time. A company must exist in Active Community before you can add 
contacts to it. 
To import data for multiple companies and contacts, see “Importing Companies 
and Contacts Using CSV Files” on page 128.
Topics include:
■ “Adding a Company to Active Community” on page 122
■ “Adding a Contact to a Company” on page 124

Adding a Company to Active Community
Security permissions: Company Permissions > Add Companies
Use this procedure to define basic information about a company in your Active 
Community community. 
Important: If you are integrated with TGO, you cannot use certain characters in 
your core fields. Refer to “Integrated Communities - Restricted Characters for Core 
Fields” on page 117.

To add a company manually
1 Click Profiles > Companies.

The All Companies list page opens.

2 Click Manage Companies > Create a Company.
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The Adding New Company page opens. Required fields are indicated by an 
asterisk (*).

3 Complete the company fields as follows:
■ Company Name—Name of the company. Do not use quotation marks (“) in 

the name. Required. 
Note: If you type or select a company name that already exists, and 
move to another tab, a dialog box asks you to confirm that you want to 
create a company with a duplicate name. If you do, a unique company ID 
is required across the community.

■ Company ID—Identifier for the company in letters and/or numbers; for 
example, “A123.” This ID is used to link contacts to a company. It must be 
unique across the community. Required.
Note: If your community has selected “Auto-generate Company IDs” 
(Admin > Community Settings tab), an asterisk does not display, and you 
do not need to complete the field.

■ Parent Company ID—Identifier for the parent company in letters and/or 
numbers; for example, “A123.” Used if the company has one or more 
divisions under a parent company.

■ Phone—Telephone number of the company; for example, 703-555-1212.
■ Fax—Fax number of the company; example, 703-555-1212.
■ Address 1, 2, and 3—Street address of the company.; example, “123 Your 

Street, Suite 123." 
■ City—Name of the city or town where the company is located; example, 

“Springfield.”
■ State/Province/Region—State or province code where the company is 

located; for example, “California.” You can use auto-fill to pick a state or 
province from the standard ISO list of valid state or province codes if the 
company country is within the United States or Canada only. Active 
Community accepts other country and provinces, but does not validate this 
information. For a full list of valid countries, visit: 
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http://www.commondatahub.com/live/geography/state_province_region/iso_3166_2_s
tate_codes.

■ Country—Country code where the company is located. For example, “USA.” 
You can use auto-fill to pick a country from the standard ISO list of valid 
countries. For a full list of valid countries, visit: 
http://www.commondatahub.com/country_source.jsp.

■ Postal Code—
■ For USA: Five- or nine-digit postal ZIP code where the company is 

located. For example, “22033” or “22033-1412.” 
■ For others: Active Community accepts any value; it does not validate the 

format.
■ Email—General company email address; for example, web@acme.com.
■ Web Site—URL of the web site of the company; for example, 

http://www.example.org.
■ # Employees—Number of employees in the company; for example, “500.”
■ Notes—Type additional notes or comments you want to add to the profile.

4 To add the new company to one or more sub-communities:
a Click the Sub-communities tab.
b Select check boxes for the sub-communities to which you want to add the 

company.
5 Perform the appropriate action:

Adding a Contact to a Company
Security permissions:
■ Contact Permissions > Add, Edit Contact

or
■ My Contacts Permissions > Add, Edit My Company Contacts
Use this procedure to add a contact person to a company profile. A company must 
exist in Active Community before you can add a contact to it.
Note: Active Community automatically gives the security role of Everyone to 
contacts added to the community. For details, see “Editing Permissions for 
Community Security Roles” on page 56. 
Important: If you are integrated with TGO, you cannot use certain characters in 
your core fields. Refer to “Integrated Communities - Restricted Characters for Core 
Fields” on page 117.

To... Do this:
Save basic company data and edit 
custom field groups at another time

■ Click Save.

Save basic information and edit custom 
field groups immediately

1 Click Save and Edit.
2 Select the custom field tabs and update 

that information.
3 Click Save after updating each custom 

field group.

http://www.commondatahub.com/live/geography/state_province_region/iso_3166_2_state_codes
http://www.commondatahub.com/country_source.jsp 
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To add a contact to a company
1 Click Profiles > Companies.

The All Companies list page opens.

2 Search for and select the company to which you want to add the contact.
3 On the company profile page, click Manage Company > Add Contact.

Note: You can also select the Summary tab, then click Add Contact.
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The Adding New Contact page opens. Required fields are indicated by an 
asterisk (*). Part of the page is shown here.

4 Complete the contact fields as follows:
■ First Name—Required. First name of the contact; for example, “John.” 
■ Last Name—Required. Last name of the contact; for example, “Smith.”
■ Salutation—Form of address or title of the contact; for example, “Mr.” 
■ Title—Title of the contact's position in the company; for example, “Senior 

Marketing Director.”
■ Communication Email—Required. Communication Email of the contact; for 

example, sue.jones@example.org.
Note: When the contact is added, the system creates a user ID identical 
to the Communication Email. A user ID must be unique across all 
communities, so if a user ID with the same name already exists in the 
system, the system creates a random user ID. If a contact wants to 
represent two companies, the contact can merge the user IDs so that both 
profiles can be accessed with one user ID. See“Merging User IDs” on 
page 41.

■ Phone—Main telephone number of the contact; for example, 703-555-
1212.

■ Mobile—Mobile phone number of the contact. For example, 703-555-1212. 
■ Fax—Fax number of the contact; for example, 703-555-1212.
■ Address-1/Address-2/Address-3—Street address of the contact, which 

might be the same as the company street address. For example, “123 State 
Street, Suite 123." 
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■ City—City or town where the contact is located; for example, “Springfield”
■ State/Province/Region—State or province code where the company is 

located. For example, “California.” You can use auto-fill to pick a state or 
province from the standard ISO list of valid state or province codes if the 
company country is within the United States or Canada only. Active 
Community accepts other country provinces, but does not validate this 
information. For a full list of valid countries, visit: 
http://www.commondatahub.com/live/geography/state_province_region/iso_3166_2_s
tate_codes. 

■ Country— Country code where the company is located, for example, “UK.” 
You can use auto-fill to pick a country from the standard ISO list of valid 
countries. For a full list of valid countries, visit: 
http://www.commondatahub.com/country_source.jsp.

■ Postal Code—
■ For USA: Five- or nine-digit postal ZIP code where the company is 

located. For example, “22033” or “22033-1412.” 
■ For others: Active Community accepts any value; it does not validate the 

format.
■ Notes—Type additional notes or comments you want to add to the profile. 

5 Click Save. 
The contact is added to the company, and the Business Roles pop-up opens.

6 Do one of the following:
■ If you want to assign one or more business roles to the contact, select the 

check boxes for the desired business roles. Click OK. The contact is 
assigned the selected business roles in addition to the default business role 
of Contact.

■ If you do not want to assign any business role to the contact, click Cancel. 
The contact is assigned the default business role of Contact.

Tabs for the contact are listed at the top of the page so more information can 
be defined (or automatically populated) for the contact later.
Note: After a contact is added, the user ID and Account Email fields display 
for a contact’s profile. Only the owning user is permitted to change their user 
ID and their Account Email. Community Administrators cannot change either of 
them; they can only view them.
To update a contact profile, see “Updating a Contact Profile” on page 31. 

http://www.commondatahub.com/live/geography/state_province_region/iso_3166_2_state_codes
http://www.commondatahub.com/live/geography/state_province_region/iso_3166_2_state_codes
http://www.commondatahub.com/country_source.jsp
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Importing Companies and Contacts Using CSV Files
Values for new companies and contacts can be imported into your community 
using comma-separated value (.csv) files. Active Community uses the imported 
data to populate values in company and contact profiles. You can edit the data for 
companies or contacts with unique requirements.
Important: Ensure the company is defined in your community before importing 
contacts that you want to assign to the company. The company must be defined 
before importing contacts.
Companies can be added to one or more sub-communities via the import process 
as long as they have already been created (see “Working with Sub-communities” 
on page 140). The sub-community names must be separated by commas in the 
.csv file. The .csv file must conform to the guidelines in “Custom Field 
Requirements for Importing Data” on page 133
During the import process, you are prompted to map or link each column header in 
your .csv file to a field that exists in profiles. The column header can be the name 
of a core field, such as Last Name, or it can be a custom field specific to your 
community, such as Hire Date. 
After mapping the data, Active Community shows a preview of the company or 
contact information to be imported. The preview prevents you from importing 
information into the wrong field.
Review the following topics before you create .csv files to import company or 
contact data.
Topics include:
■ “General Guidelines for Importing Data” on page 128
■ “Company Requirements for Importing Data” on page 130
■ “Contact Requirements for Importing Data” on page 131
■ “Custom Field Requirements for Importing Data” on page 133
■ “Custom Field Requirements for Data Tables” on page 134
■ “Importing Company or Contact Data” on page 135
■ “Updating File Upload Custom Fields Using .Zip Files” on page 170
Important: If you are integrated with TGO, you cannot use certain characters in 
your core fields. Refer to “Integrated Communities - Restricted Characters for Core 
Fields” on page 117.

General Guidelines for Importing Data
Follow these guidelines for using a .csv file to import company and contact 
information:
■ Active Community expects imported information in a comma-separated value 

(.csv) format; for example, contactdata.csv. 
To save an Excel file in .csv format, click Save As. In the Save as type drop-
down list, select CSV (Comma Delimited). Click Save.

■ Header Rows—The first row of the file must contain the same column headings 
that are mandatory in the user interface. 
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■ For example, for contacts, it would be Last Name, First Name, 
Communication Email, and Company ID. User ID is only mandatory when 
using the import to update profiles.

■ For example, for companies, it would be Company Name and Company ID. 
■ Body Rows—The data values to be imported must start in the second row of the 

file. For example, Jones, Bob, bob.jones@example.com, CFO, ABC123, 
mycomp_id.

The parts of the file:

■ Use either upper or lower case letters for most values. Only custom field values 
are case sensitive.

■ Use commas, tabs, or pipes to separate the information in each column. 
Important: To avoid errors during the import process, do not use these 
characters: # (pound) or : (colon), or paragraph returns (line breaks).

■ Before importing the file, remove blank rows between data rows.
■ Include a thousand or fewer contacts or companies in each .csv file. To import 

more than 1000, create separate .csv files to improve import performance. For 
example, if you have 7000 contacts to import, arrange the data in seven .csv 
files that contain 1000 contacts each.

■ For imports that are creating profiles, at a minimum, all mandatory fields must 
be represented in the .csv files.

Date Field Format
Date fields must be formatted as follows: MM/DD/YYYY. For example, January 7, 
2009 should be entered as 01/07/2009 in the .csv file. 
If not formatted correctly, dates cause errors during the import process.

Standard ISO Codes
To import companies or contacts located in the United States or Canada, use 
standard ISO country or state codes. For example, if the country is USA then a 
company located in the state of California must include a state field with a value of 
either CA or California. 

Disabling Imported Companies or Contacts
To disable contacts or companies by import, include a Disable Contact or Disable 
Company column with the value of “TRUE” for each row of contact or company 
data in the .csv file. 

Key Description
1 Header row.
2 Body row.

1

2



130 OpenText Active Community CE 21.2 User Guide

C O M P A N I ES  A N D  C O N T A C T S
Importing Companies and Contacts Using CSV Files

To disable companies or contacts in Active Community, see “Disabling Companies 
or Contacts” on page 155.
Importing Company Data when Registering or Re-registering a 
Company
If a company is in the registration or re-registration process, the company profile is 
locked until registration is complete. If you attempt to import data while a profile is 
locked, the email that you receive for the rejected profiles states the reason the 
import failed.
In addition to these general guidelines, please see:
■ “Company Requirements for Importing Data” on page 130
■ “Contact Requirements for Importing Data” on page 131
■ “Custom Field Requirements for Importing Data” on page 133
■ “Importing Company or Contact Data” on page 135

Company Requirements for Importing Data
In addition to the requirements in “General Guidelines for Importing Data,” follow 
these company-specific guidelines for using a .csv file to import company data:

Required Fields
At a minimum, you must include these core fields in the .csv file: 
■ Company Name
■ Company ID—Company IDs are treated as characters, not numbers. For 

example, an ID of “0010” is not the same as an ID of “10.” The first two zeroes 
are not removed automatically.

Core Company Fields
The following core company fields can be included in the .csv file, but they are 
optional:
Parent Company ID State/Province/Region
Email Postal Code
Phone Country
Fax Website URL
Address-1 # Employees
Address-2 Disable Company
Address-3 Notes
City

Custom Fields
Custom fields that are defined for a company can be included in the .csv file. They 
must conform to the guidelines in “Custom Field Requirements for Importing Data” 
on page 133. For custom fields saved in the File Upload format, see “Updating File 
Upload Custom Fields Using .Zip Files” on page 170.
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Sub-communities
Companies can be added to one or more sub-communities via the import process 
as long as they have already been created (see “Working with Sub-communities” 
on page 140). The sub-community names must be separated by commas in the 
.csv file. The .csv file must conform to the guidelines in “Custom Field 
Requirements for Importing Data” on page 133.

Repeating Field Values
With one exception, fields cannot be repeated in the file; that is, you cannot use 
two or more rows with the same Company ID. 
If, however, you are importing profile data for purposes of updating a custom field 
table, company IDs can be repeated (see “Importing Company or Contact Data” on 
page 135).

Contact Requirements for Importing Data
In addition to the requirements in “General Guidelines for Importing Data,” follow 
these contact-specific guidelines for using a .csv file to import contact data:

Required Fields
At a minimum, you must include these core fields in the contact data file: 
■ Last Name
■ First Name
■ Communication Email—A contact’s specific email at their Company, for example, 

sue.jones@acme.com.
■ Company ID—The Company ID value must match a company in your community 

for each contact in the file.
■ User ID—The user ID is only mandatory when using the import to update 

profiles.
Important: If the Company ID does not exist in your community, you must 
import or create the company first, then import the contacts. 

Core Contact Fields
The following core contact fields can be included in the .csv file, but they are 
optional:
Salutation City
Title State/Province/Region
Company Name Postal Code
Phone Country
Mobile Disable Contact
Fax Notes
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Custom Fields
Custom fields that are defined for contacts can be included in the .csv file. They 
must conform to the guidelines in “Custom Field Requirements for Importing Data” 
on page 133.

Security Roles and Business Roles
To specify security roles (permissions role) and business roles (a contact’s 
functional or organizational role in their business), include Security Role and/or 
Business Role columns with the name (or names) of the security roles and/or 
business roles. If a contact has two or more roles, separate the roles with a comma 
(role A,role B). 

If you are updating contact information, before you begin:
■ Decide if you want to replace existing roles or add to them.

■ Replace existing Security and Business Roles.
For example, if there is only one business role for a user in the import file 
and the user has three business roles, the import file overwrites the three 
business roles. After the import, the user has only one business role.
If there is only one security role for a user in the import file and the user 
has two security roles, the import file overwrites the two security roles. 
After the import, the user has only one security role. 

■ Append to Existing Security and Business Roles. 
For example, if there is only one business role for a user in the import file 
and the user has three business roles, the import file adds the additional 
business role to the existing three business roles. After the import, the user 
has four business roles.
If there is only one security role for a user in the import file and the user 
has two security roles, the import file adds the additional security role to 
the existing two security roles. After the import, the user has three security 
roles.

■ Ensure the contact (business) role is defined in your community before importing 
contacts you want to assign to the role. For details, see “Adding a Contact 
(Business) Role” on page 75. 

Address-1 Business Role
Address-2 Security Role
Address-3
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■ If the contact (business) role is not specified when importing contacts, Active 
Community assigns a default business role called Contact. After importing, you 
can change the business role by editing the contact's profile. 

■ Ensure the security role is defined in your community before importing contacts 
you want to assign to the security role (Admin > Security Roles tab). The 
security role must be defined before importing contacts. The import cannot 
create new security roles.

Custom Field Requirements for Importing Data
In addition to the requirements in “General Guidelines for Importing Data,” follow 
these guidelines for using a .csv file to import values for custom fields for 
companies or contacts.
Note: Because the .csv format does not support file uploads, see “Updating File 
Upload Custom Fields Using .Zip Files” on page 170 for custom fields saved in the 
File Upload format.
■ Create and configure the custom field groups, questions, and choices in the 

community before importing companies or contacts. For example, if you have a 
column in your company import file called “Certification Status” that details the 
company’s certification status, the same custom field (“Certification Status”) 
must exist in the company’s profiles. 

■ Custom field values are case-sensitive. Values in the .csv file must match the 
values defined in the profiles. For details, see an example of importing custom 
field values (see “Custom Field Requirements for Data Tables” on page 134).

■ Make sure cells for required custom fields are not blank. If values are missing 
from a cell, there is no data to import.

■ In the .csv file, use a comma to separate values for multiple choice answers. 
■ Do not use an import file to update multiple choice questions that include data. 

The import file overwrites the existing choices. 
To avoid this situation, the import file should include the choices a company has 
defined and that the choices be separated with a comma (choiceA,choiceB).

■ For multiple choice custom fields, Active Community uses values in the Identifier 
column when importing data. It does not use values in the Label column. 

■ Identifier values are unique internal numbers or letters that are associated 
with the answer to a question. Identifiers can be used for cross-tabulating 
results. 
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■ Label values display in the user interface for Drop List, Multiple Choice, or 
Radio Button List custom field questions. They are also used when 
exporting results out of Active Community. 

For example, for Labels named Manufacturing or Processing, the values in the 
Identifier field might be Manu or Proc. In the screen shot, both Sam Co and 
Comfortex have more than one Specialty. 

Note: If you edit a .csv file using a text editor like Notepad, be sure multiple 
choice answers are surrounded by double quotation marks; for example, 
“Sometimes.”

■ See also “Custom Field Requirements for Data Tables” on page 134 and 
“Updating File Upload Custom Fields Using .Zip Files” on page 170.

Custom Field Requirements for Data Tables
Custom fields groups that are formatted to display as data tables have special 
requirements. All custom field questions in the field group display as column 
headings in a table.
Data tables allow for multiple answers to each question. They also enable data 
sharing. 
In addition to the requirements in “General Guidelines for Importing Data” on 
page 128 and “Custom Field Requirements for Importing Data” on page 133, 
follow these guidelines for custom field groups that are data tables. 
■ Decide if you want to replace existing custom fields or add to them. 

■ Replace existing custom fields or

Import

Export
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■ Append additional custom fields to existing custom fields
■ Put data table values for custom fields in a separate .csv files. For example, if 

you want to include values for a data table and values for another custom field 
group, you should put the data table values in one .csv file and the remaining 
custom field values in a separate .csv file. 

■ Import each .csv file separately.
■ Include core company profile fields in each row, such as Company Name and 

Company ID.
■ Include columns in the .csv file that correspond to the column headings 

(questions) in the table.
In the graphic, the .csv file includes core company profile files in the 
CompanyName and CompanyID columns. It shows how the values for the ABC 
Company display in the company profile after the values for the custom field 
questions are imported.

The parts of the file:

■ Include values for each row in the table. Each row should contain the values that 
you want displayed in each table row. Values for core profile fields (such as 
Company Name and Company ID) should be repeated in each row of the .csv 
file.

Importing Company or Contact Data
Security permissions:
■ Company Permissions > Import Companies
■ Sub-community Permissions > Import Companies
■ Contact Permissions > Import Contacts
Important: Make sure the file meets the format requirements specified in 
“General Guidelines for Importing Data” on page 128.
Use this procedure to import companies or contacts into Active Community.
Companies can be added to one or more sub-communities via the import process 
as long as they have already been created (see “Working with Sub-communities” 
on page 140). The sub-community names must be separated by commas in the 

Key Description
1 Core field values.
2 Custom field values.

1 2
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.csv file. The .csv file must conform to the guidelines in “Custom Field 
Requirements for Importing Data” on page 133

To import companies or contacts into Active Community
1 After creating a data file based on the guidelines in “General Guidelines for 

Importing Data” on page 128 and the other requirements topics, click Profiles 
> Companies (or Contacts). 

2 Perform the appropriate action: 

Important: If importing contacts, ensure each contact in the file has a 
corresponding Company ID in Active Community. If the company does not 
exist, import the company or manually create the company first, then import 
the contacts.
One of the following occurs:

■ Companies - The Upload the File page opens.

■ Contacts - The Importing Contacts page opens. 
Select one of the following:

■ Create new contacts - The Sample file link displays. Click the link to 
open or save the create_import.csv file to your machine to be used as a 
template for your own import.

■ Update existing contacts - The Sample file link displays. Click the link 
to open or save the update_import.csv to your machine to be used as a 
template for your own import.

If you selected... Do this:
Companies ■ Click Manage Companies > Import Companies.
Contacts ■ Click Manage Contacts > Import Contacts.
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3 Click Browse to navigate to the file to be imported. Select the file, and click 
Open.
The name of the csv file displays.

4 Click Next.
The Map the Fields page opens so you can use the drop-down lists to map or 
link the fields in your .csv file to the fields in the user interface.

5 In the drop-down lists, specify the required, core, and custom fields in your .csv 
file that correspond to the fields user interface. 
Note: If you set up your Company ID to be mapped to a custom field, the 
Company ID does not display on this page because it is automatically mapped.
Important: The data you are importing must comply with the data format of 
the mapped field. For example, do not map a column of Street Addresses 
(letter and numbers) to a Hire Date (DD/MM/YYYY) field (all numbers). 
IGNORE is the default value for any core or custom fields that do not 
automatically match a column header value in the .csv file. If a field is not 
included in the .csv file because you are not importing it, keep the default 
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IGNORE setting for that field. The only time you need to perform manual 
mapping is if the column header and field names do not match exactly.
Note: If your contact profile does not have the Community Administrator 
role, custom fields contained in tabs to which you do not have View and Edit 
Question Group permissions are not available for mapping. For details, see 
“Editing Permissions for Community Security Roles” on page 56. 
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6 Optional.  
If you are importing 
data for... Do this:
Companies 1 At the bottom of the Map the Fields page, click Import 

Options.
2 For sub-communities, indicate if the file you are importing 

replaces sub-communities in existing company profiles 
(Replace), or if it adds sub-communities to the profiles 
(Append). 

3 For tables, indicate if the file you are importing replaces 
data in existing company profiles (Replace), or if it adds 
data to the profiles (Append).

Key Description
1 Indicate if the imported sub-communities replace

existing sub-communities or add to existing ones.
2 Indicate if the imported data replaces existing data 

or adds to it.

Contacts 1 At the bottom of the Map the Fields page, click Import 
Options. 
Note: This option applies only when updating contacts.

2 For security and business roles, indicate if the file you are 
importing replaces security and business roles in existing 
contact profiles (Replace), or if it adds security and 
business roles to the profiles (Append). 

3 For tables, indicate if the file you are importing replaces 
data in existing contact profiles (Replace), or if it adds 
data to the profiles (Append).

Key Description
1 Indicate if the imported roles replace existing roles 

or add to them.
2 Indicate if the imported data replaces existing data or

adds to it.

1

2

2

1
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7 Click Next.
The Preview Import page opens. It shows the first valid row of your file with 
the Active Community fields you mapped. If you have contact information in 
your file that is to overwrite an existing profile, Before and After columns show 
how the profile will change after you import your file. 

Note: If you are importing data tables, this page does not open.
8 Click Next.

The Import Queue page opens and a message notifies you your import file was 
added to the queue for processing.

9 To work in Active Community while the import file is being processed, click the 
Go to Companies or Go to Contacts link. 
After the file has been processed, Active Community sends you an email 
notification detailing the number of rows that were successfully or 
unsuccessfully imported. 

10 To troubleshoot errors, in the email, click Download Reject CSV File. 
Examine the Error Messages column for hints about how to fix the invalid data. 

11 To view your imported data, go to the Contacts or Companies pages (Profiles 
> Companies or Contacts).

Working with Sub-communities
Sub-communities are a collection of companies created inside a hub community. 
Sub-communities allow each department to work with a sub-community of 
companies with which they interact on a regular basis. For example, contacts in 
supplier relations might want to work with a supplier sub-community. Contacts in 
brand management might want to work with a sales sub-community.
Sub-community membership can be manual or automated based on a single field 
value (condition). See “Creating a Sub-community and Assigning Contacts and 
Roles” on page 141.
Topics include:
■ “Creating a Security Role for a Sub-Community” on page 141
■ “Creating a Sub-community and Assigning Contacts and Roles” on page 141
■ “Adding Companies to a Sub-community” on page 144
■ “Removing Companies from a Sub-community” on page 147
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■ “Viewing Contacts Assigned to Sub-community Roles” on page 149
■ “Editing a Sub-community” on page 150
■ “Deleting an Inactive Sub-community” on page 150

Creating a Security Role for a Sub-Community
Security role: Community Administrator
Security permission: Community Permissions > Manage Community

To create a security role for a sub-community
1 Follow the instructions in “Adding a Custom Security Role” (Admin > Security 

Roles tab). See “Adding a Custom Security Role” on page 65.
2 Select the permissions to assign to the role. If you want the role to be able to:

■ Create new sub-communities, under Community Permissions > select the 
Add Sub-community check box.
Note: If selected, the role is considered sub-community Administrator. 

■ Edit sub-community properties, under Sub-community Permissions > select 
the Manage Sub-communities check box.

3 Click Save.
4 Assign the sub-community security role to a contact in the hub community as 

described in “Assigning a Security Role to a Contact Profile” on page 73.
5 Go to “Creating a Sub-community and Assigning Contacts and Roles” on 

page 141.

Creating a Sub-community and Assigning Contacts and 
Roles

Permission: Add Sub-community
Use this procedure to create a sub-community and assign contacts and security 
roles to the sub-community. 
■ A maximum of 100 sub-communities can be created in a hub community. 
■ The contact who creates the sub-community is added to the sub-community 

automatically, but can be removed.
■ All Community Administrators are automatically added as sub-community 

administrators.
Important: In addition to the role created in “Creating a Security Role for a Sub-
Community,” at least one Community Administrator role must be selected for a 
sub-community. By default, contacts in the Community Administrator role can 
access all companies in all sub-communities.

To create a sub-community and assign contacts and roles
1 Click Profiles > Companies.
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The All Companies list page opens.

2 Click New Sub-community.
The New Sub-community page opens.

3 In Name, type a name for the sub-community.
4 In Description, type a description of the sub-community.
5 Do one of the following:

■ To create a sub-community where membership is manual, go to step 6.
■ To create a sub-community that automates membership based on a 

condition, click Add Condition. 
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The Condition section expands.

a In the first drop-down list, select a field on which to base the condition for 
sub-community membership.

b In the next drop-down list, select the operator that describes how you want 
Active Community to apply the condition, such as Contains or Is Equal to 
(not all operators are available for all fields).

c In the last text field/drop-down list, type or select the remaining part of the 
condition
Note: For Multiple Choice type custom fields, you can select more than 
one value from the drop-down list.
Any company is automatically added to this sub-community when the 
condition is met and the changes are saved.
Note: You cannot change the condition of a sub-community once it has at 
least one company (spoke) assigned to it.

d Continue to step 6.
6 Use the Hub Contact search box to find the hub contacts you want to access 

the sub-community.

7 Select a contact.
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The security roles that can be assigned to the contact display in the Security 
Role column.

8 To view the permissions that are assigned to the role:
a Under Security Role, click the link. 

A pop-up window opens and lists the permissions assigned to the role.

b Click X to close the pop-up window.
9 Select the check boxes for one or more roles you want to assign to the contact 

in the sub-community.
Important: At least one Community Administrator role must be selected for a 
sub-community. 
The Community Administrator tab is the first tab at the bottom of the page. It 
lists the contact assigned to the role for the hub community. For each security 
role selected, a new tab displays. The tab lists the security role and the 
contacts assigned to the role.

10 Click Save.
The sub-community is added to the directory list on the Company Directory 
page.

11 Go to “Adding Companies to a Sub-community” on page 144.

Adding Companies to a Sub-community
Permission: Add Sub-community
After “Creating a Sub-community and Assigning Contacts and Roles” on page 141, 
use this procedure to add a company to a sub-community: 
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■ From the All Companies list page (Directory tab), add one or more companies to 
one or more sub-communities.

■ From a company’s profile page, add that company to one or more sub-
communities.

■ A company is automatically added to that sub-community when it’s field value 
meets the condition defined for membership in the sub-community.

Note: You cannot manually add a company to a sub-community where 
membership is based on a condition. 
You can also import companies and add them to one or more sub-communities 
using a .csv file, separating the sub-communities by commas in the appropriate 
column. The sub-communities must already exist before importing the companies.
See “Importing Companies and Contacts Using CSV Files” on page 128.

To add companies to a sub-community
1 Click Profiles > Companies.

The All Companies list page opens.
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2 Perform the appropriate action:
If you want to add... Do this:
One or more companies 
to one or more sub-
communities

Using All Companies list 
page (Directory tab)

1 Search for the company or companies that you want to add to one or more sub-
communities.

2 Select the check boxes for the companies you want to add to one or more sub-
communities.

3 Click the Actions drop-down list, select Add to Sub-communities, and click OK.
The Add to Sub-communities page opens.

4 Select check boxes for the sub-communities to which you want to add the companies, and 
click Save.
Note: Since you cannot manually add a company to a sub-community where membership 
is based on a condition, the check boxes for these sub-communities are unavailable.
The company is added to the selected sub-communities. The number of companies in each 
sub-community is updated on the All Companies list page (Directory tab).
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Removing Companies from a Sub-community
Permission: Manage Sub-community
Use this procedure to remove a company from a sub-community:
■ From the All Companies list page (Directory tab), remove one or more 

companies from a sub-community.
■ From a company’s profile page, remove that company from one or more sub-

communities.
■ A company is automatically removed from that sub-community when it’s field 

value no longer meets the condition defined for membership in the sub-
community.

Note: You cannot manually remove a company from a sub-community where 
membership is based on a condition. 

If you want to add... Do this:
One company to one or 
more sub-communities

Using company’s profile 
page

1 Search for and click the name of the company that you want to add to one or more sub-
communities.
The company’s profile page opens.

2 Click Manage Company > Edit Company.
The Edit Profile page opens to the Overview tab.

3 Click the Sub-communities tab.
A list of sub-communities displays.

4 Select check boxes for the sub-communities to which you want to add the company, and 
click Save.
Note: Since you cannot manually add a company to a sub-community where membership 
is based on a condition, the check boxes for these sub-communities are unavailable.

The company is added to the selected sub-communities. The number of companies in each 
sub-community is updated on the All Companies list page (Directory tab).
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To remove companies from a sub-community
1 Click Profiles > Companies.

The All Companies list page opens.
2 Perform the appropriate action:

If you want to 
remove... Do this:
One or more companies 
from a sub-community

Using All Companies list 
page (Directory tab)

1 Click the link of the sub-community from which you want to remove one or more 
companies.
The companies that belong to that sub-community display.

2 Select check boxes for the companies you want to remove from the sub-community.
3 From the Actions drop-down menu, select Remove from Sub-communities, and click 

OK.
Note: Since you cannot manually remove a company from a sub-community where 
membership is based on a condition, the check boxes for these sub-communities are 
unavailable.

The Remove from Sub-communities page opens. It lists the sub-communities from which 
the company can be removed.

4 Select the sub-community from which you want to remove the company, and click Save.
The company is removed from the sub-community.
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Viewing Contacts Assigned to Sub-community Roles
Permission: Manage Sub-community
Use this procedure to view hub contacts assigned to sub-community roles.
Important: At least one Community Administrator role must be selected for a 
sub-community. 

To view contacts assigned to sub-community roles
1 Click Profiles > Companies.

The All Companies list page opens.
2 Click the link for the sub-community for which you want to view contacts by 

role.

If you want to 
remove... Do this:
One company from one 
or more sub-
communities

Using company’s profile 
page

1 Search for and click the name of the company that you want to remove from a sub-
community.
The company’s profile page opens.

2 Click Manage Company > Edit Company.
The Edit Profile page opens to the Overview tab.

3 Click the Sub-communities tab.
A list of sub-communities displays.

4 Clear the check boxes of the sub-communities from which you want to remove the 
company, and click Save.
Note: Since you cannot manually remove a company from a sub-community where 
membership is based on a condition, the check boxes for these sub-communities are 
unavailable.

The company is removed from the selected sub-communities. The number of companies in 
each sub-community is updated on the All Companies list page (Directory tab).
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3 Click Manage Sub-community, then Edit Sub-community.
The Edit Sub-community page opens.
Tabs display for each security role. 

4 Click the tab for the security role. 
The tab lists the contacts that are assigned to the role.

Editing a Sub-community
Permission: Manage Sub-community
Use this procedure to add contacts to (or delete contacts from) a sub-community 
or change other sub-community information.
Note the following:
■ You can only add a condition to sub-community or modify the existing condition 

if there are no companies assigned to the sub-community.
■ If membership is automated via a condition and at least one company belongs to 

the sub-community (because the condition is met), you cannot edit it until all 
companies have been removed from the sub-community.

To add edit a sub-community
1 Click Profiles > Companies.

The All Companies list page opens.
2 Click the link for the sub-community you want to edit.
3 Click Manage Sub-community, then Edit Sub-community.

The Edit Sub-community page opens.
4 Edit sub-community properties or modify the contact information as described 

in “Creating a Sub-community and Assigning Contacts and Roles” on page 141.

Deleting an Inactive Sub-community
Permission: Add Sub-community
Use this procedure to delete a sub-community, including company and contact 
assignments to the sub-community. 
Note: Companies and contacts are not deleted from the hub community—just 
from the sub-community.

To delete a sub-community
1 Click Profiles > Companies.

The All Companies list page opens.
2 Click the link for the sub-community you want to delete.
3 Click Manage Sub-community, then Delete Sub-community.

The message asks you to confirm the deletion of the sub-community.
4 Click Delete. 

The sub-community is deleted.
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Working with Companies and Contacts
Depending on your user permissions, you can perform many actions related to 
companies and contacts in your community. 
Topics include:
■ “Moving Divisions Between Companies” on page 151
■ “Changing the Name of the Divisions Tab” on page 152
■ “Deleting Companies or Contacts” on page 153
■ “Disabling Companies or Contacts” on page 155
■ “Enabling Companies or Contacts” on page 157
■ “Registering or Re-registering a Company” on page 159
■ “Downloading a PDF for Company or Contact Profiles” on page 164
■ “Sending a Company for TGO Provisioning” on page 166
■ “Viewing Company and Registration Audit Data” on page 168
■ “Viewing Contact Audit Data” on page 169
■ “Subscribing Your Company to AIC” on page 169

Moving Divisions Between Companies
Security permission: My Company Permissions > Edit My Company Divisions
You can move divisions between companies by modifying the parent company ID 
for a division. This can be accomplished by using either the user interface or the 
Active Community API.
Topics include:
■ “Modifying the Parent Company ID” on page 151 
■ “Modifying the Parent Company ID using the API” on page 152

Modifying the Parent Company ID

To modify the Parent Company ID
1 Click Profiles > Companies > and navigate to the company whose division 

you want to move. 
2 Click the Divisions tab. 

A list of the divisions for the company displays. For example:

3 Click the name of the division you want to move to a different parent company 
(for example, orange sub1).
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The profile for that division displays.

4 From the Manage Company drop-down list, select Edit Company.
The Edit Profile page for the division displays.

5 In the Parent Company ID box, clear the selection, and type the first few 
characters of the new parent company ID (for example, abc1). A drop-down list 
displays with selections that match the characters you typed. Select an ID from 
the list.

6 Click Save.
The division has been moved under the new parent company.

Modifying the Parent Company ID using the API
The Active Community API can be used to: 
■ Create a new division. 
■ Move a division under a different existing parent company by updating the 

parent company ID for the division.
For more details, see the OpenText Active Community API Documentation.

Changing the Name of the Divisions Tab
Security permission: My Company Permissions > Edit My Company Divisions
Community Administrators can modify the label of the Divisions tab so the word is 
meaningful to their company, such as using the word Accounts instead of Divisions. 
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For all users, the word displays everywhere the word Divisions displayed before the 
change.

To modify the division tab name
1 Click Admin > Community Settings tab.

The Community Settings page opens.
2 Click Edit Community.

The Edit Community Settings page opens.

3 Under Global Preferences, in the Division Label box, type the new label. 
Note: The custom label cannot be more than 20 characters.
In this example, Divisions has been changed to Accounts. 

4 Click Save.
A message indicates that your update is successful.
In the company profile, the tab name is now Accounts, the name of the page is 
Accounts, and the button name is Add Accounts.

Deleting Companies or Contacts
Security permissions: 
■ Community Permissions > Delete Active Profile, or
■ Company Permissions > Delete Inactive Companies, or
■ My Company Permissions > Delete My Company Contacts, or
■ Contact Permissions > Delete Inactive Contacts
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Use this procedure to permanently delete companies and contacts from your 
community. 
Important: Use caution when performing this procedure. When you delete a 
company or contact, Active Community deletes all:
■ Divisions (company only)
■ Contacts, including items they created:

■ Projects
■ Activities
■ Web Forms
■ Saved Searches
■ Custom Exports
■ Reports
■ Tags 
■ Alerts
■ Email templates

It also removes:
■ Contacts from activities
■ Posts and topics created by contacts (Workspace only)
Note: Once the data is deleted, it cannot be retrieved. Before deleting the data, 
you should export it; this ensures that the data is available in the event that you 
need it in the future.
Contacts in the Community Administrator role, the current user, or contacts 
associated with open registration requests cannot be deleted.

To delete companies or contacts
1 Click Profiles > Companies or Contacts, and search for the contact or 

company you want to delete.
The companies or contacts list page opens.

2 Perform the appropriate action:
■ To delete multiple companies, go to step 3.
■ To delete one company, go to step 4.

3 To delete one company or contact:
a View the company or contact profile. 
b In the Manage Company or Manage Profile drop-down list, click Delete 

custom fieldcustom fieldCompany or Delete Contact. 
A confirmation message opens. 

c Go to step 5.
4 To delete multiple companies or contacts:
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a Click the Actions drop-down list, then select Delete Companies or 
Delete Contacts.

■ To delete all companies or contacts, select All Search Results, then 
click OK.

■ To delete specific companies or contacts, select the check boxes of the 
companies or contacts you want to delete, select Selected Rows, and 
click OK.

A confirmation message opens.
b Go to step 5.

5 Perform the appropriate action:

Disabling Companies or Contacts
Security permissions: 
■ Company Permissions > Disable Companies
■ Sub-community Permissions > Disable Companies
■ Contact Permissions > Disable Contacts
When you disable companies or contacts, they are no longer active members of 
the community and cannot receive future communications. While their records are 
unavailable, a historical record of their participation in community activities is kept 
for future reference. For example, so you can view their past responses to surveys.
When you disable a contact, the contact cannot:
■ Complete activities
■ Receive emails from the community
■ Be added to a project as a participant or team member
■ Update their contact profile
When you disable a company, all company divisions and contacts are also disabled.
You can also disable companies or contacts by “Importing Companies and Contacts 
Using CSV Files.”
Topics include:
■ “Disabling a Company” 
■ “Disabling a Contact” on page 156

If the message indicates... Do this:
The contact cannot be deleted.... ■ Click OK. 

You have finished the procedure.
Deleting a contact(s) or companies 
permanently does the following....

1 Read and understand the significance of the 
permanent deletion.

2 Select the “Yes, I want to delete the 
companies/contacts” check box.

3 Click Delete.
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Disabling a Company

To disable a company
1 Click Profiles > Companies, and search for the company or companies that 

you want to disable. For details, see “Quick (Simple) Searches” on page 91 or 
“Advanced Searches” on page 93.

2 Perform the appropriate action:
■ To disable multiple companies, go to step 3.
■ To disable one company, go to step 6.

3 Select the check boxes for the companies you want to disable. 
4 Click the Actions drop-down list, then select Disable Companies.
5 At the confirmation message, click Disable Companies. You have finished the 

procedure.
6 Open the profile of the company you want to disable. Click Manage Profile > 

Disable Company. 

7 Click Disable in the confirmation message.
The company is disabled. All divisions and contacts within the companies are 
disabled, so contacts cannot receive communications from the community.
Note: To enable a company, see “Enabling Companies or Contacts” on 
page 157.

Disabling a Contact

To disable a contact 
1 Click Profiles > Contacts, and search for the contact or contacts that you 

want to disable. For details, see “Quick (Simple) Searches” on page 91 or 
“Advanced Searches” on page 93.
Note: You cannot disable a contact who has been assigned the Community 
Administrator role. 

2 Perform the appropriate action:
■ To disable multiple contacts, go to step 3.
■ To disable one contact, go to step 6.

3 Select the check boxes for the contacts you want to disable. 
4 Click the Actions drop-down list, then select Disable Contacts.
5 At the confirmation message, click Disable Contacts. You have finished the 

procedure.
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6 Open the profile of the contact you want to disable. Click Manage Profile > 
Disable Contact. 

7 Click Disable in the confirmation message.
The contact is disabled and cannot receive communications from the 
community. In addition, the contact cannot be added as a participant to a 
project and cannot complete activities.
Note: To enable a contact, see “Enabling Companies or Contacts” on 
page 157. 

Enabling Companies or Contacts
When you enable companies or contacts, they become active members of the 
community and can participate in daily activities. Contacts can complete activities, 
receive email communications, and can be added as project participants. Enabled 
company and contact profiles can also be edited and updated.
You can also enable companies or contacts by “Importing Companies and Contacts 
Using CSV Files” on page 128.
Topics include: 
■ “Enabling a Company”
■ “Enabling a Contact” on page 159

Enabling a Company
Security permissions: 
■ Company Permissions > Enable Companies
■ Sub-community Permissions > Enable Companies
When you enable a previously disabled company, the company, its divisions, and 
its contacts are enabled.
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To enable a company 
1 Click Profiles > Companies, and search for the company or companies that 

you want to enable. Be sure to select the Include Disabled check box when you 
perform a search. 

2 Perform the appropriate action:
■ To enable multiple companies, go to step 3.
■ To enable one company, go to step 5.

3 Select the check boxes for the companies you want to enable. 
4 Click the Actions drop-down list, select Enable Companies, then click OK. You 

have completed the procedure.
5 Open the profile of the company you want to enable. Click Manage Profile > 

Enable Company. 
6 Click Enable in the confirmation message.

The companies, divisions, and contacts within those companies are enabled.
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Enabling a Contact
Security permissions: 
■ My Company Permissions > Enable My Company Contacts

or
■ Contact Permissions > Enable Contacts

To enable a contact
1 Click Profiles > Contacts, and search for the contacts that you want to 

enable. Be sure to select the Include Disabled check box when you perform a 
search. 

2 Perform the appropriate action:
■ To enable multiple contacts, go to step 3.
■ To enable one contact, go to step 6.

3 Select the check boxes for the contacts you want to enable. 
4 Click the Actions drop-down list, then select Enable Contacts.
5 At the confirmation message, click Enable Contacts. You have finished the 

procedure.
6 Open the profile of the contact you want to enable. Click Manage Profile > 

Enable Contact. 

7 Click Enable in the confirmation message.
The contact is enabled and will receive communications from the community. In 
addition, the contact can be added as participants to a project and can is able 
to complete activities.

Registering or Re-registering a Company
Security roles: Registration Administrator
The procedures for registering a company and re-registering a company are very 
similar. 
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Registering a company
If a company profile is not created using the Registration workflow, the hub can 
use this procedure to send the company to registration at a later time. Sending the 
company to registration provides a way to collect data and/or refresh data while 
using the Registration workflow to ensure that the data is acceptable. 
Companies are eligible to be sent to registration only if they are not integrated with 
TGO. After a company is successfully registered, it can be re-registered.
Note: While a company is in the registration process, the company profile cannot 
be edited until the registration process is complete.
You can also register companies by importing company profile information. See 
“Importing Companies and Contacts Using CSV Files” on page 128.

Re-registering a company
The hub can send a spoke company back through registration (for example, during 
an annual review process) by re-registering a company. Re-registration provides a 
way to collect data and/or refresh data while using the Registration workflow to 
ensure that the data is acceptable. 
Companies are eligible for re-registration only if they are not integrated with TGO 
and were originally created via onboarding (using the Registration workflow).
Note: While a company is in the re-registration process, the company profile 
cannot be edited until the registration process is complete.
You can also re-register companies by importing company profile information. See 
“Importing Companies and Contacts Using CSV Files” on page 128.

Registration and Re-Registration Indicators
There are a number of indicators to help you identify a company that is in 
registration or re-registration.
■ Companies whose registration or re-registration process has recently been 

initiated and are in process of being resent to Registration have an informational 
icon (i) after the company name on the list page. 
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■ Companies that are currently locked due to registration or re-registration 
(profiles cannot be edited until the registration or re-registration process is 
complete) have a “padlock” icon after the company name on the list page.

■ Companies whose profiles are locked due to registration or re-registration have 
an icon after the company name on the profile page.

In addition, in the Notes section of the company profile, the following 
registration activity information displays:

■ Re-register Count - The number of times the company has been resent for 
registration

■ Re-register Status - The status of the most recent re-register action.

To register or re-register a company 
1 Click Profiles > Companies, and search for the company or companies that 

you want to register or re-register.
2 Perform the appropriate action:

■ To register or re-register multiple companies, go to step 3.
■ To register or re-register one company, go to step 8.

3 Select the check boxes for the companies you want to register or re-register.
4 Click the Actions drop-down list, and select the appropriate option:

■ To register the companies, click Send Companies for Registration
■ To re-register the companies, click Re-register Companies. 

A confirmation dialog box opens.
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5 Select the appropriate check box to acknowledge that registering or re-
registering the company(s) locks the company profile for editing until the 
registration process is complete:

■ Yes, I want to send the company(s) for registration.
■ Yes, I want to re-register the company(s).

6 Click OK. 
A confirmation message indicates that your action is in process and that you 
will receive an email with the results.

7 Check your email to see the results of the registration or re-registration.
The following scenarios are possible:

■ All of the selected companies are successfully sent or resent to registration. 
You have completed the procedure.

■ One or more of the companies cannot be registered or re-registered. 
Registration or re-registration cannot proceed if any of the following 
conditions exist.

■ In the case of re-registration, the company was not created via 
onboarding (using the Registration workflow).

■ The company does not have a primary contact.
■ The company does not have an active contact.
■ For companies with more than one contact, one or more of the contacts 

does not have a phone number.
■ The company is undergoing a Change Management process.
■ The company is already in the registration process and the profile is 

locked.
You have completed this procedure. 

8 Open the profile of the company you want to register or re-register. Click 
Manage Profile, and select the appropriate option:

■ To register a company, click Send for Registration
■ To re-register a company, click Re-register Company. 

A confirmation dialog box opens.
9 Select the appropriate check box to acknowledge that registering or re-

registering the company locks the company profile for editing until the 
registration process is complete. 

■ Yes, I want to send the company for registration.
■ Yes, I want to re-register the company.

10 Click OK. 
One of the following occurs:
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■ If the company has appropriate contact information, the Select Primary 
Contact dialog box opens. Go to step 11 to see your options for selecting a 
contact.

■ If the company does not have contact information due to one of the 
following reasons, it cannot be registered or re-registered. Correct the 
error and repeat this procedure.

■ The company does not have an active contact.
■ For companies with more than one contact, one or more of the contacts 

does not have a phone number. If the company has only one contact 
without a phone number, and that contact is selected as the primary 
contact, the company can be re-registered.

11 Do one of the following to designate a primary contact:
■ Keep the current primary contact for registration or re-registration 

(selected by default if there is a primary contact). Click OK.
■ To select a different contact as the primary contact for registration or re-

registration, select a contact from the list of other contacts belonging to 
the company. Click OK.

■ To add a new contact to the company to use as the primary contact, click 
Add New Contact. For descriptions of the contact fields, see step 4 on 
page 126  in the procedure “Adding a Contact to a Company.” After you 
have added the contact, return to this procedure.

After you select a primary contact and click OK, your request for registration or 
re-registration is successfully initiated and a success message displays.

12 Click the link in the success message to view and submit the registration 
request to the next approval level.
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The Registration Request page opens for the company you are registering or 
re-registering. 

13 Continue with the registration request approval process, step 6 on page 487  in 
the procedure “Creating a Request,” in Chapter 14, “Registration Requests.”

Downloading a PDF for Company or Contact Profiles
Security permissions: 
■ Company Permissions > Export Companies/Reports
You can download company or contact profile information in a PDF file, selecting 
the field groups you want to include. Both core and custom fields can be 
downloaded.
Note: Security permissions control which fields are included in the PDF. If you do 
not have permission to view particular fields, they do not display in the PDF.
Topics include: 
■ “Downloading a PDF for a Company Profile”
■ “Downloading a PDF for a Contact Profile” on page 165

Downloading a PDF for a Company Profile

To download a PDF for a company profile
1 Click Profiles > Companies, and search for the company or companies 

whose profile you want to download. Be sure to select the Include Disabled 
check box when you perform a search. 

2 Open the profile of the company.
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The profile page opens.

3 Click Manage Company > Download PDF. 
The Download PDF page opens.

4 Company Details is selected by default. To include custom field groups in the 
PDF, select the appropriate field group check boxes. Selecting the Field Groups 
check box selects all the field groups.

5 To narrow the selection of field groups that display, begin typing the name of a 
field group in the search box, and only those field groups beginning with those 
letters display.
Note: Security permissions control which fields are included in the PDF. If you 
do not have permission to view particular fields, they do not display in the PDF.

6 Click Download.
A dialog box asks you if you want to open the file or save it.

7 Do one of the following:
■ Select Open with selected program to open the file.
■ Select Save File to save the file to your computer.

The profile fields are displayed in the file. The PDF file can be printed.

Downloading a PDF for a Contact Profile

To download a PDF for a contact profile
1 Click Profiles > Contacts, and search for the contact whose profile you want 

to download. Be sure to select the Include Disabled check box when you 
perform a search.
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2 Open the profile of the contact. 
The profile page opens.

3 Click Manage Profile > Download PDF. 
The Download PDF page opens.

4 Contact Details is selected by default. To include custom field groups in the PDF, 
select the appropriate field group check boxes. Selecting the Field Groups check 
box selects all the field groups.

5 To narrow the selection of field groups that display, begin typing the name of a 
field group in the search box, and only those field groups beginning with those 
letters display.
Note: Security permissions control which fields are included in the PDF. If you 
do not have permission to view particular fields, they do not display in the PDF.

6 Click Download.
A dialog box asks you if you want to open the file or save it.

7 Do one of the following:
■ Select Open with selected program to open the file.
■ Select Save File to save the file to your computer.

The profile fields are displayed in the file. The PDF file can be printed.

Sending a Company for TGO Provisioning
Security permissions:
Security roles: Company Permissions > Edit Companies
Companies created via registration and companies created in base can use this 
procedure to send a company for TGO provisioning. Companies created in base 
can be sent to TGO provisioning as long as all mandatory core fields required for 
registration are complete.
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More than one company can be sent for TGO provisioning at the same time.
Note: This feature is available for hubs who are using Trading Grid Online (TGO) 
integrated with Active Community (AC).

Holding Registration Requests
For companies created via registration, typically all trading partner information 
approved through the registration workflow is automatically processed to TGO. 
However, a hub has the ability to automatically pause the registration process after 
all registration workflow approvals are complete so that they can store the ERP Id 
in Active Community before the profile data is processed to TGO. This ERP Id can 
be referred to by the hub while exchanging documents with trading partners within 
TGO. 
Note: To enable this feature, the Registration Administrator must select the Hold 
Registration Request check box (Applications > Registration > Admin tab > 
Registration Settings > TGO Settings). 
Once the ERP Id is updated in AC records, the hub can use one of the following 
methods to update the workflow status:
■ Using an API call, the hub can update the workflow status from “Not Ready” to 

“Ready.”
■ Using the UI, the workflow status is automatically set to Ready when the hub 

sends the request to registration using the Send for TGO Provisioning action 
described in this procedure. 

Either of these methods allows the registration workflow to continue and send the 
information to TGO.

To send a company for TGO provisioning
1 Click Profiles > Companies, and search for the company or companies that 

you want to send for TGO provisioning.
2 Perform the appropriate action:

■ To send multiple companies for TGO provisioning, select the check boxes 
for the companies you want to send for TGO provisioning, click the Actions 
drop-down list, and select Send for TGO Provisioning.

■ To send one company for TGO provisioning, open the profile of the 
company you want to send for TGO provisioning. Click Manage Profile > 
Send for TGO Provisioning.

3 In the confirmation dialog box, click OK to confirm that you want to send the 
company(s) to TGO provisioning. 

4 One of the following occurs:
■ The company(s) are successfully submitted for TGO provisioning. This 

action automatically updates the status to Ready, and the company is 
immediately submitted to the registration workflow.
Note: Companies sent for TGO provisioning cannot be edited until they 
are approved by TGO.
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■ A message indicates that mandatory core fields for TGO provisioning are 
not complete. You must complete these fields in the profile before 
submitting to TGO provisioning. 
Note: When completing and saving your changes to a profile, an Update 
Confirmation dialog box gives you the option to click Continue Editing to 
make further edits without locking the profile for TGO workflow approval. 
This is useful if you have multiple changes to make. If you are done with 
changes, click Update to save changes to the profile and lock the profile 
for TGO approval.

5 Go back to step 2 to select your company to send for TGO provisioning.

Viewing Company and Registration Audit Data
Security permissions:
■ Company Permissions > View Audit Log
Use this procedure to view audit data for companies. The information identifies the 
user who made the changes. It also includes the date the change was made and, if 
modified, the old and new custom field values.
Note: If data masking is enabled for a company custom field, and you do not 
have permission to view it, asterisks display in place of the value. If a masked 
custom field is deleted, the original value displays (the field value is not masked).

To view audit data for a company
1 Click Profiles > Companies, and search for the company you want.
2 View the company profile. 
3 In the profile, click the Audit Log tab. 

The tab displays audit information for the past 60 days.
The Audit Log tab has two sections:

■ Company Audit Log - Displays all changes related to the company 
profile.

■ Registration Audit Log - Displays all registration requests related to the 
company profile.

Perform the appropriate action:

To... Do this:
Save an Excel file that contains 
all company audit info with 12 
months of audit data

1 Click Company Audit Log.
2 Click Export Audit Log.
3 Click Save.
4 If needed, change the name of the file.
5 Navigate to a destination on your hard disk.
6 Click Save.

Open an Excel file that contains 
all company audit info with 12 
months of audit data

1 Click Company Audit Log.
2 Click Export Audit Log.
3 Click Open.

The file opens as an Excel spreadsheet.
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Viewing Contact Audit Data
Security permissions:
■ Contact Permissions > View Audit Log
Use this procedure to view audit data for contacts. The information identifies the 
user who made the changes. It also includes the date the change was made and, if 
modified, the old and new custom field values.

To view audit data for a contact
1 Click Profiles > Contacts, and search for the contact you want.
2 View the contact profile. 
3 In the profile, click the Audit Log tab. 

The tab displays audit information for the past 60 days.
4 To view an Excel report that contains audit information for the past 12 months, 

click Export Audit Log.
5 Perform the appropriate action:

Subscribing Your Company to AIC
Active Community AIC Provisioning is a process solution designed to help hubs 
implement application services, such as Active Invoices with Compliance (AIC). 
Note: Provisioning is available for TGO integrated communities only and must be 
enabled for your community. Contact Support for assistance.
See Chapter 15, “AIC Provisioning” for more information.

Display a list of registration 
requests related to the 
company profile

1 Click Registration Audit Log.
The list displays.

View details for a specific 
registration request

1 Click Registration Audit Log.
2 Click the appropriate Request ID.

The details display.
View or save a report that 
includes details for a specific 
registration request

1 Click Registration Audit Log.
2 Click PDF for the appropriate request.
3 Save or open the file.

To... Do this:
Save the file with 12 months of 
audit data

1 Click Save.
2 If needed, change the name of the file.
3 Navigate to a destination on your hard disk.
4 Click Save.

Open the file with 12 months of 
audit data

■ Click Open.
The file opens as an Excel spreadsheet.

To... Do this:
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Updating File Upload Custom Fields Using .Zip Files
Use this information to update File Upload custom fields for companies. Follow the 
general requirements in “Custom Field Requirements for Importing Data” on 
page 133. To update other types of custom fields, see “Importing Companies and 
Contacts Using CSV Files” on page 128.
Instead of uploading a file to each company profile one at a time, mass file upload 
lets hub contacts use a compressed (.zip) file to update custom fields saved in the 
File Upload format. The uploaded files are company-specific, such as scorecards, 
price lists, or signed contracts. The graphic shows a scorecard, in .xlsx format, that 
could be uploaded to a company profile. 

For example, hub contacts might want to create and upload 120 files to a file 
upload custom field named “Invoice.” The mass file upload process attaches the 
appropriate invoice to the appropriate spoke company profile. Spoke contacts can 
download their files for review and upload them back to their company profiles. 
In a larger context, hub contacts upload multiple files to a file upload custom field 
as described here. They use projects and activities to send activity emails to spoke 
contacts.
Topics include:
■ “Mass File Upload Requirements” on page 170
■ “Importing File Upload Custom Field Files to Company Profiles” on page 171
■ “Exporting File Upload Custom Field Files from Company Profiles” on page 172

Mass File Upload Requirements
■ Create one file per company. The file can be in any format.
■ Use the company ID as the file name. 
■ Use this format: company_ID.ext. For example:

■ 12345.xls
■ 335663.pdf
■ 5757575.txt

■ Do not use blank spaces or special characters (? ! : |) in file names. 
■ Put the files you want to upload in one folder for each file upload custom field.
■ Send the files to a compressed (zipped) file. The folder is renamed with a .zip file 

extension.
Topics include:
■ “Importing File Upload Custom Field Files to Company Profiles” on page 171
■ “Exporting File Upload Custom Field Files from Company Profiles” on page 172
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Importing File Upload Custom Field Files to Company 
Profiles

Security permissions: Companies > Import Companies
Use this procedure to import a .zip file that contains multiple files. The files 
populate file upload custom fields in spoke company profiles. 
Important: Before you begin, create a .zip file after reviewing the information in 
“Mass File Upload Requirements” on page 170. 

To import file upload custom field files to spoke company profiles
1 Click Profiles > Companies > Manage Companies > Upload Files.

The Upload Files to Company Profiles page opens. 

2 In Upload a File, click Browse to navigate to the .zip file you created, select 
the .zip file, and click Open.

3 In Community Database, select the file upload custom field to which you want 
to map the files. Only custom fields saved in the File Upload format are listed. 
Important: Because the same names can exist in different custom field 
groups, be sure to select the correct file upload custom field.

Note: If your custom field permissions do not allow you to view all file upload 
custom fields, those fields do not display in the list.
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4 In File Suffix, specify a suffix you want Active Community to append to the 
customer ID file name. The suffix, such as Scorecard_Report, further identifies 
the file to the spoke contact, such as 12345-Scorecard_Report.docx.

5 Click Save.
Active Community sends an email confirmation when all files in the .zip file 
have been uploaded. 

6 To verify the data was uploaded:
a Open a company profile. 
b Select the tab for the custom field group that contains the file upload 

custom field.
c Check the file upload custom field to verify the file was uploaded.

Exporting File Upload Custom Field Files from Company 
Profiles

Security permissions: 
■ Company Permissions > Export Companies/Reports
■ Sub-community Permissions > Import Companies
Use this procedure to export files that spoke users uploaded to their company 
profiles. 

To export file upload custom field files from spoke company profiles
1 Click Profiles > Companies > Actions menu > Download Company Files.
2 Select check boxes for the companies whose files you want to export, select 

Selected Rows, and click OK.
The Export Files from Company Profiles page opens. 
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3 In Community Database, select the file upload custom fields from which you 
want to export the files. Only custom fields saved in the File Upload format are 
listed. 
Important: Because the same names can exist in different custom field 
groups, be sure to select the correct file upload custom field.

Note: If your custom field permissions do not allow you to view all file upload 
custom fields, those fields do not display in the list.

4 In File Suffix, specify a suffix you want Active Community to append to 
customer ID file name. The suffix, such as Monthly, further identifies the file, 
such as 57575799-Monthly.xls or 678999-Monthly.pdf.

5 Click Save.
Active Community exports the files.

6 Respond to the prompts to open or save the .zip file that contains the exported 
files. 
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Company and Contact 
Reports 6

Active Community lets you create and run company reports and company and 
contact exports as needed, giving you access to real time data. In addition, you 
can view company summary information in a pop-up window, export customized 
data to an Excel spreadsheet, and schedule reports to be delivered to you on a 
regular basis.
Different options are available based on how the reports or exports are set up. For 
example, company reports are set up using saved searches and saved formats 
(company custom exports). These are different from exports which are set up 
using only custom export settings. 
In addition to reports, hub administrators can access logs that identify those 
OpenText administrators who used the impersonation tool to act on behalf of their 
hub. This information may be necessary if an audit is conducted.
Topics include:
■ “Report/Export Overview” on page 175
■ “Company Reports Based on Saved Searches and Saved Formats” on page 178
■ “Summary Exports” on page 192
■ “Exports” on page 200
■ “Accessing Impersonation Logs” on page 218

Report/Export Overview
You can generate report data based on saved search criteria and on export settings 
defined for exports. Reports and exports are generated in Microsoft Excel format 
(.xls), and can be opened or downloaded to your computer for analysis.
In addition, you can create company summary reports that display in a pop-up 
window in Active Community.
Topics include:
■ “Report/Export Availability to Other Users” on page 176
■ “Report/Export Types” on page 176
■ “How Do I?” on page 177
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Report/Export Availability to Other Users
Report and export availability can be defined in three ways, as:
■ Private (account owner)—Reports or exports the account owner created and that 

no one else can edit or run.
■ Public (account owner)—Reports or exports the account owner created that 

others can run but not edit. 
■ Public (other users)—Reports or exports that other users have created that 

anyone can run.

Using the Public Check Box
Important: When configuring settings for a report or export, use the Public? 
check box as described here:
■ If you want the report or export to be private, do not select the Public? check 

box.

■ If you want the report or export to be available to other users, select the 
Public? check box.

Report/Export Types
There are three main report/export types for companies and contacts.

Company Reports based on Saved Search and Saved Format
Company reports are based on both the criteria in a saved search and the export 
options that you configure (company custom export). They can provide 
information about companies in your community and are sent as a link in an email. 
You can also view a company summary report in a pop-up window.

Summary Exports
Summary exports (for both company and contacts) are Excel files based on data 
for selected field groups. The exports include data for up to five field groups where 
each field is displayed as a percentage. Optionally, you can include counts and 
totals for the fields.

Exports
There are two types of exports:
Both types of exports can contain information about companies or contacts.
■ Basic Exports—Let you export basic information about companies and contacts 

without defining any export settings. 
■ Custom Exports—Let you define the general criteria and custom fields to include 

in the export; you can also specify additional export options for the Excel file.
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How Do I?
For company reports and company and contact exports, you need to understand 
the options that are available to you. The table lists a few options to consider.

If you want to... Choose (or use) the following options: When you are:
Company Reports (saved search + company custom export)
Create a company report ■ Profiles > Companies > Reports tab > 

Create New Report
■ “Creating a Report” on 

page 178
Edit a company report ■ Profiles > Companies >Reports tab > 

Action menu > Edit
■ “Editing a Report” on 

page 180
Run a company report ■ Profiles > Companies > Reports tab > 

Action menu > Run
■ “Running a Report” on 

page 181
View a summary report ■ Profiles > Companies > Reports tab > 

Action menu > Summary
■ “Viewing a Summary Report” 

on page 182
Copy a company report ■ Profiles > Companies > Reports tab > 

Action menu > Copy
■ “Copying a Report” on 

page 183
Delete a company report ■ Profiles > Companies > Reports tab > 

Action menu > Delete
■ “Deleting a Report” on 

page 184
Schedule a company report to be 
emailed to recipients on a regular 
basis

■ Profiles > Companies > Reports tab > 
Action menu > Schedule

■ “Scheduling a Report to be 
Emailed to Yourself or to 
Others” on page 185

Stop a regularly scheduled 
company report

■ Profiles > Companies > Reports tab > 
Action menu > Schedule > Remove 
Schedule

■ “Stopping a Scheduled 
Report” on page 190

Summary Exports
Create a summary export

■ Companies ■ Profiles > Companies > Reports tab > 
Action menu > Edit > Create/Edit button

■ “Configuring Export Settings 
for a Company Summary 
Export” on page 192

■ Contacts ■ Profiles > Contacts > Actions menu > 
Summary Export > New Export

■ “Configuring Export Settings 
for a Contact Summary 
Export” on page 197

Run a summary export
■ Companies ■ Profiles > Companies > Actions menu > 

Summary Export
■ “Running a Company 

Summary Export” on 
page 194

■ Contacts ■ Profiles > Contacts > Actions menu > 
Summary Export

■ “Running a Contact Summary 
Export” on page 198

Basic Exports
Export data to an Excel file with basic formatting

■ Companies ■ Profiles > Companies > Actions menu > 
Basic Export

■ “Exporting Companies or 
Contacts to an Excel File” on 
page 201

■ Contacts ■ Profiles > Contacts > Actions menu > 
Basic Export

Custom Exports
■ Create a custom export

■ Companies ■ Profiles > Companies > Actions menu > 
Custom Export > New Export

■ “Creating General Settings for 
a Company Custom Export” 
on page 204
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Company Reports Based on Saved Searches and Saved 
Formats

As an administrator, you can create, configure, and run reports about companies in 
your community. A company report is based on a saved search and a saved format:
■ Saved search—A saved search identifies a set of criteria that you have selected, 

named, and saved so that you can use the same set of criteria again to re-run 
the report. See “Creating a Saved Search” on page 103.

■ Saved format (company custom export)—A saved format identifies the custom 
fields or groups that you want to include in the report. To create a new export 
format, click Create/Edit. See “Creating General Settings for a Company 
Custom Export” on page 204.

You can customize reports by combining a saved search and a saved format. The a 
report can be run and re-run, thereby accessing the latest data from a saved set of 
parameters. You can make the report public so that anyone can run it.
After creating reports, you can run the report at any time to see real time data.
Topics include:
■ “Creating a Report” on page 178
■ “Editing a Report” on page 180
■ “Running a Report” on page 181
■ “Viewing a Summary Report” on page 182
■ “Copying a Report” on page 183
■ “Deleting a Report” on page 184
■ “Scheduling a Report” on page 185
■ “Report Example - Scheduling a Report Based on a Saved Search” on page 191

Creating a Report
Permissions required for security role: 
■ Company Permissions: Export Companies/Reports

■ Contacts ■ Profiles > Contacts > Actions menu > 
Custom Export > New Export

■ “Creating General Settings for 
a Contact Custom Export” on 
page 211

■ Run a custom export
■ Companies ■ Profiles > Companies > Actions menu > 

Custom Export
■ “Running a Company Custom 

Export” on page 207
■ Contacts ■ Profiles > Contacts > Actions menu > 

Custom Export
■ “Running a Contact Custom 

Export” on page 215

If you want to... Choose (or use) the following options: When you are:
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You can run a report to export company data by using the criteria in a saved 
search. The saved search lets you run and re-run a report, thereby accessing the 
latest data from a saved set of parameters. 
Note: Saved search criteria must exist before you can complete this procedure 
(see “Saved Searches” on page 102).

To create a company report from a saved search
1 Click Profiles > Companies > Reports tab.

The Available Reports page opens. 

2 Click Create New Report. The New Report page opens.

3 Complete the fields as follows:
■ Report Name—Type a name for the report.
■ Saved Search—Select a saved search from the drop-down list. The search 

identifies a set of criteria that you have selected, named, and saved so that 
you can use the same set of criteria again to re-run the report. See “Saved 
Searches” on page 102.

■ Saved format (company custom export)—Identifies the custom fields or 
groups that you want to include in the report. Do one of the following:
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■ To use an existing format, select a format from the drop-down list. 
■ To create a new export format, click Create/Edit. The Company 

Custom Exports page opens. See “Creating General Settings for a 
Company Custom Export” on page 204.

■ To edit an existing format, click Create/Edit. The Company Custom 
Exports page opens. See “Editing a Company Custom Export” on 
page 208.

■ Make Report Public—Select the check box if you want the report to display 
on the Available Reports page as a public report that anyone can run.

4 Click Save.
The newly created report is listed on the Available Reports page.

Editing a Report
Permissions required for security role: 
■ Company Permissions: Export Companies/Reports
A report is comprised of a saved search and a saved format (company custom 
export). The saved search lets you run and re-run a report, thereby accessing the 
latest data from a saved set of parameters. The saved format lets you identify and 
save the custom fields or groups that you want to include in the report.
Note: Saved search criteria must exist before you can complete this procedure 
(see “Saved Searches” on page 102).

To edit a company report
1 Click Profiles > Companies > Reports tab.

The Available Reports page opens. 

2 Click the name of the report you want to edit.
Note: You cannot edit a report created by other users.

3 Modify the report as described in “Creating a Report” on page 178.
4 Click Save to save your changes.
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Running a Report
You can run a company report that has been created from a set of saved search 
criteria. Every time you run the report, the real time results are based on the latest 
data that matches the saved set of criteria (see “Saved Searches” on page 102 and 
“Creating a Report” on page 178).

To run a saved search report
1 Click Profiles > Companies > Reports tab.

The Available Reports page opens.

2 From the Action drop-down list for the report you want to run, select Run.
The Run Custom Export page opens.

3 Specify a name for the report in the dialog box.
4 Click Run.

The report is generated, and the data is displayed in an MS Excel spreadsheet 
file (.xls).
Note: Large exports (processing times of more than 30-40 seconds) run in 
the background, and the generated export file is sent to you as a download link 
in an email. The link is available for seven days. Smaller exports are 
downloaded instantly.
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Viewing a Summary Report 
You can view a summary of a company report in a pop-up window.
Important: To be able to view a summary report in a pop-up window, be sure to 
select the Add Summary Export check box as described in “Configuring Export 
Settings for a Company Summary Export” on page 192. 

To view a company summary report in a pop-up window
1 Click Profiles > Companies > Reports tab.

The Available Reports page opens. A summary report is available for reports 
where Summary displays in the Action drop-down list.

2 From the Action drop-down list for the report you want to view, select 
Summary.
The Report Summary opens in a pop-up.

3 Do one of the following:
■ To close the Report Summary, click the X.
■ To print the Report Summary, right-click in the pop-up and select Print.
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Copying a Report
You can copy a company report that you or someone else has created and modify 
it to fit your needs.

To copy a report
1 Click Profiles > Companies > Reports tab.

The Available Reports page opens. 
2 From the Action drop-down list for the report you want to copy, select Copy.

The New Report page opens. The parameters of the copied report display in 
the fields.

3 Edit the fields as follows:
■ Report Name—Type a name for the report to replace (Copy of) the selected 

report.
■ Saved Search—Select the name of a saved search from the drop-down list. 

The search identifies a set of criteria that you have selected, named, and 
saved so that you can use the same set of criteria again to re-run the 
report.

■ Saved format (company custom export)—Identifies the custom fields or 
groups that you want to include in the report. Do one of the following:
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■ To use an existing format, select a format from the drop-down list. 
■ To create a new export format, click Create/Edit. The Company 

Custom Exports page opens. See “Creating General Settings for a 
Company Custom Export” on page 204.

■ To edit an existing format, click Create/Edit. The Company Custom 
Exports page opens. See “Editing a Company Custom Export” on 
page 208.

■ Make Report Public—Select the check box if you want the report to display 
on the Available Reports page as a public report that anyone can run.

4 Click Save.
The copied report is now a new report saved with the name you entered.

Deleting a Report
You can only delete a company report that you created. 
Note: You cannot delete public reports created by other users. Only the 
Community Administrator can delete reports created by other users.

To delete a report
1 Click Profiles > Companies > Reports tab.

The Available Reports page opens. 
2 In the Action drop-down list for the report you want to delete, select Delete.

A confirmation dialog opens and asks if you want to delete the report. 
3 Click Delete.

The report is deleted. 
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Scheduling a Report
You can schedule a company report to be emailed to yourself or other hub users on 
a regular basis. The report, which is an Excel file (.xls), is sent using email. The 
email includes a link so you can download the file. The link is available for seven 
days.
Note: All the data visible in the report is available to every recipient who receives 
the report in the email. 
Important: If you have “View Masked Fields” permission and you schedule a 
report, the recipients of the report can see the masked data in the report, even if 
they do not have “View Masked Fields” permission.
After scheduling a report, clock icons display by the report names on the Available 
Reports page.

■ One clock icon displays beside reports that are scheduled and active. That is, the 
start date has already occurred and reports are being emailed to you. 

■ A different clock icon displays besides reports that have not yet become active or 
are no longer active; for example:

■ A report that is scheduled for the future (start date has not yet occurred)
■ A report that was scheduled in the past (end date has already occurred)

Topics include:
■ “Scheduling a Report to be Emailed to Yourself or to Others” on page 185
■ “Stopping a Scheduled Report” on page 190

Scheduling a Report to be Emailed to Yourself or to Others
Security permissions: Public Report Permissions > Create Public Exports/Reports
You can schedule a company report to be emailed to yourself or to other hub users 
on a regular basis. The report, which is an Excel file (.xls), is sent using email. The 
email includes a link so you can download the file. The link is available for seven 
days.
Use this procedure to define the report recipients, report frequency, and the 
settings for the report schedule.

To schedule a report
1 Click Profiles > Companies > Reports tab.
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The Available Reports page opens. 

2 From the Action drop-down list for the report you want to schedule, select 
Schedule.
The Schedule page opens for that report.

3 Under Email To, select the option that indicates where to email the report:
■ Me—Email the report to yourself. If selected, go to step 6.
■ Me/Others—Email the report to yourself as well as other hub users. 

When you schedule this report the first time, selecting Me/Others displays 
the Notify section so you can select recipients of the email. If selected, go 
to step 4.
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When you want to change any of the recipients for a report that is already 
scheduled, click the Update Recipients link to display the Notify section. 
This link displays only after a report has been scheduled. Go to step 4.

4 Under the Notify section, from the Select Recipient drop-down list, select one of 
the following recipient types:

■ Business Role—Business Roles that are defined for the community.
■ Contacts—Contacts in the community.
■ Security Role—Security Roles that are defined for the community.
■ Tags—Tags that are defined in the community.

The list Select Roles to add Contacts in Recipients list populates with 
information based on your selection.
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5 Perform the appropriate action:

Note: When defining report recipients, you can also:
■ Use the Search box to search for a business or security role, contact, or 

tag. Select that role, contact, or tag from the list.

If you selected... Do this:
■ Business Role
■ Security Role
■ Tags

1 Select a role or tag from the list by selecting the radio button for the role or tag. 

A list displays the contacts associated with that role or tag. 
2 From the list, select the contacts you want to be recipients of the email by 

selecting the check box for the contact.
The recipients are added to the Selected Recipients section.

3 Repeat Steps 1 and 2 as necessary to select additional roles and contacts.
4 Go to step 6.

■ Contacts 1 Select the contacts that you want to be recipients of the email by selecting the 
check box for the contact.

The recipients are added to the Selected Recipients section.
2 Go to step 6.
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■ For Contacts, use the Select All check box to select all of the contacts. 
Clear the check boxes of any contacts that you do not want to include.

6 Under Frequency, select one of the following options for emailing the report. 
The report will be emailed at midnight Eastern Standard Time (EST) based on 
the frequency you select.

■ Daily—The report is emailed every day.
■ Weekly—The report is emailed weekly. When you select Weekly, a drop-

down list displays. Select the day of the week you want the report sent.

■ Monthly—The report is emailed monthly. When you select Monthly, two 
drop-down lists display. To create the combination for sending the report, 
select the week of the month (first, second, third, fourth, last) and the day 
of the month from the lists. 
For example. select Second and Tuesday to send the report on the 
second Tuesday of every month. 

7 To specify the start and end dates for the report, click in the respective Start 
Date and End Date boxes to display the calendar. Select the appropriate date 
from the calendar.

8 Click Save Report Schedule.
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The report is scheduled and you return to the Available Reports page.

Note the clock icons.
■ A clock icon displays beside reports that are scheduled and active (start 

date has already occurred and reports are being emailed). 
■ A different clock icon displays besides reports that have not yet become 

active or are no longer active:
■ A report that is scheduled for the future (start date has not yet 

occurred)
■ A report that was scheduled in the past (end date has already 

occurred).

Stopping a Scheduled Report
Security permissions: Public Report Permissions > Create Public Exports/Reports
You can remove the schedule settings for a company report so it is no longer 
emailed on a regular basis (see “Scheduling a Report to be Emailed to Yourself or 
to Others” on page 185).

To remove the schedule for a regular report
1 Click Profiles > Companies > Reports tab.

The Available Reports page opens. 
2 From the Action drop-down list for the report whose schedule you want to 

remove, select Schedule.
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The Schedule page opens for that report.

3 Click Remove Schedule.
The schedule for that report is removed, and you return to the Available 
Reports page. The clock icon (indicating the status of a scheduled report) no 
longer displays for the report.

Report Example - Scheduling a Report Based on a Saved 
Search

A customer tracks certificate expiration dates for their spokes using a date custom 
field. A hub user wants to create a report (using a saved search and export) that is 
emailed daily to selected recipients listing all of the spokes whose certificates are 
due 30 days from today.
The expected result for setting up this report is that the hub receives a dynamic 30 
day total which changes daily based on which spokes meet the saved search 
condition (for example, certificates expire 30 days from that day).
1 The hub creates a saved search. See “Creating a Saved Search” on page 103 

for more details.

2 The hub creates the report. See “Creating a Report” on page 178 for more 
details.

3 The hub schedules the report to be emailed to selected recipients on a daily 
basis. See “Scheduling a Report” on page 185 for more details.
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Summary Exports
A summary export (both company and contacts) summarizes data for selected 
custom field groups.
When configuring export settings for the export, you can choose up to five field 
groups to display. In the summary, each field is displayed as a percentage. 
Optionally, you can choose to include the count and total for the fields.
Topics include:
■ “Company Summary Exports” on page 192
■ “Contact Summary Exports” on page 196

Company Summary Exports
You must define the settings for a company summary export before you can run it. 
Topics include:
■ “Configuring Export Settings for a Company Summary Export” on page 192
■ “Running a Company Summary Export” on page 194
■ “Deleting a Company Summary Export” on page 196

Configuring Export Settings for a Company Summary Export
Summary exports allow you to view a summary of an export in an Excel file.
When configuring export settings for the report, you can choose up to five field 
groups to display. In the summary, each field is displayed as a percentage. 
Optionally, you can choose to include the count and total for the fields.
Important: To be able to view a company summary report in a pop-up window 
(see “Viewing a Summary Report” on page 182) or a company summary export in 
an Excel file (see “Running a Company Summary Export” on page 194), be sure to 
select the Add Summary Export check box as described in this procedure.

To configure settings for a company summary report
1 Click Profiles > Companies > Reports tab.

The Available Reports page opens.
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2 From the Action drop-down list for the report you want to configure settings, 
select Edit.
The Edit Report page opens.

3 Click Create/Edit.
The Company Custom Exports list page opens.

4 Perform the appropriate action:

The Company Custom Export page opens.

5 Click the Configure Export link.

If you want to... Do this:
Edit the export settings of an existing 
export

■ Click the export link.

Define new export parameters ■ Click New Export to define the parameters 
for a new export.
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The Configure Export page opens. The Summarize Fields section, which is at 
the bottom of the page, is shown.

Note: In the Export Options section, select the options that specify how you 
want the exported file to look.

6 In the Summarize Fields section, select the Add Summary Export check box.
Important: To be able to view a company summary report in a pop-up 
window (see “Viewing a Summary Report” on page 182) or a company 
summary export in an Excel file (see “Running a Company Summary Export” on 
page 194), the Add Summary Export check box must be selected.

a Optionally, choose the Show Count and Show Total check boxes if you 
want to include the count and/or total for the fields in the export.

b Under the Group by Field drop-down list, select the fields by which you 
want to group the information. You can click the + icon to add up to 5 
groups.

c Under the Summarize On drop-down list, select the fields you want to 
summarize, and select the Type of information you want to see. Click the + 
icon to add more fields.

7 Click Save. 
The configuration is saved.

8 Go to “Running a Company Summary Export” on page 194.

Running a Company Summary Export
Important: To be able to run a company summary export, be sure to select the 
Add Summary Export check box as described in “Configuring Export Settings for a 
Company Summary Export” on page 192. 

To run a company summary export
1 Click Profiles > Companies.
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The All Companies list page opens.

2 From the Actions drop-down list, select Summary Export.
3 Select the companies whose data you want to include in the export. 

■ Select All Search Results, then click OK.
■ To include specific companies, select the check boxes for the companies 

you want to include in the export, select Selected Rows, and click OK.
The Company Summary Exports list page opens. It lists saved exports you 
created (Private Exports and Public Export Created By Current User) and 
exports created by others (Public Exports Created by Other Users).

4 Click the name of the Contact Summary Export you want to run. For example, 
click summary by state.
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The page that opens shows the saved export settings.
5 Click Run.

The Run Summary Export dialog box opens. 
6 Change the filename, if needed, and then click Run.

Note: Default file name: Company_Summary_Export_MM_DD_YYYY where 
MM_DD_YYYY represents the month, day, and year the export is run.

7 A message indicates that the file will be emailed to you.

Deleting a Company Summary Export
Users who create a summary export, as well as Community Administrators, can 
delete a summary export.

To delete a company summary export
1 Click Profiles > Companies.

The All Companies list page opens.
2 From the Actions drop-down list, select Summary Export.
3 Click OK.

The Company Summary Exports list page opens. It lists saved exports you 
created (Private Exports and Public Export Created By Current User) and 
exports created by others (Public Exports Created by Other Users).

4 Click Delete for the summary export you want to delete.
A message asks you to confirm your selection. 

5 Click OK.
The summary export is deleted.

Contact Summary Exports
You must define the settings for a contact summary export before you can run it. 
Topics include:
■ “Configuring Export Settings for a Contact Summary Export” on page 197
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■ “Running a Contact Summary Export” on page 198
■ “Deleting a Contact Summary Export” on page 199

Configuring Export Settings for a Contact Summary Export
Summary exports allow you to view a summary of an export in an Excel file.
When configuring export settings for the export, you can choose up to five field 
groups to display. In the summary, each field is displayed as a percentage. 
Optionally, you can choose to include the count and total for the fields.
Important: To be able to view a contact summary export in an Excel file (see 
“Running a Contact Summary Export” on page 198), be sure to select the Add 
Summary Export check box as described in this procedure.

To configure settings for a contact summary export
1 Click Profiles > Contacts.

The Contacts list page opens.
2 From the Actions drop-down list, select Summary Export.
3 Select the contacts whose data you want to include in the export. 

■ Select All Search Results, then click OK.
■ To include specific contacts, select the check boxes for the contacts you 

want to include in the export, select Selected Rows, and click OK.
The Contact Summary Exports list page opens.

It lists saved exports you created (Private Exports and Public Exports Created 
By Current User) and exports created by others (Public Exports Created by 
Other Users).

4 Click New Export.
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The Contact Summary Export page opens.

5 In Name, type a name for the summary export.
6 In Public?, if you want the export to be:

■ Private, do not select the Public? check box.
■ Available to other users, select the Public? check box.

7 To select the fields by which you want to group the data, make selections from 
the Group by Field drop-down list. You can click the + icon to add up to 5 
groups.

8 To select how you want the contact information to be summarized, make a 
selection from the Summarize On drop-down list. If you select: 

■ Do Not Summarize—The contact summary information is not summarized.
■ Custom Fields—Add additional parameters to the export. Use the Type 

drop-down list and + icon to indicate additional parameters.
9 Click Save. 

The configuration is saved.
10 Go to “Running a Contact Summary Export” on page 198.

Running a Contact Summary Export

To run a contact summary export
1 Click Profiles > Contacts.

The Contacts list page opens.
2 From the Actions drop-down list, select Summary Export.
3 Select the contacts whose data you want to include in the export. 

■ Select All Search Results, then click OK.
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■ To include specific contacts, select the check boxes for the contacts you 
want to include in the export, select Selected Rows, and click OK.

The Contact Summary Exports list page opens.

4 Click the name of the Contact Summary Export you want to run. For example, 
click test11.
The page that opens shows the saved export settings.

5 Click Run.
The Run Summary Export dialog box opens. 

6 Change the filename, if needed, and then click Run.
Note: Default file name: Contact_Summary_Export_MM_DD_YYYY where 
MM_DD_YYYY represents the month, day, and year the export is run.

7 Open or save the file to your computer.

Deleting a Contact Summary Export
Users who create a summary export, as well as Community Administrators, can 
delete a summary export.

To delete a contact summary export
1 Click Profiles > Contacts.

The Contacts list page opens.
2 From the Actions drop-down list, select Summary Export.
3 Click OK.
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The Contact Summary Exports list page opens.

4 Click Delete for the export you want to delete.
A message asks you to confirm your selection. 

5 Click Delete.
The summary export is deleted.

Exports
There are two types of exports: basic and custom. The data is viewed in an Excel 
file. Both types of exports can contain information about companies or contacts.
■ Basic Exports—Let you export basic information about companies and contacts 

without defining any export settings. In the exported file:
■ The first row contains column headings that correspond to the fields that 

were exported; for example, Last Name, First Name, Company, Title. 
■ The second and subsequent rows list data values; for example, Brown, 

Sally, Acme, Sales Rep.
■ Custom Exports—Let you define the general criteria and custom fields to include 

in the export; you can also specify additional export options for the Excel file.
Topics include:
■ “Basic Exports” on page 201
■ “Company Custom Exports” on page 204
■ “Contact Custom Exports” on page 211
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Basic Exports
Basic Exports let you export basic information about companies and contacts to an 
Excel file without having to define any export settings. 
In the exported file:
■ The first row contains column headings that correspond to the fields that were 

exported; for example, Last Name, First Name, Communication Email. 
■ The second and subsequent rows list data values; for example, Jones, Bob 

bob.jones@example.com.

The parts of a file:
Key Description
1 Column headings
2 Data values

Important: All company and contact profile fields can be exported, including 
custom fields, even if there are no values in them. If the company or contact is 
tagged with a keyword, however, the tag name (keyword) will not be exported. In 
addition, you will not see custom fields in groups to which you do not have View 
Question Group permission. 

Exporting Companies or Contacts to an Excel File
Use this procedure to perform a basic export for companies or contacts.
Note: The Security Role column will only be exported to Community 
Administrators.

To export companies or contacts to an Excel file
1 Click Profiles > Companies or Contacts.

The Companies or Contacts list page opens.

2 Use search options to display the list of results you want to export. For details, 
see “Quick (Simple) Searches” on page 91 or “Advanced Searches” on page 93.

3 From the Actions drop-down list, select Basic Export.
4 Select the companies or contacts whose data you want to include in the export. 

■ Select All Search Results, then click OK.

2

1
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■ To include specific companies or contacts, select the check boxes for the 
companies or contacts you want to include in the export, select Selected 
Rows, and click OK.

A dialog box opens.

5 Click Save to customize the name of the file and select a destination on your 
hard disk.

6 Click Open to open the file as an Excel spreadsheet.

When the file opens, you will see all profile fields, including custom fields 
(regardless of whether they have values in them).
Note: You will not see custom fields in groups to which you do not have View 
Question Group permission. 
If the custom values are stored in data tables, you will be able to see the values 
in separate tabs, one per table (question group). Regular custom fields are in 
the main spreadsheet tab. For example, if you had a data table called Specialty 
and a regular custom field group called Role, the exported data might look like 
this:
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The parts of the file:
Key Description
1 Regular custom fields
2 Data table values



204 OpenText Active Community CE 21.2 User Guide

C O M P A N Y  A N D C O N T A CT  R E P O R T S
Exports

Company Custom Exports
Company custom exports let you define the general criteria and custom fields to 
include in the export; you can also specify additional export options for the Excel 
file.
Topics include:
■ “Creating General Settings for a Company Custom Export” on page 204
■ “Configuring the Format for a Company Custom Export” on page 206
■ “Running a Company Custom Export” on page 207
■ “Editing a Company Custom Export” on page 208
■ “Deleting a Company Custom Export” on page 210

Creating General Settings for a Company Custom Export 
Use this procedure to define the data you want to include in an Excel (.xls) file 
when exporting company information. 
Note: To define how the data will look in the Excel file, go to “Configuring the 
Format for a Company Custom Export” on page 206 after completing this 
procedure.

To create the general settings for a company custom export
1 Click Profiles > Companies.

The All Companies list page opens.

2 From the Actions drop-down list, select Custom Export.
3 Select the companies whose data you want to include in the export. 

■ To include all companies, select All Search Results, then click OK.
■ To include specific companies, select the check boxes for the companies 

you want to include in the export, select Selected Rows, and click OK.
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The Company Custom Exports list page opens. It lists saved exports you 
created (Private Exports and Public Exports Created by Current User) and 
exports created by others (Public Exports Created by Other Users).

4 To define the general settings for a new custom export, click New Export.
The Company Custom Export page opens. 

5 In Name, type the name of the custom export.
6 In Public?, if you want the export to be:

■ Private, do not select the Public? check box.
■ Available to other users, select the Public? check box.

7 Select the Export Identifiers check box if you want to export the identifiers, 
in addition to the labels, for the custom fields. For example:

Note: Exporting the identifiers provides the information that is needed to 
import the file back into Active Community. Applies only to Multiple Choice, 
Drop List, and Radio Button List custom fields. Only available to users with 
appropriate permissions.
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8 Select the Export Additional Comments check box if you want to export the 
“Additional Comments” associated with the custom field values. The export of 
additional comments for a custom field is only available if the “Add Comment 
Field” has been enabled for that field.

9 In the Select custom fields for groups to include in export check boxes, 
select the custom fields or groups for which you want to include data in the 
export. As you select a check box, additional fields display so you can include or 
exclude them from the custom export.
Note: The exported file maintains the labels and choices in the language 
selected.

10 Click Save.
The Company Custom Exports page refreshes and lists the new export.

11 Go to “Configuring the Format for a Company Custom Export.”

Configuring the Format for a Company Custom Export
Use this procedure to define the settings that control how exported company data 
will look in the Excel file. 

To configure the format for a company custom export
1 After “Creating General Settings for a Company Custom Export” on page 204, 

on the Company Custom Exports page, select the link for the custom export.
2 To define Excel format settings for the export, click Configure Export.

The Configure Export page opens. The top part of the page is shown.

3 Under Export Options, do the following:
a Select one of the radio buttons to indicate how you want to export multiple 

choice fields (Individual Columns or Comma separated values in 1 cell).
b To export custom field groups as separate worksheets, select that check 

box.
4 Under Summarize Fields, to be able to view a summary report in a pop-up 

window (see “Viewing a Summary Report” on page 182) or a summary export 
in an Excel file (see “Running a Company Summary Export” on page 194), 
select the Add Summary Export check box.

5 Click Save. 
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The custom export configuration is saved.

6 To return to the Company Custom Exports page, click the Custom Exports 
breadcrumb.

7 Perform the appropriate action:
a To save the export, click Save. You have completed the procedure.

The export settings are saved.
b To run the export, click Run.
c When the Run Custom Export page opens, click Run.

Note: Default file name: Company_Custom_Export_MM_DD_YYYY 
where MM_DD_YYYY represents the month, day, and year the export is 
run.

d Open or save the file to your computer.

Running a Company Custom Export
You can run a custom export you created previously (see “Creating General 
Settings for a Company Custom Export” on page 204 and “Configuring the Format 
for a Company Custom Export” on page 206). 
Note: If you have permission to view the data in a masked company custom field, 
the data displays. If you do not have permission to view the data, 10 asterisks 
display instead.

To run a company custom export
1 Click Profiles > Companies.

The All Companies list page opens.
2 From the Actions drop-down list, click Custom Export.
3 Select the companies whose data you want to include in the export. 

■ Select All Search Results, then click OK.
■ To include specific companies, select the check boxes for the companies 

you want to include in the export, select Selected Rows, and click OK.
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The Company Custom Exports list page opens.

4 Click the name of the Company Custom Export you want to run. For example, 
click sajjan export.
The page that opens shows the saved export settings.

5 Click Run.
The Run Summary dialog box opens. 

6 Change the filename, if needed, and then click Run.
7 Type a file name, and click Run.

Note: Default file name: Company_Custom_Export_MM_DD_YYYY where 
MM_DD_YYYY represents the month, day, and year the export is run.

8 Open or save the file to your computer.
Note: Large exports (processing times of more than 30-40 seconds) run in 
the background. The generated export file is sent to you as a download link in 
an email. The link is available for seven days. Smaller exports are downloaded 
instantly.

Editing a Company Custom Export
You can edit any custom export that you created. 
Note: You cannot edit a custom export created by other users, or a custom export 
that is being used by a saved report. If you own the saved report, you can edit the 
report that is using the export format, and change it to use a different format. 
Then you can delete the export format that was originally used.

To edit a company custom export
1 Click Profiles > Companies.
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The All Companies list page opens.

2 From the Actions drop-down list, select Custom Export.
3 Select All Search Results, then click OK.

The Company Custom Exports list page opens. It lists saved exports you 
created (Private Exports and Public Exports Created by Current User) and 
exports created by others (Public Exports Created by Others).

4 Click the name of the custom export you want to edit.
Note: You cannot edit a custom export created by other users, or a custom 
export that is being used by a saved report. If you own the saved report, you 
can edit the report that is using the export format, and change it to use a 
different format. Then you can delete the export format that was originally 
used.

5 Modify the export as described in “Creating General Settings for a Company 
Custom Export” on page 204.

6 Click Save to save your changes.



210 OpenText Active Community CE 21.2 User Guide

C O M P A N Y  A N D C O N T A CT  R E P O R T S
Exports

Deleting a Company Custom Export
Users who create a custom export, as well as Community Administrators, can 
delete the custom export. 
Note: The custom export cannot be deleted if it is being used by a saved report, 
or if it is being used in a report. If it is being used, a message lists the users who 
are using the Custom Export, so you can contact them to change the export to a 
different one. When no reports are using the Custom Export, you can delete it.

To delete a company custom export
1 Click Profiles > Companies.

The All Companies list page opens.

2 From the Actions drop-down list, select Custom Export.
3 Select All Search Results, then click OK.

The Company Custom Exports list page opens.

4 Click Delete for the export you want to delete.
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One of the following occurs:
■ A message asks you to confirm your selection. Click OK.
■ If the custom export is being used by a saved report, a message indicates 

the export cannot be deleted until you assign a different export to the 
report.

Contact Custom Exports
Contact custom exports let you define the general criteria and custom fields to 
include in the export; you can also specify additional export options for the Excel 
file.
Topics include:
■ “Creating General Settings for a Contact Custom Export” on page 211
■ “Configuring the Format for a Contact Custom Export” on page 213
■ “Running a Contact Custom Export” on page 215
■ “Editing a Contact Custom Export” on page 217
■ “Deleting a Contact Custom Export” on page 218

Creating General Settings for a Contact Custom Export 
Use this procedure to define the data you want to include in an Excel (.xls) file 
when exporting company information.
Note: To define how the data will look in the Excel file, go to “Configuring the 
Format for a Contact Custom Export” on page 213 after completing this procedure.

To create the general settings for a contact custom export
1 Click Profiles > Contacts.

The Contacts list page opens.
2 From the Actions drop-down list, select Custom Export.
3 Select the contacts whose data you want to include in the export. 

■ To include all contacts, select All Search Results, then click OK.
■ To include specific contacts, select the check boxes for the contacts you 

want to include in the export, select Selected Rows, and click OK.
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The Contact Custom Exports list page opens. It lists saved exports you created 
(Private Exports and Public Exports Created by Current User) and exports 
created by others (Public Exports Created by Other Users).

4 To define the general settings for a new custom export, click New Export.
The Contact Custom Export page opens.

5 Define the general settings for the export:
a In Name, type the name of the custom export.
b In Public?, if you want the export to be:

■ Private, do not select the Public? check box.
■ Available to other users, select the Public? check box.

c Select the Export Identifiers check box if you want to export the 
identifiers, in addition to the labels, for the custom fields. For example:

Note: Exporting the identifiers provides the information that is 
needed to import the file back into Active Community. Applies only to 
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Multiple Choice, Drop List, and Radio Button List custom fields. Only 
available to users with appropriate permissions.

d Select the Export Additional Comments check box if you want to export 
the “Additional Comments” associated with the custom field values. The 
export of additional comments for a custom field is only available if the 
“Add Comment Field” has been enabled for that field.

e Under Select custom fields for groups to include in export, select 
one or both of the following check boxes:

■ Contact—Select this check box to display additional contact custom 
fields or groups whose data you can include or exclude from the custom 
export.

■ Company—Select this check box to display additional company custom 
fields or groups whose data you can include or exclude from the custom 
export.

f In the additional check boxes that display under Contact or Company, 
select the custom fields or groups for which you want to include data in the 
export. As you select a check box, additional fields display so you can 
include or exclude them from the custom export.

g Click Save.
The Contact Custom Export page refreshes and lists the new export. 

6 Go to “Configuring the Format for a Contact Custom Export.”

Configuring the Format for a Contact Custom Export
Use this procedure to define the settings that control how exported contact data 
will look in the Excel file.

To configure the format for a contact custom export
1 After “Creating General Settings for a Contact Custom Export” on page 211, on 

the Contact Custom Exports page, select the link for the custom export.
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2 To define Excel format settings for the export, click Configure Export.
The Configure Export page opens. The top part of the page is shown.

3 Under Export Options, do the following:
a Select one of the radio buttons to indicate how you want to export multiple 

choice fields (Individual Columns or Comma separated values in 1 cell).
b To export custom field groups as separate worksheets, select that check 

box.
4 Under Summarize Fields, to be able to view a summary export in an Excel file 

(see “Running a Contact Summary Export” on page 198, select the Add 
Summary Export check box.

5 Click Save. 
The custom export configuration is saved.

6 To return to the Contact Custom Exports page, click the Custom Exports 
breadcrumb.

7 Perform the appropriate action:
a To save the export, click Save. You have completed the procedure.

The export settings are saved.
b To run the export, click Run.
c When the Run Custom Export page opens, click Run.

Note: Default file name: Contact_Custom_Export_MM_DD_YYYY 
where MM_DD_YYYY represents the month, day, and year the export is 
run.

d Open or save the file to your computer.
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Running a Contact Custom Export
You can run a custom export you created previously (see “Creating General 
Settings for a Contact Custom Export” on page 211 and “Configuring the Format 
for a Contact Custom Export” on page 213). 

To run a contact custom export
1 Click Profiles > Contacts.

The Contacts list page opens.

2 From the Actions drop-down list, select Custom Export.
3 Select the contacts whose data you want to include in the export. 

■ To include all contacts, select All Search Results, then click OK.
■ To include specific contacts, select the check boxes for the contacts you 

want to include in the export, select Selected Rows, and click OK.
The Contact Custom Exports page opens.

4 Click the name of the Contact Custom Export you want to run. For example, 
click test1.
The page that opens shows the saved export settings for the export.
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5 Click Run.
The Run Custom Export dialog box opens. 

6 Change the filename, if needed, and then click Run.
Note: Default file name: Contact_Custom_Export_MM_DD_YYYY where 
MM_DD_YYYY represents the month, day, and year the export is run.

7 Open or save the file to your computer.
Note: Large exports (processing times of more than 30-40 seconds) run in 
the background, and the generated export file is sent to you as a download link 
in an email. The link is available for seven days. Smaller exports are 
downloaded instantly.
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Editing a Contact Custom Export
You can edit any custom export that you created. 
Note: You cannot edit a custom export created by other users.

To edit a contact custom export
1 Click Profiles > Contacts.

The Contacts list page opens.

2 From the Actions drop-down list, select Custom Export.
3 Select All Search Results, then click OK.

The Contact Custom Exports list page opens. It lists saved exports you created 
(Private Exports and Public Exports Created by Current User) and exports 
created by others (Public Exports Created by Others).

4 Click the name of the custom export you want to edit.
Note: You cannot edit a custom export created by other users.

5 Modify the export as described in “Creating General Settings for a Contact 
Custom Export” on page 211.

6 Click Save to save your changes.
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Deleting a Contact Custom Export
Users who create a custom export, as well as Community Administrators, can 
delete the custom export. 

To delete a contact custom export
1 Click Profiles > Contacts.

The Contacts list page opens.
2 From the Actions drop-down list, select Custom Export.
3 Select All Search Results, then click OK.

The Contact Custom Exports list page opens.

4 Click Delete for the export you want to delete.
A message asks you to confirm your selection. 

5 Click OK.
The export is deleted.

Accessing Impersonation Logs
Security role: Community Administrator
Security permission: Community Permissions > Manage Community
Hub community administrators can access logs that identify those OpenText 
administrators who used the impersonation tool to act on behalf of their hub. This 
information may be necessary if an audit is conducted.

To identify users of the impersonation tool
1 Click Admin > Access Logs tab.
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The Access Logs page opens.

The access log columns display the following information:
■ Impersonation Admin - The administrator who was acting on behalf of the 

hub
■ User ID - The user on whose behalf the impersonation was done
■ Start Time - The impersonation session start time 
■ End Time - The impersonation session end time
■ Duration - The duration of the session
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Custom Fields 7
Custom fields are located on your partner's company or contact profile. They are 
input fields that allow the hub to collect and keep important information about 
partners, customers, sales representatives, or other contacts in your community. 
Custom fields supplement the basic information contained in core fields.
Users respond to the hub’s custom field questions when updating a company or 
contact profile. They can be reminded to update all or part of the profile based on 
freshness settings. Freshness settings define the interval of time after which Active 
Community sends profile update reminder emails.
Custom fields consist of custom field groups, custom field questions, and custom 
field choices. After defining custom fields, you can specify which roles can view or 
edit custom field groups, including questions in the group.
Community administrators can export a custom fields configuration to send to 
OpenText support to assist in debugging and resolving issues faced by customers, 
and an exported configuration can also be used by OpenText administrators for 
internal use.
Topics include:
■ “Custom Field Overview” on page 221
■ “Adding Custom Field Groups” on page 240
■ “Adding Custom Field Questions to Groups” on page 243
■ “Adding Choices to Custom Field Questions by Format” on page 248
■ “Working with Custom Fields” on page 258
■ “Ensuring Contacts Respond to Custom Field Questions” on page 271
■ “Exporting a Custom Fields Configuration” on page 272

Custom Field Overview
Custom fields can cover a number of topics, such as sales, pricing, compliance, 
quality, and others. 
Custom fields consist of custom field groups, custom field questions, and custom 
field choices. Custom fields can be designed to:
■ Indicate whether your suppliers are compliant with an industry standard
■ Allow users to upload a certificate file
■ Gather company information, such as average sales volume or inventory capacity
The following examples outline how custom fields might be used. 
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The graphic lists two custom field groups, Company Information and Company 
Ownership. Each group contains questions and question choices. 

1

4

2

5

3

6

Understanding the graphic:
Key Description
1 Custom field group 1
2 Custom field questions for field group 1
3 Custom field choices for field group 1
4 Custom field group 2
5 Custom field questions for field group 2
6 Custom field choices for field group 2

The table provides the same information in a different way.
Custom Field Groups Custom Field Questions Custom Field Choices

List of countries

Number field
Text fields for names
Number fields for numbers

■ Company Information ■ What is your industry? ■ Manufacturing
■ Processing
■ Distribution

■ In which countries do you 
operate?

■ How many employees?
■ Company Ownership ■ Who owns your company?

■ Percentage ownership?



C U S T O M  F I E L D S
Custom Field Overview

OpenText Active Community CE 21.2 User Guide  223

7  

Contacts answer the questions when updating a company or contact profile.
Topics include:
■ “Custom Field Planning” on page 223
■ “Custom Field Groups” on page 224
■ “Custom Field Question Formats” on page 226
■ “Dependent Custom Field Questions” on page 231
■ “Masked Fields” on page 232
■ “Custom Field Groups as Data Tables” on page 233
■ “Custom Field Options” on page 235
■ “Choices and Values” on page 237
■ “Help Icon Text” on page 237
■ “Instruction Text” on page 237
■ “Language Options for Custom Field Groups, Questions, and Choices” on 

page 238
■ “How Do I?” on page 238

Custom Field Planning
Because custom field groups, questions, and choices let you request important 
information about companies and contacts in your community, careful planning is 
required. 

Prerequisites
■ Consider the types of information you want to gather from your community.
■ Design custom field groups, questions, and choices after reviewing the 

information in this section. 
■ Create custom field groups first, then questions within the group, and then 

choices for each question. 
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The graphic outlines the custom field setup process.

Custom Field Groups
Custom field questions and choices are contained in custom field groups. Each 
group is displayed as a tab in a company or contact profile. When a tab is selected, 
the questions and choices display. 
For example, a custom field group named Company Information might include 
custom field questions named Specialty or Annual Sales.
Topics include:
■ “Sample Custom Field Group During Creation” on page 225
■ “Sample Custom Field Group in a Profile” on page 225
■ “Sample Custom Field Group with Saved Responses” on page 226
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Sample Custom Field Group During Creation
This first graphic shows a custom field group, Company Information, while it is 
being created.

1

2

The parts of a field group:
Key Description
1 Custom field group name
2 Custom field questions and custom field choices

The name of the custom field group displays as a tab. When the tab is selected, 
the questions for the custom field group display. The questions can be modified 
using the various options on the page.

Sample Custom Field Group in a Profile
The next graphic shows how the Company Information custom field group and its 
questions display when contacts edit their company profiles.

2

1
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The custom field groups and their questions:
Key Description
1 Group tabs are in the first column. You can select a custom field group tab, then 

answer custom field questions associated with that tab.
2 Contacts answer custom field questions in contact or company profiles.

Similarly, the name of the custom field group displays as a tab. When the tab is 
selected, the custom field questions display. Contacts edit their profiles to answer 
the questions. 

Sample Custom Field Group with Saved Responses
After a contact saves their answers, they are stored in their company or contact 
profiles.

Custom Field Question Formats
Custom field questions can be defined in a variety of formats, including text boxes, 
multiple choice questions with check boxes, or the ability to upload a file to Active 
Community. A question’s format determines how a custom field displays in a 
company or contact profile. 
The following topics describe each custom field format. Each topic includes an 
example of the custom field as users will see it.

Note: Any custom field format can also include “Instruction Text,” that provides 
context (or instruction) for the question.

■ “Drop List” ■ “File Download”
■ “Multiple Choice” ■ “Display Image”
■ “Radio Button List” ■ “File Upload”
■ “True/False” ■ “Company Link”
■ “Yes/No” ■ “Specialized”
■ “Text” ■ “Number Formula”
■ “Number” ■ “Text Formula”
■ “Date” ■ “Date Formula”
■ “Text Area” ■ “True/False Formula”
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Drop List
Use the Drop List format to create a custom field that is a drop-down list with 
multiple options. Users can select one answer from the list.

A Drop List format can specify a value as a default answer. In addition, values for 
Drop List formats can be imported into Active Community.
For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

Multiple Choice
Use the Multiple Choice format to create a custom field with one or more check 
boxes that users can select to answer a question. Users can select more than one 
check box.

A Multiple Choice format can specify a value as a default answer. In addition, 
values for Multiple Choice questions can be imported into Active Community.
For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

Radio Button List
Use the Radio Button List list format to create a custom field with a list of one or 
more answers with radio buttons. Users can select only one answer from the list.

A Radio Button List format can specify a value as a default answer. In addition, 
values for Radio Button List custom fields can be imported into Active Community.
For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.
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True/False
Use the True/False format for custom fields if you want to use a pair of radio 
buttons with True or False as the answer to the question. Users can select either 
True or False.

For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

Yes/No
Use the Yes/No format if you want the custom field to use a pair of radio buttons 
with Yes and No as the answer to the question. Users can select either Yes or No.

For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

Text
Use the Text format if you want to use a text box with a single line of text (up to 
256 characters). Users type answers to the question in the text box. 

Note: Any custom field format can also include “Instruction Text,” that provides 
context (or instruction) for the question. In this example, the instructional text is 
“Please engage with your Group procurement Buyer before proceeding.”
You can use a Text custom field to automatically populate the Company ID as long 
as Enable Masking, Set Default Answer, and Make Dependent on Another Question 
options are not enabled. See “Defining Core Fields in Registration Requests” on 
page 431.
For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

Number
Use the Number format if you want the custom field to use a box that contains a 
single line of numbers. Users can enter numbers into the box. If characters are 
entered, they will not display in the response.
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You can use a Number custom field (for example, a DUNS number) to 
automatically populate the Company ID as long as Enable Masking, Set Default 
Answer, and Make Dependent on Another Question options are not enabled. See 
“Defining Core Fields in Registration Requests” on page 431.
For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

Date
Use the Date format to specify a calendar date in MM/DD/YYYY format.

For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

Text Area
Use the Text Area format if you want the custom field to use a text box that can 
contain multiple lines of text. The Text Area format supports pressing Enter to 
create new paragraphs.

For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

File Download
Use the File Download format to create custom fields that allow hub contacts to 
upload files from their computer or network server to spoke company profiles. 
Each spoke company sees the same file, such as terms and conditions, policies, or 
newsletters. 
File Download custom field questions are populated when configuring a custom 
field. The maximum file size is 50 MB. 

For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.
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Display Image
Use the Display Image format to create a custom field that allows contacts to 
upload and show an image file, such as a logo or product image, in a custom field. 
The file must be in GIF, JPG, or PNG format. The maximum file size is 50 MB.

Note: The image can be a maximum of 450 pixels wide by 250 pixels high. If the 
image is larger, it will be resized and scaled down to 450 x 250, which might cause 
some distortion of the image.
For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

File Upload
Use the File Upload format to create a custom field that allows hub contacts to 
upload multiple files from their computer or network server to spoke company 
profiles. Each spoke company sees different files, such as scorecards, price lists, or 
signed contracts. 
Files can be in any format. The maximum file size is 50 MB. 

For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

Company Link
Use the Company Link format to create a custom field with a company hyperlink. 
The link can be used to navigate to more detailed data within Active Community.

For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

Specialized
Use the Specialized format to collect specific types of data. Currently, there are two 
specialized format configuration options: 
■ Email - Selecting the Email option allows hubs to collect an email address and 

verify that it is correctly formatted according to industry standards. The actual 
value is not verified.

■ Tax ID (EIN) - The Tax ID (EIN) option is only available for company profiles. 
Selecting this option allows hubs to collect a federal tax ID and verify that it is 
correctly formatted as an EIN (Employer Identification Number). The system 
automatically adds the hyphen when you enter the value. The actual value is not 
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verified unless your community enables the Tax ID Verification option. Only one 
tax ID custom field can be enabled for verification at a time.
Note: To take advantage of the Tax ID Verification option, it must be enabled 
for your community. Contact Support for assistance. 

For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

Number Formula
Use the Number Formula format to create a custom field that adds or subtracts the 
values in Number fields and place the result into one field (see “Adding Formula 
Custom Field Questions” on page 253).
For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

Text Formula
Use the Text Formula format to create a custom field that combines the values in 
multiple Text custom fields into one field (see “Adding Formula Custom Field 
Questions” on page 253). 
For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

Date Formula
Use the Date Formula format to create a custom field that adds or subtracts a 
specified number of days to or from a date (see “Adding Formula Custom Field 
Questions” on page 253). 
For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

True/False Formula
Use the True/False Formula format to create a custom field that uses a true or false 
answer to one question to populate a value in a different question (see “Adding 
Formula Custom Field Questions” on page 253).
For procedural information, see “Adding Choices to Custom Field Questions by 
Format” on page 248.

Dependent Custom Field Questions
You can hide or display an entire custom field group based on the answer to 
another custom field question. For procedural information, see “Creating 
Dependent Questions” on page 259.

Example
For example, suppose you have a custom field group that includes a Yes/No 
question to indicate whether a business partner agrees with your Terms and 
Conditions. 
If the answer is:
■ Yes, you want Active Community to display Financial Information custom field 

group as a tab in a partner’s profile. 
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■ No or blank, you do not want Active Community to display the Financial 
Information custom field group as a tab in a partner’s profile. 

How to Do It
Follow this process for making the Financial Information custom field group 
depend on the Yes/No answer for Terms and Conditions. When defining the 
Financial Information group:
■ Select the “Make dependent on another question (optional)” check box.
■ In Question Name, select Terms and Conditions from the drop-down list.
■ In Answer, select Yes. Active Community will display the Financial Information 

group in the profile only if the answer to Terms and Conditions is Yes.

Masked Fields
Data masking can be enabled for Text and Number company custom fields so that 
sensitive data, such as banking information, is hidden from those who do not have 
permission to view it.
When you view a company profile and data masking is enabled, an icon displays by 
the field to identify it. If you have permission to view the data in the masked field, 
the data displays. If you do not have permission to view the data, 10 asterisks 
display. 
Note: You are always able to see your own company’s data for masked custom 
fields provided that you have “View My Company” permission; however, data is 
masked for other companies unless you have “View Masked Fields” permission. 
See “Roles and Permissions” on page 49.
Important: If you have “Edit Company” permission but not “View Masked Fields” 
permission, you can edit data that displays as asterisks. You will see the data as 
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you type new information, but as soon as soon you save it, the data again displays 
as asterisks.

Set a Custom Field as the Company ID
For Registration only, a custom field can be used automatically as the Company ID 
so that a relevant value, such as a DUNS number, can identify the company.
The following guidelines apply:
■ Only Number, Text and Specialized (Tax ID) custom fields can be used for the 

Company ID.
■ The Enable Masking, Set Default Answer, and Make Dependent on Another 

Question options cannot be enabled for the custom field.
■ On the company Registration Core Fields page (Registration > Admin tab > 

Core Field Settings > Admin tab > Company in Registration), select the 
custom field you want to use as the Company ID.

When a Registration request is approved, the Company ID is automatically 
populated based on the custom field you designated.
For procedural information, see “Adding Custom Field Questions to Groups” on 
page 243.

Custom Field Groups as Data Tables
To allow contacts to provide more than one answer to a question, most custom 
field questions can be displayed as headings in a table. Each column heading in the 
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table is a custom field question. The questions in each column heading can be in 
different formats, such as a Text format or Number format.

Data tables can be created for these custom field formats: Drop List, Multiple 
Choice, True/False, Yes/No, Text, Number, Date, Text Area, File Upload, Company 
Link, and Specialized. 
Note: Tabular fields and tabular field groups are not supported in the change 
management (CM) process.
For procedural information, see “Creating Questions in Data Tables” on page 262.

Example
For example, suppose you want to ask three questions: “Who owns your 
company?,” “Is the owner a U. S. Citizen,” and “What is their percentage 
ownership.” Your contacts might have more than one answer to each of the 
questions. 

How to Do It
When defining a custom field group, select the “Display this Group as a table” 
check box. 

When adding custom field questions to the group, create one custom field question 
for each column you want to display in the table. Select the format that is 
appropriate for the column. In the example, the first two columns were defined 
using the Text format. The last column was defined using the Number format.
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Custom Field Options
When defining custom fields, a series of options are available.
Important: Not all options are available for all formats. Based on your selection, 
additional fields might display. The additional fields let you refine the question 
further.

Option Description
Require Answer to Custom Field (Optional) Make the question mandatory.

Selecting this option displays another option, “Mandatory based 
on.”
Note: The “Mandatory based on” option is only applicable to 
multiple answer custom fields.

Selecting the “Mandatory based on” check box displays additional 
fields and allows you to make a custom field mandatory based on 
the answer to a different custom field.

To make a custom field mandatory based on the value of 
another custom field: 

1 Select the Require Answer to Custom Field (Optional) 
check box.

2 Select the Mandatory based on check box. 
3 From the Question Name drop-down list, select the custom 

field that the custom field question is based on. In this 
example, Drop List is selected.

4 From the Answer drop-down list, select the value that the 
custom field question is based on. In this example the value 
222 is selected.

In this example, if the answer to the Drop List question is 222, the 
original question becomes mandatory and requires an answer. All 
other answers keep the original custom field optional.

Use First Value as the Default Answer (Optional) Specify the first value (Position 1) as the default value for the 
answer for questions that have more than one choice, such as 
Drop List, Multiple Choice, and Radio Button List.

Add Comment Field (Optional) Allow the contact to add text comments (up to 256 characters) 
when answering the question.
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Add Validation Rule (Optional) Specify a condition such as: 
■ “On or before today” or “On or after today” for a Date 

question
■ “Min Number” and “Max Number” for a Number question
■ “Only Allow Numeric Values” for a Text question
■ “Min Length” and “Max Length” for a Text question

If the same number is entered in both the Min Length and 
Max Length fields, the Append Leading Zeroes field displays.
Select this if you want zeroes to be appended in front of the 
entered data. 
For example, if the value in the min/max length is 8 and a 
question is answered as 123456, Active Community adds two 
zeroes in front of the answer so the total number of 
characters equals the min/max length (in this example, 
00123456). 
The Append Leading Zeroes field can be used with or without 
the Only Allow Numeric Values field; that is, you can append 
zeroes to both numeric and alphanumeric values.

Make Dependent on Another Question (Optional) Make a question conditional based on the answer to another 
question. The other question must have already been defined (see 
“Dependent Custom Field Questions” on page 231 and “Creating 
Dependent Questions” on page 259).

Set Default Answer (Optional) Specify a default value for the answer, as follows. 
Note: Fields with default values cannot be masked.

■ True/False—Select True or False as the default answer
■ Yes/No—Select Yes or No as the default answer
■ Text—Type the default answer
■ Number—Type the default answer
■ Dates—Select “Set Current Date” or “Select Date” and select 

the date from the calendar as the default answer
■ Text Area—Type the default answer (255 character limit)

Enable Multiple Values (Optional) Allow more than one value to be added where values are 
separated by a comma.

Option Description
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For procedural information, see “Adding Custom Field Questions to Groups” on 
page 243.

Choices and Values
Values are contacts' responses to custom field questions. For example, when 
contacts edit their profiles, they might find a question titled: “What is your 
industry?” The question includes three choices: Distribution, Manufacturing, or 
Processing. If a contact selects Manufacturing, the value for that question is 
Manufacturing for that contact. 
In another example, a question titled “Are you a U.S. citizen?” has two choices: Yes 
or No. If a contact selects No, the value for the “Are you a U.S. citizen?” question is 
No for that contact.

Help Icon Text
When defining a custom field question, use the Instruction field to add help text for 
a question. The text displays when the contact clicks the help icon for the question.

For procedural information, see “Creating Help Icon Text” on page 267.

Instruction Text
Use the Insert Text Here or Add Text links to enter text in the body of a question. 
The text can be used for instructions, descriptions, titles, or general information.

For procedural information, see “Adding Instruction Text” on page 267.

Enable Masking (Optional) Select to hide company data, such as banking information, from 
those who do not have permission to view it. Masked fields cannot 
have default values.
Note: Only available for Text and Number company custom fields.
You are always able to see your own company’s data for custom 
fields provided that you have “View My Company” permission. 
Data is masked for custom field data for other companies unless 
you have “View Masked Fields” permission.
See “Working with Security Roles” on page 55 for information on 
permissions.
See “Using Auto-Fill” on page 10 to understand how the data is 
displayed in a company profile.

Enable Tax ID Verification (Optional) Provides the ability to verify a tax ID after it is entered. Only one 
tax ID custom field can be enabled for verification at a time. If a 
different tax ID field has already been enabled, the check box is 
unavailable. 
Note: To take advantage of the Tax ID Verification option, it must 
be enabled for your community. Contact Support for assistance.

Option Description
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Language Options for Custom Field Groups, Questions, and 
Choices

You can configure custom field groups, questions, and choices in different 
(supported) languages. After you create a custom field in one language, you can 
configure it in a second (or more) language(s). Then, for example, when a user 
accesses Active Community in English, they see the custom field in English, and 
when they access Active Community in Spanish (or change the language to 
Spanish), they see the custom field in Spanish. 
For procedural information on configuring a custom field in a different language, 
see “Configuring a Custom Field Group, Question, or Choice in a Different 
Language” on page 271.
To change the display language for Active Community, see “Changing Your 
Language” on page 11). 

How Do I?
To better understand your options when designing custom field groups, questions, 
and choices, you need to select various options. The table lists a few options to 
consider. You will choose from among these options when creating custom fields.

If you want to... Choose (or use) the following options: When you are:
Add Custom Fields
Add a custom field group ■ Profiles > Companies > Settings tab > 

Custom Field
■ Profiles > Contacts > Custom Fields tab

■ “Adding Custom Field Groups” on 
page 240

Add a custom field question ■ “Adding Custom Field Questions 
to Groups” on page 243

Add choices to a question ■ “Adding Choices to Custom Field 
Questions by Format” on 
page 248
or 

■ “Importing Custom Field Values 
Using a CSV File” on page 257

Add formula questions ■ “Adding Formula Custom Field 
Questions” on page 253

Work with Custom Fields
Search for questions ■ In Search Group, start typing the name 

of the question
■ “Finding Custom Field Groups” on 

page 259
Add dependent questions ■ Select “Make Dependent on Another 

Question” check box when adding a 
group

■ “Creating Dependent Questions” 
on page 259

Add questions as column 
headings in a table

■ Select “Display as columns in a table” 
when adding a group

■ “Creating Questions in Data 
Tables” on page 262

Re-sequence custom field tabs ■ Select a group tab, then click Move Up 
or Move Down

■ “Re-Sequencing Custom Field 
Group Tabs” on page 264

Re-sequence custom field 
questions

■ Select the appropriate custom field 
question in a group, then drag and 
drop the question to a different position 
in the group

■ “Re-Sequencing Custom Field 
Questions” on page 265
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Add instruction text to a custom 
field question

■ Click Insert Text Here when defining 
a question

■ “Adding Instruction Text” on 
page 267

Add a help icon to a custom field 
question

■ Use the Instruction field when defining 
a question

■ “Creating Help Icon Text” on 
page 267

Copy a custom field question ■ Select a group tab, click Edit Group, 
find the question, click Copy.

■ “Copying a Custom Field 
Question” on page 268

Delete a custom field group ■ Select a group tab, click Edit Group, 
click Delete.

■ “Deleting a Custom Field Group” 
on page 269

Delete a custom field question ■ Select a group tab, click Edit Group, 
find the question, click Delete.

■ “Deleting a Custom Field 
Question” on page 270

Configure a custom field group, 
question, or choice in a different 
language

■ Add a custom field group, question, or 
choice in a default language, select a 
different language, modify the label for 
the same custom field group, question, 
or choice in the second language.

■ “Configuring a Custom Field 
Group, Question, or Choice in a 
Different Language” on page 271

Define Permissions and Reminder Email Settings
Add permissions for custom field 
groups and questions

■ Select a group tab, click Set 
Permissions

■ “Assigning Custom Field 
Permissions to Security Roles” on 
page 267“

Add time intervals for reminder 
emails for custom fields

■ Select a group tab, click Set 
Freshness

■ “Defining Freshness Settings for 
Custom Fields” on page 266

Import Values to Custom Field Groups
Import custom field values ■ Profiles > Companies > Settings tab > 

Custom Field > Edit Group
■ Profiles > Contacts > Custom Fields tab 

> Edit Group

■ “Importing Custom Field Values 
Using a CSV File” on page 257

Add Values to Custom Field Questions
Encourage contacts to respond to 
custom field questions

Multiple options are available. ■ “Ensuring Contacts Respond to 
Custom Field Questions” on 
page 271

Collect Specific Types of Data
Collect an email address and 
verify that it is correctly formatted 
according to industry standards.

■ Profiles > Companies > Settings tab > 
Custom Field > Insert Custom Field > 
Specialized > Email

■ Profiles > Contacts > Custom Fields tab 
> Insert Custom Field > Specialized > 
Email

■ Using the “Specialized” custom 
field question format.

■ “Adding Custom Field Questions 
to Groups” on page 243

Collect a federal tax ID and verify 
that it is correctly formatted as an 
EIN (Employer Identification 
Number).

■ Profiles > Companies > Settings tab > 
Custom Field > Insert Custom Field > 
Specialized > Tax ID (EIN)

■ Using the “Specialized” custom 
field question format.

■ “Adding Custom Field Questions 
to Groups” on page 243

Set a Custom Field as the Company ID
Set a custom field as the 
Company ID

Follow the guidelines. ■ “Set a Custom Field as the 
Company ID” on page 233

■ “Adding Custom Field Questions 
to Groups” on page 243

If you want to... Choose (or use) the following options: When you are:
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Adding Custom Field Groups
Security role: Community Administrator
Security permissions required: Custom Field Permissions > Manage Custom Fields
The first phase of the custom field setup process is to add a custom field group and 
give it a name. 

Use this procedure to add groups of custom fields to help you categorize 
information stored in company and contact profiles (see “Custom Field Overview” 
on page 221).
Note: If your company uses the optional Registration module, any custom fields 
you create can be displayed during the company registration process. 

Export Custom Field Configurations for a Hub
Export custom field configurations 
for a hub

Follow the guidelines. ■ “Exporting a Custom Fields 
Configuration” on page 272

If you want to... Choose (or use) the following options: When you are:
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To add a custom field group
1 Perform the appropriate action:

The Company Custom Fields or (Contact) Custom Fields page opens. It shows 
any custom field groups that have been defined as tabs. When a tab is 
selected, custom field questions that have been defined for the group display.

2 Click Add Custom Field Group. 
The New Custom Field Group section opens. You will replace the “New Custom 
Field Group” name in step 4. 

3 Click Edit Group.

To add a custom field group 
for... Do this:
Companies 1 Click Profiles > Companies. 

2 Click the Settings tab.
The Company Profile Settings page opens. 

3 Click Custom Field. 
Contacts 1 Click Profiles > Contacts. 

2 Click the Custom Fields tab.
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The Editing Custom Field Group section opens. 

4 In Name, type over “New Custom Field Group” and give the group a name, 
such as “Licensing” or “Company Ownership.”

5 In Description, type a general description of the custom group, such as the 
nature of the questions it contains.

6 Select the appropriate check boxes at the bottom of the page to perform the 
actions described in the following table:

7 Click Done. 
You have created a custom field group. At the top of the page, the name of the 
group refreshes with the name you typed in step 4.

8 Go to step 2 in “Adding Custom Field Questions to Groups” on page 243.

If you want questions in the 
group to... Do this:
Display as columns in a table ■ Select the “Display this group as a table” check 

box (see “Creating Questions in Data Tables” 
on page 262).
Note: Tabular fields and tabular field groups 
are not supported in the change management 
(CM) process.

Be conditional based on the 
answer to another custom field 
question

■ Select the “Make dependent on another 
question (optional)” check box (see “Creating 
Dependent Questions” on page 259).
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Adding Custom Field Questions to Groups
Security role: Community Administrator
Security permissions required: Custom Field Permissions > Manage Custom Fields
Before you begin, be sure the custom field group to which you want to add 
questions has been created (see “Adding Custom Field Groups” on page 240).
Use this procedure to perform the next phase of the custom field setup process, 
which is to add custom field questions to a custom field group. As part of this 
procedure, you will select a format, enter any instructions, and select the options 
you want to apply to the question. 

To add questions to a custom field group
1 Perform the appropriate action:

To add a question to a custom 
field group for... Do this:
Companies 1 Click Profiles > Companies. 

2 Click the Settings tab.
The Company Profile Settings page opens. 

3 Click Custom Fields. 
Contacts 1 Click Profiles > Contacts. 

2 Click the Custom Fields tab.
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The Company Custom Fields or (Contact) Custom Fields page opens. Any 
custom field groups that have been defined, display as tabs in the first column.

2 Select the tab for the custom field group to which you want to add a question.
3 Click Insert Custom Field Here. 

The Editing New Question section opens at the selected location in the custom 
field group.

4 In Choose the type of Question, use the drop-down list to select the type of 
question you want to create, such as True/False or File Upload or Multiple 
Choice. For a description of all formats, see “Custom Field Question Formats” 
on page 226.
Note: If you choose Specialized from the drop-down list, a second drop-down 
list displays the available options.

5 Click Next.
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6 In Question, type the question text, such as “What is your buying area?” to 
replace the “New Question” text that displays automatically.
Note: If needed, use the formatting icons to emphasize any text in the 
question, such as making a word bold or changing the font.

7 In Instructions, type the help text for a question. The text displays when 
contacts click the help icon for the question.
Note: When a Tax ID (EIN) question is defined, text is automatically added 
indicating that a 9-digit value should be entered without the dash. You can add 
help text to include additional information.
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8 Select the check boxes for any options you want to apply to the question. 
Important: Not all options are available for all formats. Based on your 
selection, additional fields might display. The additional fields let you refine the 
question further.

Option Description
Require Answer to Custom Field (Optional) Make the question mandatory.

Selecting this option displays another option, “Mandatory based 
on.”
Note: The “Mandatory based on” option is only applicable to 
multiple answer custom fields.

Selecting the “Mandatory based on” check box displays additional 
fields and allows you to make a custom field based mandatory 
based on the answer to a different custom field.

To make a custom field mandatory based on the value of 
another custom field: 

1 Select the Require Answer to Custom Field (Optional) 
check box.

2 Select the Mandatory based on check box. 
3 From the Question Name drop-down list, select the custom 

field that the custom field question is based on. In this 
example, Drop List is selected.

4 From the Answer drop-down list, select the value that the 
custom field question is based on. In this example the value 
222 is selected.

In this example, if the answer to the Drop List question is 222, the 
original question becomes mandatory and requires an answer. All 
other answers keep the original custom field optional.

Use First Value as the Default Answer (Optional) Specify the first value (Position 1) as the default value for the 
answer for questions that have more than one choice, such as 
Drop List, Multiple Choice, and Radio Button List.

Add Comment Field (Optional) Allow the contact to add text comments (up to 256 characters) 
when answering the question. 
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Add Validation Rule (Optional) Specify a condition such as: 
■ “On or before today” or “On or after today” for a Date 

question
■ “Min Number” and “Max Number” for a Number question
■ “Only Allow Numeric Values” for a Text question
■ “Min Length” and “Max Length” for a Text question

If the same number is entered in both the Min Length and 
Max Length fields, the Append Leading Zeroes field displays.
Select this if you want zeroes to be appended in front of the 
entered data. 
For example, if the value in the min/max length is 8 and a 
question is answered as 123456, Active Community adds two 
zeroes in front of the answer so the total number of 
characters equals the min/max length (in this example, 
00123456). 
The Append Leading Zeroes check box can be used with or 
without the Only Allow Numeric Values check box; that is, you 
can append zeroes to both numeric and alphanumeric values.

Make Dependent on Another Question (Optional) Make a question conditional based on the answer to another 
question. The other question must have already been defined (see 
“Creating Dependent Questions” on page 259).

Set Default Answer (Optional) Specify a default value for the answer, as follows. 
Note: Fields with default values cannot be masked.

■ True/False—Select True or False as the default answer
■ Yes/No—Select Yes or No as the default answer
■ Text—Type the default answer
■ Number—Type the default answer
■ Dates—Select “Set Current Date” or “Select Date” and select 

the date from the calendar as the default answer
■ Text Area—Type the default answer (255 character limit)

Enable Multiple Values (Optional) Allow more than one value to be added where values are 
separated by a comma.

Option Description
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9 Click Done.
You have added a custom field question to a custom field group. 
Note: If a custom field question is required, an asterisk displays by the 
question. If a custom field question is dependent on another custom field or is 
mandatory based on another custom field, the details are displayed for the 
field.

10 Go to step 3 in “Adding Choices to Custom Field Questions by Format” on 
page 248. 

Adding Choices to Custom Field Questions by Format
Security role: Community Administrator
Security permissions required: Custom Field Permissions > Manage Custom Fields
The final phase in creating custom fields is to define the choices you want users to 
use when they respond to custom field questions. Users select the choices when 
answering questions while updating a profile. 

Enable Masking (Optional) Select to hide company data, such as banking information, from 
those who do not have permission to view it. Masked fields cannot 
have default values.
Note: Only available for Text and Number company custom fields.
You are always able to see your own company’s data for custom 
fields provided that you have “View My Company” permission. 
Data is masked for custom field data for other companies unless 
you have “View Masked Fields” permission.
See “Working with Security Roles” on page 55 for information on 
permissions.
See “Using Auto-Fill” on page 10 to understand how the data is 
displayed in a company profile.

Enable Tax ID Verification (Optional) Provides the ability to verify a tax ID after it is entered. Only one 
tax ID custom field can be enabled for verification at a time. If a 
different tax ID field has already been enabled, the check box is 
unavailable. 
Note: To take advantage of the Tax ID Verification option, it must 
be enabled for your community. Contact Support for assistance.

Option Description
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Use this procedure to add choices to a custom field question in a custom field 
group. 

Note: In addition, use this procedure to create choices for question formats that 
are shared by custom fields and web forms. For web form-unique question 
formats, see “Adding Question Choices for Web Form Formats” on page 363.
See also “Adding Formula Custom Field Questions” on page 253 and “Importing 
Custom Field Values Using a CSV File” on page 257.

To add choices to custom field questions manually
1 Perform the appropriate action:

To add choice to a custom field 
question for... Do this:
Companies 1 Click Profiles > Companies. 

2 Click the Settings tab.
The Company Profile Settings page opens. 

3 Click Custom Field. 
Contacts 1 Click Profiles > Contacts. 

2 Click the Custom Fields tab.



250 OpenText Active Community CE 21.2 User Guide

C U S T O M  F I E L D S
Adding Choices to Custom Field Questions by Format

The Company Custom Fields or (Contact) Custom Fields page opens. Any 
custom field groups that have been defined, display as tabs in the first column.

2 Select the tab for the custom field group to which you want to add choices.
The custom field questions in the group display.

3 Find the question to which you want to add choices, and then click Edit for that 
question.
The custom field question becomes editable.
Note: The options that display depend on the format selected in step 4 in 
“Adding Custom Field Questions to Groups” on page 243. 

4 Perform the appropriate action:
To add choices for these formats... Do this:

■ Drop List
■ Multiple Choice
■ Radio Button List

■ Go “To add choices to Drop List, 
Multiple Choice, Radio Button List 
questions” on page 251
OR

■ “Importing Custom Field Values 
Using a CSV File” on page 257

■ True/False
■ Yes/No
■ Text
■ Text Area
■ Number
■ Date
■ Specialized

■ Go “To define True/False, Yes/No, 
Text, Text Area, Number, Date, and 
Specialized questions” on page 251
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To add choices to Drop List, Multiple Choice, Radio Button List 
questions
1 At the bottom of the Editing Drop List, Multiple Choice, or Radio Button List 

Question page, click Add Choice.
2 Type the Label and Identifier information in the table.

Note: Because values for these formats can be imported, you must 
understand how the Label and Identifier columns are used. That is, 

■ Identifier column choices are used only when importing data. 
■ Label column choices display in profiles as answer options for users. Labels 

are also used when exporting results out of Active Community. 
Important: Follow these guidelines for identifiers in .csv files. 
Do not add choices that have duplicate Identifiers. Do not add choices 
with Identifiers that contain special characters, such as '$%^&() or 
spaces. Do not use blank spaces in an Identifier unless you want them 
to be automatically converted to underscore (_) characters. Also, special 
characters will be automatically removed when you click Add Choice or 
Done. For example, A%^&**$#Z followed by a blank space would be 
converted to AZ_.

3 To add more choices to the question, click Add Choice.
4 To sort custom fields alphabetically, click Sort Alphabetically.
5 To delete a custom field choice, click the icon for the row.
6 Click Done.

To define True/False, Yes/No, Text, Text Area, Number, Date, and 
Specialized questions
1 On the Editing True/False, Yes/No, Text, Text Area, Number, Date or Specialized 

Question page, in Question, type the question over “New Question.”

■ Display Image
■ File Download
■ File Upload

■ Go “To define Display Image, File 
Download, and File Upload 
questions” on page 252

■ Company link ■ Go “To define Company Link 
questions” on page 252

■ Number Formula
■ Date Formula
■ Text Formula
■ True/False Formula

■ Go to “Adding Formula Custom 
Field Questions” on page 253

To add choices for these formats... Do this:
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2 In Instructions, type the help text for a question. The text displays when 
contacts click the help icon for the question.
Note: When a Tax ID (EIN) question is defined, text is automatically added 
indicating that a 9-digit value should be entered without the dash. You can add 
help text to include additional information.

3 Select any check box options you want to apply (see “Custom Field Options” on 
page 235). 
Note: If you want to use a Text or Number custom field to populate the 
Company ID, you cannot have the Enable Masking, Set Default Answer, or Make 
Dependent on Another Question options enabled.

4 Click Done.

To define Display Image, File Download, and File Upload questions
1 On the Editing Display Image or File Upload Question page, in Question, type 

the question over “New Question.”
2 In Instructions, type the help text for a question. The text displays when 

contacts click the help icon for the question.
3 Select any check box options you want to apply (see “Custom Field Options” on 

page 235). 
4 Click the Upload Image or Upload File link. 
5 Navigate to the image location, and select the image or file you want to upload.
6 Click OK, and then click Done.

Note: Instead of uploading files one at a time, you can upload many files to 
custom fields saved in the File Upload format. For more information, see 
“Updating File Upload Custom Fields Using .Zip Files” on page 170.

To define Company Link questions
Note: A Company Link custom field can also be created using the Active 
Community API.
1 On the Editing Company Link Question page, in Question, type the question 

over “New Question.” For example, Remit payment to.
2 Select any check box options you want to apply (see “Custom Field Options” on 

page 235). 
3 lick Done.

The Custom Field Group page refreshes.
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4 Perform the appropriate action:

5 Select the tab for custom field group that contains the Company Link question 
format. 

6 In the company link field, start typing a company name in the field’s text box.
The list auto-populates with companies that you have view permissions for. For 
example, type ABC.

7 Select a company, and then click Save.
The link displays in the company or contact profile.

Important: The custom field hyperlink cannot refer to links outside of Active 
Community.

Adding Formula Custom Field Questions
Formulas can be created for the following custom field question formats. 
■ “Text Formula” on page 254
■ “Number Formula” on page 254
■ “Date Formula” on page 254
■ “True/False Formula” on page 255
See also:
■ “Using Special Characters with Formula Formats” on page 255
■ “Adding Formulas to Custom Field Questions” on page 256

To add a company link 
question for... Do this:
Companies 1 Click the Directory tab.

2 Select a company.
3 Select Edit Company from the Manage Company 

drop-down list. 
The Edit Profile page opens.

Contacts 1 Click the All Contacts tab.
2 Select a contact.
3 Select Edit Contact from the Manage Profile drop-

down list. 
The Edit Profile page opens.
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Text Formula
Use the Text Formula format to create custom fields that combine the values in 
multiple Text custom fields into one field. 
For example, create two Text fields, First Name and Last Name, to capture a 
contact’s first and last name. Use the Text Formula format to have Active 
Community combine the values in the First Name and Last Name fields into the 
Name field. 

Active Community automatically populates the value in Name when contacts type 
values in the First Name and Last Name fields.
Note: To add spaces between the first and last names, see “Using Special 
Characters with Formula Formats” on page 255.

Number Formula
Use the Number Formula format to create custom fields that add or subtract the 
values in Number fields and places the result into one field.
For example, create two Number fields, Product Insurance and Liability Insurance. 
Use the Number Formula format to have Active Community total the values in the 
Product Insurance and Liability Insurance fields to ensure the result is within 
specified limits.

Active Community automatically populates the value in the Insurance field when 
contacts type numbers in the Product Insurance and Liability Insurance fields.

Date Formula
Use the Date Formula format to create custom fields that add or subtract a 
specified number of days to or from a date. 
For example, create a Date format custom field, Start Date, to capture the date a 
contact starts a task. Use the Date Formula format to create a Completion Date 
field. In the Date Formula, indicate you want Active Community to add 30 days to 
the value in the Start Date field when it populates the Completion Date field. 
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Active Community automatically populates the value in Completion Date when 
contacts select a Start Date.

True/False Formula
Use the True/False Formula format to create custom fields that compare text 
strings or numbers. The result of the formula returns the results in true/false 
format.

E x a m p l e :  c o m pa r e  T e x t  F i e l d s
To compare text fields, use the True/False Formula to have Active Community 
compare a value in the First Name field to see if it matches a text string. The string 
must be in this format: “<STRING>”. 

Active Community puts “true” in the Compare Text field if the text value is “Mary.” 
It puts “false” in the Compare Text field if the value is not “Mary.”

E x a m p l e :  C o m p a r e  N u m B e r  F i e l ds
To compare number fields, use the True/False Formula to have Active Community 
compare the numeric value in the Product Insurance field to see if it is greater than 
100,000. 

Active Community puts “false” in the Compare Numbers field if the number value is 
less than or equal to 100,000. It puts “true” in the Compare Numbers field if the 
value is greater than 100,000. 

Using Special Characters with Formula Formats
Use these special characters with the Number, Text, Date, and True/False Formula 
formats.
■ Use basic mathematical expressions, such as >,<, >=,<=, +, -, /.
■ To add spaces between fields, use a pair of double quotes with a space between 

each quote and a space after the last quote (“ ” ):

E x a m p l e
FIELD[First(473)]+” “  +  FIELD[Last(474)]
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The screen shot shows the results of the sample formula. Note the space 
between the first and last name in the Name field.

■ To work with text strings, use a pair of double quotes with the text string in 
between them.

E x a m p l e
FIELD[First_Name(416)]>=”Mary”
The screen shot shows the results of the sample formula. 

Adding Formulas to Custom Field Questions
Important: Before starting this procedure be sure to read the tips in “Adding 
Formula Custom Field Questions” on page 253.
Use this procedure to define Number, Date, Text, and True/False formula questions 
for custom fields.

To add formulas for custom field questions
1 Perform the appropriate action:

The Company Custom Fields or (Contact) Custom Fields page opens. 
2 Select the tab for the custom field group to which you want to add a question.
3 Click Insert Custom Field Here (Companies) or Add Custom Field 

(Contacts). 

To add formula custom field 
questions for... Do this:
Companies 1 Click Profiles > Companies. 

2 Click the Settings tab.
The Company Profile Settings page opens. 

3 Click Custom Field. 
Contacts 1 Click Profiles > Contacts. 

2 Click the Custom Fields tab.
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The Editing New Question section opens at the selected location in the custom 
field group.

4 In Choose the type of Question, use the drop-down list to select Number, Date, 
Text, or True/False Formula, then click Next.

5 In Question, type the question text over “New Question.”
6 In Instructions, type the help text for a question. The text displays when 

contacts click the help icon for the question.
7 In Formula, select the custom field you want to use in the formula.
8 Copy the line that displays for the Formula field, and paste it into the field 

following the Formula drop-down list.
9 Type the formula you want use for the custom field.

10 Click Done.

Importing Custom Field Values Using a CSV File
Values are contacts' responses to custom field questions (see “Choices and Values” 
on page 237). 
Before you begin, be sure:
■ A custom field group has been created (“Adding Custom Field Groups” on 

page 240)
■ One or more questions have been added to the group “Adding Custom Field 

Questions to Groups” on page 243, and 
■ A .csv file has been created using the guidelines in “Importing Companies and 

Contacts Using CSV Files” on page 128 and “Custom Field Requirements for 
Importing Data” on page 133 in Chapter 5, “Companies and Contacts”. 

Important: Using this option overwrites values that already exist in the company 
or contact profile.
Use this procedure to import custom field values for any of the custom field 
question formats.

To import custom field values
1 Perform the appropriate action:

To import custom field values 
into Active Community for... Do this:
Companies 1 Click Profiles > Companies. 

2 Click the Settings tab.
The Company Profile Settings page opens. 

3 Click Custom Field. 
Contacts 1 Click Profiles > Contacts. 

2 Click the Custom Fields tab.
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The Company Custom Fields or (Contact) Custom Fields page opens. 
2 Select the tab for the custom field group to which you want to import question 

values, and then click Edit Group.
3 From the list, find the question to which you want to import values, and then 

click Edit.
4 Click Import Choice.

5 In the Import Custom Fields dialog box, click Browse, navigate to the .csv file 
you want to import, and click Open.
The file name populates the text box.

6 Click Import. 
The custom field values are populated in the company or contact profile.

7 Click Done.
8 Access a profile to verify the values were imported correctly.

Before the information was imported, the check boxes were not there. Now 
they display in the profile.

Working with Custom Fields
These topics describe how to tailor custom field groups, questions, and choices to 
meet your needs.
Topics include:
■ “Finding Custom Field Groups” on page 259
■ “Creating Dependent Questions” on page 259
■ “Creating Questions in Data Tables” on page 262
■ “Re-Sequencing Custom Field Group Tabs” on page 264
■ “Re-Sequencing Custom Field Questions” on page 265
■ “Defining Freshness Settings for Custom Fields” on page 266
■ “Assigning Custom Field Permissions to Security Roles” on page 267
■ “Adding Instruction Text” on page 267
■ “Creating Help Icon Text” on page 267
■ “Copying a Custom Field Question” on page 268
■ “Copying Custom Fields to Web Forms” on page 269
■ “Deleting a Custom Field Group” on page 269
■ “Deleting a Custom Field Question” on page 270
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■ “Configuring a Custom Field Group, Question, or Choice in a Different Language” 
on page 271

Finding Custom Field Groups
Use this procedure to search for and find custom field groups so you can work with 
the questions in them.

To search for custom field groups
1 Perform the appropriate action:

The Company Custom Fields or (Contact) Custom Fields page opens. 

2 In Search Group, start typing the name of the group you want to find.
The auto-fill feature lists the groups based on the letters you type.

3 Select the group you want to work with.
The questions in the group display.

Creating Dependent Questions
Use this procedure to hide or display a custom field group based on a contact’s 
answer to another custom field question. 

To find for custom field 
groups... Do this:
Companies 1 Click Profiles > Companies. 

2 Click the Settings tab.
The Company Profile Settings page opens. 

3 Click Custom Field. 
Contacts 1 Click Profiles > Contacts. 

2 Click the Custom Fields tab.
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Dependent questions are defined when creating or editing a custom field group.

To create a custom field group that is dependent on an answer to a 
question
1 Perform the appropriate action:

The Company Custom Fields or (Contact) Custom Fields page opens. 

2 Click Add Custom Field Group. 
The New Custom Field Group section opens. You will replace the “New Custom 
Field Group” name in step 4. 

3 Click Edit Group.

To create a dependent custom 
field question for... Do this:
Companies 1 Click Profiles > Companies. 

2 Click the Settings tab.
The Company Profile Settings page opens. 

3 Click Custom Field. 
Contacts 1 Click Profiles > Contacts. 

2 Click the Custom Fields tab.
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The Editing Custom Field Group section opens. 

4 In Name, type over “New Custom Field Group” and give the group a name, 
such as “Licensing” or “Company Ownership.”

5 In Description, type a general description of the custom group, such as the 
nature of the questions it contains.

6 At the bottom of the page, select the “Make Dependent on Another Question 
(Optional)” check box.
Additional fields display.

7 In Question Name, select the name of the question on which you want this 
question to depend, such as Specialty.

8 In Answer, select the answer on which you want this question to depend, such 
as Manufacturing. 

9 Select the OR or AND button if you want to make the question dependent on 
one or more custom field choices.
Note: If AND is selected and two options are highlighted, then both options 
must be selected for the dependent field to display. The AND operator is 
generally used when the hub sets a dependent field on a multiple choice 
question. The OR operator can be used for all question formats.

10 Click Done.
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Text that describes the dependency displays under the question.

In the example, Active Community displays this custom field group in a profile 
only if the answer to the Specialty question is Manufacturing.

Creating Questions in Data Tables
Use this procedure to display all questions in a group as column headings in a 
table. 

Each column heading is a custom field question. Each question can be in a 
different custom field format, including Drop List, Multiple Choice, True/False, 
Yes/No, Text, Number, Date, Text Area, File Upload, Company Link, and 
Specialized. 
For examples, see “Custom Field Groups as Data Tables” on page 233.
Data table questions are defined when creating a custom field group. They cannot 
be defined when editing a group.
Note: Tabular fields and tabular field groups are not supported in the change 
management (CM) process.

To create custom field questions in a data table
1 Perform the appropriate action:

To create a custom field 
question in a data table for... Do this:
Companies 1 Click Profiles > Companies. 

2 Click the Settings tab.
The Company Profile Settings page opens. 

3 Click Custom Field. 
Contacts 1 Click Profiles > Contacts. 

2 Click the Custom Fields tab.
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The Company Custom Fields or (Contact) Custom Fields page opens. 

2 Click Add Custom Field Group. 
The New Custom Field Group section opens. You will replace the “New Custom 
Field Group” name in step 4. 

3 Click Edit Group.
The Editing Custom Field Group section opens. 
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4 In Name, type over “New Custom Field Group” and give the group a name, 
such as “Licensing” or “Company Ownership.”

5 In Description, type a general description of the custom group, such as the 
nature of the questions it contains.

6 At the bottom of the page, select the “Display this group as a table” box check 
box. 

7 When adding custom field questions to the group, create one custom field 
question for each column you want to display in the table. 

8 Select the format that is appropriate for the column. 
Important: You add questions in data tables as described in “Adding Custom 
Field Questions to Groups” on page 243. The table doesn’t display until 
contacts edit their profiles.

9 Define the question, then click Done.

Re-Sequencing Custom Field Group Tabs
Use this procedure to change the display order of custom field group tabs.

To change the sequence of custom field group tabs
1 Perform the appropriate action:

The Company Custom Fields or (Contact) Custom Fields page opens. 
2 Select the tab for the custom field group you want to re-sequence.
3 Click Move Up or Move Down to re-sequence the order in which the tab 

displays on this page and in a company or contact profiles. 

The tab order changes.
4 Click Done.

To re-sequence custom field 
group tabs for... Do this:
Companies 1 Click Profiles > Companies. 

2 Click the Settings tab.
The Company Profile Settings page opens. 

3 Click Custom Field. 
Contacts 1 Click Profiles > Contacts. 

2 Click the Custom Fields tab.



C U S T O M  F I E L D S
Working with Custom Fields

OpenText Active Community CE 21.2 User Guide  265

7  

Re-Sequencing Custom Field Questions
Use this procedure to change the display order of custom field questions in a 
custom field group by dragging and dropping the questions to a new location.

To change the sequence of custom field questions
1 Perform the appropriate action:

The Company Custom Fields or (Contact) Custom Fields page opens. 
2 Select the tab for the custom field group that includes the questions you want 

to re-sequence.
3 Select the custom field question header, hold your cursor down, and drag and 

drop the question to a different position in the custom field group. 

4 The question sequence changes. In this example, the Specialty custom field 
question was moved before the Date question

5 Click Done.

To re-sequence a custom field 
question for... Do this:
Companies 1 Click Profiles > Companies. 

2 Click the Settings tab.
The Company Profile Settings page opens. 

3 Click Custom Field. 
Contacts 1 Click Profiles > Contacts. 

2 Click the Custom Fields tab.
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Defining Freshness Settings for Custom Fields
In addition to defining freshness settings from company or contact profiles as 
described in “Setting Time Intervals for Profile Reminder Emails” on page 45, you 
can set profile freshness while working with a custom field group.
Use this procedure to define the interval of time after which Active Community will 
send profile update reminder emails for custom fields. 

To define freshness settings for a custom field group
1 Perform the appropriate action:

The Company Custom Fields or (Contact) Custom Fields page opens. 
2 Select the tab for a custom field group, and click Set Freshness.

The Contact (or Company) Freshness Setting page opens. 

Important: The number of days set for update profile reminder emails is 
listed in the Interval (days) column. 

■ If there is a number in the field, the freshness setting is on. Reminder 
emails will be sent at the appropriate interval for that set of fields.

■ If there is no number in the field, the freshness setting is off. No reminder 
email will be sent for that set of fields. 

3 Click Edit for the information you want to keep current.

To define freshness settings in a 
custom field group for... Do this:
Companies 1 Click Profiles > Companies. 

2 Click the Settings tab.
The Company Profile Settings page opens. 

3 Click Custom Field. 
Contacts 1 Click Profiles > Contacts. 

2 Click the Custom Fields tab.
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The Edit Freshness Settings page opens.

4 In Interval (days), enter the number of days after the last profile update that 
you want a reminder email to be sent. For example, you enter 45 in the Interval 
(days) field for the Contact Core Fields group. If contact core fields in a profile 
are not updated in 45 days, Active Community automatically sends a profile 
update reminder email to the profile owner. 

5 Click Save. 
On the Freshness Setting page, you will see the number of days you set for 
update reminders. 

Assigning Custom Field Permissions to Security Roles
Go to “Assigning Custom Field Group Permissions to Security Roles” on page 64 in 
“Roles and Permissions.”

Adding Instruction Text
To add instruction text to a custom field question
■ When defining a custom field, use the Insert Text Here link to type any special 

instructions, such as descriptions, titles, or general information. 

The text displays in the body of the question.

Creating Help Icon Text
To add help icon text to a custom field question
■ When defining a custom field question, use the Instruction field to type help text 

for a question. 

The text displays when the contact clicks the help icon for the question.
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Copying a Custom Field Question
Use this procedure to copy a custom field question to a new custom field group, 
and modify the question to create a new custom field.
Important: If you copy a question that is dependent on another custom field, the 
dependency information will not be copied. 

To copy a custom field group or question
1 Perform the appropriate action:

The Company Custom Fields or (Contact) Custom Fields page opens. 
2 Select the tab for the custom field group that contains the question you want to 

copy, and then click Edit Group.

3 Navigate to the custom field question you want to copy, and click Copy for that 
custom field.
The Copy Custom Fields pop-up opens.

4 To copy the custom field question to a specific custom field group, select the 
group from the Field Group drop-down list.
Note: The dependencies of the existing custom field will not be copied.

5 Click Copy.
The copied custom field question is added to the field group you specified.

6 Click Edit.
The fields become editable.

7 Modify the custom field as needed, and then click Done.
The new custom field question is added to the group.

To copy a custom field question 
for... Do this:
Companies 1 Click Profiles > Companies. 

2 Click the Settings tab.
The Company Profile Settings page opens. 

3 Click Custom Field. 
Contacts 1 Click Profiles > Contacts. 

2 Click the Custom Fields tab.
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Copying Custom Fields to Web Forms
You can copy a custom field group or question to a web form, then distribute the 
web form as a survey to contacts. After contacts complete the survey, Active 
Community automatically updates the company or contact profile with their 
responses. For details, see:
■ “Creating a Web Form for Inside Your Community” on page 355
■ “Adding Question Choices for Web Form Formats” on page 363
■ “Copying a Web Form to Create a New One” on page 367

Deleting a Custom Field Group
Use this procedure to delete custom field groups, which deletes all questions in the 
group.
Important: Review these rules before deleting a custom field group:
■ You cannot delete groups or questions that are dependent on other groups or 

questions. You must delete the dependent group or question first. 
■ You cannot delete a custom field group if the group is associated with a sub-

community and/or a change management process.

To delete a custom field group
1 Perform the appropriate action:

The Company Custom Fields or (Contact) Custom Fields page opens. 
2 Select the custom field group you want to delete.
3 Click Delete. 

To copy a custom field question 
for... Do this:
Companies 1 Click Profiles > Companies. 

2 Click the Settings tab.
The Company Profile Settings page opens. 

3 Click Custom Field. 
Contacts 1 Click Profiles > Contacts. 

2 Click the Custom Fields tab.
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The group, and all questions in it, are deleted.

Deleting a Custom Field Question
Use this procedure to delete custom field questions in a custom field group.
Important: Review these rules before deleting a custom field:
■ You cannot delete groups or questions that are dependent on other groups or 

questions. Before starting this procedure, you must either:
■ Delete the dependent question, or
■ Edit the group or question and clear the “Make Dependent on Another 

Question (Optional)” check box.
■ You cannot delete a custom field if it is associated with a sub-community and a 

change management process.
Note: If a masked company custom field question is deleted from a custom field 
group, the original values display on the audit log even if data masking was 
enabled for the field. 

To delete a custom field question
1 Perform the appropriate action:

The Company Custom Fields or (Contact) Custom Fields page opens.
2 Select the custom field group that contains the question you want to delete.
3 Click Delete for the question you want to delete. 

The question is deleted from the group.

To copy a custom field question 
for... Do this:
Companies 1 Click Profiles > Companies. 

2 Click the Settings tab.
The Company Profile Settings page opens. 

3 Click Custom Field. 
Contacts 1 Click Profiles > Contacts. 

2 Click the Custom Fields tab.
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Configuring a Custom Field Group, Question, or Choice in a 
Different Language

Use this procedure to configure a custom field group, question, or choice in a 
different language (one that is supported by Active Community).
After you create a custom field group, question, or choice in your default language, 
you can configure it in a second (or more) language(s). Then, for example, when a 
user accesses Active Community in English, they see the custom field in English, 
and when they access Active Community in Spanish (or change the language to 
Spanish), they see the custom field in Spanish. 

To configure a custom field in a different language
1 Create a custom field group, question, and choice in your default language. 

Save your changes. See applicable topics in “Custom Fields” on page 221.
2 Change the Active Community language to another (supported) language (see 

“Changing Your Language” on page 11).
3 In that second language, modify the label for same custom field group, 

question, or choice. For example, if you changed your language to Spanish, 
modify the custom field group, question, or choice so that it is in Spanish. Save 
your changes. 
You can now change your language to either of the languages where you 
configured the custom fields, and those fields will display in either of the two 
languages depending on which language you select for Active Community.

Ensuring Contacts Respond to Custom Field Questions
After creating custom field groups, questions, and choices, Active Community 
automatically adds them as tabs in company and contact profiles. The custom field 
groups and questions do not contain answers to the questions until contacts in the 
community respond to the questions by updating contact and company profiles. 
There are several ways to ensure contacts keep custom field information up-to-
date. 
Topics include:
■ “Define Automatic Email Reminder Settings” on page 271
■ “Send an Update Profile Email Message” on page 271
■ “Use the Registration Module to Collect Profile Data” on page 272

Define Automatic Email Reminder Settings
You can set automatic email reminders to be sent to your partners when their 
contact or company profile becomes stale. For details, see “Defining Freshness 
Settings for Custom Fields” on page 266.

Send an Update Profile Email Message
You can send an email message to your community, prompting them to update 
their profiles. For details, see “Adding an Activity to a Project” on page 290.
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Use the Registration Module to Collect Profile Data
If your company uses the optional Registration module, you can collect information 
for any custom field group or question using the Registration approval process. 
After final approval, Active Community creates the company and includes the 
collected values for the custom field.

Exporting a Custom Fields Configuration
Security role: Community Administrator
Security permissions required: Custom Field Permissions > Manage Custom Fields
Community administrators who have custom field permissions can use this 
procedure to export a custom fields configuration to send to OpenText support to 
assist in debugging and resolving issues faced by customers. All custom field-
related configurations are included in the export such as dependencies, mandatory 
requirements, multi-language translations, etc.
Note: Only the custom fields configuration is exported; no data is exported.
An exported custom fields configuration can also be used by OpenText 
administrators for internal use. The following conditions apply:
■ Import of the exported custom field configuration can only be performed by 

OpenText and is for internal use only. 
■ The professional services team must submit a request to the development team 

to import the custom field configuration into a hub. 
■ The exported custom field configuration can be imported only to a new hub, one 

that does not yet have an existing custom fields configuration.

To export a custom fields configuration
1 Click Profiles > Companies. 
2 Click the Settings tab.

The Company Profile Settings page opens.
3 Click Custom Fields. 

The Company Custom Fields page opens.
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4 Click Export.
A dialog box asks if you want to open or save the file. The configuration file 
opens or is saved.
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Projects and Activities 8
You use projects to communicate or collaborate with your business contacts, 
partners, vendors, or suppliers. A project consists of one or more activities which 
represent actions you want community members to perform. Sample activities 
might be to:
■ Send a satisfaction survey to a specific group of your suppliers, or
■ Inform all your trading partners about new policy changes. 
In the user interface, a project is a workspace that helps you organize and track all 
the components of its activities. Whenever you create an activity, it becomes part 
of the project’s archives.

1

4

3

2

The parts of a page:
Key Description
1 Indicates activity managed project
2 Indicates regular project
3 List of projects
4 Number of activities in each project

Note: Depending on your user permissions, you may not be able to create a 
project directly; you may need to contact your Community Administrator to do so.
Topics include:
■ “Project Overview” on page 276
■ “Creating a Regular or Activity Managed Project” on page 287
■ “Adding an Activity to a Project” on page 290
■ “Defining Activity Dependencies and Due Dates” on page 297
■ “Adding Participants to an Existing Activity” on page 299
■ “Adding Team Members to a Project” on page 301
■ “Editing Project Settings” on page 303
■ “Editing Activity Settings” on page 303
■ “Starting a Regular Project” on page 305
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■ “Starting an Activity Managed Project” on page 306
■ “Copying a Project to Create a New One” on page 309
■ “Copying an Activity to Create a New One” on page 310
■ “Suspending or Activating Activity Participants” on page 312
■ “Suspending or Restarting an Activity” on page 314
■ “Customizing Upcoming and Overdue Reminder Messages” on page 315
■ “Customizing a Project Kickoff Message” on page 318

Project Overview
You can define two types of projects: 
■ Use regular projects for ongoing projects, such as updating your community 

directory. 
■ Use activity managed projects for campaigns that have:

■ Fixed start and end dates
■ Include steps that need to be completed in order. You can assign due dates 

and dependencies to each activity, so that if one step is incomplete, the 
remaining steps won't start. 

For example, you might have a project to communicate with suppliers, as 
shown in the following graphic.

P r o j e c t :  C o m m u n i c at e  w i t h  S u p p l i e rs

The parts of a project:
Key Description
1 Activity: Send Email to Suppliers
2 Activity: Suppliers Acknowledge Email
3 Activity: Send File to Suppliers

Topics include:
■ “Activity Managed Projects” on page 277
■ “Project Tabs” on page 279
■ “Activity Tabs” on page 281
■ “Email Messages” on page 282
■ “Project Phases” on page 285
■ “Project Planning” on page 285

1 2 3
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■ “How Do I?” on page 286

Activity Managed Projects
Activity managed projects contain activities with start and end dates. They can 
include prerequisite activities to ensure activities are completed in the proper 
sequence.
By enabling activity management for a project, you can:
■ Schedule a project to automatically start in the future
■ Have one activity automatically start after another activity has been completed
■ Automatically send activity reminder email messages to participants. Emails are 

sent to a participant’s Communication Email.
When you are creating an activity managed project, you specify options that 
customize the project to your needs. The options apply to all activities in the 
project. 
For example, you might have a project that has three activities that must be 
completed in order: 
1 Send Email to Suppliers
2 Suppliers Acknowledge Email
3 Send File to Suppliers

P r o j e c t :  C o m m u n i c at e  w i t h  S u p p l i e rs

If you make activity 2 dependent on activity 1, the setting ensures activity 2 does 
not start until after activity 1 is completed.

Activities
An activity is any item that can be completed within a regular or activity managed 
project, such as:
■ Send a survey to suppliers
■ Issue a letter to the entire community
■ Update a business contact's profile
An activity can be assigned to one or more contacts in your community, and can be 
added to regular projects and activity managed projects.

Key Description
1 Activity: Send Email to Suppliers
2 Activity: Suppliers Acknowledge Email
3 Activity: Send File to Suppliers

1 2 3
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The screen shots emphasize the differences between activities for regular projects 
and activities for activity managed projects.
Regular Projects
Regular projects are ongoing, with no start or end dates. There is no Dependencies 
and Due Dates link.

Activities for regular projects display as shown:

Activity Managed Projects
Note the start and end dates associated with activity managed projects and the 
existence of the Dependencies and Due Dates link.

Activities for activity managed projects display as shown:

Activity Participants
After starting an activity, Active Community sends communications to the activity 
participants, which are the trading partners you selected to receive the survey or 
email message. For example:
■ In a regular project, if you create an activity to send an email reminder to all 

participants to update their profile, the email is sent when you click Start in the 
activity. 
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■ In an activity managed project, the activity is started when the project is started, 
or when the previous activity is complete.

Important: After an activity is started, you can add but not remove participants 
from it.

Project Tabs
Each project includes a set of tabs that let you define and manage all data related 
to the project. 

Project Tabs
■ “Overview”
■ “Activities”

■ Overview
■ Participants
■ Messages
■ Files
■ Web Forms

■ “Team”
■ “Participants”
■ “Files”
■ “Web Forms”
■ “Permissions”
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Overview
The Overview tab lists general information about the project, including its name, 
description, status, history, and summary of participants. Use it to get a high-level 
glimpse into its status.

3

2

1

The key parts of a project:
Key Description
1 Overall project status
2 Project-related activities, including status
3 All actions performed as part of the project

Activities
The Activities tab lists all project activities and their status. You can add and modify 
activities, monitor responses and results, and set dependencies and due dates 
(activity managed projects only). See “Activity Tabs” on page 281.

Team
The Team tab lists project team members, which are people in your community 
who assist the project owner in creating and maintaining the project.

Participants
The Participants tab lists the participants in the project, including the project owner 
and team members. Participants are the contacts in Active Community who will 
receive all activity communications, such as email messages and surveys. 
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Files
The Files tab includes all files that have been uploaded as part of web form 
activities in the project. If files are attached to email messages, you can find those 
attachments in the Messages tab of each activity.

Web Forms
The Web Forms tab includes all web forms created in the project. A web form must 
be published before it can be used in activities. 

Permissions
The Permissions tab lists the project rights, or privileges, for each security role 
(such as Participant, Team Member, or Project Owner) in the project. If you change 
the permissions in this tab, the change only applies only to this project, not all 
projects. 

Activity Tabs
Within a project, each activity includes tabs to let you manage all data related to 
the activity.

Project Activity 
Tabs

Overview
The Overview tab lists general information about the activity, including name, 
description, status, start date, and other summary information.

Participant
The Participant tab lists all participants in the activity. Participants are contacts in 
Active Community that will receive all activity communications, such as email 
messages and surveys.

Messages
Displayed only for activity managed projects, the Messages tab contains the 
project kickoff message and any file that was attached to an email message. You 

■ Overview
■ Activities

■ “Overview”
■ “Participant”
■ “Messages”
■ “Files”
■ “Web Forms”

■ Team
■ Participants
■ Files
■ Web Forms
■ Permissions
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can edit this message before the project has started. For details, see “Customizing 
a Project Kickoff Message” on page 318.

Files
The Files tab includes all files that have been uploaded as part of web form 
activities in the project. If files are attached to email messages, you can find those 
attachments in the Messages tab of each activity.

Web Forms
The Web Forms tab includes all web forms created in the project. A web form must 
be published before it can be used in activities. 

Email Messages
You can send project kickoff emails and reminder emails as part of a project or 
activity. The emails, which use a standard email template, are sent to participants 
as part of a project. You customize the messages so they are appropriate for your 
community. Emails are sent to a participant’s Communication Email.
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The parts of an email template are outlined here. Specific procedures provide more 
detailed information about how to modify the templates. 

2

3

1

The key parts of an email template:
Key Description
1 Insert “placeholders” for a contact’s first and last name, subject line, etc.
2 Text of the email message, which you modify for your company.
3 Add attachments to the email message

To
The To part of the email indicates the number of participants who will receive the 
message. Click the link to view or edit the list of recipients. 
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From
The From part of the email lists the email address that is displayed in the From 
field when the message is sent. Typically, it is the email address of the project 
owner or the email address specified in Project Settings when the project was 
created. 

Date
The Date part of the email indicates the date the message was created. 

Subject
The Subject part of the email describes the message’s subject line. If an activity 
type of Send a Profile Update Reminder was selected, the Subject line is 
automatically filled in with “Update Your Profile.” In other situations, the subject 
line will be blank. You can also customize the subject line using merge fields.

Available Merge Fields
The Available Merge Fields part of the email lists values found in the recipient's 
profile. You can select a field type of Company or Contact, and then select the 
respective “placeholder” field you want inserted in the email. 

E x a m p l e
If, in Select Field Type, you select Contact, and in Select Field you select First 
Name, the field %FirstName% is inserted in the message text. Active Community 
uses the first name in the recipient's profile (for example, “John”) to replace the 
%FirstName% “placeholder” when the message is sent. 

Insert Contact Fields
Insert Contact Fields also lists values found in the recipient's profile. 

E x a m p l e
When you click First Name, the field %FirstName% is inserted in the message text. 
Active Community uses the first name in the recipient's profile (for example, 
“John”) to replace the %FirstName% “placeholder” when the message is sent.

Message Text
The body of the message, which you customize to participants by using merge 
fields. The message can also include attachments, such a spreadsheets or images.

Attachments
This part of the email lets you add attachments to the message when it is sent, 
such as a spreadsheet or an image. The file size can be up to 50 MB.
Note: If an attachment is added to an email, it is not tracked or audited when a 
contact downloads it. To track when contacts download attachments, it is best to 
create a web form, upload the file with a File Download question, and send the 
form to your contact. See “Web Forms” on page 347.
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Project Phases
There are two phases in any project: a planning phase and an active phase.

1

21

The phases of a project:
Key Description
1 Planning Phase - Define Projects and Activities

2 Active Phase - Start Projects and Activities

■ In the planning phase, you define the project and its activities. During the 
Planning Phase you can make changes to all aspects of a regular or activity 
managed project, including its participants, activities, due dates, email 
messages, etc.

■ In the active phase, after starting the project, Active Community coordinates and 
orchestrates all activities related to the project. It starts the first activity and 
sends all project partners a project kickoff email.
Important: After a regular project has started, changes can be made to 
project participants, activities, etc. After an activity managed project has 
started, changes cannot be made. 

Because you cannot change most aspects of an activity managed project after it 
has started, OpenText recommends you plan all aspects of a project carefully (see 
“Project Planning” on page 285 and “How Do I?” on page 286.

Project Planning
These topics outline the prerequisites for projects and activities, and some of the 
options you need to consider when planning projects for your community.
Topics include:
■ “Project Prerequisites” on page 285
■ “Activity Prerequisites” on page 286
■ “How Do I?” on page 286

Project Prerequisites 
Before you create a project, consider the nature of your project and its activities. Is 
it a regular project (ongoing) or an activity managed product with start and end 
dates? 

■ Changes allowed in all aspects of a project.

■ Regular projects can be changed after the project or activity has started.
■ Activity managed projects cannot be changed after the project or activity has 

started.
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Depending on its scope, you may want to create multiple projects. For example, 
when measuring supplier satisfaction, you might create one project for conducting 
a supplier satisfaction survey and follow-up activities, and another project for 
dispute resolution.
Before you begin, be sure the project participants, such as the trading partners you 
want to include in the project, have contact profiles in Active Community. If they 
don't have profiles, you will not be able to select them for project activities (see 
“Adding a Company to Active Community” on page 122).

Activity Prerequisites
Before creating an activity, you must create a project.
Note: If you will be sending web form(s), you need to create it before creating 
the activity. 
Example: Suppose you want to send a survey to a set of suppliers. After creating 
a project, you do the following:
■ Create a web form that contains the survey questions and possible answers
■ Create an activity in the project and link it to the web form
■ Add suppliers as participants in the activity

How Do I?
For regular or activity managed projects you need to plan which options you will 
select based on the needs of the project. The table lists a few options to consider.
Note: You will choose from among these options when creating a project or 
activity. 

If you want to...
Choose (or use) the following 
option: When you are:

Create or Edit Projects
Create a regular project ■ Do not select Enable Activity 

Management
■ “Creating a Regular 

or Activity Managed 
Project” on page 287
OR

■ “Editing Project 
Settings” on 
page 303

Add Activities or Edit Activity Settings
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Creating a Regular or Activity Managed Project
Use this procedure to add a regular or activity managed project. If you are adding 
a regular project, do not select the Enable Activity Management check box. If you 
are adding an activity managed project, be sure to select the check box; it allows 
you to add due dates and dependencies to activities in the project.
A project is a container for those activities that you want to perform to 
communicate and collaborate with your business contacts.
Note: A quick and easy way to create a project is to copy an existing one (see 
“Customizing Upcoming and Overdue Reminder Messages” on page 315). 

Create an activity managed project; this type of 
project allows you to add due dates and 
dependencies to activities in the project

■ Select Enable Activity Management ■ “Adding an Activity to 
a Project” on 
page 290
OR

■ “Editing Activity 
Settings” on 
page 303

Allow activity due dates to adjust automatically ■ Select Automatic Rescheduling
Send project kickoff emails automatically ■ Select Send Project Kickoff Email
Send an email message to participants ■ Select Send a Message
Send an Update Your Profile reminder email to 
participants

■ Select Send a Profile Update 
Reminder

Use a different email than the default project 
email

■ Enter ‘Reply to’ and ‘From’ email 
addresses for the activity.

Use web forms to send email alerts ■ Select Complete a Web Form
Collect responses to an activity by company ■ Select Complete by Company
Collect responses to an activity by individual 
participants

■ Do not select Complete by company

Require participants login to complete an 
activity

■ Select Login Required

Send an email to the team when a web form is 
submitted

■ Select Notify team on web form 
submission

Do not require a response to an activity when it 
is started; mark the activity as complete

■ Select No response required

Define activity due dates ■ Due Date field “Defining Activity 
Dependencies and Due 
Dates” on page 297

Define when a reminder email is to be sent in 
relation to the activity’s due date

■ Notification fields

Define dependencies among and between 
activities in a project

■ Dependencies drop-down list

Prevent a user from re-submitting web form 
responses

■ Restrict re-submission ■ “Adding an Activity to 
a Project” on 
page 290
OR

■ “Editing Activity 
Settings” on 
page 303

If you want to...
Choose (or use) the following 
option: When you are:
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To add a regular or activity managed project
1 Click the Projects module.

The All Projects page opens. 
2 Click Add Project.

The Name Your Project page opens.

Important: Note this information about the Enable activity management 
check box:

3 Complete the appropriate fields:
a In Project Name, type the name of your project. This name should 

correspond to the nature of the project and its activities; for example, 
“Supplier Satisfaction” or “Compliance with EDI 850." Required.

b In Description, type text that summarizes and describes the project.
c Under Project Settings, in Reply To Email Address, type the email address 

that you want shown as the Reply To address in all project email 
communications. If an address is not specified, the project owner's email 
address is used. 
Example: Suppose you have a project activity that sends an email 
message to a group of your suppliers. When suppliers reply to your email 
message, you want the reply to be sent to your Accounting group, not you. 

Key Description
1 Important:

■ For activity managed projects, select the Enable Activity Management 
check box; it allows you to add due dates and dependencies to 
activities in the project.

■ For regular projects, do not select the check box.

1
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In the Reply To box, you enter your Accounting department's email 
address.

d In From Email Address, type the email address that you want shown as the 
From address in all project email communications. If an address is not 
specified, the project owner's Communication Email is used.
Example: Suppose you want to show your email message as being sent 
from your Accounting department. In the From box, you enter your 
Accounting department's email address. The recipient supplier will see the 
email as being sent from Accounting, not you.

e If you want to create an activity managed project that includes due dates 
and activity dependencies, select the Enable Activity Management check 
box. If you are creating a regular project, do not select the check box.
If selected, additional fields display on the page. 

a In Copy Team Members on All Communications, select the check box if you 
want to copy team members on all communications in the project.

4 Click Save Changes. 
You have created a new project. You can now add activities, participants, team 
members, and more to the project.

5 Go to “Adding an Activity to a Project” on page 290.

Type or Select Description
Start Date Date the project will start, either today's date or a future 

date. Required.
Use this format: Jan 10, 2009. You can change the date after 
the project has been created, but cannot change it after the 
project has been started. 

Enable Automatic 
Rescheduling

Indicates if you want activity due dates to be automatically 
changed when the project's start date is changed, or when 
preceding activity due dates are changed.
Example: You have two activities (1) Send File and (2) 
Acknowledge Receipt. Acknowledge Receipt is dependent on 
the Send File activity being completed. If you change the 
Send File activity’s due date to three days later, Automatic 
rescheduling automatically adjusts Acknowledge Receipt's 
due date to three days later as well.
Note: When dates are automatically changed, they will not 
be changed to a weekend or holiday. If that happens, the 
date will be moved to the next weekday.

Send Project 
Kickoff Email

Indicates if you want to send a project welcome message to 
all participants when the project is started. Emails are sent to 
a participant’s Communication Email. The message contains a 
link to the participant's To Do list of activities. This option 
makes it easy for the participant to navigate to and complete 
activities throughout the project's duration.
Note: If selected, you must create a project kickoff message. 
The message won't be sent until the project is started.
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Adding an Activity to a Project
An activity is any item that can be completed within a project. For example: 
■ Send a survey to suppliers
■ Issue an email to the entire community.
■ Prompt a set of business contacts to update their contact information

Use this procedure to:
■ Create a new activity
■ Select the activity type (send message, profile update reminder, or web form)
■ Indicate how you want participants to respond to the activity
■ Add participants to the activity
■ Assign a different default ‘Reply to’ and ‘From’ email address for the activity than 

the default project email address
■ Customize the email message that is related to the activity
Important: Be sure to complete “Activity Prerequisites” on page 286 before you 
begin this procedure. For example, if you plan to send a survey to your suppliers, you 
need to create a web form to contain the survey so you can select it as part of this 
procedure (see “Creating a Web Form for Inside Your Community” on page 355).
Note: A quick and easy way to create an activity is to copy an existing one (see 
“Copying an Activity to Create a New One” on page 310).

To add an activity to a project
1 After creating a project as described in “Creating a Regular or Activity Managed 

Project” on page 287, click the Projects module.
The All Projects page opens. 

2 Find the project to which you want to add an activity. You have several options:
■ If you created the project, click the Your Projects tab.
■ If someone else created the project, remain on the All Projects tab. In 

the Search for Projects field, start typing part of the project name, and 
then click Search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).

3 Select the name of the project to which you want to add activities.
The project opens to the Overview tab.

4 Click the Activities tab.
The Activities tab opens. It lists all activities associated with the selected 
project.

5 Click Add Activity. 



P R O JE C T S  A N D  A C T I V I T I E S
Adding an Activity to a Project

OpenText Active Community CE 21.2 User Guide  291

8  

The Choose Kind of Activity page opens. 

6 Decide which type of activity you want to add to the project. 
■ Under Message Activities, if you select:

■ Send a Message, the activity will send an email message to participants. 
Emails are sent to a participant’s Communication Email. By default, the 
subject and message text are blank so you can customize the message.

■ Send a profile Update Reminder, the activity will send an email message 
to participants with a subject of “Update Your Profile.” Emails are sent to 
a participant’s Communication Email. You can customize the message 
text, including the contact’s first and last name, and include a link to 
complete the activity in Active Community (see “Customizing Profile 
Reminder Messages” on page 44).
Note: To associate a message activity with an alert, you need to 
select the Associate with Activity check box when you add or edit an 
alert (see Step 7 in “Adding an Alert Configuration” on page 387).

■ Under Web Form Activities, if you select:
■ Complete a Web Form, the activity will send an email message to 

participants with a link to a web form for recipients to complete. Emails 
are sent to a participant’s Communication Email.
Note: Only published web forms are available to be linked to 
activities. To associate a web form activity with an alert, you need to 
select the Associate with Activity check box when you add or edit an 
alert (see Step 7 in “Adding an Alert Configuration” on page 387).

7 Click Choose this for the activity type you want.
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If you selected Send a message or Send a profile update reminder, the Name 
Your Activity page opens immediately.
Note: If you selected Complete a Web Form, select the web form you want to 
use, and then click Continue to go to the Name Your Activity page.

The key parts of an activity page:
Key Description
1 Indicates your progress in the setup wizard (for example, Step 2 of 4)
2 Activity Settings let you:

8 Complete the fields as follows: 
a In Activity Name, type the name of the activity to be completed; for 

example, “Supplier Diversity Survey.” 

■ Set a different ‘Reply to’ and ‘From’ email address for the activity than the default 
project email

■ Collect company or individual responses
■ Require participants to log in to Active Community
■ Send an email with a link to a web form (survey)
■ Send an email and mark an activity as complete
■ Send a copy of the email to contacts who are not users of Active Community
■ Prevent a participant from changing the answers of their web form responses 

once they are submitted

2

1
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b In Description, type a summary description about the activity, such as 
audience, goals, and deadlines. 

c Under Activity Settings, choose your options carefully. Some options might 
not be listed based on your previous selections.

Select this option... If you want the activity to:
‘Reply to’ email address Type the email address that you want shown as the Reply 

To address in all email communications for this activity. If 
an address is not specified, the project email address is 
used.

Example: Suppose you have several project activities, 
and each activity is managed by a different team in your 
company. Each team wants to send an email message to a 
group of your suppliers about a particular activity. When 
suppliers reply to your email message about that activity, 
you want the reply to be sent only to the team handling 
that activity.
In the Reply To box, enter your team’s email address.

‘From’ email address Type the email address that you want shown as the From 
address in all email communications for this activity. If an 
address is not specified, the project email address is used.

Example: Suppose you have several project activities, 
and each activity is managed by a different team in your 
company. Each team wants to show their email message 
as being sent from their team about a particular activity. 
In the From box, enter your team’s email address. The 
recipient suppliers will see the email as being sent from 
the team that is handling that activity.

Complete by company Collect company responses instead of individual contact 
responses. When any participant in the company 
responds, the activity will be marked as complete for the 
company. 

Example: You have five participants from Acme assigned 
to the Send Survey activity. When the first Acme 
participant responds, their response is recorded as the 
response from Acme, and the Send Survey activity is 
marked as complete. 

Login required Require participants to log in to Active Community to 
complete the activity.



294 OpenText Active Community CE 21.2 User Guide

P RO J E CT S  A N D  A C T I V I T I E S
Adding an Activity to a Project

9 Click Continue.

Notify team on web form 
submission

Only available if you selected Complete a Web Form as the 
activity type.

Send an email notification to all team members assigned 
to the activity as soon as a web form is submitted. Emails 
are sent to a participant’s Communication Email. 

The email includes the contact or company (and company 
ID) who submitted the web form and the date and time it 
was submitted, including a hyperlink to the web form.

Example:

No response required Only available if you selected Send a Message as the 
activity type.

Send the email without the activity link. As soon as the 
email is sent, the activity is marked as complete. 

CC email address Only available if you selected Send a Message or Complete 
a Web Form as the activity type. Not available if you 
selected Send a Profile Update Reminder as the activity 
type. 

Send a copy of the email to contacts who are not users of 
Active Community.
When you select this option, a drop-down list displays. 

Select the name of the company custom field that 
contains the email address to which you want to send a 
copy of the email. The company custom field must be a 
Specialized (Email) custom field.

Example: Select Sales Rep (Email).

Note: If you do not have permission to view a particular 
custom field, it does not display in the list.

Restrict re-submission Prevents a supplier from changing the answers to their 
web form responses once the answers have been 
submitted. They are still able to view their answers in a 
read-only format.

Select this option... If you want the activity to:
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The Add Participants page opens. Use it to add participants to the activity.
a In the Search for Contacts field, start typing part of the name of the 

participant you want to add to the project, and then click Search (see 
“Quick (Simple) Searches” on page 91 or “Advanced Searches” on 
page 93).

b To add one participant, click Add after the name. To add more than one 
participant, select the check boxes for the participants you want to add to 
the activity, and click OK.

c Under Actions, click Add Participants, and then click OK.
d Confirm that you want to add the participant(s) and click OK.

10 After adding all participants, click Continue. 
The Set Details for the activity page opens so you can customize the email 
message that will be sent to participants when the activity is started.

1

2
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The key parts of the email page:
Key Description
1 The top of the page lets you insert “placeholder” fields in the subject line or message 

text.
2 The bottom of the page lets you add attachments to the message.

Important: There are two ways to customize the subject line and the text of 
the email message. You can type the name of any merge field in the text box 
for Available Mail Merge Fields, or you can use the Insert buttons to insert the 
merge fields quickly. 

11 Under Available Merge Fields, in Select Field Type, select Company or 
Contact.

a Put your cursor in the subject line or email message where you want to 
insert the field.

b Use either the text box to insert merge fields or use the Insert buttons. 

Note: If you selected No response required in step 8, remove the 
link in the body of the email.

12 To add attachments with your message, such as a spreadsheet or an image, at 
the bottom of the page, click Browse, navigate to where the file is located on 
your hard drive, and then click Open.
The file is added to the bottom of the message. The file size must be less than 
50 MB.
Note: If an attachment is added, when a contact downloads it, it is not 
tracked or audited. If you want to track when contacts download attachments, 
it is best to create a web form, upload the file with a File Download question, 
and send the form to your contact. For details, see “Web Forms” on page 347. 

13 When the message is complete, click Save. 
Active Community saves the activity and all information about it. It saves the 
message related to the activity, but does not send it.

14 Go to “Defining Activity Dependencies and Due Dates.”

To use the... Do this:
Text box 1 Start typing the name of a field. The box automatically 

fills with field names that contain the characters you 
type. 

2 Select a field name, and click Insert Field.
The mail merge field displays in the body of the email.

Insert buttons 1 Select the name of the merge field you want to insert, 
such as Email.

2 Click the Email button.
The mail merge field displays in the body of the email.
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Merge Field Descriptions
The table describes merge fields available as buttons in email templates used in 
project activities. Some fields are common to all email templates; others are used 
only in specific templates. Not all merge fields are shown.

Click this button...

To insert this merge 
field in an email 
template: Description
%Salutation% Form or address listed in the Salutation field in the participant's 

contact profile, such as Mr., Ms., or President.
%FirstName% First name of the participant; for example, “John.”
%LastName% Last name of the participant; for example, “Smith.”
%CommunicationEmail% Communication Email of the participant; for example, 

“jsmith@example.org.”
%Userid% User ID of the participant; for example, “jsmith@example.org.”
%Title% Title in the participant's profile; for example, “Sales Director.”
%CompanyName% Name of the participant's company; for example, “Acme 

Industries.”
Current Activity Inserts a link to the current activity, such as “To complete this task, 

please click on the following link: [Click Here]” with instructions to 
the participant about how to link to the activity to complete it. 
Includes two links to the activity.
Important: If you have trouble with the links in this email, please 
copy and paste the following address into your browser to 
complete this task: %ActivityLink%

%Support Email% Inserts the email address for Active Community support.
Dear %FirstName% 
%LastName%

Activity Managed projects only.
Welcome message text for the project, which includes instructions 
to the participant about how to link to their To Do list of activities. 
Includes two links to the participant's To Do list. For example, 
“Welcome to the %ProjectName% A series of activities have been 
assigned to you. To access your To Do list, please click on the 
following link: [Click Here]
Important: If you have trouble with the links in this email, please 
copy and paste the following address into your browser to 
complete this task: %ProjectLink%”

Defining Activity Dependencies and Due Dates
In an activity managed project, you must define due dates for each activity. You 
have the option of specifying that project activities be completed in a sequence. To 
do this, you set dependencies, or prerequisite activities, that must be completed 
before an activity can start. Dependencies are optional. They are not needed for 
the first activity in a project.
Based on an activity's due date, participants are automatically emailed a reminder 
when the activity is upcoming or overdue. These reminders are sent based on the 
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notification settings in the Dependencies and Due Dates section of the Activities 
tab, which is described in this procedure.
Important: While the project is still in the planning stage, you can add and edit 
activities. After starting a project, you cannot change it (for example, you cannot 
add more activities or participants or edit the project kickoff email message). 

To define activity dependencies, due dates, and notifications
1 After “Adding an Activity to a Project,” click the Projects module.

The All Projects page opens. 
2 Find the project that includes an activity for which you want define due dates and 

dependencies. You have several options:
■ If you created the project, click the Your Projects tab.
■ If someone else created the project, remain on the All Projects tab. In 

the Search for Projects field, start typing part of the project name, and 
then click Search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).

3 Select the name of the project to which you want to define activity due dates 
and dependencies.
The project opens to the Overview tab.

4 Click the Activities tab.
The Activities tab opens. It lists all activities associated with the selected 
project.

5 Click Dependencies and Due Dates.
The Project Activity Dependencies, Due Dates and Notifications page opens. It 
lists all activities that have been defined for the project.

1 32
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The parts of the page:

6 Complete the fields as follows:
a Find the activity for which you want to define a due date or dependency.
b Use the Dependencies drop-down list to select a dependency for the 

activity. The dependency must be completed before the activity can start. 
Example: You have two activities that need to be completed in sequence, 
Activity A and Activity B. To ensure Activity B starts after Activity A is 
complete, in the list, select Activity A as the dependency for Activity B.

c In Due Date, type the date you want the activity to be completed, such as 
a project start date or a future date. Use this format: “Jan 10, 2009." You 
can change this date later, but must change it before the project has 
started (see “Starting an Activity Managed Project” on page 306). 
Required.

d In Notification List, indicate if you want a reminder email message to be 
sent to participants before or after the activity due date (up to 90 days). 
For example, if you select the Days After box and type the number 1, a 
reminder will automatically be sent to all participants who have not 
responded to the activity the day after the activity is due. 
Note: To customize the text of the reminder email, see “Customizing 
Upcoming and Overdue Reminder Messages” on page 315.

7 Click Save Changes. 
A message indicates the activity dependencies and due dates were successfully 
updated.

Adding Participants to an Existing Activity
Activity participants are contacts in Active Community that receive all activity 
communications, such as email messages and surveys. Before you can start an 
activity, you must have added participants to it. 

To add participants to an existing activity
1 After creating a project as described in “Creating a Regular or Activity Managed 

Project” on page 287, click the Projects module.
The All Projects page opens. 

2 Find the project to which you want to add participants. You have several options:
■ If you created the project, click the Your Projects tab.
■ If someone else created the project, remain on the All Projects tab. In 

the Search for Projects field, start typing part of the project name, and 

Key Description
1 Select an activity that must be completed before this activity can begin (define a 

due date or dependency).
2 Due date for the activity. Use this format: “Jan 10, 2009."
3 Indicate the number of days before or after the activity’s due date that you want 

to send a reminder email to activity participants (up to 90 days).
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then click Search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).

3 Select the name of the project in which you want to add participants.
The project opens to the Overview tab. 

4 In the Name column, select the activity to which you want to add participants.
The Activity page opens to the Overview tab.

5 Click the Participants tab.
6 Click Manage Participants.

The Manage Participants page opens 

7 Search for the people you want to add to the activity (see “Quick (Simple) 
Searches” on page 91 or “Advanced Searches” on page 93).
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8 Perform the appropriate action:

In the Participant Summary section, the “Number of participant(s) are already 
in this activity” are increased.

Adding Team Members to a Project
A team member is a person in your company who assists the project owner in 
maintaining the project. For example, you may want a team member to:
■ Monitor survey responses in the project
■ Re-send email messages to trading partners
■ Create activities and surveys
Typically, team members are fellow employees who can help in fostering 
communication with your suppliers or business contacts. 
Note: A team member can perform most of the actions as a project owner, such 
as creating a survey and starting an activity. Team members cannot delete a project 
or reopen an activity (see “Editing Permissions for Community Security Roles” on 
page 56).

If you want to 
add... Do this:
One participant 1 Click Add for a participant’s name.

A confirmation dialog opens and asks if you want to add 
the participant to the activity. 

2 Click OK. 
The participant is added.

Multiple participants 1 Select the check boxes for the participants you want to 
add.

2 In the Actions drop-down list, select Add Participants, 
and then click OK.

A confirmation dialog opens and asks if you want to add 
the participants to the activity.

3 Click OK. 
The participants are added.

All participants 1 In the Participant Summary section, click Add number of 
Participants, where number of is the number of 
participants not yet in the activity.
A confirmation message opens.

2 Click OK.
The participants are added.
Note: Because the list can span over multiple pages;, you 
might not see all of the contacts on one page.
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To add team members in an existing project
1 After creating a project as described in “Creating a Regular or Activity Managed 

Project” on page 287, click the Projects module.
The All Projects page opens. 

2 Find the project to which you want to add team members. You have several 
options:

■ If you created the project, click the Your Projects tab.
■ If someone else created the project, remain on the All Projects tab. In 

the Search for Projects field, start typing part of the project name, and 
then click Search.

3 Select the name of the project to which you want to add team members.
The project page opens to the Overview tab.

4 Click the Team tab.
The Project Team Members page opens.
Note: You can search for the additional team members by using Quick or 
Advance search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).

5 Click Manage Team Members.
The Team Members page opens.

Note: Only employees in your company can be team members. Team 
members cannot be vendors or suppliers or external contacts. 
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6 Click Add for the contact you want to add.
Note: If you want to add all of the available team members, click Add 
number of Team Members where number of is the number of available team 
members not yet added. To remove all of the team members, click Remove 
number of Team Members where number of is the number of team 
members already in the project.

7 When you have finished selecting team members, click Done Managing 
Team Members.
The team members will now receive the same communications as the project 
owner. 

Editing Project Settings
Use this procedure to change project settings, including:
■ To/from email addresses
■ Enable or disable activity management for a project:

■ Start date
■ Enable automatic rescheduling
■ Send project kickoff email

■ Copy team members on all communications

To edit project settings
1 After “Creating a Regular or Activity Managed Project,” click the Projects module.

The All Projects page opens. 
2 Find the project that you want to edit. You have several options:

■ If you created the project, click the Your Projects tab.
■ If someone else created the project, remain on the All Projects tab. In 

the Search for Projects field, start typing part of the project name, and 
then click Search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).

3 Select the name of the project you want to edit.
The project opens to the Overview tab.

4 Click Edit.
The Edit Project page opens.

5 Change the project settings as appropriate, and then click Save Changes.
A message indicates you have successfully modified the project’s settings.

Editing Activity Settings
Use this procedure to change activity settings within a project, including:
■ Activity type:
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■ Send an email
■ Send a profile update reminder
■ Complete a web form

■ Activity settings: 
■ Set a different ‘Reply to’ and ‘From’ email address for the activity than the 

default project email
■ Collect company or individual level responses
■ Require participants to log in to Active Community
■ Send an email with a link to a web form (survey)
■ Send an email and mark an activity as complete
■ Send a copy of the email to contacts who are not users of Active 

Community

To edit activity settings
1 After “Adding an Activity to a Project” on page 290, click the Projects module.

The All Projects page opens. 
2 Find the project that includes the activities you want to edit. You have several 

options:
■ If you created the project, click the Your Projects tab.
■ If someone else created the project, remain on the All Projects tab. In 

the Search for Projects field, start typing part of the project name, and 
then click Search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).

3 Select the name of the project that contains the activities you want to edit.
The project opens to the Overview tab.

4 Click the Activities tab, and then select the activity you want to edit.
The activity opens to the Overview tab.

5 Click Edit.
The Edit Activity page opens.

6 Change the activity settings as appropriate, and then click Save.
You have modified the activity’s settings.
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Starting a Regular Project
A regular project, or one that is ongoing, must have at least one activity and one 
participant before it can be started.

1

Important: Before starting a regular project:

To start a regular project
1 After creating a project as described in “Creating a Regular or Activity Managed 

Project” on page 287, click the Projects module.
The All Projects page opens. 

2 Find the regular (ongoing) project you want to start:
■ If you created the project, click the Your Projects tab.
■ If someone else created the project, remain on the All Projects tab. In 

the Search for Projects field, start typing part of the project name, and 
then click Search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).

3 Select the activity in the regular project you want to start. 
Note: The project must have at least one activity and one participant 
associated with it.

4 Click Start.

A message indicates that you are about to send an email to one or more 
participants and asks you to confirm the action.

5 Click OK.

Key Description
1 Regular projects must include at least one activity and one participant before they can be started.
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Active Community starts the activity based on the criteria you defined for the 
project. The page refreshes and shows the percentage complete for the 
activity. 

Starting an Activity Managed Project
Activity managed projects can be started immediately, or they can be scheduled to 
automatically start at a future date. 
Important: In an activity managed project, the activity is started when the 
project is started, or when the previous activity is complete. After starting an 
activity, you cannot remove participants from it.
Topics include:
■ “Starting Activity Managed Project Immediately” on page 306
■ “Starting Activity Managed Projects on a Future Date” on page 307

Starting Activity Managed Project Immediately

To start an activity managed project immediately
1 After creating a project as described in “Creating a Regular or Activity Managed 

Project” on page 287, click the Projects module.
The All Projects page opens. 

2 Find the project you want to start immediately. You have several options:
■ If you created the project, click the Your Projects tab.
■ If someone else created the project, remain on the All Projects tab. In 

the Search for Projects field, start typing part of the project name, and 
then click Search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).

3 Select the activity managed project you want to start. 
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On the project page, the Start Project button displays when the Start Date of 
the project is today's date (or earlier).

4 Click Start Project.

Active Community automatically starts the first activity. 
Important: If Send Project Kickoff Email was selected for the project, all 
project participants receive the project kickoff email message that you 
composed as part of you creating the project (see “Creating a Regular or 
Activity Managed Project” on page 287). The message contains a link to the 
participant's To Do list of activities in Active Community.

Starting Activity Managed Projects on a Future Date

To start an activity managed project on a future date
1 After creating a project as described in “Creating a Regular or Activity Managed 

Project” on page 287, click the Projects module.
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The All Projects page opens. 
2 Find the project you want to start on a future date. You have several options:

■ If you created the project, click the Your Projects tab.
■ If someone else created the project, remain on the All Projects tab. In 

the Search for Projects field, start typing part of the project name, and 
then click Search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).

3 Select the activity managed project you want to start. 
Important: On the project page, the Schedule Project button displays 
when the Start Date of the project is later than today's date. 

4 Click Schedule Project.

After the project is scheduled, it will automatically start on the date shown in 
the project's Start Date. You do not have to manually start the project on that 
date. 
Example: In the screen shot, Active Community will start the project and send 
the project kickoff email to all participants on April 20 (if the Send Project 
Kickoff Email option was selected for the project).

5 To change the start date of the project or any other information, such as add 
activities or edit the project kickoff email message, click Alter Project and 
then edit the project.
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Copying a Project to Create a New One
Note: To copy a project, you must have View Project and Add Project permissions 
in Active Community (see “Editing Permissions for Community Security Roles” on 
page 56).
You can create a project quickly and easily by copying an existing one. When you 
copy a project, the following items are copied into the new project:
■ Project name and description
■ Activities (including activity dependencies and due dates, but not activity 

reminders if part of an activity-managed project)
■ Messages
■ Web forms
■ Files
■ Project permissions
Any activities that were currently in progress are reset, and no responses are 
copied to the new project. 
Web forms retain their status; that is, published web forms retain their published 
status when the project is copied and unpublished web forms remain unpublished.

To copy a project
1 After creating a project as described in “Creating a Regular or Activity Managed 

Project” on page 287, click the Projects module.
The All Projects page opens. 

2 Find the project you want to copy. You have several options:
■ If you created the project, click the Your Projects tab.
■ If someone else created the project, remain on the All Projects tab. In 

the Search for Projects field, start typing part of the project name, and 
then click Search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).

3 Select the name of the project you want to copy.
The project opens to the Overview tab.

4 Click Copy. 
The Create New Project tab opens.
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5 Enter the new name and description for the new project.

6 Click Copy. 
A new project is created with the new name.
Note: The new project has the same activities, participants, messages, web 
forms, and permissions. Activities that were in progress are reset. Activity 
reminders are not copied.

Copying an Activity to Create a New One
Note: To copy an activity, you must have View Activities and Add Activities project 
permissions (see “Editing Permissions for Community Security Roles” on page 56).
You can create an activity quickly and easily by copying an existing one within the 
same project. When you copy an activity, the following items are copied into the 
new activity:
■ Name and description
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■ Dependencies and due dates (but not activity reminders, if part of an activity-
managed project)

■ Participants
■ Messages
■ Files
You can copy an activity even if it is in-progress. When an activity is copied, the 
new activity will be reset and have no responses.

To copy an activity
1 After creating a project as described in “Creating a Regular or Activity Managed 

Project” on page 287, click the Projects module.
The All Projects page opens. 

2 Find the project from which you want to copy an activity. You have several options:
■ If you created the project, click the Your Projects tab.
■ If someone else created the project, remain on the All Projects tab. In 

the Search for Projects field, start typing part of the project name, and 
then click Search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).

3 Select the name of the project from which you want to copy an activity.
The project opens to the Overview tab.

4 Click the Activities tab.
The activities list page opens.

5 Open the activity which you want to copy.

6 Click Copy.
The Copying Activity opens to the Overview tab.

7 Enter the name and description of the new activity, and click Copy. 
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A new activity is created in the project. The new activity has the same 
participants, messages, files, dependencies, and due dates as the original. 
Activity reminders are not copied.

Suspending or Activating Activity Participants
As a hub or activity owner, you can suspend one or more participants from an 
activity that is in-progress. 
Suspended participants will not receive any communications, and they will not be 
able to participate in the activity. In addition, the activity link sent in the earlier 
communication will be disabled. If you reactivate a suspended participant, the links 
will be enabled again.

To suspend or activate activity participants for in-progress activities
1 After creating a project as described in “Creating a Regular or Activity Managed 

Project” on page 287, click the Projects module.
The All Projects page opens. 

2 Find the project from which you want to suspend or activate participants. You have 
several options:

■ If you created the project, click the Your Projects tab.
■ If someone else created the project, remain on the All Projects tab. In 

the Search for Projects field, start typing part of the project name, and 
then click Search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).
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3 Select the name of the project from which you want to suspend or activate 
participants.
The project opens to the Overview tab.

4 Click the Activities tab.
The activities list page opens.

5 Open the activity that contains the participant you want to suspend or activate.
Important: Remember, the activity must be in-progress.

6 Click the Participants tab.
The Activity Participants page opens. 

7 Click Manage Participants. 
The Manage Participants page opens. 

8 Find the participant(s) you want to suspend or activate by following the 
instructions in the table.

If you want to... Do this on the Manage Participants page:
Suspend current 
participants

■ On the Participant Summary page, click the View link for 
participants who are already in this activity.

The list of current activity participant(s) opens.
Activate participants 
who are currently 
suspended

■ On the Participant Summary page, click the View link for 
participants who are suspended from this activity.

The list of participant(s) who are suspended opens.
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9 Perform the appropriate action to suspend or activate participants:

On the Manage Participants page, the number of participants who “are already 
in this activity” and the number of participants who “are not yet in this activity” 
adjusts based on your selections.

Suspending or Restarting an Activity
You can suspend an activity in a regular project after it has been started. If you 
suspend the activity, contacts will no longer be able to access it. If you change 
your mind, you can restart the suspended activity.

To suspend or restart an activity in a regular project
1 After creating a project as described in “Creating a Regular or Activity Managed 

Project” on page 287, click the Projects module.

To suspend or activate... Do this:
One participant 1 Click Suspend (or Activate) for a participant’s 

name. 
A confirmation dialog opens and asks if you want to 
suspend (or activate) the participant. 

2 Click OK. 
In the contact list, the participant is suspended (or 
activated).

Multiple participants 1 Select the check boxes for the participants you want 
to suspend (or activate).

2 In the Actions drop-down list, select Suspend 
Participants (or Activate Participants).

A confirmation dialog opens and asks if you want to 
suspend (or activate) the participant. 

3 Click OK. 
In the contact lists, participants are suspended (or 
activated).

All participants 1 Select the “check all” check box for Contact Name (in 
the header).

2 In the Actions drop-down list, select Suspend 
Participants (or Activate Participants).

3 Click OK.
In the contact lists, participants are suspended (or 
activated).
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The All Projects page opens. 
2 Find the regular (ongoing) project from which you want to suspend an activity:

■ If you created the project, click the Your Projects tab.
■ If someone else created the project, remain on the All Projects tab. In 

the Search for Projects field, start typing part of the project name, and 
then click Search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).

3 Select the regular project you want.
4 Click the Activities tab.

The Activities page opens. It lists the status of the activities in the project.

5 Perform the appropriate action:

Customizing Upcoming and Overdue Reminder Messages
In an activity managed project, you can customize the upcoming and overdue 
reminder messages for each activity. A reminder email can be sent up to 90 days 
before or after an activity’s due date (see “Defining Activity Dependencies and Due 
Dates” on page 297).

To customize upcoming or overdue reminder messages
1 After creating a project as described in “Creating a Regular or Activity Managed 

Project” on page 287, click the Projects module.
The All Projects page opens. 

2 Find the project from for which you want to customize the reminder message. You 
have several options:

■ If you created the project, click the Your Projects tab.

If you want to... Do this:
Suspend the activity 1 On the Activities tab, click Suspend for the activity 

you want to suspend.
A message indicates contacts will no longer be able 
to access the activity.

2 To suspend the activity, click OK.
Active Community suspends the activity.

Restart an activity that has 
been suspended

■ On the Activities tab, click Resume for the activity 
you want to resume
Active Community restarts the activity.
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■ If someone else created the project, remain on the All Projects tab. In 
the Search for Projects field, start typing part of the project name, and 
then click Search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).

3 Select the name of the project that includes the activity for which you want to 
customize the reminder message.
The project opens to the Overview tab.

4 Click the Activities tab.
The activities list page opens.

5 Select the activity that contains reminder message.
6 In the activity, click the Messages tab.
7 Do one of the following:

If a message... Do this:
Already exists  Click Edit for the message you want to customize.

Does not exist Click Create Upcoming or Create Overdue. 
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8 Customize the text of the reminder message (see “Merge Field Descriptions” on 
page 297).

Important: There are two ways to customize the text of the email message. 
You can type the name of any merge field in the text box under Available Mail 
Merge Fields, or you can use the Insert buttons to insert the merge fields 
quickly. 

9 Under Available Merge Fields, in Select Field Type, select Company or 
Contact.

a Put your cursor in the email message where you want to insert the field.
b Use either the text box to insert merge fields or use the Insert buttons. 

10 When the message is complete, click Save to save your changes. 
Your changes are saved. The email message will be sent on the notification 
date defined in “Defining Activity Dependencies and Due Dates” on page 297.

To use the... Do this:
Text box 1 Start typing the name of a field. The box automatically 

fills with field names that contain the characters you 
type. 

2 Select a field name, and click Insert Field.
The mail merge field displays in the body of the email.

Insert buttons 1 Select the name of the merge field you want to insert, 
such as Email.

2 Click the Email button.
The mail merge field displays in the body of the email.
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Customizing a Project Kickoff Message
In an activity managed project, you can customize the project kickoff message any 
time before starting the project. If the Send Project Kickoff Email option is selected 
in the project options, the kickoff email message is automatically sent to all project 
participants after the project is started.

To customize the project kickoff message
1 After creating a project as described in “Creating a Regular or Activity Managed 

Project” on page 287, click the Projects module.
The All Projects page opens. 

2 Find the project from for which you want to customize the project kickoff message. 
You have several options:

■ If you created the project, click the Your Projects tab.
■ If someone else created the project, remain on the All Projects tab. In 

the Search for Projects field, start typing part of the project name, and 
then click Search (see “Quick (Simple) Searches” on page 91 or “Advanced 
Searches” on page 93).

3 Select the name of the project that includes the project kickoff reminder 
message.
The project opens to the Overview tab.

4 In the project, click the Messages tab.
The Project Email Messages page opens.

5 Click Edit for the kickoff message you want to edit.
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6 Customize the text of the project kickoff message (see ““Merge Field 
Descriptions” on page 297). The default message contains a link to each 
participant's To Do list of activities. 

Important: There are two ways to customize the text of the email message. 
You can type the name of any merge field in the text box under Available Mail 
Merge Fields, or you can use the Insert buttons to insert the merge fields 
quickly. 

7 Under Available Merge Fields, in Select Field Type, select Company or 
Contact.

a Put your cursor in the email message where you want to insert the field.
b Use either the text box to insert merge fields or use the Insert buttons. 

8 When the message is complete, click Save to save your changes. 
Your changes are saved. The email message will only be sent when you start 
the project (if Send Project Kickoff is enabled in the project).

To use the... Do this:
Text box 1 Start typing the name of a field. The box automatically 

fills with field names that contain the characters you 
type. 

2 Select a field name, and click Insert Field.
The mail merge field displays in the body of the email.

Insert buttons 1 Select the name of the merge field you want to insert, 
such as Email.

2 Click the Email button.
The mail merge field displays in the body of the email.
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Workspaces 9
A workspace is a group-editable Web page where you and groups of people in your 
community can interact and share information. 

Examples of when you might use a workspace include:
■ Feedback & Innovation—Provide a collaborative place where buyers and 

suppliers can review new product capabilities, comment on their design and help 
influence overall product strategies.

■ RFP Responses—Create a place where distributed teams come together to share 
market and competitive intelligence information on RFP’s to better address 
prospective opportunities and improve win rates.

■ Relationship Management—Develop an environment where the entire 
community comes together to resolve issues and define strategies that better 
service and support suppliers or end customers.

All workspaces are private and can only be seen by people who have been 
explicitly invited to participate in it by the workspace administrator. Your ability to 
view and participate in a workspace (such as reply to a conversation topic or share 
a file with your partners and suppliers) is controlled by permissions that you have 
been assigned by the workspace administrator. For details on workspace 
permissions, see “Workspace Roles” on page 81.
Topics include:
■ “Workspace Overview” on page 322
■ “Adding, Editing, and Deleting Events” on page 325
■ “Setting Workspace Email Notifications” on page 330
■ “Adding People to a Workspace” on page 332
■ “Sharing Workspace Files” on page 335
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■ “Receiving Emails of Recent Workspace Changes” on page 338
■ “Starting or Replying to a Conversation” on page 340
■ “Switching Between Different Workspaces” on page 345

Workspace Overview
The following topics describe the “Parts of a Workspace” and “Workspace 
Permissions.”

Parts of a Workspace
Following are descriptions of all of the items in a workspace. Keep in mind that 
your workspace may look differently, based on your permissions. For example, you 
may not see “Add Event” if you are not allowed to create events (that is, do not 
have Add Event workspace permission).
A workspace includes these main areas:
■ “Name and Description” on page 322
■ “Conversations” on page 322
■ “Upcoming Events” on page 323
■ “Files and File Libraries” on page 323
■ “File Library Folders” on page 323
■ “Recent Activity” on page 324
■ “Members” on page 324
■ “Menu” on page 324

Name and Description
Name of the workspace and a description (optional). The name and description 
usually indicate the context and scope of the workspace. For example, suppose a 
workspace was created for you and a major supplier to discuss product offerings 
for surgical bandages. The name of the workspace might be “Surgical Bandages - 
Product Design and Review” and the description might provide detail as to orient 
people to the purpose of the workspace.
The person who creates the workspace specifies the name and description; this 
person is known as the Workspace Administrator. The name and description can be 
changed by the Workspace Administrator, or any person with an Edit Workspace 
permission.

Conversations
Topics that workspace members have created to encourage discussion and 
feedback, similar to an online forum. Within a conversation, you can include links 
to Web sites of interest, attach documents and images, embed videos, and other 
media. In addition, you can leverage your workspace file library by linking to 
shared documents and files that are already stored in the workspace.
For details, see “Starting or Replying to a Conversation” on page 340.
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Upcoming Events
Meetings and important dates. For example, suppose you have a workspace 
devoted to planning a response to an RFP; one event might be a Gold Team 
Review in the conference room on Tuesday.
When you create an event, you can designate people in contact roles in your 
workspace (such as all COOs) to be notified of an upcoming event by email, similar 
to a meeting reminder message in Microsoft Outlook. For example, in a workspace 
devoted to Compliance, you might want all Account Managers to be reminded of 
an upcoming meeting to discuss supplier compliance with a purchase order policy. 
For details, see “Adding, Editing, and Deleting Events” on page 325.

Files and File Libraries
Documents, images, spreadsheets, and other files that are shared with members 
of the workspace are placed in the File Library. These files can be seen by all 
members and can provide a central reference library for your partners and 
suppliers. For example, in a workspace for planning a sales event, the official logo 
and collateral for the event can be added to the File Library.
To facilitate reviews and participation, you can add different versions of the same 
file in the File Library. For example, suppose you have a PowerPoint sales 
presentation that you want workspace members to review. They can each revise 
the sales deck and add it to the File Library. The Library will show the original file 
and all revised files that were added by reviewers as versions in a simple 
collapsible view. For details, see “Sharing Workspace Files” on page 335.
You can also conveniently insert a link to any file in the library in any conversation 
topic. For details, see “Starting or Replying to a Conversation” on page 340.

File Library Folders
You can organize files within a B2B workspace library into folders. For example, 
within a B2B Workspaces focused on trading partner performance collaboration 
you might create a folder for each performance category. As you add new files to 
the workspace, either from the home page or the library, you simply provide the 
name of the folder you want the files to be placed. Note, if you want the same 
document to exist in two folders, you must save it to each folder location.

All files in folders can be sorted by file name, date posted, who posted and file size. 
Additionally, you can delete folders by simply clicking a button. Deleting a folder 
will prompt you to delete all the files in that folder.
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Recent Activity
A summary of all of the recent changes in the workspace. For example, the Recent 
Activity area might show:
■ People recently added to the workspace
■ Replies to conversation topics, and who replied
■ Files recently deleted
■ Events added
Instead of having to check the Recent Activity area in the workspace, you can 
choose to receive email messages summarizing the recent changes. To specify 
when you want to receive email notifications (instantly, daily, or none at all), click 
Preferences on the Menu. For details, see ““Receiving Emails of Recent Workspace 
Changes” on page 338.

Members
A list of all people from your community in the workspace. Keep in mind that based 
on your workspace permissions, you may be only able to view or participate in 
certain areas of the workspace. For example, if you are only able to view content in 
the workspace, you may not be able to add people to the workspace. (That is 
usually reserved for Workspace Administrators.) For details, see “Workspace 
Permissions” on page 324.
If you hover your mouse over each person's picture in the Members area, you can 
see part of their contact profile (name, email address, title). If you click their 
name, you can view their entire profile (provided that you have View Contacts 
permission).

Menu
A list of options for workspace preferences, settings, and navigation, including:
■ Workspace Preferences—How often you would like to be notified of recent 

workspace activity by email. 
■ Navigation—Navigate back to your projects, your profile, or other Active 

Community applications. 
■ Workspace Settings—Configure default email notifications, set permissions for 

workspace members, and change the workspace logo (Workspace or Community 
Administrator roles).

Workspace Permissions
Everything in a workspace is controlled by permissions, or rights. To view or use 
part of the workspace, you must have explicit permission to do so, granted by the 
workspace administrator. For example, if you do not see a link to add an event, you 
do not have Edit Events permission in the workspace. For details, see “Workspace 
Roles” on page 81.
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Adding, Editing, and Deleting Events
An event can be a sales meeting, product review session, upcoming supplier 
conference, or any other important date or engagement on your schedule.
Workspace events can inform and alert your partners and suppliers of upcoming 
meetings and conferences in which they need to participate. For example, in a 
workspace devoted to planning a response to an RFP; one event might be a Gold 
Team Review in the conference room on Tuesday.
When you create an event, you can designate people in business roles in your 
workspace (such as all COOs) to be notified of an upcoming event via email, 
similar to a meeting reminder message in Microsoft Outlook. For example, in a 
workspace devoted to Compliance, you might want all Account Managers to be 
reminded 2 days in advance of a meeting to discuss supplier compliance with a 
purchase order policy.

Note: To add, edit, and delete events, you must have Edit Events permission in 
the workspace. Typically, this is allowed for people in all workspace roles except 
Observer. For details, see “Workspace Roles” on page 81. 

To add an event
1 Click Applications > Workspaces.
2 On the workspace home page, click Add Event.

Note: If you do not see the link, then you do not have Edit Events permission 
in the workspace. For details, see “Workspace Roles” on page 81. 

3 Type the name of the event (up to 60 letters) and a description (for example, 
the location and purpose of the meeting). Specify the starting date and time 
and click Add Event. 
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The event is added to the event list in your workspace. You can skip the rest of 
this procedure.
Note: If you want to specify an end date and time, or remind people by email 
that the event is approaching, then skip to Step 3 to add an event. If you've 
already added an event, you can edit it. 

4 To add an event, click View All Events.

5 Click Add Event.
Note: If you do not see the link, then you do not have Edit Events permission 
in the workspace. For details, see “Workspace Roles” on page 81. 
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6 Type the name of the event (up to 60 letters) and a description (for example, 
the location and purpose of the meeting). Specify the starting and ending date 
and time. Keep in mind that you cannot specify a date or time in the past. 

7 If you want to designate people in business roles in your workspace (such as all 
COOs) to be reminded of the upcoming event by email, click Require email 
notification. 
The email notification is similar to a meeting reminder message in Microsoft 
Outlook. For example, in a workspace devoted to Compliance, you might want 
all Account Managers to be reminded 2 days in advance of a meeting to discuss 
supplier compliance with a purchase order policy.

■ To specify where the email is sent—Select the number of days before the 
Start Date that an email reminder will be sent. Only one reminder will be 
sent per event. For example, if you select 2 days before, and the Start Date 
is 10/31, then the email will be sent on 10/29.

■ To specify who receives the email—From the scrolling list, select the 
business roles that represent the people you want to alert to the upcoming 
event. For example, if a meeting requires Supply Managers and Primary 
Contacts to attend, you might select those roles from this list. Only people 
in the workspace with those business roles will receive the email; those 
outside your workspace will not.
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8 Click Add Event.

The event is added to the summary and detailed event lists on the page. The 
bell icon indicates that an email reminder will be sent to alert people of the 
upcoming event.

To edit an event
Note: You cannot edit events that occur in the past. For example, if today is 
October 20, you cannot change an event that occurred on October 18. 
1 Click Applications > Workspaces.
2 On the workspace home page, open an event.
3 On the Events page, hover your mouse over the title of the event. Click Edit.

Note: If you do not see the link, then you do not have Edit Events permission 
in the workspace. For details, see “Workspace Roles” on page 81. 

4 If desired, change the name of the event (up to 60 letters) and the description 
(for example, the location and purpose of the meeting). Specify the starting 
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and ending date and time. Keep in mind that you cannot specify a date or time 
in the past.

5 If you want to designate people in business roles in your workspace (such as all 
COOs) to be reminded of the upcoming event by email, click Require email 
notification.
This email notification is similar to a meeting reminder message in Microsoft 
Outlook. For example, in a workspace devoted to Compliance, you might want 
all Account Managers to be reminded 2 days in advance of a meeting to discuss 
supplier compliance with a purchase order policy.
Sample Email 

■ To specify WHEN the email is sent... Select the number of days before the 
Start Date that an email reminder will be sent. Only one reminder will be 
sent per event. For example, if you select 2 days before, and the Start Date 
is 10/31, then the email will be sent on 10/29.

■ To specify WHO receives the email... From the scrolling list, select the 
business roles that represent the people you want to alert to the upcoming 
event. For example, if a meeting requires Supply Managers and Primary 
Contacts to attend, you might select those roles from this list. Only people 
in the workspace with those business roles will receive the email; those 
outside your workspace will not

6 Click Update Event.
The event is updated in the summary and detailed event lists on the page. The 
bell icon indicates that an email reminder will be sent to alert people of the 
upcoming event.
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To delete an event
1 Click Applications > Workspaces.
1 On the workspace home page, open an event.
2 On the Events page, hover your mouse over the title of the event. Click Delete.

Note: If you do not see the link, then you do not have Edit Events permission 
in the workspace. For details, see “Workspace Roles” on page 81. 

3 Confirm that you want to delete the event and click OK.

The event is removed from the Events list. Keep in mind that event reminder 
emails may have already been sent, if you specified them to be sent days 
before the Start Date.

Setting Workspace Email Notifications
As a Workspace Administrator, you can keep everyone in the workspace “in the 
loop” and informed about recent changes by sending automatic email alerts that 
show workspace activity. You can send emails instantly (every time a change 
occurs in the workspace) or daily (a summary of the day's activity). Or, you can 
specify that you don't want members to receive any email. You indicate this in your 
Workspace Settings.
Daily Notification 
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Specifying notification settings (such as Daily Notification) does not guarantee that 
all workspace members will receive emails; workspace members can override your 
notification setting by updating their Preferences. For details, see “Receiving Emails 
of Recent Workspace Changes” on page 338.
Note: Keep in mind that if you specify No Notification, you and other workspace 
members may still receive email reminders about upcoming events, based on their 
contact role in their profile. For example, someone in your workspace might create 
a Sales Meeting event and specify all Sales Reps to receive an email notification. If 
you have a contact role of Sales Rep in your profile, then you will receive an 
upcoming event reminder via email. 

To set workspace email notifications
1 After clicking Applications > Workspaces, and opening a workspace, click 

Menu, and then click Workspace Settings. 

2 On the Workspace Settings page, specify how often you want workspace 
members to receive notifications about workspace activity. 

The following table describes the available options.
Click... To...
No Notification Not send any email about workspace activity. The exception is 

event reminders; depending on a person's contact role in their 
profile, they may receive upcoming event reminders for the 
workspace. This is controlled by the person who creates the 
event. For details, see “Adding, Editing, and Deleting Events” on 
page 325.
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3 Click Save.

Adding People to a Workspace
A workspace member is a person in your community (i.e., someone who already 
has a contact profile) who participates in or views your workspace. Typically, they 
are fellow trading partners, suppliers, customers, or internal staff who need to 
collaborate around a central purpose or concept. For example, you may invite 
someone to:
■ Comment on a conversation topic on how to innovate the supply chain
■ Add a file containing the latest product logos and price sheet
■ Post a meeting announcement for a Gold Team RFP review 
When adding a member, you automatically assign a role to them which grants 
them access to part or all of the workspace. For details, see “Workspace Roles” on 
page 81.
Note: You cannot add disabled contacts (that is, any contact that is unavailable in 
your Contacts list) or external contacts (that is, a contact that is not in your 
community) to your workspace. 
In order to add people, you must have Add Members permission in the workspace. 
Typically, this is granted to Community and Workspace Administrators.

Daily Notification Send a daily email (usually in the evening) summarizing all of the 
changes to the workspace over the past 24 hours. The email 
contains:

■ The name of the workspace 
■ A list of changes, such as events added, conversations 

started, and people added 
■ The names of the people who made the changes 
■ Links to updated conversations

Instant Notification Send an email every time a change occurs in the workspace. For 
example, if someone is added to the workspace, members will 
automatically receive a single-line email notifying them of the 
change. Similarly, if someone replies to a conversation topic, 
members will receive an email with a link to the updated 
conversation.
Important: Depending on the level of participation in your 
workspace, this setting may result in a large number of email 
notifications. You might consider switching to Daily Notification if 
the number of emails becomes overwhelming.

Click... To...
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To add people to a workspace
1 After clicking Applications > Workspaces, and opening a workspace, click 

Menu, and then click Workspace Settings. 
2 If you know the email address of the person that you want to add as a member, 

click Add Member on the workspace home page. Type the email address and 
click Add Member.

If the email address is matched to a contact profile in your community, the 
person is added to the workspace (with an Editor role, which allows them to do 
most tasks except add and remove people). You can skip the rest of this 
procedure.

3 If you don't know the email address of the person you want to add, click 
View/Manage Members. 

4 On the Members page, search for the people you want to add from the 
Community Directory. To do this, do one of the following:

■ Type the name, email address, or company name of the people you want 
to find and click Search. Keep in mind that this will search both the 
Existing Members and the Community Directory. 

■ Click a tag to show all contacts in Existing Members and the Community 
Directory that are assigned that tag. These tags are the same as those in 
your community Contacts list. (To create tags, you must close the 
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workspace and go back to your community Contacts list. For details, see 
“Tagging Search Results with Keywords” on page 107.

5 In the search results list, click the check boxes for the people you want to add. 
In the drop-down list of roles (Editor, etc.), select the level of access that you 
want them to have in your workspace. For example, if you want a contact to 
only be able to view the workspace content, click Observer. For details, see 
“Workspace Roles” on page 81.
Note: If you add someone from the Community Directory who is already in 
your workspace, keep in mind that whatever role you selected when you added 
the person will change their role to the new one. For example, if Joe Smith is an 
Editor in the workspace, and you select Joe Smith from the Community 
Directory and add him as an Observer, then Joe Smith's new role in the 
workspace will be Observer. 

6 Click Add. These people are now part of the workspace and can participate in it 
as their role allows (such as starting conversations, adding events, etc.). For 
details, see “Workspace Roles” on page 81.
Note: If you have set your Workspace Settings to send email notifications 
about workspace activity, then your newly-added members will also receive 
those emails. Each member can change how often they receive notifications via 
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their Preferences. For details, see “Receiving Emails of Recent Workspace 
Changes” on page 338. 

Sharing Workspace Files
You can easily share documents, logos, product images, and other files with your 
partners and suppliers by adding files to the File Library in the workspace. When 
you add them to the File Library, everyone in the workspace can see them 
automatically. In addition, you can quickly link to any document in the File Library 
within a conversation, saving time and disk space. 
You can also store multiple versions of the same document, enabling you to collect 
review comments from distributed teams and keep an auditable “paper trail” of 
changes. If you want to add a new version, simply follow “Adding a File to a 
Workspace” on page 336.
Topics include:
■ “Workspace File Types” on page 335
■ “Deleted Files” on page 336
■ “Adding a File to a Workspace” on page 336
■ “Deleting a File from the Workspace” on page 337
■ “Getting Previous Versions of a File” on page 337

Workspace File Types
You can add any kind of file - document, spreadsheet, image, or video, to name a 
few. The only limitation is that the file must be under 50 MB in size. 
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Deleted Files
When you delete a file from the File Library, it is permanently removed from the 
workspace. It can no longer be seen by people and any links to the file within 
conversations are removed. If you delete a file with multiple versions (hover over 
the file name to detect versions), then only the most recent version is deleted; the 
previous version of the file then becomes active.
If you want to delete all versions of a file, you must delete them individually.
Note: To add or delete a file, you must have Add Files or Delete Files permission 
in the workspace, respectively. Typically, this is allowed for all workspace roles 
except Observer. For details, see “Workspace Roles” on page 81. 

Adding a File to a Workspace
To add a file to a workspace 
1 Click Applications > Workspaces, and then click Add File.

Note: If you do not see the link, then you do not have Add Files permission in 
the workspace. For details, see “Workspace Roles” on page 81. 

2 In the Upload a File box, click Browse. Navigate to the file on your computer, 
and click Open.
Note: Your file must be 50 MB or less in size. 

■ If you want to add several files at once... Click Upload Another File for 
each file that you want to add.

■ If you want to add a new version of a shared file already in the 
workspace... Simply add the file as if it was a new file to the library. The 
File Library will automatically detect that the file already exists in the 
workspace, and add your file as the newest version (“at the top”).

3 Click Upload File. The file or files that you specified now display in the File 
Library, with icons to show the type of file (document, spreadsheet, etc.). If you 
added a file that is already in the library, it is added as the most current version 
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of that file. To view older versions, see “Getting Previous Versions of a File” on 
page 337.
Now that your files are in the library, you can link to them from within 
conversations. For details, see “Starting or Replying to a Conversation” on 
page 340.

Deleting a File from the Workspace
To delete a file 
1 Click Applications > Workspaces, and then hover your mouse over the 

name of the file. Click Delete.
Note: If you do not see the link, then you do not have Delete Files permission 
in the workspace. For details, see “Workspace Roles” on page 81. 

2 Confirm that you want to delete the file and click Delete again.

3 The file is removed from the File Library. If you had any conversation topics 
that contained links to the file, then those links are also removed. 
If the file had multiple versions, then only the current version is deleted; the 
previous version then becomes active in the File Library.

Getting Previous Versions of a File
An important feature of the File Library is the ability to add different versions of the 
same file. For example, suppose you have a PowerPoint sales presentation that you 
want workspace members to review. They can each revise the sales deck and add 
it to the File Library. The Library will show the original file and all revised files that 
were added by reviewers as versions in a simple collapsible view.



338 OpenText Active Community CE 21.2 User Guide

W O RK S P A C E S
Receiving Emails of Recent Workspace Changes

You can view or download copies of each version directly from the File Library. The 
most current version is always shown at the top of the collapsible list.
Note: When you delete a file with multiple versions from the File Library, only the 
most current version is deleted; previous versions are retained. If you want to 
delete all versions of a file, you must delete them individually. 

To get a previous version of a file
1 In the File Library, hover your mouse over the file and click Older Versions.

2 Click the file name of the version that you want to get. 

3 Open or save the file to your computer. Keep in mind that after you save the 
file, you can make changes to it and add it as a new version to the File Library.

Receiving Emails of Recent Workspace Changes
To keep up-to-date with recent workspace changes, you can receive alerts of 
workspace activity by email on an instantaneous basis (one email per change) or 
daily basis (one email with a summary of the day's activity). You indicate this in 
your workspace Preferences.
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Here is a sample daily notification 

If you do not specify a preference, you will receive email notifications based on the 
setting that the Workspace Administrator set when they created the workspace. 
For example, if the person who created the workspace set email notifications to be 
sent daily, then you will receive an email daily until you specify otherwise.
Note: Keep in mind that if you specify that you do not want to receive any 
notifications, you still may receive email reminders about upcoming events, based 
on your contact role in your profile. For example, someone in your workspace 
might create a Sales Meeting event and specify all Sales Reps to receive an email 
notification. If you have a contact role of Sales Rep in your profile, then you will 
receive an upcoming event reminder via email. For details, see “Adding, Editing, 
and Deleting Events” on page 325. 

To get recent changes by email
1 Click Applications > Workspaces,.
2 Open a workspace, click Menu, and then click Workspace Preferences. 

3 On the Preferences page, specify how often you want to receive emails about 
workspace activity.
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The following table describes the available options.

4 Click Save.

Starting or Replying to a Conversation
Collaboration around a topic in a workspace is known as a conversation.
A conversation is a topic that in a workspace about any subject or issue that you 
can post to collaborate with or obtain feedback from partners and suppliers. Similar 
to an online forum, your partners and customers can post replies to conversations 
to provide their input on a topic. 

Click... To...
No Notification Not receive any email about workspace activity. The exception is 

event reminders; depending on your contact role in your profile, 
you may receive upcoming event reminders for the workspace. 
This is controlled by the person who creates the event. For 
details, see “Adding, Editing, and Deleting Events” on page 325.

Daily Notification Receive a daily email (usually in the evening) summarizing all of 
the changes to the workspace over the past 24 hours. The email 
contains:
The name of the workspace 
A list of changes, such as events added, conversations started, 
and people added 
The names of the people who made the changes 
Links to updated conversations 

Instant Notification Receive an email every time a change occurs in the workspace. 
For example, if someone is added to the workspace, you will 
receive a single-line email notifying you of the change. Similarly, 
if someone replies to a conversation topic, you will receive an 
email with a link to the updated conversation.
Depending on the level of participation in your workspace, this 
setting may result in a large number of email notifications. You 
might consider switching to Daily Notification if the number of 
emails becomes overwhelming.

Workspace Setting Use the default notification setting that the Workspace 
Administrator set for the workspace. Every workspace has a 
default notification setting, such as Daily Notification or Instant 
Notification. When a person creates a workspace (the Workspace 
Administrator), he or she can specify how often they want 
workspace members to receive notifications. You can override 
this setting by selecting any of the other notification settings in 
Preferences.
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For example, you might start a conversation to:
■ Encourage ideas on how to innovate the supply chain with Sales and Marketing 

staff
■ Discuss the latest product logos and price sheet with suppliers
■ Collaborate on design refinements for the latest surgical bandage product

Within a conversation, you can include links to Web sites of interest, attach 
documents and images, embed videos, and other media. In addition, you can 
leverage your workspace file library by linking to shared documents and files that 
are already stored in the workspace.

Note: To start or reply to a conversation, you must have Start/Reply to 
Conversations permission in the workspace. Typically, this is allowed for all 
workspace roles except Observer. For details, see “Workspace Roles” on page 81. 
■ “Starting a Conversation” on page 342
■ “Replying to a Conversation” on page 344
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Starting a Conversation
To start a conversation
1 After clicking Applications > Workspaces, and opening a workspace, click 

Menu, and then click Start a Conversation.
Note: If you do not see the link, then you do not have Start/Reply to 
Conversations permission in the workspace. For details, see “Workspace Roles” 
on page 81. 

2 On the Start a New Conversation page, type the subject and body of the topic. 
Any links to web sites will be automatically converted to clickable links in the 
conversation, so you can easily paste links to web sites that you want your 
partners and suppliers to view.

3 If you want to include a document, image, video, or any other file, click Attach 
a File.
Note: If you do not see the link, then you do not have Add Files permission in 
the workspace. For details, see “Workspace Roles” on page 81. 

■ If you want to attach a new file, click Browse, navigate to the file on your 
computer, and click Open. If you also want to share the file with other 
partners and suppliers by adding it to the workspace File Library, click the 
Add a copy of this file to the library check box. This can be helpful if you 
know that you will need to share or reference a document in the future.

Note: Your file must be 50 MB or less in size. 
■ If you want to link to a shared file already in the workspace, select the 

check box for the file to which you want to include a link. All of the files 
listed have been added to the workspace File Library. When a partner or 
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supplier clicks the link, it will take them directly to the file in the File Library 
and open it.

4 If you want an email sent to you when others post feedback to your 
conversation, click the Notify me when people reply check box.
Sample Email Notification 

5 Click Post Topic. Any files that you attached or linked to automatically become 
clickable links in the topic. 
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Replying to a Conversation
To reply to a conversation 
1 After clicking Applications > Workspaces, and opening a workspace, hover 

your mouse over the title of the conversation. Click Reply.
Note: If you do not see the link, then you do not have Start/Reply to 
Conversation permission in the workspace. For details, see “Workspace Roles” 
on page 81. 

2 On the Conversation page, type the subject and content of your reply. Any links 
to web sites will be automatically converted to clickable links in the 
conversation, so you can easily paste links to web sites that you want your 
partners and suppliers to view.

3 If you want to include a document, image, video, or any other file, click Attach 
a File.

■ If you want to attach a new file... Click Browse, navigate to the file on your 
computer, and click Open. If you also want to share the file in the 
workspace File Library, click the Add a copy of this file to the library check 
box. This can be helpful if you know that you will need to share or 
reference a document in the future.

Note: Your file must be 50 MB or less in size. 
■ If you want to include a link to a shared file already in the workspace... 

Select the check box for the file to which you want to include a link. All of 
the files listed have been added to the workspace File Library. When a 
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partner or supplier clicks the link, it will take them directly to the file in the 
File Library and open it.

4 If you want an email sent to you when others post a reply to your conversation, 
click the Notify me when people reply check box.
Sample Email Notification 

5 Click Post Your Reply. Any files that you attached or linked to automatically 
become clickable links in the topic. 

Switching Between Different Workspaces
To open a different workspace from the current workspace
1 After clicking Applications > Workspaces, and opening a workspace, click 

the Workspaces drop-down list. 
2 Select the workspace you want from the list.
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A web form is an electronic form that lets a Community Administrator gather 
survey information about business contacts, trading partners, suppliers, and other 
contacts. A web form can be used to prompt contacts for information. The contacts 
can be inside your Active Community community or they can be outside of it. For 
example, you can create a supplier survey to ask if suppliers are compliant with an 
industry standard. Or, you can create a trading partner survey to prompt partners 
for company information, such as average sales volume or inventory.
Topics include:
■ “Web Forms Overview” on page 347
■ “Creating a Web Form for Inside Your Community” on page 355
■ “Creating a Web Form for Outside Your Community” on page 358
■ “Adding Question Choices for Shared Formats” on page 362
■ “Adding Question Choices for Web Form Formats” on page 363
■ “Copying a Web Form to Create a New One” on page 367
■ “Testing a Web Form” on page 368
■ “Publishing a Web Form” on page 370
■ “Distributing a Web Form” on page 372
■ “Viewing Web Form Results” on page 373
■ “Working with Web Forms” on page 374

Web Forms Overview
A web form is an electronic form that allows you to gather survey information 
about contacts inside or outside your community. 
Topics include:
■ “Web Form General Settings” on page 348
■ “Groups, Questions, and Choices” on page 349
■ “Web Form Question Formats” on page 350
■ “Web Form Planning” on page 352
■ “Web Form Setup Process” on page 353
■ “How Do I?” on page 353
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Web Form General Settings
Active Community provides two types of web forms, those for contacts:
■ Inside an Active Community community, called community web forms
■ Outside an Active Community community, called public web forms

Community Web Forms (Tracked or Anonymous Responses)
Community web forms are web forms sent to contacts inside an Active Community 
community. Community web forms must be associated with an activity in a project 
(see “Adding an Activity to a Project” on page 290). 
Community web forms can be configured to track responses, gather anonymous 
responses, or collect responses by company. That is, Active Community can:
■ Track responses and identify participants by name in the results

■ Create anonymous responses so the hub sees only answers to questions, not the 
names of the respondents

■ Collect company-level responses instead of individual contact responses. When 
any participant in a company responds, the project activity is marked as 
complete for the company. You define “complete by company” settings when 
adding an activity to a project.

Existing custom field questions can be copied to and included in community web 
forms. Custom fields supplement the basic information in core fields in contact and 
company profiles.
See “Creating a Web Form for Inside Your Community” on page 355.

Public Web Forms (Anonymous Responses)
Public web forms gather information about contacts who are outside of an Active 
Community community. Contacts use a URL to access the web form. You can add 
the contacts to your community later by “Importing Companies and Contacts Using 
CSV Files” on page 128.
For example, after conducting a national sales meeting, you can decide to send a 
survey to registrants who are not yet part of your community.
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Public web forms are associated with a project, but they are not associated with a 
project activity.

Responses are anonymous. The Community Administrator can view answers to 
web form questions, but cannot view information about the contact who 
responded. 
See “Creating a Web Form for Outside Your Community” on page 358.

Groups, Questions, and Choices
Web form questions are organized into groups that contain related questions. Each 
question has choices that contacts select or type when answering a question. For 
example, a group could be named “Colors,” and the a question might be “What is 
your favorite color?” The choices associated with the question might be red, green, 
yellow, and blue. 
Web form questions are similar to custom field questions. Both contain groups, 
questions and choices. 
■ A group is a group of related questions that are in a named section.
■ A question is a question in a group.
■ A choice is a selection that contacts make when responding to a question in a 

group.
In the Group column, the table displays two custom field groups, Company 
Information and Company Ownership. For each group, the Question and Choices 
columns contain questions and choices. The same concepts apply to web forms.

Groups Questions Choices

List of countries

Number field
Text fields for names
Number fields for numbers

Important: You should review “Custom Field Overview” on page 221 and 
“Working with Custom Fields” on page 258 to better understand basic concepts.
The table indicates where contacts answer custom field or web form questions.

For... Contacts answer them:
Custom field questions When updating a contact or company profile in Active 

Community
Web form questions By responding to questions in a web form

■ Company Information ■ What is your industry? ■ Manufacturing
■ Processing
■ Distribution

■ In which countries do you 
operate?

■ How many employees?
■ Company Ownership ■ Who owns your company?

■ Percentage ownership?
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Web Form Question Formats
Most, but not all, web form question formats are the same as custom field question 
formats. A question’s format determines how the question displays in a web form 
or a company or contact profile. 
The following question formats are shared between questions for web forms and 
custom fields. Click a link to see more information, including an example, of the 
format as users see it.
■ “Drop List”—Creates a field that is a drop-down list with multiple options.
■ “Multiple Choice”—Creates a custom field with one or more check boxes.
■ “Radio Button List”—Creates a custom field with a list of one or more answers 

with radio buttons. Users can select one answer.
■ “True/False”—Creates a pair of radio buttons with True or False as the answer to 

the question.
■ “Yes/No”—Creates a pair of radio buttons with Yes and No as the answer to the 

question.
■ “Text”—Creates a text box with a single line of text (up to 256 characters).
■ “Number”—Creates a box that contains a single line of numbers.
■ “Date”—Creates a a calendar date in MM/DD/YYYY format.
■ “Text Area”—Creates a text box that can contain multiple lines of text.
■ “Display Image”—Creates a custom field that allows contacts to upload and 

show an image file, such as a logo or product image, in a custom field. 
■ “File Upload”—Creates a custom field that allows contacts to upload a file to their 

profile in Active Community. 
■ “Company Link”—Creates a custom field with a company hyperlink that can be 

used to navigate to more detailed data within Active Community.
■ “Specialized”—Creates a custom field that has pre-configured formatting based 

on the type of configuration selected. Configurations include:
■ An Email option that allows hubs to collect one or more email addresses 

which must be in the correct format.
■ A Tax ID (EIN) option that allows hubs to collect one or more tax 

identification numbers which must be in the correct format.
The following question formats are unique to web form questions. They are not 
available for custom field questions.
Topics include:
■ “Company Profile” on page 351
■ “Contact Profile” on page 351
■ “Collect Contact” on page 351
■ “Custom Field...” on page 352
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Company Profile
This question format is unique to web form questions. 
Use the Company Profile format to create a web form and have recipients update 
core fields in their company profiles. Active Community uses the recipient's 
answers to record and overwrite existing data in their company profiles.

For procedural information, see “Adding Question Choices for Web Form Formats” 
on page 363. 

Contact Profile
This question format is unique to web form questions. 
Use the Contact Profile format to create a web form and have recipients update 
core fields in their contact profiles. Active Community uses the recipient's answers 
to record and overwrite existing data in their contact profiles. 

For procedural information, see “Adding Question Choices for Web Form Formats” 
on page 363. 

Collect Contact
This question format is unique to web form questions. 
Use the Collect Contact format to collect contacts for existing companies and 
assign them to different contact (business) roles already setup in your community. 
The question format lets you add, edit, or disable roles for all active contacts in 
your community.

For procedural information, see “Adding Question Choices for Web Form Formats” 
on page 363. 
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Custom Field...
This question format is unique to web form questions. 
Use the Custom Field... format to create a web form to have recipients update 
custom field information in their company or contact profiles. Use the Custom 
Field... format to copy contact or company profile fields into the web form.
Important: The copied custom fields display in the web form and include data in 
contact or company profiles (if the profile has data). When contacts respond to 
questions in the web form, their answers overwrite existing data in their contact or 
company profiles.
Custom fields supplement core field information stored in contact and company 
profiles. If you do not have the View Question Group permission assigned to your 
role for a custom field, those groups are not displayed in the Choose a Custom 
Field drop-down list. 

For procedural information, see “Adding Question Choices for Web Form Formats” 
on page 363. 

Web Form Planning
Web forms provide many options for surveying contacts inside and outside an 
Active Community community. Careful planning is required. 
Follow this process to send a web form to a set of suppliers in your community:
1 Create a project (see “Creating a Regular or Activity Managed Project” on 

page 287).
2 Create a web form that contains survey questions and possible answers as 

described in this section. 
3 In the project, create an activity that emails the web form to suppliers. 
4 In the activity, associate the web form to the activity and add suppliers 

(contacts) to the participant list (see “Adding Participants to an Existing 
Activity” on page 299).
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Web Form Setup Process
The graphic outlines the phases in the web form creation process.

Note: For a summary of planning options, see “How Do I?” on page 353.

How Do I?
Based on how a web form is to be used to gather survey responses, you must plan 
which options to choose when you create a web form. You choose from among the 
options in the table. 

If you want to... Choose (or use) the following option: When you are:
Create a web form for contacts:

■ Inside your community
In General Settings, select:

■ Community (with tracked responses)
or

■ Community (with anonymous responses)

“Creating a Web Form for 
Inside Your Community” on 
page 355

■ Outside your community In General Settings, select:
■ Public

“Creating a Web Form for 
Outside Your Community” 
on page 358

Track responses:
■ Anonymously

In General Settings, select:
■ Community (with anonymous responses), 

or
■ Public

■ “Creating a Web Form 
for Inside Your 
Community” on 
page 355

■ “Creating a Web Form 
for Outside Your 
Community” on 
page 358

■ By contact ■ Community (with tracked responses) 

■ By company In Activity Settings, select:
■ Complete by Company

“Adding an Activity to a 
Project” on page 290
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Use Custom Fields
Use question formats shared by web 
forms and custom fields

Formats:
■ Drop List
■ Multiple Choice
■ Radio Button List
■ True/False
■ Yes/No
■ Text
■ Number

■ Date
■ Text Area
■ Display Image
■ File Upload
■ Company Link
■ Specialized

“Adding Choices to Custom 
Field Questions by Format” 
on page 248

Use question formats unique to web 
forms

Formats:
■ Company Profile
■ Contact Profile

■ Collect Contacts
■ Custom Field...

“Adding Question Choices 
for Web Form Formats” on 
page 363

Copy custom field questions to a 
web form

■ For contacts inside your community, click Edit 
Form Information.

“Editing Web Form 
Questions” on page 375

Test a Web Form
Test a web form ■ Click Test. “Testing a Web Form” on 

page 368
Publish a Web Form
Publish a web form ■ Click Publish. “Publishing a Web Form” on 

page 370
Distribute a Web Form
Distribute a web form to contacts 

■ Inside a community
■ Add an activity to a project and associate the 

web form with the activity
“Adding an Activity to a 
Project” on page 290
or 
“Distributing a Web Form” 
on page 372

■ Outside a community ■ Distribute the web form URL to contacts 
outside a community

“Distributing the URL for a 
Public Web Form” on 
page 377

View Web Form Results
Export web form results

■ In a community
■ Projects > Select a project > Click the:

■ Activities tab > Select the activity > Click 
the Web Forms tab > Click View > Click 
Export All.

■ “Viewing Web Form 
Results” on page 373

■ “Exporting Web Form 
Results” on page 378

■ Outside a community ■ Web Forms tab > Click View > Click 
Export All.

Print web form responses 1 Login to Active Community or click a link in an 
email.

2 Respond to questions, then click Submit > 
Print.

“Responding to Web Forms” 
on page 379

If you want to... Choose (or use) the following option: When you are:
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Creating a Web Form for Inside Your Community
Permissions required:
■ Security: Add Projects (Admin > Security Roles tab)
■ Project: Web Form-related permissions (Projects > Permissions tab)
A web form allows you to quickly and easily collect information from your business 
contacts by using a survey called a web form. The first phase of the web form set 
up process is to name the web form, define how you want it to collect responses, 
and setup up custom field groups, questions and question choices. 

1

Create Web Form:
Key Description
1 To create a web form:

Important: Before creating a web form, you must create a project. After the web 
form has been created, you associate the web form with an activity (see “Web 
Form Planning” on page 352). 

To add a web form
1 Click Projects and locate and open the project to which you want to add a web 

form.
2 Select the Web Forms tab.

The Web Forms list page opens.
3 Click Add Web Form.

■ Give it a name
■ Define how to collect responses
■ Create question groups, questions, and choices
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The Creating a New Web Form page opens.

4 In Web Form Name, type the name of the web form, which can be a survey, 
poll, or request for information (required). Example: Supplier Diversity Survey

5 In Description, type optional text that provides more detail about the web form, 
such as its purpose and the deadline for responses. 
Note: Recipients see the description, as well as all other fields in the form.

6 In General Settings, select either:
■ Community (with tracked responses)—Creates a community web form to 

be sent to contacts in the Active Community community. Respondents are 
identified by name and company in survey results.

■ Community (with anonymous responses)—Creates a community web form 
to be sent to contacts in the Active Community community. Removes the 
respondents' First Name, Last Name, Company Name, and Company ID 
from web form results. The Community Administrator sees only answers to 
questions, not information about the contact who responded to the 
questions.

7 Click Save Changes. 
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The question group, called “Questions,” opens. 

Note: A question group is a grouping of related questions. The questions are 
in a separate section.

8 Click Edit Group. 
The Editing Custom Field Group page opens.

9 In Name, type over the word “Questions” and give the group a name, such as 
“Level of Performance.”

10 In Description, type more detail about the question group; for example, 
“Information about the quality and frequency of communication with suppliers.” 
Contacts who respond to the survey can see the description. 

11 Perform the appropriate action (optional):

12 Click Done. 
You have created a web form with a question group. At the top of the page, the 
name of the group refreshes with the name you typed in step 9.

13 Next steps (required):

Select... To:
■ Display this group as a table Display all questions in the group in a data table, 

which allows multiple answers to each question (see 
“Creating Questions in Data Tables” on page 262).

■ Make dependent on another 
question (optional) 

Make a question conditional based on the answer to 
another question (see “Creating Dependent 
Questions” on page 259).
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a Add questions to the group (go to “Adding Custom Field Questions to 
Groups” on page 243).

b Define choices for contacts to select for each question based on question’s 
format. Perform the appropriate action:

Creating a Web Form for Outside Your Community
Permissions required:
■ Security: Add Projects (Admin > Security Roles tab)
■ Project: Web Form-related permissions (Projects > Permissions tab)
A web form allows you to quickly and easily collect information from your business 
contacts by using a survey called a web form. Public web form results are similar to 
community web form results, except responses are anonymous. 
Because respondents are not yet part of your Active Community community, you 
cannot use custom fields in the web form. Custom fields supplement the basic 
information contained in core fields in contact and company profiles. You can, 
however, add groups, questions, and choices to a public web form.
After the form has been created, tested, and published, use an email to distribute 
the web form URL to contacts. There is no need to link a public web form to an 
activity in a project.

For these question formats... Go to:
■ Drop List
■ Multiple Choice
■ Radio Button List
■ True/False
■ Yes/No
■ Text
■ Number

■ Date
■ Text Area
■ Display Image
■ File Upload
■ Company Link
■ Specialized

“Adding Question Choices for Shared 
Formats” on page 362

■ Company Profile
■ Contact Profile

■ Collect Contact
■ Custom Field...

Step 4 in “Adding Question Choices 
for Web Form Formats” on page 363



W E B  F O RM S
Creating a Web Form for Outside Your Community

OpenText Active Community CE 21.2 User Guide  359

1 0

The first phase of the web form setup process is to name the web form, define 
how you want it to collect responses, and setup up web form groups, questions 
and question choices. 

1

Create Web Form:
Key Description
1 To create a web form:

Important: Before creating a public web form, you must create a project. 

To add a web form
1 Click Projects and locate and open the project to which you want to add a web 

form.
2 Select the Web Forms tab.

The Web Forms list page opens.
3 Click Add Web Form.

■ Give it a name
■ Define how to collect responses
■ Create question groups, questions, and choices
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The Creating a New Web Form page opens.

4 In Web Form Name, type the name of the web form, which can be a survey, 
poll, or request for information (required). Example: Supplier Diversity Survey

5 In Description, type optional text that provides more detail about the web form, 
such as its purpose and the deadline for responses. 
Note: Recipients see the description, as well as all other fields in the form.

6 In General Settings, select Public to generate a link (URL) to the web form 
after the web form has been published. 
The host distributes the URL to contacts outside an Active Community 
community. 

7 Click Save Changes. 
The question group, called “Questions,” opens. 

Note: A question group is a grouping of related questions. The questions are 
in a separate section.
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8 Click Edit Group. 
The Editing Custom Field Group page opens.

9 In Name, type over “Question” and give the group a name, such as “Level of 
Performance.”

10 In Description, type more detail about the question group; for example, 
“Information about the quality and frequency of communication with suppliers.” 
Contacts who respond to the survey can see the description. 

11 Perform the appropriate action (optional):

12 Click Done. 
You have created a web form with a custom field group. At the top of the page, 
the name of the group refreshes with the name you typed in step 9.

13 Next steps (required):
a Add questions to the group (go to “Adding Custom Field Questions to 

Groups” on page 243).

Select... To:
■ Display this group as a table Display all questions in the group in a data table, 

which allows multiple answers to each question (see 
“Creating Questions in Data Tables” on page 262).

■ Make dependent on another 
question (optional) 

Make a question conditional based on the answer to 
another question (see “Creating Dependent 
Questions” on page 259). 
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b Define choices for contacts to select for each question based on question’s 
format. Perform the appropriate action:

Adding Question Choices for Shared Formats
Web forms share the following question formats with custom fields:
■ Drop List
■ Multiple Choice
■ Radio Button List
■ True/False
■ Yes/No
■ Text
■ Number
■ Date
■ Text Area
■ Display Image
■ File Upload
■ Company Link
■ Specialized

To add question choices for shared formats
■ Go to step 2 in “Adding Choices to Custom Field Questions by Format” on 

page 248.

For these question formats... Go to:
■ Drop List
■ Multiple Choice
■ Radio Button List
■ True/False
■ Yes/No
■ Text
■ Number

■ Date
■ Text Area
■ Display Image
■ File Upload
■ Company Link
■ Specialized

“Adding Question Choices for 
Shared Formats” on page 362

■ Company Profile
■ Contact Profile

■ Collect Contact
■ Custom Field...

Step 4 in “Adding Question Choices 
for Web Form Formats” on 
page 363
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Adding Question Choices for Web Form Formats
Security role: Community Administrator
Security permissions required: Custom Field Permissions > Manage Custom Fields,
View Question Group
Important: This procedure describes how to add choices for question formats 
that are unique to web forms, such as Company Profile, Contact Profile, Collect 
Contact, and Custom Fields. To learn how to add choices to formats shared by 
custom fields and web forms, see “Adding Choices to Custom Field Questions by 
Format” on page 248.
The next phase in creating web forms is to define the choices you want users to 
use when they respond to web form questions. 
Use this procedure to add choices to a question in a group. 

To add choices to web form questions
1 Click Projects, open the project in which you want to add a question choice to 

a web form, and click the Web Forms tab.
The Web Forms page opens and displays a list the web forms for your project.

2 Click View for a web form. 
The web form you selected opens.

3 On the web form page, click Edit.

4 Select the custom field group to which you want to add a choice. 
5 Click Insert Custom Field Here. 
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The Editing New Custom Field section opens at the selected location in the 
question group.

6 In the Choose the Type of Custom Field drop-down list, select the type of web 
form-unique question you want to create (Company Profile, Contact Profile, 
Collect Contact, or Custom Field).
Note: To add question choices for formats shared with custom fields, see 
“Adding Question Choices for Shared Formats” on page 362.

7 Perform the appropriate action:
If you selected... Do this:
Company Profile 1 Click Next.

2 In Custom Field, type the question text, such as 
“What is your buying area?” to replace the “New 
Custom Field” text that displays automatically.
Note: If needed, use the formatting icons to 
emphasize any text in the question, such as making a 
word bold or changing the font.

3 In Instructions, type the help text for a question. 
The text displays when contacts click the help icon for 
the question.

4 Go to step 8.
Contact Profile 1 Click Next.

2 In Custom Field, type the question text, such as 
“What is your buying area?” to replace the “New 
Custom Field” text that displays automatically.
Note: If needed, use the formatting icons to 
emphasize any text in the question, such as making a 
word bold or changing the font.

3 In Instructions, type the help text for a question. 
The text displays when contacts click the help icon for 
the question.

4 Go to step 8.
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Collect Contact 1 Click Next.
2 In Custom Field, type the question text.
3 In Instructions, edit the help text for the question.

The text displays when contacts click the help icon for 
the question.

4 In Select Functional Roles to be Collected for 
Contacts, select the roles you want contacts to select 
in the web form based on the column headings: 

■ Hidden Roles—Roles you do not want to show or 
collect in the web form.

■ Required Roles—Roles that display with an asterisk 
in the web form. The contact completing the web 
form must add a new contact or assign an existing 
contact from the list to the contact (business) role.

■ Optional Roles—Roles that show in the web form, 
but the contact completing the web form has the 
option of adding a new contact or assigning an 
existing contact to the contact (business) role. 

5 Go to step 8.
Custom Field
Important: If you do not have the View 
Question Group permission assigned to 
your role for a custom field, the group is 
not displayed in the drop-down list. 

1 Click Next.
2 In the Choose a Custom Field drop-down list, select 

the company or contact custom fields whose 
questions you want to copy.

3 If the field you are copying has parent/child 
dependencies, use the check boxes to select the 
dependencies you want to be copied to the web form 
custom field. 

4 Click Copy.
Active Community copies the company or contact 
profile custom fields into the web form. 
Important: The copied custom fields display in the 
web form. When responding to web form questions, 
contacts write data directly into their profiles.

5 Go to step 8.

If you selected... Do this:
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8 Select any options that are appropriate to the custom field.
Important: Not all options are available for all formats. Based on your 
selection, additional fields might display. The fields let you refine the question 
further.

Select... To:
Make Field Read-Only (Optional) Make the field read-only. Contacts cannot enter values in the field.
Require Answer to Question 
(Optional)

Make the question mandatory.

Add Comment Field (Optional) Allow the contact to add text comments (up to 256 characters) 
when answering the question. 

Add Validation Rule (Optional) Specify a condition such as: 
■ “On or before today” or “On or after today” (Date format)
■ “Min Number” and “Max Number” (Number format)
■ “Only Allow Numeric Values (Text format)
■ “Min Length” and “Max Length” (Text format)

If the same number is entered in both fields, the Append 
Leading Zeroes field displays. 

Select it if you want zeroes to be appended in front of the 
entered data. 
For example, if the value in min/max length is 8 and a question 
is answered as 123456, Active Community adds two zeroes in 
front of the answer so the total number of characters equals 
the min/max length (in this example, 00123456). 
The Append Leading Zeroes field can be used with or without 
the Only Allow Numeric Values field; that is, you can append 
zeroes to both numeric and alphanumeric values.

Add New Contacts (Optional) Allow the contact completing the web form to add a new contact 
and assign the contact to a contact (business) role.

Edit Existing Contacts (Optional) Allow the contact completing the web form to edit the contact 
profile of a person listed. Can be used, for example, when reviewing 
and updating a job title, phone number, address, etc.

Disable Existing Contacts 
(Optional)

Allow the contact completing the web form to disable a contact 
from the list, such as if a contact is no longer with the company.

Make Dependent on Custom Field 
(Optional)

Make a question conditional based on the answer to another 
question. The other question must have already been defined (see 
“Creating Dependent Questions” on page 259). 

Set Default Answer (Optional) Specify a default value for the answer in the text box.
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9 Click Done.
If the type of custom field you are creating is a Company Profile or Contact 
Profile, the company or contact profile opens with new question groups and 
choices. If you modified question choices copied from a custom field group, 
your changes display.

Copying a Web Form to Create a New One
Security role permissions required: 
■ View Web Forms
■ Add Web Forms Project
Use this procedure to create a web form by copying an existing web form from any 
project. All questions and settings are copied to the new web form. Any existing 
responses are removed. 
You can copy both unpublished and published web forms. Active Community 
creates the new form in an unpublished state.

To copy a web form
1 Click Projects and locate and open the project to which you want to add a web 

form.
2 Select the Web Forms tab.

The Web Forms list page opens.
3 Click Add Web Form.

The Creating a New Web Form page opens.
4 Under Copy Web Form from Any Project, click the drop-down list and select the 

existing web form you want to copy to the new web form.
The name (and project) for all web forms in the community are listed.

Enable Multiple Values (Optional) Allow more than one value to be added where values are separated 
by a comma.

Enable Masking (Optional) This option cannot be changed for a copied custom field. The check 
box is unavailable and the selection that was made for the original 
company custom field remains intact.
If the Enable Masking check box is selected, and you have “View 
Masked Field” permission, you will see masked field values in the 
response. Spoke users see masked field values for their companies 
if they have “View My Company” permission (see “Security Role 
Permission Descriptions” on page 57)

Select... To:
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5 Type the name and description of the new web form. 
6 Under General Settings, indicate if you want the web form to be for contacts 

inside or outside your community.
■ Community (with tracked responses)—Creates a community web form to 

be sent to contacts in an Active Community community. Participant names 
are identified in survey results.

■ Community (with anonymous responses)—Creates a community web form 
to be sent to contacts in an Active Community community. Removes the 
respondents' First Name, Last Name, Company Name, and Company ID 
from the web form results. The Community Administrator sees only answers 
to questions, not information about the contact who responded to the 
questions.

■ Public—Generates a link (URL) to the web form after the web form has 
been published. The host distributes the URL to contacts outside an Active 
Community community. Responses to survey questions are anonymous. 

7 Click Save Changes. 
The new web form opens with all questions from the original web form.

8 Edit the questions and question groups as needed, and click Done. 
The web form is ready to be published and used in an activity in a project or to 
be distributed as a URL to contacts outside your community.

Testing a Web Form
The next phase of the web form setup process is to test the web form. By doing so, 
you verify the survey is working as expected and can make modifications as 
needed before publishing the form. Testing lets you see the web form in exactly 
the same way as survey recipients see it. You can answer questions and see your 
responses. Active Community does not save your test responses. 
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Before starting this procedure, you must have created a web form.

1

Test Web Form:
Key Description
1 Test web form and make changes as needed

Important: When testing a public web form, which is one sent to contacts 
outside your community, you are not able to change it to a non-public (inside your 
community) web form after it has been tested. 

To test a web form
1 Click Projects, open the project in which you want to test a web form, and 

click the Web Forms tab.
The Web Forms page opens. It displays a list the web forms for your project.

2 Click View for a web form. 
The web form you selected displays.
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3 On the web form page, click Test.

4 Respond to the questions on the web form, then click Save Changes. 
Important: This action tests your changes; it does not save or update web 
form data. 
The page displays the test values you entered. Your answers are recorded in 
test response statistics. After you leave the page, Active Community deletes the 
test responses.

5 Perform the appropriate action: 

Publishing a Web Form
After creating and testing a web form, publish it so it can be distributed to your 
partners to gather survey information.

■ 1

Publish Web Form:
Key Description
1 Publish a web form so it can be distributed to contacts

To... Do this
Modify the web form ■ Click Back, then click Edit to make your changes.
Print your responses ■ Click Print.
Publish the web form ■ Click Publish (see “Publishing a Web Form” on page 370)
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To publish a web form
1 Click Projects, open the project in which you want to publish a web form, and 

click the Web Forms tab.
The Web Forms page opens. It displays a list web forms for your project.

2 Click View for a web form. 
The web form you selected opens.

3 On the web form page, click Publish.

A message indicates the web form has been published. The web form can be 
associated with an activity in a project for web forms inside your community. 
For web forms for outside your community, the URL can be distributed to 
contacts in an email. For Public web forms, the URL displays following the row 
of buttons.

4 Go to “Distributing a Web Form” on page 372.
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Distributing a Web Form
The next phase of the web form setup process is to distribute it so the hub can 
gather contact answers to web form questions. 

1

Distribute Web Form:
Key Description
1 ■ Inside a community: Add an activity to a project and associate the web form with 

the activity
■ Outside a community. Send an email with the public web form URL
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For web forms for contacts:
■ Inside an Active Community community, add an activity to a project and select 

the published web form. Go to “Adding an Activity to a Project” on page 290.
■ Outside an Active Community community, use an email to distribute the web 

form URL as described in “Distributing the URL for a Public Web Form” on 
page 377.

Viewing Web Form Results
The final phase of the web form setup process is to view contact responses to web 
form questions. 

Use this procedure to view contact responses to web form questions.

To see a summary of responses to web form questions
1 Click Projects and locate and open the project in which you want to view web 

form responses.
2 To access the web form, either:

a Click the Web Forms tab, or
b Click the Activities tab, select an activity, and click the Web Forms tab.

3 Select a web form, then click View.
The page shows a summary of responses by question.

4 To generate an Excel report of all responses, click Export All (see also 
“Exporting Web Form Results” on page 378).
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Working with Web Forms
The following topics describe how to change web forms.
■ “Editing a Web Form’s General Settings” on page 374
■ “Adding a Logo to a Web Form” on page 374
■ “Editing Web Form Questions” on page 375
■ “Distributing the URL for a Public Web Form” on page 377
■ “Exporting Web Form Results” on page 378
■ “Responding to Web Forms” on page 379
■ “Deleting a Web Form” on page 379

Editing a Web Form’s General Settings
Permissions required:
■ Security: Add Projects (Admin > Security Roles tab)
■ Project: Web Form-related permissions (Projects > Permissions tab)
Use this procedure to edit the general properties of a web form, such as name, 
description, or the general settings that determine if the web form is to be used 
inside a community or outside a community. 

To edit a web form
1 Click Projects and locate and open the project to which you want to edit a web 

form.
2 Select the Web Forms tab.

The Web Forms list page opens.
3 For the web form you want to edit, click View > Edit.
4 Click Edit Form Information.

5 Change the name, description, and general settings as needed.
6 Click Save.

Adding a Logo to a Web Form
Permissions required:
■ Security: Add Projects (Admin > Security Roles tab)
■ Project: Add Web Form/Edit Web Form (Projects > Permissions tab)
Use this procedure to add a logo to a web form.
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To add a logo to a web form
1 Click Projects and locate and open the project to which you want to add a 

logo.
2 Select the Web Forms tab.

The Web Forms list page opens.
3 For the web form you want to edit, click View > Edit.
4 Click Edit Form Information.

5 Change the name, description, and general settings as needed.
6 To add a logo, click Browse.
7 In the Choose File to Upload dialog box, navigate to an image file on your hard 

drive (for example, .GIF), select it and click Open. The logo is resized (if 
applicable) and displayed.
Note: The maximum file size is 50 MB.

8 Click Save.

Editing Web Form Questions
Use this procedure to edit questions in a web form. Any changes you make are 
reflected in the web form when a contact accesses the form. That is, if you already 
published and sent the web form to your partners, but they have not submitted 
responses, the updated web form opens when they click the link or log in to Active 
Community.
Note: After it has been published, a web form cannot be deleted. In addition, its 
general settings (community or public) cannot be changed.

To edit a web form
1 Click Projects, open the project in which you want to edit web form questions, 

and click the Web Forms tab.
The Web Forms page opens and displays a list the web forms for your project.

2 Click View for a web form. 
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The web form you selected opens.
3 On the web form page, click Edit.

4 Click Edit Form Information and update the general information as 
described in “Editing a Web Form’s General Settings” on page 374.

5 Click Save Changes. 
Note: If you changed the web form’s General Settings from Community to 
Public, all profile fields are removed.

6 To add or copy question groups, use the following links.

7 To add questions to groups, use the following links. 

8 To resequence, edit, or delete question groups, use the following links.

9 When the form is complete, click Done.
Your changes are saved to the web form. Any changes you made are reflected 
in the web form when a contact accesses the form. 

Click... To...
Add Question Group Add a question group to the web form. For details, see “Creating 

a Web Form for Inside Your Community” on page 355. 
Copy Question Group Copy a question group from a contact or company profile's 

custom fields (see “Copying a Custom Field Question” on 
page 268). 
Note: Option unavailable for public web forms.

Click... To: See also:
Insert Custom Field Here Add a question before the 

current question. 
“Adding Custom Field 
Questions to Groups” on 
page 243Add Question Add a question after the 

current question. 

Click... To...
Move Down/Move Up Resequence question groups.
Select a question and 
drag it to a new position

Resequence questions in a group.

Edit Group Change the name and description of the question group. 
Note: If the form has been published, you cannot select or 
deselect Display This Group as a Table.

Delete Remove the question group from the form.
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Distributing the URL for a Public Web Form
Permissions required:
■ Security: Add Projects (Admin > Security Roles tab)
■ Project: Web Form-related permissions (Projects > Permissions tab)
Use this procedure to find a public web form URL so you can distribute it to 
contacts outside your Active Community community.

To distribute the URL for a public web form
1 Click Projects and locate and open the project to which you want to edit a web 

form.
2 Select the Web Forms tab.

The Web Forms list page opens.
3 For the public web form, click View > Edit.

The URL is listed following the row of buttons on the Edit page. 

4 Copy the URL and paste it in an email to send it to contacts outside your 
community. 
When contacts click the link, the web form opens in Active Community so they 
can respond to the questions.

Important: After contacts click Submit, their answers are submitted to 
Active Community. 
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5 Follow steps 1 through 3 of this procedure to view the results.

6 Go to “Exporting Web Form Results” on page 378

Exporting Web Form Results
Use this procedure to export web form results to an Excel spreadsheet. 
Important: Contacts can re-submit a web form until an activity is suspended or 
completed. For web form results that are exported to Excel, the Submitted Date 
column in the spreadsheet lists the most recent submitted date. The data in the 
spreadsheet is the most recent data.

To export web form results
1 Click Projects and locate and open the project to which you want to edit a web 

form.
2 Perform the appropriate action:

3 For the web form you want to export, click View, then click Export All.
4 At the prompt, indicate if you want to Open or Save the results. If you click:

■ Open, the .xlsx file opens. 
■ Save, navigate to a location on your computer where you want to save the 

file, and click Save.
The Excel file opens and shows the results of the web form survey.

To export web form 
results... Do this;
Inside a community 1 Click the Activities tab.

The Activities list page opens.
2 Select an activity, then click the Web Forms tab.
3 Go to step 3.

Outside a Community 1 Click the Web Forms tab.
The Web Forms list page opens.

2 Go to step 3.
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Responding to Web Forms
Use this procedure to print responses to web form questions.

To respond to web form questions
1 Perform the appropriate action: 

2 Respond to the questions in the web form. The options you see depend on the 
format selected when the web form was created. 

3 Perform the appropriate action:
■ To print your responses, click Print.
■ To submit your responses, click Submit.

Your answers are submitted to Active Community. 

Deleting a Web Form
Permissions required:
■ Security: Add Projects (Admin > Security Roles tab)
■ Project: Delete Web Forms (Projects > Permissions tab)
Use this procedure to delete an unpublished web form. After a web form has been 
published, it remains part of the project and cannot be deleted.

To delete a web form
1 Click Projects, open the project in which you want to delete a web form, and 

click the Web Forms tab.
The Web Forms page opens. It displays a list for web forms for your project.

2 Click View for a web form. 
The web form opens.

If you received... Do this:
A web form as part of an activity 1 Login to Active Community.

2 Click Home > Inbox tab.
3 Open the activity.
4 Click the link to the web form.

An email with a link to the web form ■ Click the link in the email to open Active 
Community.
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3 Select the web form you want to delete.

4 At the confirmation prompt, click OK. 
Active Community removes the web form and all test responses from the 
project.
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Alerts 11
Active Community can send alert emails based on conditions you define in an alert 
configuration. Active Community checks alert conditions every hour, and sends 
emails as needed. 
Note: Event Date alerts do not run every hour, as the other alerts do. They run at 
midnight Eastern Time (ET).
If an activity is associated with an alert, the alert triggers an activity email.
Topics include:
■ “Alert Components” on page 381
■ “Adding an Alert Configuration” on page 387

■ “Defining Alert Triggers and Conditions” on page 389
■ “Selecting Alert Email Recipients” on page 394

■ “Configuring an Alert Email Template” on page 396
■ “Working with Alerts and Email Templates” on page 399

■ “Editing an Alert” on page 399
■ “Deleting an Alert” on page 400
■ “Activating an Alert Email Template” on page 400
■ “Editing an Alert Email Template” on page 401
■ “Deleting an Alert Email Template” on page 402

Alert Components
An alert configuration includes the following components, which are available from 
the Configure Alert page (Admin > Alerts > Add New Alert).
■ “Basic Information” on page 382
■ “Alert Triggers” on page 382
■ “Alert Conditions” on page 383
■ “Recipients of an Alert Email” on page 385
■ “Email Templates” on page 386
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Basic Information
Basic information describes the name and description of the alert, whether the 
alert is active, and the type of change that triggers the alert.

See “Adding an Alert Configuration” on page 387.

Alert Triggers
Triggers are user actions that cause an alert email to be sent to recipients. Emails 
can be sent when users create or modify profiles, modify core or custom fields, or 
require notification of an upcoming (or past) event.
Note: An additional option (XML Push) is available for company alerts, but can 
only be used by OpenText Managed Services customers.
Emails are sent to users depending on the trigger type. Trigger types include:
■ Contact Profile - Alert is sent when a contact profile is create or modified.

■ Company Profile - Alert is sent when a company profile is created or modified.

■ Core and Custom Fields - Alert is sent when a core or custom field is modified.
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■ Event Date - Alert is sent at a predetermined interval. For example, a hub wants 
to send an alert x days before the expiration date of a spoke’s certificate 
(represented by a custom field).
Important: If your trigger type is an event date, the alert must have at least 
one date field with the Before or After operator as one of the conditions.

Note: Event Date alerts do not run every hour, as the other alerts do. They 
run at midnight Eastern Time (ET).

■ XML Push - Alert sends company profile data in XML format to a pre-configured 
Managed Services staging environment. Should only be used by communities 
that have integrated Active Community with OpenText Managed Services.

See “Adding an Alert Configuration” on page 387 and “Defining Alert Triggers and 
Conditions” on page 389.

Alert Conditions
Conditions are statements that describe the situations in which an alert email is 
sent. You use fields from company or contact profiles, or core and custom fields, to 
define conditions. You can:
■ Match all or any condition
■ Use or and and between sets of conditions
■ Include the following operators (not all operators are available for all fields): 

■ Contains/Does Not Contain
■ Is Equal To/Is Not Equal To
■ Is Less Than/Is Greater Than
■ Starts With/Ends With
■ Is On or Before/Is On or After
■ In Last 24 Hours
■ Changes (does not apply to the following custom fields: Text Area, File 

Download, Display Image, Company Link, Formula field types)
This condition allows you to be notified when specific data in your company 
changes in one of the following ways:

■ From no value (blank) to a value (specific or non-specific)
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■ From a value (specific or non-specific) to another value (specific or non-
specific)

■ From a value (specific or non-specific) to no value (blank)
■ After/Before
■ All/None

Conditions can be defined individually and/or defined as sets of conditions. 
Note: When defining alert conditions, note these differences for company and 
contact alerts:
■ Company Alerts—only company custom fields can be used.
■ Contact Alerts—company custom fields and contact custom fields can be 

combined to create alert conditions. 
The type of alert, either company or contact, determines the custom fields that are 
available for selection.

Example 1 - “Is Equal To” / ”Is Not Equal To” Operator
Using company profile fields, you might define this set of conditions:
■ State/Province/Region Is Equal to Maryland AND City Is Not Equal to Baltimore. 

In the example, Active Community sends an alert email if the state is Maryland and 
the city is not Baltimore.

Example 2 - Event Date Trigger with “Before” Operator
Using a custom field with a Date format, you might define a condition that sends 
an alert email 30 days before the expiration date of a certificate. To accomplish 
this, select Event Date as the trigger, then use a custom field that represents a 
date, such as “Certification - Valid Until” (in this example), the Before operator, and 
a specified number of days, such as 30.

In the example, Active Community sends an alert email if the current date is 30 
days before the value in the custom field. Alert recipients will receive an alert email 
based on the value of the specific expiration date.
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Example 3 - “Changes” Operator
Using company profile fields, you might define this condition:
■ Postal Code Changes from 94549 to another value.

In the example, Active Community sends an alert email if the Postal Code changes 
from 94549 to any other value.
See “Adding an Alert Configuration” on page 387 and “Defining Alert Triggers and 
Conditions” on page 389.

Recipients of an Alert Email
The recipients of an alert email can be hub users, spoke users, or both. 

Hub Recipients
You can determine the hub recipients of an alert email based on one of the 
following:
■ Security role (all contacts assigned to the selected Security Role receive the 

email)
■ Business Role (all contacts assigned to the selected Business Role receive the 

email)
■ Contacts (specific contacts receive the email)
■ Tags (contacts who have the selected tag receive the email)

Spoke Recipients
An alert can be set up to go to the spoke contact (based on business role) of the 
company that triggered the alert. 
For example, spoke contact John Smith has a business role of Auditor. The hub 
creates an alert to go out to the spoke (Auditor business role)
You can determine the spoke recipients of an alert email based on one of the 
following:
■ Business Role (all contacts assigned to the selected Business Role receive the 

email)
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■ Tags (contacts who have the selected tag receive the email)

See “Adding an Alert Configuration” on page 387 and “Selecting Alert Email 
Recipients” on page 394.

Email Templates
Email templates control the content and formatting in emails. The templates use 
merge fields to include values found in the recipient's company or contact profile or 
in custom fields. The merge field acts as a “placeholder” for profile information you 
want Active Community to insert in the email. For example, to insert a recipient’s 
first name in an email, you select First Name when configuring an email 
template. The %FirstName% merge field is inserted in the message text. When it 
sends an email, Active Community uses the first name in the recipient's profile, 
such as John or Sally, to replace the %FirstName% merge field “placeholder” in 
the email message. Instead of “Dear %FirstName%,” the email text reads “Dear 
Sally.”

You can also use merge fields to indicate old and new values such as when using 
an alert to notify someone information has changed. For example, “John Smith 
changed his email address from jsmith@sample.com to john.smith@sample.com.” 
Important: The Ready for Use check box must be selected before the email 
template can be selected.
See “Adding an Alert Configuration” on page 387 or “Configuring an Alert Email 
Template” on page 396.



A L E R T S
Adding an Alert Configuration

OpenText Active Community CE 21.2 User Guide  387

1 1

Adding an Alert Configuration
Security permissions: Community or Company Permissions > Manage Alerts
Use this procedure to configure settings for an alert that sends emails based on the 
conditions you define. 
The configuration includes the:
■ Email template Active Community uses when the alert email is sent
■ Email triggers and the conditions under which the alert email is sent
■ Recipients who receive the alert email by security or business role, tags, or 

contacts. 
■ Settings related to a web form or message type of activity (optional)
Note: If an activity is associated with an alert configuration, contacts might 
receive two emails after alert conditions are met. One email is related to the alert 
configuration. The other email is related to the activity.

To add basic information about an alert
1 Click Admin > Alerts tab.

The Alerts page opens.

2 Click Add New Alert.
The New Alert dialog box opens.

3 Select the type of alert you want to create, Contact or Company, and click 
Next.
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The Configure Alert page opens.

4 Type or select basic information about the alert:
■ In Alert Name, type a name for the alert.
■ In Description, type a description for the alert.
■ Scroll down to the Notify section. In Email Template, click the Search icon. 

The Email Templates page opens. 

5 In the Action column, click Select for the email template you want to use for 
the alert. 
Note: If the Select link is not available, the email template cannot be 
selected. Ensure the Ready for Use check box is selected in the email 
template.
You return to the Configure Alert page.

6 To enable the alert configuration, select the Active check box. 
Note: When an alert is active, Active Community evaluates alert conditions 
every hour to see if the conditions are met. If they are, it sends alert emails 
and/or triggers activity emails.



A L E R T S
Adding an Alert Configuration

OpenText Active Community CE 21.2 User Guide  389

1 1

7 To associate an activity with an alert, scroll down to the Associate with Activity 
section and select the Associate with Activity check box. 

The Configure Alerts page refreshes with additional fields and sub-tabs.
8 Under Select Associated Activity, in Activity Name, select the web form or 

message activity that you want to trigger an activity email if alert conditions are 
met. 

9 Complete the alert configuration by:
■ “Defining Alert Triggers and Conditions” on page 389
■ “Selecting Alert Email Recipients” on page 394

Defining Alert Triggers and Conditions
Security permissions: Community or Company Permissions > Manage Alerts
Use this procedure to define the settings for alert triggers and the conditions under 
which emails are sent, such as:
■ Changes to contact or company profiles
■ Changes to core or custom fields
■ Alerts based on an event date, for example, an alert 30 days before a date 

custom field that might represent when a certificate expires, or an alert 10 days 
after a date custom field that might represent when an invoice is due. 

■ Alerts to send selected company profile data in XML format to Managed Services. 
Only available for company alerts and communities who use OpenText Managed 
Services.

Note: If a File Upload custom field has been created, you can select it as a custom 
field trigger (see“Custom Field Question Formats” on page 226). Recipients are 
sent an email if a file is uploaded to a company or contact profile.
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To define alert triggers and conditions
1 After completing the steps in “Adding an Alert Configuration,” go to the Trigger 

part of the Configure Alert page. 

2 Perform the appropriate action:

3 Select Contact (or Company) Profile.
4 Under “When Contact/Company Profile is,” select:

■ Created—Sends an email when a new contact or company is created, and 
one of the fields matches the conditions you set.

■ Modified—Sends an email when the conditions you define for field(s) are 
met. That is, one or more the fields in the profile are changed. 

5 Go to step 12.
6 Select Core and Custom Fields.
7 Under “When the following field changes,” select one of the following:

■ The core or custom field you want to monitor so that an email is sent to 
recipients if the field changes. 

■ A File Upload custom field you have created. If selected, recipients receive 
an email when a file is uploaded to a company or contact profile.

Note: If data masking is enabled for a company custom field and you 
do not have permission to view it, the field is unavailable in the drop-
down list. If you later mask a custom field used in the alert, the alert 
configuration is not updated. You must edit the alert and select different 
conditions (see “Editing an Alert” on page 399).

8 Click Add Conditions. Go to step 12.
9 Select Event Date. Go to step 12.

10 Select XML Push. Only available for company alerts and communities who use 
Managed Services.

11 Select one of the following options:
■ Profile Push—Allows the user to select company profile data (core/custom 

fields) to be pushed to Managed Services as an XML File.

This option Triggers an email based on Do This:
Contact (or Company) Profile Changes or modifications to a contact or company profile Go to step 3.
Core and Custom Fields Modifications to a core or custom field Go to step 6.
Event Date An event date Go to step 9.
XML Push Push data to Managed Services as an XML file. 

Note: The following limitations apply:
■ Only available for Company alerts
■ Only available for communities who use OpenText Managed 

Services
■ Must be configured with the assistance of Professional Services

Go to step 10.
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1 In the Configure XML File section, click Select Custom Fields. The 
Configure XML dialog opens.

2 Select the custom fields and their table names that you want to send to 
Managed Services in the XML file.

The sections on the page:

■ Tabular Push—Allows the user to select ONLY custom fields which are part 
of a Table displayed field group to be pushed to Managed Services as an 
XML File.
1 In the Configure XML File section, click Select Custom Fields. The 

Configure XML dialog opens.
2 Select the custom fields and their table names that you want to send to 

Managed Services in the XML file.

12 Under Condition(s), define the conditions for sending an alert email or 
triggering an activity email. The more conditions you use, the more conditions 
that must be met before an email is sent. You can define one or more 

Key Description
1 Custom fields
2 Table names

Key Description
1 Table data only

1

2

1
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conditions, including sets of conditions. The type of alert, either contact or 
company, determines the custom fields that are available in the drop-down lists.

Note: If your trigger type is an event date, you must select at least one date 
field with the Before or After operator as one of the conditions.

a Select one of the following:
■ All to send alert emails if all conditions are met. 

For example, the State/Province/Region Is Equal to Maryland AND City 
Is Not Equal to Baltimore. 

■ Any to send alert emails if any conditions are met. 
For example, State/Province/Region Is Equal to Maryland OR City Is Not 
Equal to Baltimore. 

b When selecting conditions, note the following differences between 
Company and Contact alerts. The type of alert determines your action:

■ Company Alerts—only company custom fields can be used. Go to step c. 

■ Contact Alerts—company custom fields and contact custom fields can be 
combined to create alert conditions. Select Contact or Company from 
the drop-down list.

c Do one of the following:
■ For Company alerts, from the drop-down list, select an option, such as 

State.
■ For Contact alerts—from the drop-down list, select an option, such as 

State.
d In the operator drop-down list, which initially displays Contains, select the 

operator that describes how you want Active Community to apply the 
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condition, such as Contains or Is Not Equal To (not all operators are 
available for all fields). Your options might include:

■ Contains/Does Not Contain
■ Is Equal To/Is Not Equal To
■ Is Less Than/Is Greater Than
■ Starts With/Ends With
■ Is On or Before/Is On or After
■ In Last 24 Hours
■ Changes (does not apply to the following custom fields: Text Area, File 

Download, Display Image, Company Link, Formula field types)
This condition allows you to be notified when specific data in your 
company changes in one of the following ways:

■From no value (blank) to a value (specific or non-specific)
■From a value (specific or non-specific) to another value (specific or 
non-specific)
■From a value (specific or non-specific) to no value (blank)

■ After/Before
■ All/None

e In the final field or drop-down list, type or select the remaining part of the 
condition, such as State Is Not Equal To California.

f To add another row of conditions, click the + icon, and repeat steps a 
through e.

13 To add sets of conditions, click Add Condition Block, and specify additional 
conditions in the boxes provided.
Note: Condition blocks combine sets of conditions.
Company Alerts
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14 Select one of the following:
■ AND to match both sets of conditions before an email is sent. 
■ OR to match either set of conditions before an email is sent.

15 If defining conditions for a File Upload custom field, use the Is Equal to and 
Uploaded drop-down lists as part of the condition.

16 Go to “Selecting Alert Email Recipients” on page 394.

Selecting Alert Email Recipients
Security permissions: Community or Company Permissions > Manage Alerts
Use this procedure to select email recipients for an alert based on roles, tags, or 
specific contacts. You can add multiple recipients for each available category.

To select the recipients for an alert
1 After completing the steps in “Adding an Alert Configuration” on page 387 and 

“Defining Alert Triggers and Conditions” on page 389, go to the Notify part of 
the Configure Alerts page. 

2 If the alert:
■ Has an activity associated with it, go to step 3.
■ Does not have an activity associated with it, go to step 5.
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3 Under Notify, click the Activity sub-tab in order to send activity emails based 
on the alert configuration. The email can subsequently include a link to the 
activity for the appropriate participants to complete.

4 Click the Alert sub-tab so recipients receive alert emails based on the 
configuration. 
Important: If the same contacts are selected from the Alert and Activity sub-
tabs, each contact receives two emails after alert conditions are met. One email 
is related to the alert configuration. The other email is related to the activity. 
The activity email can include a link to a form for recipients to complete.

5 From the Select Recipients drop-down list, select one of the following types of 
recipients. Based on previous selections, all options might not be available.

■ Business Role—Select from all business roles defined for the community. At 
least one business role is required.

■ Security Role—Select from all security roles defined for the community.
■ Contacts—If available, select from all contacts in the community.
■ Tags—If available, select from all tags defined in the community.

6 Do one or more of the following to select recipient(s) for the alert:
a Click Select All to select all of the roles, contacts, or tags. Clear the check 

boxes for any roles, contacts, or tags you do not want to receive emails.

b To search for a contact, business or security role, or tag, in the Search box, 
click the Search icon and select the contact, role, or tag from the list. 

c Select the check box for the contact, role, or tag you want to use.
The contacts, roles, or tags are added to the Selected Recipients section at 
the bottom of the page.
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7 To add contacts of a different type, repeat steps 5 and 6.
8 Click Save.

The alert configuration is saved, and a success message displays. 
Active Community checks alert conditions on an hourly basis, and sends an 
email or triggers an activity email if conditions are met.

Configuring an Alert Email Template
Security permissions: 
Community, Company, or Contact Permissions > Manage Alerts
Email templates, which control the content and formatting in emails, use merge 
fields to include values found in the recipient's company or contact profile or in 
custom fields. The merge field acts as a “placeholder” for profile information you 
want Active Community to insert in the email. For more information, see “Email 
Templates” on page 386.

After one email template has been configured, it can be copied and updated to 
create new templates.
Important: As described in this procedure, the Ready for Use check box must 
be selected before the email template can be selected.

To create an email template
1 Click Admin > Alerts tab > Add New Alert.

The New Alert dialog box opens.
2 Select the type of alert you want to create, Contact or Company, and click 

Next.
The Configure Alert page opens. 

3 Scroll down to the Notify section.
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4 In the Email Template field, click the Search icon. 

The Email Template page opens.

5 Click New Email Template.
The Create Email Template page opens.

6 Type or select values in the fields:
a In Name, type a name for the email template.
b In Description, type a description for the email template.

7 Do one of the following:
■ If you are creating an email template for a company alert, go to step, 8.
■ If you are creating an email template for a contact alert, select the type of 

merge field (Contact or Company) you want to insert into the email.
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8 To insert merge fields into the subject line or body, put your cursor where you 
want to insert the merge field.
Note: There are two ways to insert merge fields. You can type the name of 
any custom field in the text box under Available Mail Merge Fields, or you can 
use the Insert buttons to insert the merge fields. 

9 To use the Available Mail Merge Fields text box, start typing the name of the 
field. The box automatically fills with field names that contain the characters 
you type, such as Email.

a Select a field, and click Insert Field.
The mail merge field displays in the body of the email.

b Use the Old Value option to insert an old value merge field. For example, to 
be notified that “John Smith changed his email address from 
jsmith@sample.com to john.smith@sample.com.” do the following:

■ In the Email merge field, select the Old Value option. Active 
Community inserts the merge field for the old email address 
(%pcore_old_email%) into the template

■ In the other Email merge field, select the New Value option (default). 
Active Community inserts the merge field for the new email address 
(%pcore_email%) into the template. 

10 To use the Insert buttons to insert merge fields quickly, click the buttons you 
want. For example:

■ Recipients—Click the first and/or last name of the person to receive the 
alert email

■ User—Click the first and/or last name of the user making the updates
■ Links—Click Profile Link to add a link to the company or contact profile. 

Click Password Link to add a link to change a contact’s password. 
Note: Passwords are not sent in emails. The email message contains 
a link that opens a page in Active Community (password links are not 
available for integrated communities). The recipient of the email uses 
the link to create a new password.

11 To activate the email template, select the Ready for use? check box at the top 
of the page.



A L E R T S
Working with Alerts and Email Templates

OpenText Active Community CE 21.2 User Guide  399

1 1

12 For contact alerts only, to send the alert email to only new users (for example, 
when using the alert as a type of Welcome Email), select the Enable for New 
Users only? check box.

13 Click Save.
Your email template is saved. You return to the Email Templates page.

14 Click the X to return to the Configure Alert page.

Working with Alerts and Email Templates
After email templates have been created, you can edit or delete an alert or an 
email template.
Topics include:
■ “Editing an Alert” on page 399
■ “Deleting an Alert” on page 400
■ “Activating an Alert Email Template” on page 400
■ “Editing an Alert Email Template” on page 401
■ “Deleting an Alert Email Template” on page 402

Editing an Alert
Security permissions: 
Community, Company, or Contact Permissions > Manage Alerts
Use this procedure to edit an alert configuration.

To edit an alert configuration
1 Click Admin > Alerts tab.

The Alerts page opens.

2 Click Edit for the alert configuration you want to update.
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The Edit Alert page opens.

3 Edit the fields (see “Adding an Alert Configuration” on page 387 for field 
descriptions).

4 Click Save. 
The alert configuration is saved. A success message displays. 
Alert conditions are checked on an hourly basis. An email is sent if the 
conditions are met.

Deleting an Alert
Security permissions: 
Community, Company, or Contact Permissions > Manage Alerts
Use this procedure to delete an alert configuration.

To delete an alert configuration
1 Click Admin > Alerts tab.

The Alerts page opens.

2 Click Delete for the alert configuration you want to delete.
A dialog box asks you to confirm you want to delete the alert.

3 Click OK.
The selected alert configuration is deleted.

Activating an Alert Email Template
Security permissions: 
Community, Company, or Contact Permissions > Manage Alerts
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To activate an alert email template
■ Ensure the Ready for Use? check box is selected (see “Configuring an Alert 

Email Template” on page 396 or “Editing an Alert Email Template”).

Editing an Alert Email Template
Security permissions: 
Community, Company, or Contact Permissions > Manage Alerts
Use this procedure to edit an email template associated with an alert configuration. 
You can only edit email templates that you created.
Note: To quickly create a new template, save an existing template with a new 
name and modify it.

To edit an alert email template
1 Click Admin > Alerts tab.

The Alerts page opens.

2 Click Edit for the alert configuration you want to update.
The Edit Alert page opens.

3 Scroll down to the Notify section.
4 In the Email Template field, click the Search icon. 

The Email Templates page opens.

5 Click Edit for the email template you want to edit.
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The Edit Email Template page opens.

6 Edit the fields (see “Configuring an Alert Email Template” on page 396 for field 
descriptions).

7 Click Save.
Changes to the email template are saved. You return to the Email Templates 
page.

8 Click the X to return to the Configure Alert page.

Deleting an Alert Email Template
Security permissions: 
Community, Company, or Contact Permissions > Manage Alerts
Use this procedure to delete email templates you created.

To delete an alert email template
1 Click Admin > Alerts tab.

The Alerts page opens.

2 Click Edit for the alert configuration you want to update.
The Edit Alert page opens.

3 Scroll down to the Notify section.
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4 In the Email Template field, click the Search icon. 

5 In the Email Template field, click the Search icon. 
The Email Templates page opens.

6 Click Delete for the email template you want to delete.
A dialog box asks you to confirm you want to delete the email template.

7 Click OK.
The email template is deleted.
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Active Community Change Management (CM) is a process solution designed to 
help hubs manage and track changes. 
CM is available for company core fields as well as the following company custom 
fields:

A Community Administrator can create a change management process that 
requires approval of any change made to a company core or company custom 
field. Approval or rejection of the change is decided by contacts belonging to a 
selected business role that has been assigned as the change management 
approver(s). 
All contacts in the business role can receive an email notification that a field 
change has been submitted for review. A report is available to provide the details 
of any change management instance, including where in the approval process the 
change is and who is reviewing it.
The change management process allows hubs to be alerted to, and approve or 
reject, changes such as:
■ a spoke changing a bank account number
■ a hub user changing a vendor code or ID that requires executive approval
Topics include:
■ “Change Management Overview” on page 405
■ “Creating a Change Management Process” on page 409
■ “Working with Change Management Processes” on page 414
■ “Working with Change Management Tasks” on page 418

Change Management Overview
Change Management (CM) allows you to easily:
■ Monitor and ensure that specific information is not changed without the proper 

approval (based on a business role)

■ “Drop List” ■ “True/False” ■ “Number”
■ “Multiple Choice” ■ “Yes/No” ■ “Date”
■ “Radio Button List” ■ “Text” ■ “Text Area”
■  Tax ID (EIN), (“Specialized”) ■  Email, (“Specialized”) ■
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■ Receive notification when a company core or company custom field change has 
been submitted for review and when the change has been approved or rejected. 
One email is sent for each CM process even if multiple fields change within that 
process.
Note: Change management does not apply to all custom fields.

■ Ensure (with role-based security) that the field change has been approved by the 
relevant personnel

If a company core or company custom field has been defined as a trigger for a 
change management process, the trigger field in a company profile displays an 
Approval Required icon and rollover text indicating that approval is required to 
change the field. 

If you edit the company profile and change the field, the field displays an icon and 
rollover text indicating that the requested change is in review (the change to the 
field value is pending approval). The current value (if one exists) and requested 
value are displayed, as well as the person requesting the change.

While in review, the field can not be changed; you need to wait until the Requested 
change is in Review icon reverts to the Approval Required icon. This occurs after 
the change has been approved or rejected; the icon reverts to the Approval 
Required icon and the rollover text indicates that approval is required for any 
change to the field.
Topics include:
■ “Change Management Process” on page 406.
■ “Tasks Tab” on page 407
■ “Approval/Rejection of Changes” on page 407
■ “Company Core and Company Custom Fields” on page 409

Change Management Process
Community Administrators can create a change management (CM) process for a 
company core or company custom field(s). Creating a CM process includes:
■ Creating a process name and description
■ Selecting the field(s) and, optionally, the conditions that trigger the change 

management workflow
■ Selecting the business role(s) that have authority to approve/reject the change
■ Deciding whether approvers will be notified by email and whether they will see 

the original and new value(s) for the changed field(s)
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Only one active CM process can exist for a specific custom field(s) at any given 
time. Multiple company core and company custom fields can be used to trigger a 
given CM process; however, once a field is used for a CM process, it cannot be 
used again for another CM process.
When a change is made to the field(s) that is designated to trigger the workflow, 
and defined conditions have been met, the CM process creates an instance of the 
requested change. If more than one change (for example, from different spokes) 
triggers the CM workflow, then more than one instance is created.
For example, each spoke may be taking action on any of a hub’s 5 custom fields at 
a given time, so potentially there can be many instances. To the hub, each change 
request would appear “separate” because each spoke is separate when viewed in 
Active Community.

Tasks Tab
The Tasks tab (Home > Tasks) displays all open and completed change 
management tasks.
After a change management (CM) instance is created, an open task is created for 
approvers to take action on; they can approve or reject the change. The open task 
displays in the Open Tasks section of the Tasks tab.
Note: The Tasks tab in the user interface (UI) is the only way to approve/reject 
CM tasks

Once a CM task is complete (the proposed change(s) has been approved or 
rejected), the completed task displays in the Completed Tasks section.
Note: The Completed Tasks section only displays tasks that you have approved or 
rejected.

Approval/Rejection of Changes
If you are a member of a business role that has been assigned to approve/reject 
changes associated with a change management (CM) process, your CM tasks 
display on the Home > Tasks tab. 
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Each task consists of approving or rejecting the change. Any of the members of the 
assigned business role(s) can take action on a task. When a member takes action 
on a task, it is on a first come, first serve basis. 
To take action on a task, a business role member claims the task from the queue 
and assumes ownership of it. If you claim a task and then decide that you do not 
want to assume ownership of it, you can release the task back to the queue for 
another member to claim.

Approvals
When a task is approved, the following occurs:

■ The change(s) is approved and the task moves from the Open Tasks 
section to the Completed Tasks section (this section only displays tasks 
that you have taken action on).

■ The person who changed the field(s) that triggered the CM workflow 
receives an email notification that their change was approved. At this 
time, notification cannot be turned off. One email is sent for each CM 
process approval.

■ In the company profile, the field(s) is updated with the new value(s).
■ In the company profile, the Requested change is in review icon and 

rollover text revert back to the Approval Required icon and rollover text 
that indicates that approval is required for any change to the field.

Rejections
When a task is rejected, the following occurs:

■ The change is rejected and the task moves from the Open Tasks section 
to the Completed Tasks section (this section only displays tasks that you 
have taken action on).

■ The person who changed the field(s) that triggered the CM workflow 
receives an email notification that their change was rejected. At this 
time, notification cannot be turned off. One email is sent for each CM 
process rejection.

■ In the company profile, the field(s) retains the original value(s) and is 
not updated with the requested change(s).
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■ In the company profile, the Requested change is in review icon and 
rollover text revert back to the Approval Required icon and rollover text 
that indicates that approval is required for any change to the field.

Company Core and Company Custom Fields
There a few things to be aware of when you select a company core or company 
custom field to be subject to change management (CM):
■ In a company profile, if multiple fields are changed simultaneously, and one or 

more are CM-dependent fields, the non-CM-dependent fields are updated 
immediately when the profile is saved. The CM-dependent fields must wait for 
their changes to be reviewed and acted upon. 

■ If you copy a change management enabled custom field into a web form (from 
Profile), any update to the copied custom field will trigger the CM workflow 
before its value is committed to the profile.

■ Parent-child dependent fields can be used as CM triggers. If you select a “child” 
field in a parent-child relationship, the “parent” field is automatically selected 
too.

■ Multiple fields can be used as CM triggers within a CM process. If multiple 
dependent fields are used, they must be part of the same CM process.

■ Tabular fields and tabular field groups are not supported.

Creating a Change Management Process
Security role: Community Administrator
Security permission: Change Management Permissions > Create/Edit/Delete 
Change Management Process

To create a change management process
1 Click Admin > Change Management tab. 
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The Change Management Process page opens.

2 Click Add New Process.
The New Process page opens. 

3 Under Profile Selected: Company, specify the following:
■ Process Name—The name by which you want to identify this process.
■ Description—A description of the process.
■ To enable the change management process, select the Active check box. 

Note: When a CM process is active, change management instances will 
occur every time the selected field(s) (trigger field(s) selected in Step 4) is 
changed for any company profile.

4 Under Select Trigger Field(s), select the field(s) that you want to trigger the 
workflow when the field(s) changes according to the conditions you set in the 
next step (optional). Both company core fields and company custom fields are 
displayed.

■ Company core fields.
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■ Company custom fields are organized by custom field groups.

Note the following: 
■ If data masking is enabled for a field, and you do not have permission to 

view the field, the field is unavailable and cannot be selected.
■ If a field has already been used in another CM process, it is unavailable and 

cannot be selected.
■ If you select a “child” field in a parent-child relationship, the “parent” field 

is automatically selected.
■ Once the CM process is saved, you cannot change the trigger field(s); you 

must create a new CM process.
The trigger field(s) you select is displayed in the Selected Trigger Fields section. 
From here, you can easily remove a field by clicking the x by the field name. 

Note: If you remove the “parent” field in a parent/child relationship, the 
“child” field is also removed from the trigger. 

5 Optional. Do one of the following:
■ If you do not want to set a condition, then any change to the trigger field 

starts the CM workflow. Go to step 10 on page 413.
■ If you want to set a condition(s) to the trigger field, continue with step 7 

on page 412. 
6 Click Add Conditions.

The Condition section displays.
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7 Under Condition, define the conditions for triggering a change management 
workflow. The more conditions you use, the more conditions must be met 
before a workflow is triggered. You can define one or more conditions, 
including sets of conditions.

a Select one of the following:
■ All to trigger a CM workflow if all conditions are met. 
■ Any to trigger a CM workflow if any conditions are met. 

b From the drop-down list, select an option, such as Company Data - Multiple 
choice.
Note: If data masking is enabled for a field, and you do not have 
permission to view the field, the field is unavailable in the drop-down list 
and cannot be selected.

c In the operator drop-down list, which initially displays Contains, select the 
operator that describes how you want Active Community to apply the 
condition, such as Contains or Is Equal To. The options vary based on the 
field you select in the initial drop-down list. Your options may include:

■ Contains/Does Not Contain
■ Is Equal To/Is Not Equal To
■ Is Greater Than/Is Less Than
■ Starts With/Ends With
■ After/Before

d Based on your selection in the operator drop-down list, either type the 
remaining part of the condition in the text box, or select it from the drop-
down list. For example, select choice a so the entire condition is Company 
Data - Multiple choice Is Equal to choice a.

e To add another row of conditions, click the + icon, and repeat steps a 
through d.
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8 To add sets of conditions, click Add Condition Block, and specify additional 
conditions in the boxes provided.
Note: Condition blocks combine sets of conditions.

9 Select:
■ AND to match both sets of conditions before a CM workflow is triggered. 
■ OR to match either set of conditions before a CM workflow is triggered.

10 Under Select Business Roles, select the business role(s) whose members can 
approve/reject any changes to the field that is triggered by the CM process.
Note: All members of a role have the same ability to approve/reject a task. 
The Task is approved/rejected by the first member to claim the task and act on 
it.
Do one or more of the following to select business role(s):

a Select the check box for the business role whose members you want to be 
approvers.

b Click Select All to select all of the business roles. Clear the check boxes for 
any roles you do not want to be approvers.
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c To search for a business role, in the Search box, type the beginning letters 
of the business role, and click the Search icon. Select the business role 
from the list. 

11 If you want approvers to receive an email when the CM workflow is triggered, 
select the Notify Approvers via Email check box. This alerts them to check 
the Home > Tasks tab for CM tasks they need to act on.
Note: If this check box is not selected, an email is not sent, and approvers 
must access the UI and check the Home > Tasks tab to see if there are tasks 
waiting for them to approve/reject.

12 In addition to notifying approvers that a CM task needs their attention, select 
the Show Original and New Value for the changed field check box if you 
want the email notification to display the original value and the new value for 
the field being changed.

13 If you want all fields that are selected as triggers for this CM process included 
in the alert notification email and tasks, even if the values have not changed, 
select the Include Unchanged Fields in the Email/Tasks check box. If the 
values have not been changed, then the old and new values displayed are the 
same.

14 Click Save. The CM process is created.

Working with Change Management Processes
After a change management process (CM) has been created, you can activate, edit 
delete, and view the details of a CM process.
Topics include:
“Activating a Change Management Process” on page 414
“Editing a Change Management Process” on page 415
“Deleting a Change Management Process” on page 416
“Exporting a Report for Change Management Instances” on page 416

Activating a Change Management Process
Security role: Community Administrator
Security permission: Change Management Permissions > Create/Edit/Delete 
Change Management Process
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Use this procedure to activate a change management (CM) process.
Note: Only one active CM process can exist for a specific custom field(s) at any 
given time. Multiple company core and company custom fields can be used to 
trigger a given CM process; however, once a field is used for a CM process, it 
cannot be used again for another CM process.

To activate a change management process
1 Ensure the Active check box is selected (see “Creating a Change Management 

Process” on page 409).
2 Click Save. 

The CM process is active.

Editing a Change Management Process
Security role: Community Administrator
Security permission: Change Management Permissions > Create/Edit/Delete 
Change Management Process
Use this procedure to edit a change management (CM) process.

To edit a change management process
1 Click Admin > Change Management tab. 

The Change Management Process page opens.

2 Click Edit for the CM process you want to update.
The Edit Process page opens.
Note: You cannot edit a CM process if there are active instances that are still 
open. Clear the Active check box to inactivate the process so that no new 
instances are created. You can edit the process when all open instances are 
complete.



416 OpenText Active Community CE 21.2 User Guide

C H A N G E  M A N A G E M E N T
Working with Change Management Processes

3 Edit the fields. See “Creating a Change Management Process” on page 409 for 
field descriptions.
Note: You cannot change the trigger field(s) for an existing CM process; you 
must create a new CM process.

4 Click Save.
5 The CM process is saved. A success message displays.

Deleting a Change Management Process
Security role: Community Administrator
Security permission: Change Management Permissions > Create/Edit/Delete 
Change Management Process
Use this procedure to delete a change management (CM) process.

To delete a change management process
1 Click Admin > Change Management tab. 

The Change Management Process page opens.

2 Click Delete for the CM process you want to delete.
A dialog box warns you that deleting the process will delete all instances of the 
process; it asks you to confirm that you want to delete the process.

3 Do one of the following:
■ Select the Yes, I want to delete the process check box to delete the 

CM process and all instances of the process. The Delete button is enabled. 
Click Delete. The selected CM process is deleted.

■ Click Cancel to cancel the deletion request.

Exporting a Report for Change Management Instances
Security role: Community Administrator
Security permission: Change Management Permissions > Create/Edit/Delete 
Change Management Process
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Each change management (CM) process can have multiple instances associated 
with it. A Community Administrator can use this procedure to export a report of 
open, accepted, and rejected instances associated with a particular CM process.
You can:
■ View the details of each instance in a pop-up window
■ Export the details of all instances to an Excel file

To export a report of change management instances
1 Click Admin > Change Management tab. 

The Change Management Process page opens.

2 Click Report for the CM process whose instance details you want to 
view/export.
The Report window for that instance opens.

3 Do one of the following:
■ Click View for the instance whose details you want to see. 
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A pop-up displays the details. Click the X to close the pop-up.

■ Click Export Report to export the details of all instances associated with 
this CM process to an Excel file. A dialog box asks if you want to open or 
save the file. Click OK.

This is an example of an Excel file.

Working with Change Management Tasks
After a change management process (CM) has been created, and the conditions 
are met to trigger the CM workflow for the selected field, a task is opened. 
Approvers must take action to approve or reject the change. The task displays on 
the Home > Tasks tab of those users who are members of the business role(s) 
selected to be approvers.
Topics include:
■ “Approving/Rejecting a Change Management Task” on page 419
■ “Releasing a Change Management Task” on page 421
■ “Viewing Change Management Instance Details” on page 421
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Approving/Rejecting a Change Management Task
If you are a member of a business role that has been selected to approve/reject 
changes associated with a change management (CM) process, your CM tasks 
display on the Home > Tasks tab. 
Each task consists of approving or rejecting the change. Any one of the members 
of the assigned business role(s) can take action on a task. This is done by claiming 
the task from the queue and assuming ownership of it. If you claim a task and then 
decide that you do not want to assume ownership of it, you can release the task 
back to the queue for another member of the business role(s) to claim.

To claim and approve/reject a task
1 Click Home > Tasks tab.
2 The Tasks page opens.

3 Click Claim for the task you want to take ownership of. 
Release, Approve, Reject, and View buttons display for the task you have 
claimed. Your name displays as the owner of the task: 

Other members of the approver business role(s) see:
■ Status—In Progress
■ Owner—your name
■ Action—only the View link

4 Do one of the following:
■ Click Approve.

The following occurs:



420 OpenText Active Community CE 21.2 User Guide

C H A N G E  M A N A G E M E N T
Working with Change Management Tasks

■ The change is approved and the task moves from the Open Tasks 
section to the Completed Tasks section (this section only displays tasks 
that you have taken action on).

■ The person who changed the field(s) that triggered the CM workflow 
receives an email notification that their change was approved. At this 
time, notification cannot be turned off. An email is sent for each CM 
process.

■ In the company profile, the field(s) is updated with the new value.
■ In the company profile, the Requested change is in review icon and 

rollover text revert back to the Approval Required icon and rollover text 
that indicates that approval is required for any change to the field.

■ Click Reject.
The following occurs:

■ The change is rejected and the task moves from the Open Tasks section 
to the Completed Tasks section (this section only displays tasks that you 
have taken action on).

■ The person who changed the field that triggered the CM workflow 
receives an email notification that their change was rejected. At this 
time, notification cannot be turned off. An email is sent for each CM 
rejection.

■ In the company profile, the field retains the original value and is not 
updated with the requested change.

■ In the company profile, the Requested change is in review icon and 
rollover text revert back to the Approval Required icon and rollover text 
that indicates that approval is required for any change to the field.
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Releasing a Change Management Task
If you claim a task and then decide that you do not want to assume ownership to 
take action on that task, you can release the task back to the queue for another 
member of the business role(s) to claim and act on.

To release a change management task
1 Click Home > Tasks tab.
2 The Tasks page opens.

Release, Approve, Reject, and View buttons display for tasks that you have 
claimed. Your name displays as the owner of the task.

3 Click Release for the task you want to put back in the queue. 

The buttons for the task change to Claim and View, and the task can now be 
claimed by someone else with the appropriate business role. 

Viewing Change Management Instance Details
You can view the details of a change management instance (open or complete 
task).

To view change management instance details
1 Click Home > Tasks tab.
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2 The Tasks page opens.

3 Click View for the instance whose details you want to see. 
A pop-up displays the details. Click the X to close the pop-up.

Note: A Community Administrator can export a report of all open, accepted, 
and rejected instances associated with a particular CM process. See “Exporting 
a Report for Change Management Instances” on page 416.
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The Registration module lets a hub company register potential new suppliers in a 
community by sending registration requests. A registration request is an electronic 
form that contains information from a prospective trading partner. 
After following an approval process, the trading partner information from an 
approved registration request is automatically added to company and contact 
profiles in the hub’s community.
Important: Because the Registration module relies on many functions in a 
standard Active Community system, such as core fields, custom fields, contacts, 
and roles, a basic system must exist. Only then can the registration request 
approval process be setup.
This section describes how to set up the Registration module. Topics include:
■ “Registration Setup Overview” on page 423
■ “Phase 1: Plan Data to be Collected from Future Suppliers” on page 431
■ “Phase 2: Design a Registration Workflow” on page 438
■ “Phase 3: Customize Email Templates” on page 446
■ “Phase 4: Configure Approval Levels and Groups” on page 460
■ “Phase 5: Configure Other Registration Settings” on page 469
■ “What’s Next?” on page 475

Registration Setup Overview
A registration request is an electronic form that contains information from a 
prospective trading partner. The information in the request must be approved by 
contacts in the hub community before the prospective supplier can be added to a 
community. The request is supported by a workflow that passes through several 
phases until the prospective trading partner is registered.
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Each registration request includes tabs that contain categories of company 
registration information. The information can include company, contact, product, 
financial, and other information. 

The hub customizes registration tabs to reflect information they want to collect for 
their community. For example, a hub might include a custom field named Terms 
and Conditions as a tab. Prospective suppliers must agree to the hub’s terms and 
conditions before they can be added to the hub’s community.
Topics include:
■ “Request Approval Process” on page 425
■ “Registration Roles and Contacts” on page 425
■ “Registration Email Templates” on page 427
■ “Roles, Workflow Actions, and Request Buttons” on page 427
■ “Registration Request Planning” on page 429
■ “Registration Setup Process” on page 429
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Request Approval Process
A registration workflow drives the registration request approval process. For 
example, a registration request might follow this approval process (depending on 
how the registration workflow is set up).

5

1 2 3 4

Request Approval Process
Key Description
1 Internal/External Requestor Creates Request
2 Pre-Approval/hub Member Pre-Approves Request
3 Potential Supplier Adds Data to Request
4 Approval/hub member Approves Request
5 Company and Contact created in TGO (only for TGO integrated communities) and 

Registered in Active Community

The registration workflow starts when a request is:
1 Submitted to the hub community by a Requester contact, such as an account 

manager in the hub company or a prospective trading partner.
2 Pre-approved by a contact in the hub community, such as a supply chain 

manager.
3 Sent to the trading partner's point-of-contact (Primary Contact) to provide 

supplemental information about themselves and their company. 
The information might include insurance certificates, contacts in primary 
business roles, or payment terms.

4 Approved by another employee of the hub community, such as a finance 
manager. 

5 After approval, for TGO integrated communities only, the trading partner is 
added to Trading Grid Online. In the hub's community, Active Community 
creates company and contact profiles for the new partner. 
The newly added company or contact can be searched for and located by any 
member of the community.

Registration Roles and Contacts
Registration roles and contacts control the amount of information a person sees on 
a company registration request. The information in a request is based on a 
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contact’s registration role or on the “part” a contact plays in the registration 
process. That is, the:
■ Pre-Approval and Approval roles can be assigned to contacts in the hub 

community. In addition to security roles, these registration roles are assigned to 
contacts.

■ Requesters and Primary Contacts are contacts inside and outside the hub 
community. Registration roles cannot be assigned to them.

Topics include:
■ “Requester” on page 426
■ “Pre-Approval Role” on page 426
■ “Primary Contact” on page 426
■ “Approval Role” on page 426
Note: To edit permissions for registration roles and assign roles to contacts, see 
“Working with Registration Roles” on page 88. For a list of available permissions, 
see “Registration Role Permission Descriptions” on page 89.

Requester
Requesters create or submit registration requests. 
A Requester can be a contact inside or outside the hub community, such as an 
account manager in the hub company or a contact with a potential supplier. 
Requesters can be contacts with these business roles: buyer, sales representative, 
or supplier liaison.

Pre-Approval Role
Hub contacts in the Pre-approval role review registration requests and pre-approve 
them. The request then goes to the next stage in the registration process. 
The Pre-Approval role can be assigned to such hub employees as category 
managers or buyers. Multiple Pre-Approval roles can be defined.
The hub contact must be a member of a pre-approval group. 

Primary Contact
Primary Contacts receive registration requests from the hub company and 
complete information in the request. 
A Primary Contact is the primary contact for a company outside the hub 
community. 

Approval Role
Hub contacts in the Approval role validate that a Primary Contact has completed all 
required details in a registration request. Contacts in the role decide if they need 
to:
■ Return the request to a Primary Contact because it contains incomplete 

information or 
■ Approve the request and register the company in their community. 
Multiple Approval roles can be defined.
The hub contact must be a member of an approval group. 
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Registration Email Templates
Emails can be sent to all roles in the workflow, or all people involved in registration 
inside and outside of the hub community. They can also be sent to specific roles, 
such as the primary point-of-contact at the supplier.
Note: When “Assigning Contacts to Approval Groups,” the Receive Emails field 
must be selected for users to receive emails.
Active Community uses email templates to send messages to contacts in 
registration roles. Standard email templates are provided and can be customized. 
Multiple languages are supported.
Here are the names of some standard email templates for workflow emails. Not all 
template names are listed. 

For all standard templates, see “Workflow Email Templates” on page 450 and 
“Reminder Email Templates” on page 454.

Roles, Workflow Actions, and Request Buttons
The table shows the relationship between actions selected in a registration 
workflow and the buttons that display (or not) in registration requests. 
The last column outlines what the workflow does if contacts in a role click the 
button in a registration request. The button might cause the request to be returned 
to a different role or to different stage in the registration approval process.

■ New Company Request
■ Copy to Requester
■ Submitted for Pre-Approval
■ Sent to Company to Complete
■ Submitted for Approval
■ Returned to Requester
■ New company request returned to all 

Pre-approvers
■ New company request returned to 

company

■ New Company Request, continued
■ New company request declined back to 

Requester
■ New company request declined back to 

Pre-approvers
■ New company request declined back to 

Requester
■ New Registered Company

■ Copy to Requester
■ Copy to Pre-Approvers

For the…
If this workflow 
action is selected….

This button displays in a 
registration request… If the button is clicked, this happens:

Requester contact
Re-Open Re-Open Request Requester contact reopens a request that 

was declined by a Pre-Approval role.

Submit Request Requester contact submits the request to 
the Pre-Approval role.

Hold Hold/Reactivate Requestor contact puts the request on hold 
to obtain more information and reactivates 
the request when ready to continue with 
the request. 
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Pre-Approval role (all levels)
Return Return for More Information Pre-Approval role sends request back to the 

Requester contact for more information.
Decline Decline Request Pre-Approval role declines the request and 

sends it back to the Requester contact. 
Note: If the Re-Open action is selected in 
the workflow, the Requester can click Re-
Open Request to reopen the request and 
send it back to the Pre-Approval role.

Re-Open Re-Open Request Pre-Approval role re-opens a request that 
was declined by a company.

Approve Approve Request Pre-Approval role sends request to the next 
level of approval (in the case of multiple 
levels).

Hold Hold/Reactivate Pre-Approval role puts the request on hold 
to obtain more information and reactivates 
the request when ready to continue with 
the request approval process. 

Primary Contact
Return Return for More Information Primary Contact returns the request to the 

Pre-Approval role for more information.
Decline Decline Request Primary Contact declines the request, which 

is returned to the Pre-Approval role. 
Note: If the Re-Open action is selected in 
the workflow, the Primary Contact can click 
Re-Open Request to reopen the request 
and send it back the Pre-Approval role.

Submit Request Primary Contact submits request to the 
Approval role.

Approval role
Return Return for More Information Approval role returns the request to the 

Primary Contact for more information.
Decline Decline Request Approval role declines the request and 

sends it back to the Requester contact.
Approve Request Approval role approves the request and the 

supplier is registered in Active Community.
Recall Request Recalls or withdraws a request and sends it 

back to the Pre-Approval stage. Information 
in the request can be corrected, such as an 
incorrect email address, and the request be 
resent.

Hold Hold/Reactivate Approval role puts the request on hold to 
obtain more information and reactivates the 
request when ready to continue with the 
request approval process. 

For the…
If this workflow 
action is selected….

This button displays in a 
registration request… If the button is clicked, this happens:
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Registration Request Planning
The registration setup process requires planning on the part of the hub company.
OpenText recommends the administrator at the hub work with others to design a 
registration request and to configure workflow, email messages, and other 
settings. After planning is complete, Active Community can gather information 
from prospective suppliers and trading partners and automatically add them to 
your community. 

Registration Setup Process 
Registration module set up involves several phases, which are listed in the graphic 
and in the table that follows. 

1

2 3 4 5 6

7

Registration Setup Process
Key Description
1 Plan Registration Process
2 Plan Data to be Collected from Future Suppliers

■ Core fields
■ Custom fields
■ Business roles

3 Design a Registration Workflow
■ Select workflow actions
■ Select workflow emails

4 Customize Email Templates
■ Customize workflow email templates
■ Customize reminder email templates

5 Configure Approval Levels and Groups
■ Configure approval levels
■ Manage approval level names
■ Create approval groups
■ Assign roles and settings
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The table provides links to the appropriate procedures for each phase.

6 Configure Other Registration Settings
■ Reminder email frequency
■ Emails (to, from, undelivered)
■ Document title for registration request report
■ Anonymous request settings
■ Assign Registration Admin role

7 Requests can be Created for Future Suppliers

Choose (or use) the following options... When you are:
“Phase 1: Plan Data to be Collected from Future Suppliers” on page 431
Applications > Registration > Admin tab >

■ Core Field Settings
■ “Defining Core Fields in Registration Requests” on 

page 431

■ TGO Invitation Codes ■ “Managing TGO Invitation Codes” on page 434
■ Manage Permissions ■ “Defining Custom Field Forms in Registration 

Requests” on page 435
■ Registration Settings ■ “Gathering Business Role Data in Registration 

Requests” on page 437
“Phase 2: Design a Registration Workflow” on page 438
Applications > Registration > Admin tab > Configure 
Overall Workflow

■ “Configuring Workflow Actions” on page 443
■ “Configuring Workflow Emails” on page 445

“Phase 3: Customize Email Templates” on page 446
Applications > Registration > Admin tab >

■ Configure Overall Workflow
■ “Customizing Workflow Email Templates” on 

page 456

■ Registration Settings ■ “Customizing Reminder Email Templates” on 
page 458

■ Emails in a Different (Supported) Language ■ “Configuring an Email in a Different (Supported) 
Language” on page 460

“Phase 4: Configure Approval Levels and Groups” on page 460
Applications > Registration > Admin tab >

■ Configure Approvals
■ “Defining Approval Levels and Approval Names” on 

page 461
■ “Bypassing Pre-Approval and Approval Levels” on 

page 468
■ Manage Approval Groups ■ “Adding Approval Groups Based on Approval Levels” 

on page 463
■ Contact Security Settings ■ “Assigning Contacts to Approval Groups” on page 464
■ Map Approval Groups to Approval Roles ■ “Mapping Approval Groups to Approval Levels” on 

page 466
“Phase 5: Configure Other Registration Settings” on page 469
Applications > Registration > Admin tab >

■ Registration Settings
■ “Defining Reminder Email Settings” on page 470

■ Email Settings ■ “Configuring From, To, and Undeliverable Email 
Addresses” on page 472

Key Description
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Phase 1: Plan Data to be Collected from Future Suppliers
The first phase in the registration setup process is to define the information you 
want to collect from prospective suppliers.

1

Phase 1: Plan Data to be Collected from Future Suppliers

Key Description
1 Plan Data to be Collected from Future Suppliers

Topics include:
■ “Defining Core Fields in Registration Requests” on page 431
■ “Managing TGO Invitation Codes” on page 434
■ “Defining Custom Field Forms in Registration Requests” on page 435
■ “Gathering Business Role Data in Registration Requests” on page 437

Defining Core Fields in Registration Requests
Security roles: Community Administrator and/or Registration Administrator
Use this procedure to define which company and contact core fields you want to 
include in a registration request. Core fields provide basic information about a 
company or contact. The administrator can also select when required core fields 

■ Customize document title for registration request 
report

■ “Customize Document Title for Registration Request 
Report” on page 473

■ Anonymous Request Settings ■ “Configuring Anonymous Request Settings” on 
page 473

■ Core fields
■ Custom fields
■ Business roles

Choose (or use) the following options... When you are:
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(both company and contact fields) become mandatory (for example, at what 
stage).
Fields that are required, display an asterisk during registration. Fields that are not 
required, do not display an asterisk.

To define core fields in registration requests
1 Click Applications > Registration > Admin tab.
2 Click the Core Field Settings link. 

The Registration Core Fields page opens to Company in Registration link. 

Note: For TGO integrated communities, the Address, State, Postal Code, 
Country, and TGO Service fields are checked by default and cannot be cleared. 

3 Select the check boxes for the company core fields you want included in the 
registration request. The Required Stage drop-down list displays if a check box 
is selected.
Note: If a check box is de-selected or cleared, it means the field is optional. 
Some fields cannot be de-selected or cleared because they are always required.

4 From the Required Stage drop-down list, select the approval stage for which 
you want this field to be required. 
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The default stage is the first available stage of registration, but administrators 
can change the stage to a later one; after a selection is made, the asterisk that 
indicates a field is mandatory displays for the field.
Note: The selections in the drop-down list vary depending on the number of 
approval levels you selected on the Configure Approval page (see “Defining 
Approval Levels and Approval Names” on page 461).

5 Optional. If you want the Company ID to be populated with a specific custom 
field value, select the custom field from the second drop-down list for the 
Company ID field.

Note: Custom fields can only be selected if they are Number, Text, or 
Specialized (Tax ID) custom fields and if they do not have any of the following 
options enabled: Enable Masking, Set Default Answer, and Make Dependent on 
Another Question.
See “Set a Custom Field as the Company ID” on page 233.

6 TGO Service field is required for TGO integrated communities. Active 
Community uses Trading Grid Online (TGO) invitation codes to automatically 
provision a Trading Partner (registration request) with a TGO service (for 
example, Intelligent Web Forms (IWF), Active Orders (AO), or Active Invoices 
with Compliance (AIC)).
To add or view invitation codes, see “Managing TGO Invitation Codes” on 
page 434.

7 At the top of the page, click the Contact in Registration link.
8 Select the check boxes for the contact core fields you want to included in the 

registration request. The Required Stage drop-down list displays if a check box is 
selected.
Note: If a check box is de-selected or cleared, it means the field is optional. 
Some fields cannot be de-selected or cleared because they are always required.

9 From the Required Stage drop-down list, select the approval stage for which 
you want to require this field. 
The default stage is the first available stage of registration, but administrators 
can change the stage to a later one; after a selection is made, the asterisk that 
indicates a field is mandatory displays for the field.
Note: The selections in the drop-down list vary depending on the number of 
approval levels you selected on the Configure Approval page (see “Defining 
Approval Levels and Approval Names” on page 461).

10 Click Save to save the settings.
Your settings are reflected in the registration request.
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Managing TGO Invitation Codes
Security roles: Registration Administrator
Trading Grid Online (TGO) invitation codes are required for provisioning a Trading 
Partner (registration request) with a TGO application such as Intelligent Web Forms 
(IWF), Active Orders (AO), or Active Invoices with Compliance (AIC)).
You can obtain your company’s TGO invitation code from your Implementor or by 
contacting your OpenText program manager.
Use this procedure to:
■ Add a TGO invitation code that can be selected from a drop-down list on the 

registration request.
■ View a list of existing TGO invitation codes.

To add or view TGO invitation codes
1 Click Applications > Registration > Admin tab.
2 Click the Core Field Settings link. 

The Registration Core Fields page opens to Company in Registration link. 
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3 Perform the appropriate action.

Defining Custom Field Forms in Registration Requests
Security roles: Community Administrator and/or Registration Administrator
Use this procedure to control which custom field groups are included in a 
registration request. In the request, each custom field group is displayed as a tab. 
You select the custom field groups that can be viewed or edited by each 
registration role. By doing so, contacts in a role might not be able to view a 
particular tab (for example, the Questions tab). 
For example, you want the Requester contact (a buyer or sales representative) to 
view and edit custom fields in a Buyer Checklist tab. You do not want contacts in 
the Pre-Approval role (procurement) to be able to see the same tab. The following 

To... Do this:
Add a TGO invitation code 1 Click Add New Invitation Code.

The Add New Invitation Code pop-up 
opens.

2 In Invitation Code Label, type a name for 
the invitation code. 

3 In Invitation Code, type a code for the 
invitation code.

4 Click Save.
The invitation code is added.

View a list of existing TGO invitation 
codes

1 Click Show Invitation Codes.
The Invitation Codes List pop-up opens.

2 When you are done viewing the list, click 
OK.
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settings would allow Requester contacts to see the tab, but not contacts in the Pre-
Approval role.

Important: Custom field information shown in request tabs is displayed or 
hidden based on selections in View/Edit Group or Field as described in this 
procedure. 

To define custom fields for registration requests
1 Click Applications > Registration > Admin tab.

The Registration Setup page opens.
2 Click the Manage Permissions link.

The Registration Permissions page opens.

3 For each custom field group, select or clear the check boxes for the tabs or 
fields you want registration roles and contacts to view or edit on a registration 
request.
Note: The Primary Contact Details field group (tab) is now nested under the 
Contact Details field group (tab).
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4 Change the tab order of the custom and core field groups, as needed, by 
clicking a field group (tab) and dragging it up or down with your cursor, then 
releasing the cursor.

5 Click Save. 

Gathering Business Role Data in Registration Requests
Security roles: Community Administrator and/or Registration Administrator
Use this procedure to collect information about people in business or functional 
roles during the registration process. For example, you might want to collect the 
name, email address, and phone number of a supplier's chief financial officer, 
supply chain manager, and distribution manager. 
When the request is approved and the supplier is registered in your community, 
the business role information is available to you in contact profiles.

To collect business role data in registration requests
1 Click Applications > Registration > Admin tab.
2 Click the Registration Settings link.

The Registration Settings page opens.

3 In the Contact Collection part of the page, indicate which business roles you 
want to collect from prospective suppliers during the registration process. If 
you select:
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■ Required—Prospective suppliers must provide information for at least one 
person for each role in the request. If they do not, their request cannot be 
submitted for approval.

■ Not Required—Prospective suppliers can provide the role information, but it 
is not required. If they do not, their request can be submitted for approval.

■ Optional—Prospective suppliers have the option of providing the 
information. Their request can be submitted for approval with or without 
the information.

4 Click Save.
You have saved settings for contact role collection in a registration request.

Phase 2: Design a Registration Workflow
The second phase in the registration setup process is to define the registration 
workflow for the hub community. Active Community provides a pre-configured 
workflow. The workflow can be customized to meet the hub’s business needs (see 
“Registration Request Planning” on page 429).

1

Phase 2: Design a Registration Workflow
Key Description
1 Design a Registration Workflow

Topics include:
■ “Understanding the Registration Process Page” on page 439
■ “Configuring Workflow Actions” on page 443
■ “Configuring Workflow Emails” on page 445

■ Select workflow actions
■ Select workflow emails



R E G I S T R A T I O N  S E T U P
Phase 2: Design a Registration Workflow

OpenText Active Community CE 21.2 User Guide  439

1 3

Understanding the Registration Process Page
The Registration process page shows a Registration workflow by role, including 
workflow actions and links to email templates. 

The page lists:
■ Registration roles and contacts (for example, Requestor, Pre-Approval, Primary 

Contact, Approval). The standard role and contact names can be customized 
(see “Registration Roles and Contacts” on page 425 and “Defining Approval 
Levels and Approval Names” on page 461).

■ Actions, such as Hold, Return, Reopen, or Decline a registration request, can be 
included or excluded in various workflow phases, depending on a hub’s business 
process for registering prospective suppliers. An action is shown with a check 
box for the role that can perform it. 

■ Email templates send email messages to contacts in registration roles. Emails 
can be included or excluded at many points in the workflow process. An email 
template is shown as a link in the box for the role that can perform it. 

Important: Workflow actions and email templates are visually connected to the 
lines in the workflow. 
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To better understand how to work with the Registration Process page, see the 
following topics:
■ “Simple Registration Workflow” on page 440
■ “Typical Registration Workflow” on page 442

Simple Registration Workflow
The graphic shows a simple registration workflow where all actions go as planned. 
That is, the Requester submits a request, the request is approved by the Pre-
Approval role, the request goes back to the Primary Contact at the supplier for 
more information, and the Approval role approves the request.
When a contact in the Approval role approves the request, Active Community:
■ Creates the company and contacts based on information in the completed 

registration request. 
■ Sends emails to the Pre-Approval role and the Requester contact and the Primary 

Contact to notify them the company was registered in the hub’s community.
Important: Email notifications are visually tied to workflow actions, such as 
submit a request, pre-approve a request, and approve a request. You customize 
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email templates represented by the boxes by clicking the Email link associated with 
the workflow action. 

Action Key
1 Hub sends “New Company Request, Copy to Requester” email to Requester contact
2 Requester contact sends “New Company Request Submitted for Pre-Approval” email 

to Pre-Approval role
3 Pre-Approval role sends “New Company Request Sent to Company to Complete” 

email to Primary Contact
4 Primary Contact sends “New Company Request Submitted for Approval” email to 

Approval role
5 Approval role sends “New Registered Company, Copy to Requester” email to 

Requester contact
6 Approval role sends “New Registered Company, Copy to Pre-Approvers” email to Pre-

Approval role

1

2

3

4

7

6

5

Registration Workflow Start

8
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Typical Registration Workflow
This graphic shows a more complex registration workflow where registration 
requests are returned or declined. 
When a contact in the Approval role approves the request, Active Community:
■ Creates the company and contacts based on information in the completed 

registration request.
■ Sends emails to the Pre-Approval role and the Requester contact and the Primary 

Contact to notify them the company was registered in the hub’s community.
Important: Email notifications are visually tied to workflow actions, such as 
return request or decline request. You customize email templates by clicking the 
Email link associated with the workflow action.

7 Approval role sends “New Registered Company, Copy to Company” email to Primary 
Contact

8 Approval role sends “New Registered Company, Copy to All Approvers” email to all 
approvers at all approval levels

Action Key
1 Pre-Approval role sends “New company request returned to requester” email to 

Requester contact

1

2

3

4

5

6

7

8
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Configuring Workflow Actions
Security roles: Community Administrator and/or Registration Administrator
Important: Before you begin, ensure you review “Understanding the Registration 
Process Page” on page 439.
To configure a Registration workflow, select or clear check boxes for the actions 
you want to enable or disable for each registration role and contact. If you clear an 
action, that action button does not display in a registration request (see “Roles, 
Workflow Actions, and Request Buttons” on page 427). For example:
■ If you clear the Return check box for the Approver role, all people in your 

organization who are Approvers (such as finance or supplier relations) do not see 
the Return for More Information button on registration requests.

■ If you want your Pre-Approval role (procurement) to be able to re-submit a 
registration request if the supplier declines it because they do not recognize the 
sender, select the Re-Open check box. The Reopen Request button displays on 
registration requests.

To configure actions in a registration workflow
1 Click Applications > Registration > Admin tab.

2 Pre-Approval role sends “New company request returned to all pre-approvers” email 
to Primary Contact

3 Approval role sends “New company request returned to company” email to Primary 
Contact

4 Pre-Approval role sends “New company request declined back to requester” email to 
Requester contact
Note: A request created using an anonymous URL can only be opened using the URL 
in the declined email message to the Requester contact. If the check box is clear or 
the email is unattended, the request cannot be reopened. 

5 Primary Contact sends “New company request declined back to pre-approvers” email 
to Pre-Approval role

6 Approval role sends “New company request declined back to requester” email to 
Requester contact

7 Approval role sends “New company request declined back to requester, copy pre-
approvers” email to Approval role

8 Approval role sends “New company request declined back to requester, copy to 
company” email to Approval role
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The Registration Setup page opens.
2 Click the Configure Overall Workflow link.

The Registration Process page opens.
In general, the lines with arrows that go down or up indicate workflow actions. 
The dotted lines (in the graphic) are a reminder that selected actions are 
specific to the roles and contacts listed (for example, Requestor, Pre-Approval, 
Primary Contact, Approval).

3 Select or clear check boxes for the actions you want to enable or disable for 
each registration role and contact. 
Important: When you clear an action, that action button does not display on 
the request. 

4 Click Save. 
5 Go to step 3 in “Configuring Workflow Emails” on page 445.
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Configuring Workflow Emails
Security roles: Community Administrator and/or Registration Administrator
Important: Before you begin, ensure you review “Understanding the Registration 
Process Page” on page 439.
To configure email notifications to be sent to various roles at different stages of the 
registration process, select or clear check boxes for the email templates you want 
to enable or disable for each registration role and contact. For example:
■ If you want a person who submits a registration request (buyer, sales 

representative, or another person) to receive an email copy of his or her request, 
select the Email check box. If you also want to notify the Pre-Approval role to 
notify him or her of a request that needs to be reviewed), select the Email check 
box. 

■ If you want a Requester contact (buyer) to receive an email when the Pre-
Approval role approves the request, select the Email check box. If you do not 
want the Pre-Approval role to be notified (since that contact approved the 
request), do not select the Email check box.

To configure emails for a registration request
1 Click Applications > Registration > Admin tab.

The Registration Setup page opens.
2 Click the Configure Overall Workflow link.
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The Registration Process page opens. Emails are indicated by Email check 
boxes.
Note: Remember, workflow actions and email templates are visually 
connected to the lines in the workflow.

3 Select or clear check boxes for the emails you want to enable or disable for 
each registration role and contact. 
Note: For example, if you want a Requester contact (buyer, sales 
representative, or another person) to receive an email copy of their request, 
select the Email check box for the Requestor for the Submit action.

4 Click Save. 
5 To customize the text for each email message, click the Email link to view and 

customize the message. For details, see “Phase 3: Customize Email Templates” 
on page 446.

Phase 3: Customize Email Templates
The next phase in the registration setup process is to tailor the message text for 
workflow or reminder email templates used by the host (that is, the email 
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templates selected in the registration workflow). Active Community provides 
standard email templates that are easily customized.

1

Phase 3: Customize Email Templates
Key Description
1 Customize Email Templates

Email messages can be sent to new suppliers indicating they have been registered 
in Active Community, existing suppliers indicating their changes are being reviewed 
for approval, and procurement or supplier relation staff at the hub indicating 
requests are waiting to be reviewed and approved.
Topics include:
■ “About Form Fields” on page 447
■ “Workflow Email Templates” on page 450
■ “Reminder Email Templates” on page 454
■ “Customizing Workflow Email Templates” on page 456
■ “Customizing Reminder Email Templates” on page 458
■ “Configuring an Email in a Different (Supported) Language” on page 460

About Form Fields
Form fields (merge fields) use data extracted from core and custom fields in 
completed registration requests. They are “placeholder” fields that Active 
Community uses to insert values into email messages. 
Note: The following custom field question formats are not supported as form 
fields in email messages: File Download, File Upload, Display Image Fields.

■ Customize workflow email templates
■ Customize reminder email templates
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Percent signs (%) start and end each form field, for example, “%First Name%” 
and “%Last Name%. Regular text can be included between the % signs, for 
example, %From First Name%” and “%From Last Name%.
For example, in the default email template for the “New company request second 
reminder” email, form fields are highlighted with bold text. The email reminds the 
Primary Contact to respond to a registration request.

Dear %To First Name% %To Last Name% ,
%Reminder - Number of Days% days ago you were sent a request to register with 
%Hub Company Name%. This is our second reminder to you about this registration 
request. To date, we see that you have not completed the registration forms. The 
completion of this registration request is important for us to do business with you. Please 
contact me ASAP, see my contact details below.

Please click the link to %View Request Link%.

If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL%

Regards,
%From First Name% %From Last Name%
%From Phone Number%
%From Company Name%

Based on form fields in the email template, the following email was sent. The form 
fields were filled in with the appropriate information from data in the registration 
request.

Dear Jane Smith,
Reminder 5 days ago you were sent a request to register with Acme Company. This is our 
second reminder to you about this registration request. To date, we see that you have 
not completed the registration forms. The completion of this registration request is 
important for us to do business with you. Please contact me ASAP, see my contact details 
below.

Please click the link to www.acmecompany.com.

If you have trouble with the link, please copy and paste the following address into your 
browser: www.requestURL.com

Regards,
Robert Jones
713-454-7752
Acme Company
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Sample Email Template Page
The graphic shows the parts of the “New company request second reminder” 
registration email template (see “Customizing Reminder Email Templates” on 
page 458). 

T o  a n d  F r o m
To and From fields are populated based on registration roles and contacts, 
workflow actions, and the phase of the registration process in which the email is 
being sent. In this example, the registration reminder email is sent based on the 
number of days after an initial reminder email was sent.

I n s e r t  a n d  A v a i l a b l e  M e r g e  F i e l d s
Use Insert buttons to insert form fields into the subject line and body of a 
registration request. For example, when you click First Name, the field %First 
Name% is inserted in the message text. Active Community uses the first name in 
the recipient's completed registration request (for example, “John”) to replace the 
%First Name% “placeholder” when the message is sent. 
Under Available Merge Fields, you can also use the drop down list and text box 
field to insert core and custom fields as merge fields by selecting the field type 
from the Select Field Type drop down list (for example, Company), and then 
type a field name into the Select Field box (for example, Tax ID). Then click 
Insert Field to insert the field into the body of the message text.
Note: The following custom field question formats are not supported as merge 
fields in email messages: File Download, File Upload, Display Image Fields.
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S u b j e c t  L i n e  a n d  M e s s a g e  T e x t
The Subject line and Message Text can be customized by using a combination of 
regular text and “placeholder” text (merge fields).
Note: The following custom field question formats are not supported as merge 
fields in email messages: File Download, File Upload, Display Image Fields.
The message can also include attachments, such a spreadsheets or images.

Important: So emails can flow through email servers, there is a 2 MB limit on 
attachments.

Workflow Email Templates
The actions in a registration workflow determine which registration emails Active 
Community sends to registration roles and contacts. You access and customize 
standard email templates from the Registration Process page, which is also used to 
define workflow actions. Email templates support multiple languages (see 
“Configuring an Email in a Different (Supported) Language” on page 460).
Each standard email template is described in the following topics:
■ “Submit Action Email Templates” on page 450
■ “Pre-Approve Action Email Templates” on page 450
■ “Registration Request Action Email Templates” on page 451
■ “Approval Action Email Templates” on page 451
■ “Return Action Email Templates” on page 452
■ “Decline Action Email Templates” on page 453

Submit Action Email Templates

N e w  C o m pa n y  R e q u e s t ,  C o py  t o  R e q u e s t e r
The email indicates the request has been submitted for approval. It is sent from 
the hub community to the Requester contact.

Dear %To First Name% %To Last Name%,
Your new company request for %Request Company% has been sent for approval.
You may monitor this request at any time.
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL%

Pre-Approve Action Email Templates

N e w  C o m pa n y  R e q u e s t  S u b mi t t e d  f o r  P r e - A p p r o v a l
The email indicates the request must be reviewed and approved. It is sent from 
the Requester contact to the Pre-Approval role.

Dear Pre-Approvers,
A new company registration request for %Request Company% has been sent for 
approval.
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL%
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Regards from the requester
%From First Name% %From Last Name%
%From Phone Number%
%From Company Name%

Registration Request Action Email Templates

N e w  C o m pa n y  R e q u e s t  S e n t  t o  C o m p a n y  t o  C o m pl e t e
The email includes a link to the standard registration request for the host. It is sent 
from the Pre-Approval role to the Primary Contact. It is associated with the 
Registration Request action in the workflow.

Dear %To First Name% %To Last Name% ,
You have been accepted to register with %Hub Company Name% . We have a standard 
registration form that you need to complete in order to be set up.
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL%
If you have any questions please contact me,
%From First Name% %From Last Name%
%From Phone Number%
%From Company Name%

Approval Action Email Templates

N e w  C o m pa n y  R e q u e s t  S ub m i t t e d  f o r  A p p r o v a l
The email indicates the Primary Contact submitted the completed registration 
request to the Approval role. It is sent from Primary Contact to the Approval role. It 
is associated with the Approval Action in the workflow.

Dear Approvers,
%From First Name% %From Last Name% from %Request Company% has submitted 
their registration forms for approval and registration.
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL%

N e w  R e g i s t e re d  C o m p an y ,  C o p y  t o  R e qu e s t e r
The email notifies the Requester contact the company has been registered in the 
hub’s community. It is sent from the Approval role to the Requester contact. It is 
associated with the Approval Action in the workflow.

Dear %To First Name% %To Last Name% ,
%Request Company% has been registered with %Hub Company Name%
Regards
%From First Name% %From Last Name%
%From Phone Number%
%From Company Name%

N e w  R e g i s t e re d  C o m p an y ,  C o p y  t o  P r e - A p p ro v e r s
The email notifies the pre-approvers the company has been registered in the hub’s 
community. It is sent from the Approval role to the Pre-Approval role. It is 
associated with the Approval Action in the workflow.

Dear Pre-Approvers,
%Request Company% has been registered with %Hub Company Name%
Regards
%From First Name% %From Last Name%
%From Phone Number%
%From Company Name%
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N e w  R e g i s t e re d  C o m p an y ,  C o p y  t o  C o m p a n y
The email notifies the Primary Contact the company has been registered in the 
hub’s community. It is sent from the Approval role to the Primary Contact. It is 
associated with the Approval Action in the workflow.

Dear %To First Name% %To Last Name% ,
%Request Company% has been registered with %Hub Company Name% 
If you have any questions please contact me,
%From First Name% %From Last Name%
%From Phone Number%
%Hub Company Name%

N e w  R e g i s t e re d  C o m p an y ,  C o p y  t o  A l l  A p pr o v e r s
The email notifies all approvers at all approval levels the company has been 
registered in the hub’s community. It is sent from the Approval role to all approval 
roles. It is associated with the Approval Action in the workflow.

Dear Approvers,
%Request Company% has been registered with %Hub Company Name%
Regards
%From First Name% %From Last Name%
%From Phone Number%
%From Company Name%

Return Action Email Templates

N e w  c o m p a n y  r e q u e s t  r e t u r n e d  t o  r e q u e s t e r
The email notifies the Requester contact they must update specific information. 
The email is sent from the Pre-Approval role to the Requester contact. It is 
associated with the Return action in the workflow.

Dear %To First Name% %To Last Name% ,
Thank you for the new company registration request for %Request Company% . I have 
returned the request to you to update for the following reason:
%Reason%
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL% 
Regards
%From First Name% %From Last Name% 
%From Phone Number% 
%From Company Name%

N e w  c o m p a n y  r e q u e s t  r e t u r n e d  t o  a l l  p r e - a p p r o v e r s
The email notifies the Primary Contact that they must update specific information. 
The email is sent from the Pre-Approval role to the Primary Contact. It is 
associated with the Return action in the workflow.

Dear Pre-Approvers,
%From First Name% %From Last Name% from %Request Company% has returned the 
request, for the following reason:
%Reason%
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL%

N e w  c o m p a n y  r e q u e s t  r e t u r n e d  t o  c o m p a n y
The email notifies the Primary Contact that they must update specific information. 
The email is sent from the Approval role to the Primary Contact. It is associated 
with the Return action in the workflow.
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Dear %To First Name% %To Last Name% ,
Thank you for completing the %Hub Company Name% registration forms. I have 
returned the forms to you to update for the following reason:
%Reason%
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL% 
If you have any questions please contact me,
%From First Name% %From Last Name% 
%From Phone Number% 
%From Company Name%

Decline Action Email Templates
Important: An anonymous requester can only reopen and re-submit the request 
with the registration request link from a Declined email. 

N e w  c o m p a n y  r e q u e s t  d e c l i n e d  b a c k  t o  re qu e s t e r
The email notifies the Requester contact their request to join the community has 
been declined for a specific reason. The email is sent from the Pre-Approval role to 
the Requester contact. It is associated with the Decline action in the workflow.

Dear %To First Name% %To Last Name% ,
Thank you for the new company registration request for %Request Company%. I have 
declined the request for the following reason:
%Reason%
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL% 
Regards
%From First Name% %From Last Name% 
%From Phone Number% 
%From Company Name%

N e w  c o m p a n y  r e q u e s t  d e c l i n e d  b a c k  t o  p r e - a pp r o v e r s
The email notifies the Pre-Approval role that the Primary Contact has declined not 
to join the community for a specific reason. The email is sent from the Primary 
Contact to the Pre-Approval role. It is associated with the Decline action in the 
workflow.

Dear Pre-Approvers,
%From First Name% %From Last Name% from %Request Company% has declined the 
request, for the following reason:
%Reason%
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL%

N e w  c o m p a n y  r e q u e s t  d e c l i n e d  b a c k  t o  re qu e s t e r
The email notifies the Requester contact their request to join the community has 
been declined for a specific reason. The email is sent from the Approval role to the 
Requester contact. It is associated with the Decline action in the workflow.

Dear %To First Name% %To Last Name%,
The new company registration request for %Request Company% has been declined for 
the following reason:
%Reason%
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL% 
Regards
%From First Name% %From Last Name% 
%From Phone Number% 
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%From Company Name%

N e w  c o m p a n y  r e q u e s t  d e c l i n e d  b a c k  t o  re qu e s t e r ,  c o p y  p re - a p pr o v e r s
The email notifies the Pre-Approval role that a company’s request to join the 
community has been declined for a specific reason. The email is sent from the 
Approval role to the Pre-Approval role. It is associated with the Decline action in 
the workflow.

Dear Pre-approvers,
The new company registration request for %Request Company% has been declined for 
the following reason:
%Reason%
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL% 
Regards
%From First Name% %From Last Name% 
%From Phone Number% 
%From Company Name%

N e w  c o m p a n y  r e q u e s t  d e c l i n e d  b a c k  t o  re qu e s t e r ,  c o p y  t o  c o m p a n y
The email notifies the Primary Contact that their company’s request to join the 
community has been declined for a specific reason. The email is sent from the 
Approval role to the Primary Contact. It is associated with the Decline action in the 
workflow.

Dear %To First Name% %To Last Name% ,
Thank you for completing the %Hub Company Name% registration forms. The 
registration has been declined for the following reason:
%Reason%
If you have any questions please contact me,
%From First Name% %From Last Name%
%From Phone Number%
%From Company Name%

Reminder Email Templates
Active Community sends reminder emails based on the number of days that have 
elapsed after a request was sent but no response has been received (see “Defining 
Reminder Email Settings” on page 470). Reminder emails can be sent to the 
Primary Contact, and to the Pre-Approval and Approval registration roles. Email 
templates support multiple languages (see “Configuring an Email in a Different 
(Supported) Language” on page 460).
Topics include:
■ “Primary Contact Reminder Email Templates” on page 454
■ “Approval/Pre-Approval Reminder Email Templates” on page 455

Primary Contact Reminder Email Templates
With increasing urgency, these email templates remind the Primary Contact to 
respond to a registration request. The emails are sent from the Pre-Approval role 
to the Primary Contact.

N e w  C o m pa n y  R e q u e s t  F i r s t  R e m i n d e r
Dear %To First Name% %To Last Name% ,
%Reminder - Number of Days% days ago you were sent a request to register with %Hub 
Company Name%. We see that you have not completed the registration forms. If you are 
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not sure the purpose of this request or need help getting started please contact me 
ASAP, see my contact details below.
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL% 
Regards,
%From First Name% %From Last Name%
%From Phone Number%
%From Company Name%

N e w  c o m p a n y  r e q u e s t  s e c o n d  re m i n d e r
Dear %To First Name% %To Last Name% ,
%Reminder - Number of Days% days ago you were sent a request to register with %Hub 
Company Name%. This is our second reminder to you about this registration request. To 
date, we see that you have not completed the registration forms. The completion of this 
registration request is important for us to do business with you. Please contact me ASAP, 
see my contact details below.
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL% 
Regards,
%From First Name% %From Last Name%
%From Phone Number%

N e w  C o m pa n y  R e q u e s t  T h i r d  R e m i n d e r
Dear %To First Name% %To Last Name% ,
%Reminder - Number of Days% days ago you were sent a request to register with %Hub 
Company Name%. We have sent two previous reminders and offers to provide assistance 
with this process however, to date we see that you have not completed the registration 
forms. This is a final reminder. If you do not complete the registration request your 
organization will be dropped from the registration process in 7 days of this reminder. 
If you do not wish to be dropped from the registration process please contact me ASAP, 
see my contact details below.
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL% 
Regards,
%From First Name% %From Last Name%
%From Phone Number%
%From Company Name%

Approval/Pre-Approval Reminder Email Templates
With increasing urgency, these email templates remind contacts in the Pre-
Approval and Approval groups they need to review and approve registration 
requests. The emails are sent from the registration Administrator role to all 
Approval/Pre-Approval groups.

N e w  c o m p a n y  r e q u e s t  A p p r o v e r / P r e - A p p r o v e r  f i r s t  r e m i n d e r
Dear %To First Name% %To Last Name% ,
%Reminder - Number of Days% days ago you were sent a registration request for 
%Request Company% to review and approve. We see that you have not yet completed 
this task.
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser:
%Request URL% 
Regards,
%From Company Name%

N e w  c o m p a n y  r e q u e s t  A p p r o v e r / P r e - A p p r o v e r  s e c o n d  r e m i n d e r
Dear %To First Name% %To Last Name% ,
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%Reminder - Number of Days% days ago you were sent a request to register with %Hub 
Company Name%. This is our second reminder to you about this registration request. To 
date, we see that you have not completed the registration forms. The completion of this 
registration request is important for us to do business with you. Please contact me ASAP, 
see my contact details below.
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: %Request URL% 
Regards,
%From First Name% %From Last Name%
%From Phone Number%
%From Company Name%

N e w  c o m p a n y  r e q u e s t  A p p r o v e r / P r e - A p p r o v e r  t h i r d  r e m i n d e r
Dear %To First Name% %To Last Name% ,
%Reminder - Number of Days% days ago you were sent a request for %Request 
Company% to review and approve. We have emailed you two reminders to approve this 
registration request but see that you have still not completed this task. The completion of 
this registration request is important to our business, please review and approve as soon 
as possible. 
Please click the link to %View Request Link%.
If you have trouble with the link, please copy and paste the following address into your 
browser: 
%Request URL% 
Regards,
%From Company Name%

Customizing Workflow Email Templates
Security roles: Community Administrator and/or Registration Administrator
Use this procedure to customize the message text, form fields, and attachments 
included in email templates for workflow actions.

To customize messages in workflow email templates
1 Click Applications > Registration > Admin tab.

The Registration Setup page opens.
2 Click the Configure Overall Workflow link.

The Registration Process page opens.
3 Click the Email link for the workflow action for which you want to customize the 

message. 
Important: Each Email link in the workflow corresponds to a different email 
template, which allows for different messages to be sent at different parts of 
the workflow (see “Workflow Email Templates” on page 450).
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The Configure Email page opens for the selected email template.

4 Customize the message text as needed.
Note: You use a combination of regular text and “placeholder” text called 
form fields. The “placeholder” text allows you to add, for example, the 
recipient’s first and last name to the email message. The fields are filled in with 
the participant's information when the email is sent.

a To use form fields, put your cursor in the email message where you want to 
insert the form field (see “Form Field Descriptions” on page 459).

b Select the appropriate form field button to insert the form field, such as 
Email Address.

5 To add attachments, such as spreadsheets or images, click Browse, navigate 
to and select the attachment, and click Open. 
The attachment is added to the email template.

6 When the message is complete, click Save. 
Important: Clicking Save does not send the message; it saves your changes 
to the email template. The email message is sent when a registration request 
reaches the appropriate stage in the workflow; for example, when a contact in 
the Pre-Approval role declines or approves a request. 
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Customizing Reminder Email Templates
Security roles: Community Administrator and/or Registration Administrator
Use this procedure to customize the message text, form fields, and attachments 
included in reminder email templates. 

To customize messages in reminder email templates
1 Click Applications > Registration > Admin tab.

The Registration Setup page opens.
2 Click the Registration Settings link.

The Registration Settings page opens.
3 In the Approval/Pre-Approval Reminders part of the page, click Configure 

Email for the appropriate reminder setting. The email’s text is different based 
on whether it is for reminder 1, 2, or 3.
Important: Each Email link corresponds to a different email template, which 
allows for different messages to be sent (see “Reminder Email Templates” on 
page 454).
The Configure Email page opens for the selected email template.

4 Customize the message text as needed.
Note: You use a combination of regular text and “placeholder” text called 
form fields. The “placeholder” text allows you to add, for example, the 
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recipient’s first and last name to the email message. The fields are filled in with 
the participant's information when the email is sent.

a To use form fields, put your cursor in the email message where you want to 
insert the form field (see “Form Field Descriptions” on page 459).

b Select the appropriate form field button to insert the form field, such as 
Email Address.

5 When the message is complete, click Save. 
The Registration Settings page re-opens. A message indicates the email 
template was successfully updated.
Important: Clicking Save does not send the message; it saves your changes 
to the email template. The email message is sent based on the reminder email 
settings, such as four days after a first reminder email is sent.

Form Field Descriptions
The table describes form fields available as buttons in email templates used during 
the registration process. Some fields are common to all email templates; others are 
used only in specific templates. Not all form fields are shown.

Click this button...

To insert this form 
field in an email 
template: Description
%From First Name% First name of the registration role that sends the message.
%From Last Name% Last name of the registration role that sends the message.
%From Phone Number% Telephone number for the from registration role.
%From Company Name% Name of the hub company that is sending the registration request; 

for example, “Big Hub Stores.”

%To First Name% First name of the registration request participant; for example, 
“John.”

%To Last Name% Last name of the registration request participant; for example, 
“Smith.”

%To Phone Number% Telephone number for the registration request participant.
%To Company Name% Name of the potential supplier the hub company wants to do 

business with; for example, “Acme Industries.”

%Request Company% Company name to be registered.
%Request ID% Unique ID generated for each registration request.
%Request Type% Company registration is the default
%Request URL% URL for the request page, which is a hyperlink.

Note: Each approval level has its own URL.
%View Request Link% Link to navigate to the request page.
%Reason% Reason the request is being declined, returned for more 

information, or re-opened.
%View Registration 
Report%

A link to generate a PDF that contains the information in the 
registration request page.

%Hub Company Name% Name of the company to which the requester contact belongs 
(typically the hub company).
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Configuring an Email in a Different (Supported) Language
Use this procedure to configure an email in a different language (one that is 
supported by Active Community).
After you create an email in your default language, you can configure it in a second 
(or more) language(s). Then, for example, when a user accesses Active 
Community in English, they see the email in English, and when they access Active 
Community in Spanish (or change the language to Spanish), they see the email in 
Spanish. 

To configure an email in a different language
1 Create an email. Save your changes. See applicable topics in “Phase 3: 

Customize Email Templates” on page 446.
2 Change the Active Community language to another (supported) language (see 

“Changing Your Language” on page 11).
3 In that second language, modify the same email. For example, if you changed 

your language to Spanish, modify the email so that it is written in Spanish. Save 
your changes. 
You can now change your language to either of the languages where you 
configured the emails, and those emails will display in either of the two 
languages depending on which language you select for Active Community.

Phase 4: Configure Approval Levels and Groups
In the next phase of the registration request setup process, you configure settings 
for approval levels, groups, and roles.
■ Approval levels determine how many times a registration request must be 

approved as it flows through a registration workflow.
Important: Registration requests have two approval stages: Pre-Approval and 
Approval. You configure the number of approval levels for each stage. Up to 10 
approval levels are available. 

■ Approval groups are groups of contacts who have been assigned to one or more 
Pre-Approval or Approval levels. 
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■ Approval roles include the Pre-Approval and Approval roles. The roles are 
assigned to contacts in addition to their security roles.

Phase 4: Configure Approval Levels and Groups
Key Description
1 Configure Approval Levels and Groups

Topics include:
■ “Defining Approval Levels and Approval Names” on page 461
■ “Adding Approval Groups Based on Approval Levels” on page 463
■ “Assigning Contacts to Approval Groups” on page 464
■ “Mapping Approval Groups to Approval Levels” on page 466
■ “Bypassing Pre-Approval and Approval Levels” on page 468

Defining Approval Levels and Approval Names
Security roles: Community Administrator and/or Registration Administrator
Approval levels determine how many times a registration request must be 
approved as it flows through the registration approval process. 
Registration requests have two approval stages: Pre-Approval and Approval. You 
configure the number of approval levels for each stage. Up to 10 approval levels 
are available. 
Important: Pre-Approval level 1 and Approval level 1 can edit a registration 
request. The request is read only for approval levels 2-10, but levels 2-10 can view, 
decline, approve, and ask questions.

■ Configure approval levels
■ Manage approval level names
■ Create approval groups
■ Assign roles and settings

1
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To define approval levels and approval names
1 Click Applications > Registration > Admin tab.

The Registration Setup page opens.
2 Click the Configure Approvals link.

The Configure Approval page opens.

3 Under Configure Approval, select the number of approvals required for the Pre-
Approval and Approval stages in the workflow. If you select:

■ None (skip) you bypass the Pre-approval or Approval stages in the 
workflow. A registration request submitted by a supplier is not reviewed by 
approvers, and the supplier is automatically registered in Active Community 
and its company and contacts are created.

■ Level 1 (Default) or levels 2-10, the Map Approval Groups to Approval 
Roles link is activated (see “Mapping Approval Groups to Approval Levels” 
on page 466).

The Routing Condition Field displays if one or more levels are selected.
Note: You cannot delete a level if that level is responsible for completing a 
required core field for registration (see “Defining Core Fields in Registration 
Requests” on page 431).

4 In the Routing Condition field, select or type the custom field(s) in the request 
that automatically route the request to an approval role.
Important: The request routes to the assigned approvals only if the Routing 
field is populated in the request. Drop List and Radio Button List custom fields 
are displayed in the drop-down list. 
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5 Under Customize Approval Stage Labels, in the Label column, type over any 
label you want to modify.
Note: TGO Provision displays for TGO integrated communities only.

Note: There is multiple language support for the Primary Contact label. For 
more information on language support, see “Language Options for Custom 
Field Groups, Questions, and Choices” on page 238 and “Changing Your 
Language” on page 11.

6 Select a default landing tab for the primary contact. This is the tab that you 
want the primary contact to land on when they receive a registration request 
and enter the registration module.
Note: Only tabs that are parent tabs are displayed in the drop-down list and 
can be selected. You cannot select a dependent tab (child tab)

7 Click Save.
8 Go to “Adding Approval Groups Based on Approval Levels” on page 463.

Adding Approval Groups Based on Approval Levels
Security roles: Community Administrator and/or Registration Administrator
Approval groups are groups of contacts who have been assigned to one or more 
Pre-Approval and Approval levels for registration requests. 
Use this procedure to indicate if contacts in an approval group have the ability to 
pre-approve or approve registration requests.

To add approval groups based on approval levels
1 Click Applications > Registration > Admin tab.

The Registration Setup page opens.
2 Click the Manage Approval Groups link.
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The Manage Approval Groups page opens. It lists the approval stages and the 
number of reviewers assigned to each stage.

3 Click Manage Approval Groups > Add Group.
The New Approval Group page opens.

4 In Name, type a name for the approval group. 
5 In Approval Stages, select Pre-Approval or Approval to indicate the approval 

stage to associate with a role.
6 Click Save.
7 Go to “Assigning Contacts to Approval Groups” on page 464.

Assigning Contacts to Approval Groups
Security roles: Community Administrator and/or Registration Administrator
Use this procedure to assign approval roles, groups, and settings to hub contacts. 

To assign roles, groups, and email settings for registration requests
1 Click Applications > Registration > Admin tab.
2 Click the Contact Security Settings link.
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The Contact Security Settings page opens.

3 In the Contact column, select a hub contact.
The Configure Roles page for the selected contact opens. Two sections, 
Approval Role and Administrative Role, display initially.

4 In Approval Roles, select one or both approval roles to assign to the hub 
contact.
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If either approval role is selected, Approval Group and Approval Settings display 
on the page.

5 In Approval Group, select the Approval or Pre-Approval groups to assign to the 
contact. To assign the contact to multiple approval groups, select the groups 
and click Add to List.

6 In Approval Settings, select one or more check boxes. Based on your selections, 
you can let the contact view or receive emails for all group requests, not just 
the requests for which they are the owner.

■ View All Requests—View all registration requests.
■ Receive Emails—Receive all emails related to registration requests.

Note: If the check box for Receive Emails is clear, the contact does 
not receive any registration emails.

7 In Administrative Role, select the check box to assign the Registration 
Administrator role to the contact. 
Important: The role allows the contact to address undeliverable email issues 
and re-assign requests to different approval groups.

8 Click Save.
9 Go to “Mapping Approval Groups to Approval Levels” on page 466.

Mapping Approval Groups to Approval Levels
Security roles: Community Administrator and/or Registration Administrator
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Use this procedure to select the approval group you want to pre-approve and 
approve registration requests for each approval level. Based on your selections, 
Active Community routes registration requests to contacts in the approval group.
Important: To use this functionality, the Number of Levels field for each approval 
stage must have Level 1 (Default) or levels 2-10 selected (see “Defining Approval 
Levels and Approval Names” on page 461). 

To map approval groups to approval levels
1 Applications > Registration > Admin tab.

The Registration Setup page opens.
2 Click the Map Approval Groups to Approval Roles link.

The Map Approval Groups to Approval Roles page opens for Pre-Approval 
Mapping.

Note: The information on this page is based on settings in the Number of 
Levels for pre-approvers (see “Defining Approval Levels and Approval Names” 
on page 461). 

3 Use the drop-down lists to select the approval group for the appropriate 
approval level, and click Save.
At the top of the page, click Approval Mapping.
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The Map Approval Groups to Approval Roles page opens for Approval Mapping.

Note: The information on this page is based on settings in the Number of 
Levels for approvers (see “Defining Approval Levels and Approval Names” on 
page 461). 

4 Use the drop-down lists to select the approval group for the appropriate 
approval level, and click Save.

Bypassing Pre-Approval and Approval Levels
Security roles: Community Administrator and/or Registration Administrator
To onboard companies with little or no manual intervention, you can bypass the 
Pre-Approval and/or Approval levels during registration. As a result, registration 
requests submitted by any supplier are not reviewed by any approvers. Instead, 
the supplier is automatically registered in Active Community and its company and 
contact profiles created.
Limitations:
■ The Requester and Primary Contact levels cannot be skipped. 
■ If final approval is Skipped, ensure the Auto Generate Company IDs field is 

selected (Admin > Community Settings). 
■ The Questions tab cannot be used if approval levels are skipped.

To bypass approval levels for registration requests
1 Click Applications > Registration > Admin tab.

The Registration Setup page opens.
2 Click the Configure Approvals link.
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The Configure Approval page opens.

3 To bypass the Pre-approval stage, from the Pre-approval drop-down list, select 
None (skip).

4 To bypass the Approval stage, from the Approval drop-down list, select None 
(skip).

5 Click Save.

Phase 5: Configure Other Registration Settings
The final phase in the registration setup process is to configure miscellaneous 
request settings, including reminder email frequency and anonymous request 
settings.

1
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Phase 5: Configure Other Registration Settings
Key Description
1 Configure Other Registration Settings

Topics include:
■ “Defining Reminder Email Settings” on page 470
■ “Configuring From, To, and Undeliverable Email Addresses” on page 472
■ “Customize Document Title for Registration Request Report” on page 473
■ “Configuring Anonymous Request Settings” on page 473
■ “Assigning the Registration Administrator Role” on page 475

Defining Reminder Email Settings
Security roles: Community Administrator and/or Registration Administrator
To automatically prompt contacts in the Primary Contact, Pre-Approval, or Approval 
roles to respond to requests for information or approve a registration request, you 
can:
■ Send up to three automatic reminders after a request has been submitted. Active 

Community sends a reminder email after a specific number of days has passed.
■ Tailor the message text for each reminder email, insert form fields (such as the 

first and last name of the recipient), and attach files (such as pictures) to the 
message. 

For example, you might send a registration request to the Primary Contact at the 
prospective supplier and asked him or her to complete information gaps in the 
request, but have not yet received a response. Or, you might want to remind 
contacts in the Pre-Approval or Approval roles that a registration request is waiting 
to be reviewed and approved. 

To configure reminder email settings for primary contacts and 
approvers
1 Click Applications > Registration > Admin tab.
2 Click the Registration Settings link.

■ Reminder email frequency
■ Emails (to, from, undelivered)
■ Document title for registration request report
■ Anonymous request settings
■ Assign Registration Admin role
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The Registration Settings page opens.

3 Perform the appropriate action: 

4 In Primary Contact Reminders and/or Approval/Pre-Approval Reminders:
a Click the check boxes for the first, second, and third reminder emails.
b In Number of Days, type a number for the reminder you want to send. 

Note: You define actual days or business days in step 5.
c To customize message text, click Configure Email for the appropriate 

reminder. The email text is different based on whether it is for reminder 1, 
2, or 3.
1 Click Save to save any registration settings you have already made. 
2 Modify the message text, insert form fields, and attach files to the 

message as needed (see “Reminder Email Templates” on page 454.
3 After formatting the email message, click Save. 
The Registration Settings page re-opens. A message indicates the email 
template was successfully updated.

To define settings for... Do this:
Reminder emails for Primary Contacts and/or Approval and 
Pre-Approval roles

Go to step 4.

Business role data collection from prospective suppliers Go to step 7.
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5 In Calendar Settings, select Business Days or Actual Days to indicate how you 
want Active Community to calculate the number of elapsed days before it sends 
reminder emails.

6 (Optional) If you are using Trading Grid Online (TGO) integrated with Active 
Community), the TGO Settings section displays. 

Indicate the following:
■ If you want emails to be sent to approvers when an approver submits a 

registration to TGO, select the appropriate check box.
■ If you want registration requests to be held until you send to TGO for auto 

provisioning, select the appropriate check box.
7 In the Contact Collection part of the page, indicate which business roles you 

want to collect from prospective suppliers during the registration process. If 
you select:

■ Required—Prospective suppliers must provide information for at least one 
person for each role in the request. If they do not, their request cannot be 
submitted for approval.

■ Not Required—Prospective suppliers can provide the role information, but 
the information is not required before the request can be submitted for 
approval.

■ Optional—Providing the information is optional.
8 Click Save.

You have saved registration settings related to reminder emails and contact role 
collection.
Important: Active Community uses the settings to send reminder emails after 
the specified number of days have elapsed. It uses the contact collection 
settings to include the information in a registration request.

Configuring From, To, and Undeliverable Email Addresses
Security roles: Community Administrator and/or Registration Administrator
Use this procedure to specify email addresses used for all registration approval and 
reminder email messages. You can also define an email addresses for emails that 
“bounce” due to incorrect email address information. The email address receives 
the bounced emails and contacts can identify which email addresses are incorrect. 

To configure email from, to, and undeliverable addresses
1 Click Applications > Registration > Admin tab.
2 Click the Email Settings link.
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The Email Settings page opens.

3 In From Address, type the email address used as the from address for all 
registration approval and reminder emails.

4 In Reply to Address, type the email address to which all registration request 
replies are sent.

5 In Undeliverables Address, type the email address that is to receive all bounced 
or returned registration emails.

6 Click Save.

Customize Document Title for Registration Request Report
Security roles: Community Administrator and/or Registration Administrator
Use this procedure to customize the document title of the registration request 
report so that it has a specified name when the registration request is downloaded 
as a PDF.

To customize the document title of the registration request report
1 Click Applications > Registration > Admin tab.
2 Click the Registration Settings link to open the Registration Settings page.
3 Select the Use custom report title for Company Registration Report 

check box, and enter the name of the title you want to use for the report.

4 Click Save.

Configuring Anonymous Request Settings
Security roles: Community Administrator and/or Registration Administrator
Use this procedure to configure gateways and email domains so contacts inside 
and outside the hub community can create anonymous registration requests from 
a link in an email or web site.
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To configure gateways and email domains for anonymous requests
1 Click Applications > Registration > Admin tab.
2 Click the Anonymous Request Settings link.

The 
The Anonymous Request Settings page opens. 

Important: Use the Anonymous Requester URL at the top of the page to 
create an anonymous registration request. The hub posts the link on external 
websites for Requester contacts who do not have access to Active Community. 
(The URL is generated when the Registration module is activated.)

3 In Restrict Access to Companies and Contacts, select the Show Companies Tab 
and/or Show Contacts Tab check boxes to indicate if you want anonymous 
Requester contacts to view those tabs in the request.
Important: This setting lets anonymous Requester contacts view companies 
and/or contacts to avoid creating duplicate suppliers.

4 In Gateway IP Address(es), type one or a range of Gateway IP addresses to 
allow access to the anonymous requester page, and click Add IP Addresses.

5 In Validate Anonymous Requester Email Address, type the text required in the 
domain of the Requester contact's email address, and click Add Email 
Domain.
Note: Only users with specified domain email addresses can create a 
request.

6 Click Save.



R E G I S T R A T I O N  S E T U P
What’s Next?

OpenText Active Community CE 21.2 User Guide  475

1 3

Assigning the Registration Administrator Role
Security roles: Community Administrator and/or Registration Administrator
Use this procedure to assign the Registration Administrator role to hub contacts. 

To assign the registration administrator role
1 Click Applications > Registration > Admin tab.
2 Click the Contact Security Settings link.

The Contact Security Settings page opens.
3 Select a hub contact.

The Configure Roles page for the selected contact opens. Two sections, 
Approval Role and Administrative Role, display.

4 In Administrative Role, select the check box to assign the Registration 
Administrator role to the contact. 
Important: The role allows the contact to address undeliverable email issues 
and re-assign requests to different approval groups.

5 Click Save.

What’s Next?
After setting up the Registration module, the hub company can send registration 
requests to prospective suppliers. For more information, see “Registration 
Requests” on page 477
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Registration Requests 14
A registration request is an electronic form used to gather information about 
prospective suppliers. The hub customizes the information in a registration request 
by identifying the types of information it wants to collect from prospective 
suppliers. 
Each registration request includes tabs that contain categories of registration 
information. The information can include company, contact, product, financial, 
legal, and other information. For example, a hub might include a custom field 
named Terms and Conditions as a tab in a request. Prospective suppliers must 
agree to the hub’s terms and conditions before they can be added to the hub’s 
community.
Topics include:
■ “Registration Request Overview” on page 479
■ “Creating a Registration Request” on page 484
Working with Requests
■ “Finding Registration Requests” on page 499
■ “Asking and Responding to Questions” on page 502
■ “Verifying a Tax ID” on page 503
■ “Pre-Approving or Approving a Request” on page 504
■ “Approving Requests in Bulk” on page 505
■ “Putting a Request On Hold” on page 508
■ “Putting Requests On Hold in Bulk” on page 509
■ “Reactivating a Request that is On Hold” on page 511
■ “Reactivating Requests in Bulk” on page 512
■ “Declining a Request” on page 514
■ “Reopening a Request” on page 515
■ “Returning a Request for More Information” on page 515
■ “Recalling and Resending a Request” on page 516
■ “Deleting Registration Requests” on page 517
■ “Downloading a Registration Request as a PDF” on page 519
■ “Canceling a Re-registration Request” on page 518
■ “Resending Registration Emails” on page 520
■ “Correcting Undeliverable Email Addresses” on page 521
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Tracking Requests and Using Charts and Reports
■ “Using the Registration Dashboard to Track Requests” on page 523
■ “View and Download Chart Data” on page 525
■ “Working with Registration Custom Exports” on page 527
■ “Downloading a Registration Request History Report” on page 534
■ “Viewing and Exporting an EIN (Tax ID) Usage Report” on page 535

Registration Request Overview
A registration request is part of an online request and approval process that lets 
the hub automatically register suppliers in their community. The information 
contained in the request is specified as the first part of the “Registration Setup” 
process, “Phase 1: Plan Data to be Collected from Future Suppliers” on page 431.
The graphic shows a sample registration request. The tabs contain information that 
must be filled in before the request is submitted to or approved by the hub.
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Topics include:
■ “Request Approval Process” on page 480
■ “Registration Request Roles and Contacts” on page 481
■ “Request Tabs” on page 482
■ “Request Buttons, Roles, and Workflows” on page 483

Request Approval Process
A registration workflow drives the online request and approval (commonly referred 
to as “onboarding”) process. For example, a registration request might follow the 
approval process outlined in the graphic. 

5

1 2 3 4

Request Approval Process
Key Description
1 Internal/External Requestor Creates Request
2 Pre-Approval/Hub Member Pre-Approves Request
3 Potential Supplier Adds Data to Request
4 Approval/Hub Member Approves Request
5 Company and Contact Created in TGO (only for TGO integrated communities) and 

Registered in Active Community

Important: The approval process depends on how a registration workflow is 
configured for the hub community.
The process starts when an internal or external requester creates a registration 
request. The following process is typical.
1 A Requester creates a request and submits it to the hub community. 

Important: A Requester can be an account manager in the hub company or a 
prospective supplier who clicks a link in an anonymous URL.

2 The request is Pre-approved by a contact in the hub community, such as a 
supply chain manager.

3 The request is sent to the supplier’s point-of-contact (Primary Contact). The 
Primary Contact provides information about themselves and their company 
when they register. The information might include insurance certificates, 
contacts in primary business roles, or payment terms.
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4 The request is Approved by a contact in the hub community, such as a finance 
manager. 

5 After approval, for TGO integrated communities only, the trading partner is 
added to Trading Grid Online. In the hub's community, Active Community 
creates company and contact profiles for the new partner. 
The newly added company or contact can be searched for and located by any 
member of the community.

Registration Request Roles and Contacts
Your registration role controls the amount of information you see on a registration 
request. In addition to security roles, registration roles are assigned to contacts in 
a community.
Important: Pre-Approval and Approval roles can be assigned to contacts in the 
hub community. Requesters and Primary Contacts can be contacts inside and 
outside the hub community. 

Requester
Requesters create or submit registration requests. A Requester can be a contact 
inside or outside the hub community, such as a supplier liaison at the hub or a 
sales representative with a potential supplier. 

Pre-Approval Role
The Pre-Approval role reviews registration requests and pre-approves them. After 
pre-approval, the request moves to the next stage in the registration process. The 
Pre-Approval role might be assigned to such hub employees as category managers 
or buyers. 
Note: Hub contacts can be assigned a Pre-approval role in addition to their 
security role.

Primary Contact
A Primary Contact is the main point-of-contact for a company outside the hub 
community. Primary Contacts receive registration requests from the hub, fill out 
information in the request, and submit completed requests to the hub company.
Important: By default, all primary contacts have “View Masked Fields” 
permission; this enables them to see the data for masked company custom fields 
in the request. See “Roles and Permissions” on page 49.

Approval Role
The Approval role validates that a Primary Contact has completed all required 
details in a registration request. After approval, the trading partner is added to the 
hub’s community. Company and contact profiles are created. The newly added 
company or contact can be searched for and located by any member of the 
community.
Note: Hub contacts can be assigned to the Approval role in addition to their 
security role.
Important: If the Approver does not have “View Masked Fields” permission, they 
cannot see the data for masked company custom fields in the request. See “Roles 
and Permissions” on page 49.
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Request Tabs
When hub contacts create a request, they fill in information on the following tabs:

Company Tab
The Company tab is used to specify company information about the prospective 
supplier. At a minimum, the requester must provide the name of the prospective 
company that is being asked to register with the hub company. 
Important: An initial request is completed by someone internally (an employee 
of the hub) or externally (the potential new company).

Contact(s) Tab
Before a request is submitted, the Contact(s) tab is used to provided details about 
the primary contact at the prospective supplier. This person receives the email with 
a link to the registration forms. Required fields: First Name, Last Name, Email, and 
Phone number. 
After a request is submitted, the Contact(s) tab displays additional fields. The fields 
allow the hub to provide additional address and phone information for the primary 
contact and to select additional business roles.
After a request is submitted, the tab allows the hub to add additional contacts such 
as accounts payable, EDI, sales, or legal contacts. The contact that is designated 
as the primary contact can also be changed.

Custom Field Group Tabs
Multiple custom field tabs can display based on the custom field permissions 
assigned to registration roles. 
Each tab represents a custom field group designed by the hub to gather 
information for the initial request. For example, a hub might have forms around 
Certificate of Insurance, Terms & Conditions, EDI, Diversity Classification 
Information, Shipping Returns, Invoicing, etc. 

S p e c i a l i z e d  T a x  I D  ( E I N )  C u s t o m  F i e l d
Tax ID (EIN) is a specialized custom field that allows hubs to collect a federal tax 
ID and verify that it is correctly formatted as an EIN (Employer Identification 
Number). The value is not verified unless you have the Tax ID Verification option 
enabled for your community. To enable the option, contact Support. 
Note: Custom field forms are designed by clicking Company > Settings > Custom 
Fields. The hub decides which forms to include in the request using Applications > 
Registration > Admin tab > Manage Permissions (see “Custom Fields” on 
page 221” and “Registration Setup” on page 423).
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After a hub contact clicks Submit, additional tabs display on the new request page 
so the information can be reviewed before the request is sent.

Request Tab
The Request tab shows all details for the request, including the contact who 
created the request, the contact who approved the request, the number of days it 
has been open, and when it was created, submitted, and approved. The tab also 
contains information that indicates if the request has been returned for more 
information or it was declined. The language that was selected by the requestor or 
pre-approver for sending out TP emails is displayed.

Questions Tab
The Questions tab is used by contacts in the Primary Contact and Pre-Approval 
roles to ask and respond to questions while completing a registration request. 
Questions might be around why the hub needs such a high insurance amount, if 
certain information is necessary, or even a discussion to negotiate some of the 
terms. For more information, see “Asking and Responding to Questions” on 
page 502.

Request Buttons, Roles, and Workflows
Action buttons might or might not display in a registration request based on:
■ Your role in the registration process
■ How the hub’s:

■ Registration workflow is configured
Note: Applications > Registration > Admin tab > Configure Overall 
Workflow

■ Approval levels are configured
Note: Applications > Registration > Admin tab > Configure Approvals, 
Manage Approval Groups, Contact Security Settings, and Map Approval 
Groups to Approval Roles

■ The workflow phase the request is in
■ Actions done by others to the request
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The table lists the reasons an action button might not display in a registration 
request.

For this Button 
to Display

You Must Have 
this Role

The button does NOT display if:
In the workflow, the... The request is not ready/other...

Approve Request Approve action is not selected.
OR
In Approval Levels, the Pre-Approval 
and Approval levels are skipped.

The request is not ready for approval.
Example: If a request does not include 
business contact information from the 
Primary Contact, it cannot be approved 
until the information is provided.

Decline Request Decline action is not selected. The request is not ready to be declined. 
Example: If a request to modify a 
company’s certification information has 
already been approved by another 
Approver in your community, it cannot be 
declined by you. 

Put Request on 
Hold

Hold action is not selected.

Reactivate a 
Request

Hold action is not selected (the Hold 
action controls both the Hold and 
Reactivate buttons)

Return for More 
Information

Return action is not selected. The request is not ready to be returned. 
Example: If a request does not include 
business contact information from the 
Primary Contact, it cannot be returned for 
more information until the information is 
provided. 

Recall Request Request’s status is not “Assigned to 
Primary Contact”

Reopen Request

Re-register 
Request

The company is not being 
re-registered.

Cancel 
Re-registration

The company is not being 
re-registered.

Creating a Registration Request
There are several ways registration requests can be created:
■ By a hub contact with access to Active Community
■ By a contact outside the hub who has access to an anonymous URL

■ Pre-Approval
■ Approval

■ Pre-Approval
■ Primary 

Contact
■ Approval

■ Requester
■ Pre-Approval
■ Approval

■ Requester
■ Pre-Approval
■ Approval

■ Pre-Approval
■ Primary 

Contact
■ Approval

■ Pre-Approval

■ Requester
■ Pre-Approval

■ Re-Open action is not selected.
■ Request’s status not “Declined”

■ Registration 
Administrator

■ Registration 
Administrator
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■ By importing registration requests into Active Community and specifying a 
registration status and request approval stage

The contact who adds a request is considered the Requester contact in the 
registration approval process.
Note: Requests can also be made by a Community Administrator sending a 
registered company back through registration (that is, re-registration). 
Topics include:
■ “Creating a Request” on page 485
■ “Creating a Request Using an Anonymous URL” on page 492
■ “Importing Registration Requests Using CSV Files” on page 493

Creating a Request
Registration role: Requester at the hub company
Use this procedure to create a registration request. By creating a request, a hub 
contact becomes the Requester contact in the registration approval process.
Note: The hub can design its registration process to collect legal profile 
information at the same time it collects company information. If collected during 
registration (see step 3 in this procedure), the trading partner company is created 
for the hub, and the legal profile is created for AIC.

To add a registration request
1 Do one of the following:

■ Click Applications > Registration.
The Requests for My Approval page opens to the Registration Requests 
tab. Continue with step 2.

■ If the Registration Administrator is re-registering a company, and has 
successfully initiated a request for re-registration from Base (Profiles > 
Companies), go to step 9 on page 488 to move the request forward to 
activate the Re-registration process.

2 Click Add Request.
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The Request Company Registration page opens.

3 On the Company tab, type the required information for the prospective 
company, then click Next.
Note the following:

■ For TGO integrated communities only, the TGO Service field displays. This 
field is used to select a pre-defined invitation code. To populate this list or 
see a list of existing TGO invitation codes, see “Managing TGO Invitation 
Codes” on page 434.

■ To include legal profiles in the registration process, select the legal profile 
for the trading partner’s country from the drop-down list. The legal profile 
form must be published to display on the list.

■ TP Email Language - From the drop-down list of languages that Active 
Community supports, select the language you want the system to use 
when sending out trading partner registration emails. You can select 
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different languages for different trading partners. The selected language 
displays on the Request tab. The default language is English. 

Note: 
■ The hub needs to configure the registration email in a supported 

specific language before the trading partner can see the email in the 
selected language. For details, see “Configuring an Email in a Different 
(Supported) Language” on page 460.

■ The selected language is only valid for TP registration emails. For all 
other communication with the TP (for example, activities and other 
emails from the hub), the language selected by the trading partner is 
used.

■ The “TP Email Language” field is available for Registration custom 
export under the Registration Company Details group (see “Working 
with Registration Custom Exports” on page 527).

4 On the Contact(s) tab, type the required information for the primary contact at 
the prospective company, then click Next.

5 On the remaining tabs, type the required information, then click Next.
6 Do one of the following:

■ Put the request on hold - After you have added all required information, if 
you are not ready to submit the request, you can put the request on hold. 
See “Putting a Request On Hold” on page 508.

■ Submit the request - Continue with step 7.
7 On the last tab, click Submit Request.

A confirmation dialog opens.

8 Click OK to submit the request.
A New Company Request is created. The page displays additional tabs, such as 
Questions so you can provide additional information in the request. On the 
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Contact(s) tab, you can add additional information for the primary contact, as 
well as add additional contacts. 

9 Before you start the registration request approval process, review and revise 
any information in the request.
Note: If you are not ready to start the approval process, you can put the 
request on hold. See “Putting a Request On Hold” on page 508.

To... Do this...
Download a PDF for your records ■ Click Download PDF.
Start a conversation 1 Click the Questions tab.

2 Go to “Asking and Responding to Questions” on 
page 502.

Verify a tax ID 1 Click the Custom Field Group tab that contains 
the Specialized Tax ID (EIN) custom field that 
has been enabled for verification. Only one 
Specialized Tax ID (EIN) custom field can be 
enabled for verification at a time.

2 Go to “Verifying a Tax ID” on page 503.
Note: To take advantage of the Tax ID 
Verification option, it must be enabled for your 
community. Contact Support for assistance.
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Refer to the following table to make changes on the Request tab.

To... Do this...
Assign an owner to the request 1 Click the Request tab.

2 In Owner, select an owner from the drop-
down list. 

3 Click OK in the Change of Owner 
confirmation dialog box.

4 Click Save.
Assign a request to a different 
approval group

1 Click the Request tab.
2 In Group, click the re-assign link.
3 Select the group. 
4 Click OK. 
5 Click Save.

Review members in an approval group 1 Click the Request tab.
2 In Group, click the view contacts link.
3 Click OK.

Change the Primary Contact email 
address

1 Click the Request tab.
2 Under User Details, click edit for Email.
3 Update the email address.
4 Click Save.
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Refer to the following table to make changes on the Contact(s) tab.

To... Do this...
Change primary contact information 1 Click the Contact(s) tab.

2 Under Primary Contact, update primary 
contact information, and click Save.

Select additional business roles for the 
primary contact 

1 Click the Contact(s) tab.
2 Under Primary Contact, select the business 

role(s) you want to associate with the 
primary contact.

3 Click Save.
Add additional address and phone 
information for primary contact.

1 Click the Contact(s) tab.
2 Under Primary Contact, click the 

Additional Information link.
3 Add additional information for the primary 

contact
4 Click Save.

Add contacts to the request
Note: Contacts added to the request 
are registered in Active Community 
when the request is approved.

1 Click the Contact(s) tab.
2 Under Additional Contacts, click Add 

Additional Contact.
3 Type the required information.
4 Click Save.



R E G I S T R A T I O N  RE Q U E S T S
Creating a Registration Request

OpenText Active Community CE 21.2 User Guide  491

1 4

10 Click Approve Request.

Edit an additional contact’s 
information. 
You can also:

■ Add business roles for the contact
■ Add additional address and phone 

information for the contact

1 Click the Contact(s) tab.
2 Under Additional Contacts, click the Edit 

icon for the name of the contact you want 
to edit.

3 Type and/or select your changes.
4 Click Save.

Assign a different contact as the 
primary contact for the request

Note: This option is not available 
when re-registering a company.

1 Click the Contacts tab.
2 Under Additional Contacts, click the Make 

this Contact as Primary Contact icon for 
the name of the contact you want to make 
the primary contact.

3 Click OK in the Make Primary Contact 
confirmation dialog box.

4 Click Save.
Delete an additional contact from the 
request

1 Click the Contact(s) tab.
2 Under Additional Contacts, click the Delete 

icon for the name of the contact you want 
to delete.

3 Click OK in the Delete Contact confirmation 
dialog box.

To... Do this...
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Active Community sends the appropriate email notifications, including an email 
to the Primary Contact. The email contains a link to the request so the Primary 
Contact can complete the request form and submit it back to the hub.

Creating a Request Using an Anonymous URL
Use this procedure to create a registration request from a URL posted on a web 
site or given to you in an email. By creating a request, the person becomes the 
Requester contact in the registration approval process.

To create a registration request
1 Copy and paste the URL into your browser window.

The Get Started tab opens to the registration request.

2 On the Company tab, type the required information for your company, then 
click Next.

3 On the Contact(s) tab, type the required information for the primary contact at 
the company, then click Next.
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4 On the remaining tabs, type the required information, then click Next.
5 On the last tab, click Submit Request.

A confirmation dialog opens for the anonymous request. 

6 Type your name, email address, phone number, and company name in the 
fields, then click OK to submit the request.
You are notified by email when the request moves to the next stage in the 
approval process.

Importing Registration Requests Using CSV Files
You can import new registration requests into the Registration module by using a 
file saved in comma separated value (CSV) format. You must adhere to the 
guidelines for importing company and contact information described in “Importing 
Companies and Contacts Using CSV Files” on page 128.
Note: Import cannot be used to update registration requests.

General Import Requirements Summary
Here is a high-level summary of .csv file requirements:
■ The first row of the file (header row) must contain the same column headings 

that are mandatory in the user interface. 
■ For example, for contacts, it would be Last Name, First Name, 

Communication Email, and Company ID. User ID is only mandatory when 
using the import to update profiles.

■ For example, for companies, it would be Company Name and Company ID. 
■ The data values to be imported must start in the second row of the file (body 

rows). For example, Jones, Bob, bob.jones@example.com, CFO, ABC123, 
mycomp_id.

1

2
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The parts of the file:

■ Upper or lower case letters can be used for most values. Only custom field 
values are case sensitive.

■ Use commas, tabs, or pipes to separate the information in each column. 

Registration Import Requirements
The fields included in a .csv file depend on the stage and status (Open, On Hold, 
Declined, Completed) to which you want to import the requests, as well as the 
information included in the registration request.
These fields are required in the .csv file:
■ Basic information about the Primary Contact, Requester, and Company:

■ All required custom fields that the hub configured as mandatory for a request. 
■ Unless the Auto Generate Company IDs field is selected for the hub (Admin > 

Community Settings), Company ID must be included.
■ To specify which legal profile to assign to a trading partner in a .csv file, use the 

identifier for the legal profile found in the first column of the Provisioning 
Configuration list page (Admin > Legal Profile tab). Map the identifier to the 
Legal Profile Form field during the import process.

Registration Import Requirements for Tabular Data
You can import tabular data during registration by using a file saved in comma 
separated value (CSV) format. 
In addition to following the “General Import Requirements Summary” on page 493 
and the “Registration Import Requirements” on page 494, you must adhere to 
these requirements:
■ The first body row of a given company of the file is for non-tabular data.
■ The company name needs to be repeated for all rows of the tabular data.

Note: The company name must be in the first column of the file.

Key Description
1 Header row.
2 Body row.

■ Primary Contact
■ First Name
■ Last Name
■ Email
■ Phone

■ Requester
■ Requester First Name
■ Requester Last Name
■ Requester Email
■ Requester Phone
■ Requester Company
■ Requested Date
■ Assigned Date

■ Company
■ Company Name
■ Company Address
■ Company City
■ Company State
■ Company Postal Code
■ Company Country
■ Company Phone
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■ Tabular data can be entered beginning with the second body row for a given 
company.

In this example, 
■ The company name is in the first column of the file.
■ Body row 2 (the first body row for the first company, TestCompany1902_1) 

contains all the non-tabular data for the first company.
■ The first company, TestCompany1902_1, is repeated in column A for all the rows 

of tabular data for that company (rows 3-14).
■ Tabular data for TestCompany1902_1 begins in column AV in the second body 

row for the company (row 3) and continues in subsequent columns AW, AX, AY, 
etc. and subsequent rows 4-14.

■ Body row 15 (the first body row for the second company, TestCompany1902_2) 
contains all the non-tabular data for the second company.

■ The second company, TestCompany1902_2, is repeated in column A for all the 
rows of tabular data for that company (rows 16-23).

■ Tabular data for TestCompany1902_2 begins in column AV in row 16 and 
continues in subsequent columns AW, AX, AY, etc. and subsequent rows 17-23.

Importing Registration Requests in a .csv File
Security roles: Community Administrator
Permissions:
■ Company Permissions > Import Companies
■ Contact Permissions > Import Contacts
When importing a .csv file, you are prompted to map or link each column header 
in your .csv file to a field that exists in the registration request. The column 
heading might be the name of a core field, such as Last Name, or it might be a 
custom field specific to your community, such as Hire Date. If a non-required field 
is not included in the .csv file, you select IGNORE for that field when mapping the 
fields in the request to the fields in the .csv file.
Use this procedure to import registration requests using a .csv file.
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To import registration requests using a .csv file
1 Click Applications > Registration.

The Registration Requests tab opens. 
2 Click Import.

The Upload the File page opens.

3 In Import File, click Browse to navigate to the file location, select the file, and 
click Open.

4 In Status, select a status, such as Open, On Hold, Declined, or Completed, to 
which you want the new requests set.

5 (Optional). Do one of the following to set the workflow stage to which you want 
the requests set:

■ If Open is selected, select Requester, Primary Contact, Pre-Approval, or 
Approval.

■ If On Hold is selected, select Requester, Pre-Approval, or Approval.
6 Click Next.



R E G I S T R A T I O N  RE Q U E S T S
Creating a Registration Request

OpenText Active Community CE 21.2 User Guide  497

1 4

The Map the Fields page opens.

When you import a .csv file that contains tabular data, the Map the Field page 
contains sections for tabular data as well.
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7 In the drop-down lists, specify the required, core and custom fields in your .csv file 
that correspond to the fields in the user interface. 
Note: IGNORE is the default value for any core or custom fields that do not 
automatically match a column header value in the .csv file. If a field is not 
included in the .csv file because you are not importing it, keep the default 
IGNORE setting for that field.

8 Click Next.
The Preview Import page opens. It shows the values for the first row of your 
.csv file mapped to the fields in the registration request. 
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The Preview Import for tabular data displays.

9 Click Next.
The Import Queue page opens. It notifies you that your import file was added 
to the queue for processing. 

After processing the file, Active Community sends you an email that details the 
number of rows that were successfully or unsuccessfully imported. 

10 (Optional) In the email, click Download Reject CSV File, and review the 
Error Messages column for hints about how to fix the invalid data. 

Finding Registration Requests
Use the search links at the top of the Registration Requests tab to monitor and 
manage your registration list. By default, you see Open requests in your lists. To 
view requests in any other completion or ownership status (On Hold, Declined, 
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Completed, For Your Approval, etc.), you must change the filter criteria on your 
request list. 

Use this procedure to find requests using different search criteria. 
Note: You can also access your request list by clicking a link to a request in an 
email.

To find registration requests
1 Click Applications > Registration.

The Registration Requests tab opens. Because the For My Approval and My 
Requests check boxes are selected, the page lists Open requests you need to 
pre-approve or approve and requests you created.

2 To change the filter on your request list, perform the appropriate action:
■ To find all requests or requests by status, click All, On Hold, Declined, or 

Completed.
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■ To find open requests by registration role or requests you created, click 
Open, then select the role the request is open with based on the hub’s 
approval process. 

Options include:
■ Requester contact
■ Pre-Approval role (all levels)
■ Primary Contact
■ Approval role (all levels)
■ Requested by You

■ To sort requests by Days Open, Days Assigned, or Approval stage, click a 
column heading. For example, you might want to sort the registration 
request list by Days Assigned to identify any approval delays or by Declined 
to view all declined requests so you can review and re-submit them.

■ To sort requests by dates, custom field values, status, etc, click Advanced 
Search (see “Advanced Searches” on page 93.)

The page lists requests based on your search criteria. 
3 To act on a request, click its link and go to the appropriate procedure:

■ “Asking and Responding to Questions” on page 502
■ “Verifying a Tax ID” on page 503
■ “Resending Registration Emails” on page 520
■ “Pre-Approving or Approving a Request” on page 504
■ “Approving Requests in Bulk” on page 505
■ “Putting a Request On Hold” on page 508
■ “Putting Requests On Hold in Bulk” on page 509
■ “Reactivating a Request that is On Hold” on page 511
■ “Reactivating Requests in Bulk” on page 512
■ “Declining a Request” on page 514
■ “Reopening a Request” on page 515
■ “Returning a Request for More Information” on page 515
■ “Recalling and Resending a Request” on page 516
■ “Deleting Registration Requests” on page 517
■ “Resending Registration Emails” on page 520
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■ “Correcting Undeliverable Email Addresses” on page 521
■ “Re-submitting Requests Stuck in TGO Provisioning Status” on page 522

Asking and Responding to Questions
The Primary Contact and Pre-Approval roles can use the Questions tab to ask and 
respond to questions about the request. Files can be attached to the question.
Note: Asking and responding to questions does not send emails. If approvals are 
skipped, the Questions tab cannot be used.
Topics include:
■ “Asking Questions About a Registration Request” on page 502
■ “Responding to Questions (Pre-Approval Role)” on page 502
■ “Closing Request Conversations” on page 503

Asking Questions About a Registration Request
As a Primary Contact, use this procedure to ask a question about a request.

To ask questions about a request
1 Click the view request link in the request email to access the request.

2 In the registration request, click the Questions tab.
3 Click Start a Question.
4 In Subject and Question, type the subject and text of the question. 
5 If needed, click Browse to attach a file to the request.
6 Click Send Question.

The Pre-Approval role receives an email that states a question has been posted.

Responding to Questions (Pre-Approval Role)
You might need to respond to questions as part of the request process. 

To respond to questions in a request
1 If you receive an email that indicates a Primary Contact asked a question 

related to a request, log in to Active Community, find and open the request, 
and click the Questions tab to post a reply.
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2 Find the question asked by the Primary Contact, and click Post.
3 Type your answer to the question.
4 If needed, click Browse to attach a file to your response.
5 Click Post Your Reply.

Your response is sent to the Primary Contact who asked the question, who 
must click the view request link in the email to view your reply.

Closing Request Conversations
Important: When a request is registered, all questions must be closed. If they 
are not, the contact in the Approval role receives a validation error. 

To close a conversation
1 Follow the instructions in “Finding Registration Requests” on page 499 to find 

the request with questions that need to be closed.
2 In a registration request, click the Questions tab.
3 Find the question you want to close, and select the Question Closed check 

box.

The question is closed. If the request is at the final Approval stage, the 
company can be registered.

Verifying a Tax ID
The Specialized Tax ID (EIN) custom field allows hubs to collect a federal tax ID 
and verify that it is correctly formatted as an EIN (Employer Identification 
Number). The value is not verified unless the Tax ID Verification option is enabled 
for your community. To enable the option, contact Support. 
After the Tax ID Verification option is enabled for your community, you can use a 
Specialized Tax ID (EIN) custom field in your registration request, and verify the 
Tax ID using the Verify Tax ID link. 

To verify a tax ID (EIN)
1 After a Tax ID is entered in the Tax ID custom field, click Verify Tax ID.

The system attempts to verify the tax ID. 
2 One of the following occurs:
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■ The Tax ID is not valid. A message displays saying that the Tax ID cannot 
be found. You can correct the tax ID and click Verify Tax ID again.

■ The Tax ID is valid. The Verified Data pop-up opens and displays the details 
associated with the Tax ID.

The verified data is then accessible on the Company tab, the Request tab, and the 
Custom Fields tab, so you can copy it from the pop-up window and use it to fill in 
the request form.

Pre-Approving or Approving a Request
Registration role: Pre-Approval, Approval
Use this procedure to pre-approve or approve a registration request. 
Important: Depending on your role and the part of the approval process the 
request is in, you might see different buttons in the request (see “Request Buttons, 
Roles, and Workflows” on page 483).

To approve a request
1 Click Applications > Registration.

The Registration Requests tab opens. The page lists Open requests you need to 
approve and requests you created.

2 Click the link for the request you want to approve, review the information, and 
do one of the following:

■ Pre-approver - Click Approve Request.
■ Approver - Click Register Request (or click Re-register a Request if 

the request is a subsequent registration (re-registration)).
3 At the confirmation message, click OK.

The request moves to the next phase in the registration approval process. If a 
registration request is:

■ Pre-approved - the request is sent to the prospective supplier’s Primary 
Contact to collect information about the company and business contacts.
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■ Approved - the company is registered in your community. A company 
profile is added to your Companies list and any contact profiles are added 
to your Contacts list. The link in the original registration request becomes 
inactive.

4 For final approvals, before the request is registered, the approver must ensure:
■ The Question Closed check box is selected in the request. The check box 

indicates a question has been resolved. To select the check box:
1 Go to the request.
2 Click the Question tab.
3 Select Question Closed.

The question is closed. If the request is in the final Approval stage, the 
company can be registered.

■ If a company ID is not created automatically, the Approval role must enter 
the Company ID and/or the Parent Company ID when registering the 
request.

Note: If the Auto-generate Company ID check box is selected under 
Admin > Community Settings, Active Community creates the Company 
ID automatically.

Approving Requests in Bulk
Security roles: Community Administrator and/or Registration Administrator
Use this procedure to approve more than one registration request at a time (in 
bulk). 
Note: Approving requests in bulk is available only for TGO integrated 
communities.
Requirements and limitations for using this feature include:
■ OpenText must enable it for your community. 
■ Bulk approval of registration requests is allowed only when the Auto-generate 

Company IDs check box is selected (Admin > Community Settings tab).
■ Bulk approval only works for requests in the Approval stage (for example, 

moving between approver levels or completing the final registration).

To approve requests in bulk
1 Click Applications > Registration.
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The Registration Requests tab opens. The page lists Open requests you need to 
approve and requests you created.

2 Do one of the following:
■ Select check box(es) for the requests you want to approve.
■ Search for the requests you want to approve. Select All Search Results. 

This allows you to select more results than are displayed on the first page.
3 From the Actions drop-down list, select Approve Registrations, and click OK.

A dialog box opens and asks you to confirm the approval of the selected 
registration requests.

4 Click OK to approve the selected registration requests.
A message indicates that the registration request(s) have been submitted for 
approval. 

5 The Request for My Approval page displays an icon for each request that has 
been submitted for bulk approval. Rollover text displays, “In Approval Process.”



R E G I S T R A T I O N  RE Q U E S T S
Approving Requests in Bulk

OpenText Active Community CE 21.2 User Guide  507

1 4

If you try to submit a request (s) that has already been submitted, a message 
displays to indicate that the request (s) is in progress and cannot be re-
submitted for approval.

When the system completes processing the requests, it sends you an email. 

The email contains the number of requests that have been successfully 
approved, the number of requests that have been rejected (if any), and a link 
to a file that contains details of the rejected requests. 
The file is available for 7 days before being deleted.
The request moves to the next phase in the registration approval process. If a 
registration request is:

■ Between approval levels, it moves to the next approval level. 
■ In the final approval level, the request is registered in your community. A 

company profile is added to your Companies list (Profiles > Companies > 
Directory tab) and any contact profiles are added to your Contacts list. The 
link in the original registration request becomes inactive.

6 For final approvals, before the request is registered, the approver must ensure:
■ The Question Closed check box is selected in the request. The check box 

indicates a question has been resolved. To select the check box:
1 Go to the request.
2 Click the Question tab.
3 Select Question Closed.

The question is closed. If the request is in the final Approval stage, the 
company can be registered.
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Putting a Request On Hold
Registration role: Requester at the hub company, Pre-Approval, Approval
Use this procedure to put a registration request on hold, for example, if you need 
to obtain more information. Putting a request on hold applies only to requests in 
the Requestor, Pre-approval, or Approval stages (for example, before the request is 
submitted or for a request in the pre-approver or approver stages).
Important: The Hold button displays only if the Hold action has been activated in 
the registration workflow (See“Phase 2: Design a Registration Workflow” on 
page 438
Depending on your role and the part of the approval process the request is in, you 
might see different buttons in the request (see “Request Buttons, Roles, and 
Workflows” on page 483).

Cumulative Days on Hold
If you put a registration request on hold, reactivate it, and then put it on hold 
again, the Days on Hold number that displays in Request Details is the cumulative 
number of days that the request was on hold during its lifetime in the registration 
workflow.

To put a request on hold
1 Click Applications > Registration.

The Registration Requests tab opens. The page lists open requests you need to 
approve and requests you created.

2 Find requests that you want to put on hold by changing your filter settings as 
described in “Finding Registration Requests” on page 499.

3 Click the link for the request you want to put on hold, and click Hold.
4 In the Confirm dialog box, type the reason for putting the request on hold.

This reason is available in the Registration Request History Report (see 
“Downloading a Registration Request History Report” on page 534) as well as 
the registration custom export (see “Creating General Settings for a 
Registration Custom Export” on page 528).

5 Click OK.
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A message indicates that the registration request has been put on hold. The 
status indicates that the request is on hold.

One of the following occurs:
■ If the request is in the pre-approval or approval stage, an email notification 

is sent to each contact in that approval group (for example, all Pre-
Approval 1 contacts or all Approval 2 contacts) notifying them that the 
request is on hold. 

■ If the request is in the Requestor stage, the requestor does not receive an 
email notification.

Note: Only a user in the same group level as the user who put the request on 
hold can reactivate the request (see “Reactivating a Request that is On Hold” 
on page 511).

Putting Requests On Hold in Bulk
Registration role: Requester at the hub company, Pre-Approval, Approval
Use this procedure to put on hold more than one registration request at a time (in 
bulk). Putting a request on hold applies only to requests in the Requestor, Pre-
approval, or Approval stages (for example, before the request is submitted or for a 
request in the pre-approver or approver stages).
Important: The Hold button displays only if the Hold action has been activated in 
the registration workflow (see “Phase 2: Design a Registration Workflow” on 
page 438).
Depending on your role and the part of the approval process the request is in, you 
might see different buttons in the request (see “Request Buttons, Roles, and 
Workflows” on page 483).

Cumulative Days on Hold
If you put a registration request on hold, reactivate it, and then put it on hold 
again, the Days on Hold number that displays in Request Details is the cumulative 
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number of days that the request was on hold during it’s lifetime in the registration 
workflow.

To put requests on hold in bulk
1 Click Applications > Registration.

The Registration Requests tab opens. The page lists Open requests you need to 
approve and requests you created.

2 Do one of the following:
■ Select check box(es) for the requests you want to put on hold.
■ Search for the requests you want to put on hold. Select All Search 

Results. This allows you to select more results than are displayed on the 
first page.

3 From the Actions drop-down list, select Hold, and click OK.

4 In the Hold Registrations dialog box, type a reason for putting the selected 
registration requests on hold. 
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This reason is available in the Registration Request History Report (see 
“Downloading a Registration Request History Report” on page 534) as well as 
the registration custom export (see “Creating General Settings for a 
Registration Custom Export” on page 528). 

5 Click OK.
A message indicates that the registration request(s) have been put on hold.
One of the following occurs:

■ If the request(s) are in the pre-approval or approval stage, an email 
notification is sent to each contact in that approval group (for example, all 
Pre-Approval 1 contacts or all Approval 2 contacts) notifying them that the 
request(s) are on hold. A separate email is sent for each request that was 
put on hold.

■ If the request is in the Requestor stage, the requestor does not receive an 
email notification.

Note: Only a user in the same group level as the user who put the request on 
hold can reactivate the request (see “Reactivating a Request that is On Hold” 
on page 511).

Reactivating a Request that is On Hold
Registration role: Requester at the hub company, Pre-Approval, Approval
Use this procedure to reactivate a registration request that has been put on hold. 
The request must have a Hold status. Only a user in the same group level as the user 
who put the request on hold can reactivate the request.
Important: The Reactivate button displays only if the Hold action has been 
activated in the registration workflow (see“Phase 2: Design a Registration 
Workflow” on page 438).
Depending on your role and the part of the approval process the request is in, you 
might see different buttons in the request (see “Request Buttons, Roles, and 
Workflows” on page 483).

To reactivate a request
1 Click Applications > Registration.

The Registration Requests tab opens. The page lists open requests you need to 
approve and requests you created.
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2 Under Search for Requests, click On Hold.

The page lists On Hold requests that can be reactivated (see also “Finding 
Registration Requests” on page 499).

3 Click the link for the request you want to reactivate, and click Reactivate.
4 In the Confirm dialog box, type the reason for reactivating the request.

This reason is available in the Registration Request History Report (see 
“Downloading a Registration Request History Report” on page 534) as well as 
the registration custom export (see “Creating General Settings for a 
Registration Custom Export” on page 528).

5 Click OK.
A message indicates that the registration request has been reactivated.
One of the following occurs:

■ If the request is in the pre-approval or approval stage, an email notification 
is sent to each contact in that approval group (for example, all Pre-
Approval 1 contacts or all Approval 2 contacts) notifying them that the 
request is reactivated. 

■ If the request is in the Requestor stage, the requestor does not receive an 
email notification.

Reactivating Requests in Bulk
Registration role: Requester at the hub company, Pre-Approval, Approval
Use this procedure to reactivate more than one registration request (in bulk) that 
has been put on hold. The requests must have a Hold status. Only a user in the 
same group level as the user who put the requests on hold can reactivate the requests.
Important: The Reactivate button displays only if the Hold action has been 
activated in the registration workflow (see“Phase 2: Design a Registration 
Workflow” on page 438).
Depending on your role and the part of the approval process the request is in, you 
might see different buttons in the request (see “Request Buttons, Roles, and 
Workflows” on page 483).
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To reactivate requests in bulk
1 Click Applications > Registration.

The Registration Requests tab opens. The page lists Open requests you need to 
approve and requests you created.

2 Under Search for Requests, click On Hold.

The page lists On Hold requests that can be reactivated (see also “Finding 
Registration Requests” on page 499).

3 Do one of the following:
■ Select check box(es) for the requests you want to reactivate.
■ Search for the requests you want to reactivate. Select All Search Results. 

This allows you to select more results than are displayed on the first page.
4 From the Actions drop-down list, select Reactivate, and click OK.

5 In the Reactivate Registrations dialog box, type a reason for reactivating the 
selected registration request(s).
This reason is available in the Registration Request History Report (see 
“Downloading a Registration Request History Report” on page 534) as well as 
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the registration custom export (see “Creating General Settings for a 
Registration Custom Export” on page 528).

6 Click OK.
A message indicates that the registration request(s) have been reactivated.
One of the following occurs:

■ If the request(s) are in the pre-approval or approval stage, an email 
notification is sent to each contact in that approval group (for example, all 
Pre-Approval 1 contacts or all Approval 2 contacts) notifying them that the 
request(s) are reactivated. A separate email is sent for each request that 
was reactivated.

■ If the request is in the Requestor stage, the requestor does not receive an 
email notification.

Declining a Request
Registration role: Pre-Approval, Primary Contact
Use this procedure to decline a registration request, for example, if the company or 
contact already exists in your community or the prospective supplier is not optimal. 
Depending on your settings, the original requester might be able to reopen the 
request.
Important: Depending on your role and the part of the approval process the 
request is in, you might see different buttons in the request (see “Request Buttons, 
Roles, and Workflows” on page 483).

To decline a request
Note: If you are a primary contact for a prospective supplier and decide to decline 
a request, open the link in the registration request email, and click Decline 
Request.
1 Click Applications > Registration.

The Registration Requests tab opens. The page lists open requests you need to 
approve and requests you created.

2 Find requests that you want to decline by changing your filter settings as 
described in “Finding Registration Requests” on page 499.

3 Click the link for the request you want to decline, review the information, and 
click Decline Request.

4 At the confirmation message, click OK.
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The request moves to the next phase in the registration approval process. If a 
request is declined, it is sent back to the previous request stage, such as back 
to the Requester or to the prospective supplier’s Primary Contact. Depending 
on workflow settings, registration requests can be re-submitted after they have 
been declined. 

Reopening a Request
Registration role: Requester, Pre-Approval
If a registration request was declined, it can be reopened and re-submitted if you 
are the original Requester or are in a Pre-Approval role, such as a procurement 
director or category manager. For example, procurement might want to reopen, 
edit, and re-submit a request to register a new supplier if the original request was 
declined by the supplier’s Primary Contact.
Important: Depending on your role and the part of the approval process the 
request is in, you might see different buttons in the request (see “Request Buttons, 
Roles, and Workflows” on page 483).

To reopen a declined request
1 Click Applications > Registration.

The Registration Requests tab opens. The page lists open requests you need to 
approve and requests you created.

2 Under Search for Requests, click Declined.

The page lists declined requests that can be reopened (see also “Finding 
Registration Requests” on page 499).

3 Click the link for the request you want to reopen, modify the information, and 
click Reopen Request.

4 At the confirmation message, click OK.
The request moves to the next phase in the registration approval process. If a 
request is reopened, it is sent to the next person in the registration process, 
typically the Pre-Approval role or the Primary Contact at the prospective 
supplier.

Returning a Request for More Information
Registration role: Pre-Approval, Primary Contact
Use this procedure to return a registration request to the previous person in the 
process, such as the original Requester (buyer, sales representative, or member of 
your community), a Pre-Approval role (category manager, supplier relations) or the 
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Primary Contact at the prospective supplier to be registered. You are prompted to 
provide a reason why the request is being returned for more information. 
Important: Depending on your role and the part of the approval process the 
request is in, you might see different buttons in the request (see “Request Buttons, 
Roles, and Workflows” on page 483).

To return a request for more information
1 Click Applications > Registration.

The Registration Requests tab opens. The page lists open requests you need to 
approve and requests you created.

2 Under Search for Requests, click Open > With Pre-Approval (all levels) or 
Open > With Primary Contact.

The page lists requests that are open (see also “Finding Registration Requests” 
on page 499).

3 Click the link for the request you want to return, review the information, and 
click Return for More Information.
A confirmation dialog opens.

4 Type the reason the request is being returned, and click OK.
The request moves to the next phase in the registration approval process. If a 
request is returned, the person who submitted the request (or someone else 
with the same role, such as procurement or finance) can open and edit the 
request, provide more information, and send the request back for review. 

Recalling and Resending a Request
Registration role: Pre-Approval and Registration Administrator
Use this procedure to send a request back to yourself so you can edit any 
information that might be incorrect, such as the Primary Contact’s email address. 
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By recalling a request, you move it back to the Pre-Approval stage. After recalling a 
request, you can update information in the request and resend it to a Primary 
Contact.

To recall and resend a request
1 Click Applications > Registration.

The Registration Requests tab opens. The page lists open requests you need to 
approve and requests you created.

2 Under Search for Requests, click Open > With Primary Contact.

The page lists requests that are open and with the Primary Contact (see also 
“Finding Registration Requests” on page 499).

3 Click the link for the request you want to recall, review the information, and 
click Recall Request.
A message indicates the request was recalled successfully.
Important: The request is sent back to the Pre-approval role, such as the 
category manager or supplier relations. 

4 To find the recalled request, click Open > Pre-Approval.
5 Click the request’s link to determine why it was not completed by the 

prospective supplier, such an incorrect email address.
6 Correct the information, click Save, and click Approve Request.

The email with the link to the request is sent to the Primary Contact.

Deleting Registration Requests
Security roles: Community Administrator and/or Registration Administrator
You can delete registration requests that are no longer needed. The requests must 
have an Open, Declined, or Completed status. 
Note: When a registration is deleted, the related company profile is no longer 
eligible for re-registration.

To delete a registration request
1 Click Applications > Registration.
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The Requests for My Approval page opens. 

2 At the top of the page, perform the appropriate action:
■ Click Declined, Open, or Completed to search for requests that were 

declined, are still open, or are complete.
■ Click Advanced Search, provide additional search criteria, and search for 

Declined, Open, or Completed requests. 
3 Select check box(es) for the requests you want to delete.
4 From the Actions drop-down list, select Delete Registrations, and click OK.

A dialog box opens and asks you to confirm the deletion of the selected 
registration requests.

5 Click OK to delete the selected registration requests.
A message indicates the request(s) were deleted.
Note: When a registration is deleted, the related company profile is no longer 
eligible for re-registration.

Canceling a Re-registration Request
Security roles: Requestor and/or Registration Administrator
You can cancel a re-registration request which results in unlocking the company 
profile in the directory. 

To cancel a registration request
1 Click Applications > Registration.
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The Requests for My Approval page opens. 

2 Search for and click on the name of the company whose re-registration you 
want to cancel.
The company’s registration request page opens.

3 Click Cancel Re-registration.
A dialog box opens and asks you to confirm the cancellation of the selected 
re-registration request.

4 Click OK to cancel the selected re-registration request.
A message indicates the request was canceled. The company profile in Base is 
unlocked.

Downloading a Registration Request as a PDF
Security roles: Requestor and/or Registration Administrator
You can download a registration request as a PDF. 

To download a registration request as a PDF
1 Click Applications > Registration.
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The Requests for My Approval page opens. 

2 Search for and click on the name of the company whose registration you want 
to download.
The company’s registration request page opens.

3 Click Download as PDF (which might display in the More drop-down list).
Check your Download folder for the file, or click the Open file link to view it.
Note: To customize the name of the document title in the PDF, see 
“Customize Document Title for Registration Request Report” on page 473.

Resending Registration Emails
Security roles: Community Administrator and/or Registration Administrator
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You can resend a copy of the original registration email to Primary Contacts and/or 
the Pre-approvers/approvers. The emails remind contacts they need to respond to 
a registration request to complete it, approve it, or add more information to it.
Note: Up to three reminder messages can be defined (see “Defining Reminder 
Email Settings” on page 470). The content in reminder emails can be customized 
(see “Reminder Email Templates” on page 454).

To resend a request
1 Click Applications > Registration.

The Registration Requests tab opens. 
2 Under Search for Requests, click Open > With Pre-Approval (all levels), 

With Primary Contact, or With Approval (all levels).

The page lists open requests for the selected role (see also “Finding 
Registration Requests” on page 499).

3 Click Email.
A confirmation message asks if you want to send registration requests to the 
contact(s) in the selected role.

4 Click Send.
The email is sent.

Correcting Undeliverable Email Addresses
Registration role: Pre-Approval, Approval
When prospective suppliers do not respond to prompts for information, the delay 
might be caused because incorrect email addresses for Primary Contacts were 
specified in the request. In addition, email notifications can “bounce” back to the 
sender due to unexpected, obsolete, or incorrect email address information. 
Note: The email address that receives all bounced or returned registration emails 
is defined during Registration setup (see “Configuring From, To, and Undeliverable 
Email Addresses” on page 472).
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To correct an email address for a primary contact
1 Click Applications > Registration.

The Requests for My Approval page opens. 
2 Find the request for the email address you want to correct, and click its link 

(see “Finding Registration Requests” on page 499).
The request opens to the Request tab.

3 Under User Details, click edit for Email.
The Change Primary Contact Email dialog opens.

4 Update the email address, and click Save.

Re-submitting Requests Stuck in TGO Provisioning Status
Customers with Active Community/Trading Grid Online (TGO) integrated 
communities have the ability to resolve registration requests stuck in “TGO 
Provisioning” status.
After a registration request is submitted, one of the following occurs:
■ If the request can be set up, the registration is processed normally.
■ If the request cannot be processed, the following occurs:

a The user receives an error message with additional information. 
b Support receives a copy of the issue and begins an investigation.
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c Support notifies the user when the request can be successfully 
re-submitted a final time.

d Support instructs the user to click Re-Submit Request (the button 
displays 15 hours after submitting a registration request). 

An icon displays for requests that have already been re-submitted.

Using the Registration Dashboard to Track Requests
The Registration Dashboard lets you view the number of open requests, requests 
assigned to you, and other statistics. It also provides views of registration activity 
over a period of days and months, which helps track trends and issues. 
For example, you might note the average number of days to register a company 
increases by 30 percent during the month of July because people are out on 
vacation. 
The Dashboard consists of two parts:
■ Registration Summary - the links take you to the Registration Requests tab so 

you can, for example, view a list of all requests with an Open status or a list of 
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requests you created. Click a link to open a request and act on it as described in 
“Finding Registration Requests” on page 499.

■ Chart Data - the links allow you to view and download registration data.
■ Download Chart Data lets you view chart data in .xls format. See “View and 

Download Chart Data” on page 525.
■ View Summary Level Chart and its counterpart View Role Level Chart are 

accessed by toggling the two links; you can view request data in chart 
format by status or registration role.

Registration Summary Level Chart 
The Registration Summary Level chart displays request data for the past five days. 
It includes charts for requests with Registered and Declined statuses.

Registration Summary Role Level Chart 
The Registration Summary Role Level chart displays request data for the past five 
days by registration role. The chart can help you analyze request activity by groups 
of people in your registration process. 
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For example, you might want to see how request processing is trending by the Pre-
Approval role compared to the Approval role over the first quarter of the year.

1 2

3

The key parts of the page:

The axes on the chart are defined as follows:
■ Horizontal axis represents Average Number of Days Open (by month). 
■ Vertical axis represents Number of Requests.
Note: If you hover your mouse over a point in the chart, the statistics for that 
period display. 

View and Download Chart Data
Ageing reports are based on chart data by status and role. They can be run in .xls 
format. The reports let you analyze requests over a period of time. For example, 
you can see the number of requests processed over a given month to provide 
statistics on the efficiency and frequency of your supplier registration process. 
Use this procedure to view and download reports in .xls format. 

To view and download chart data in Excel format
1 Click Applications > Registration > Dashboard tab. 

Key Description
1 Registration Summary Role Level data
2 Link to View Summary Level Chart view
3 Registration roles
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The Dashboard page opens.

2 Click View Summary Level Chart to display registration summary data.

3 If you want to download:
■ Registration summary level data, click Chart Data.
■ Registration summary role level data, click View Role Level Chart, then 

click Chart Data.
Note: Click the View Summary Level Chart and View Role Level Chart 
links to switch between the two charts and view the data by registration status 
or by role.

4 Do one of the following:
■ Click Open with, and select the program you want to use to open and 

display the report (for example, Microsoft Excel).
■ Click Save File, and navigate to a location on your computer where you 

want to save the file.
5 Click OK.

If you selected open with Microsoft Excel, the Excel file opens and displays 
the report.
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Working with Registration Custom Exports
Create custom exports to use for reporting, analysis, or problem resolution. 
Registration custom exports let you define the general criteria and custom fields to 
include in the export. You can also specify additional export options for the Excel 
file. 
The custom export contains every detail about requests in Active Community 
registration in your community. Exports are commonly used for keeping a printed 
file copy of request information.
Note: If you have permission to view the data in a masked company custom field, 
the data displays. If you do not have permission to view the data, 10 asterisks 
display instead.
Important: 
■ Basic request information is on one tab of the Excel file. The information includes 

current status, names of contacts in the Pre-Approval and Approval roles, and 
time/dates of submission and modification.

■ Custom field information displays in other tabs at the bottom of the file. The tabs 
correspond to each tab in a registration request. If the Add Summary Export 
check box is selected when configuring the export, summary data displays on a 
separate tab (see “Formatting a Registration Custom Export” on page 530).

If you do not have registration permissions to view information in a request 
(such as the request tabs for custom fields), the tab is not included in the 
export file (see “Registration Roles and Contacts” on page 82). 
For more information, see “Registration Setup” on page 423, especially the 
section, “Defining Custom Field Forms in Registration Requests” on page 435
Note: If you have permission to view the data in a masked company custom 
field, the data displays. If you do not have permission to view the data, 10 
asterisks display instead.

Topics include:
■ “Creating General Settings for a Registration Custom Export” on page 528
■ “Formatting a Registration Custom Export” on page 530
■ “Running a Registration Custom Export” on page 531
■ “Editing a Registration Custom Export” on page 532
■ “Deleting a Registration Custom Export” on page 533
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Creating General Settings for a Registration Custom Export
Use this procedure to define the data you want to include in an Excel (.xls) file 
when exporting registration data. 
Note: To define how you want the data look in the Excel file, go to “Formatting a 
Registration Custom Export” on page 530 after completing this procedure.

To create the general settings for a registration custom export
1 Click Applications > Registration.

The Requests For My Approval page opens.

2 From the Actions drop-down list, select Custom Export.
3 Select the registration requests you want to include in the export. 

■ To include all requests, select All Search Results, then click OK.
■ To include specific requests, select the check boxes for the contacts you 

want to include in the export, select Selected Rows, and click OK.
The Registration Custom Exports list page opens. It lists saved exports you 
created (Private Exports and Public Exports Created by Current User) and 
exports created by others (Public Exports Created by Other Users).
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4 To define the general settings for a new custom export, click New Export.
The Registration Custom Export page opens. 

5 Complete the following: 
a In Name, type the name of the custom export.
b In Public?, if you want the export to be:

■ Private, do not select the Public? check box.
■ Available to other users, select the Public? check box.

c Select the Export Identifiers check box if you want to export the 
identifiers, in addition to the labels, for the custom fields. For example:

Note: Exporting the identifiers provides the information that is 
needed to import the file back into Active Community. Applies only to 
Multiple Choice, Drop List, and Radio Button List custom fields. Only 
available to users with appropriate permissions.

d Select the Export Additional Comments check box if you want to export 
the “Additional Comments” associated with the custom field values. The 
export of additional comments for a custom field is only available if the 
“Add Comment Field” has been enabled for that field.

6 In the Select custom fields for groups to include in export check boxes, 
select the custom fields or groups for which you want to include data in the 
export. As you select a check box, additional fields display so you can include or 
exclude them from the custom export.

7 Click Save.
The Registration Custom Export page refreshes and lists the new export.

8 Go to “Formatting a Registration Custom Export.”
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Formatting a Registration Custom Export
Use this procedure to define settings that control how exported registration data 
looks in the Excel file. 
Important: If you want registration information to be summarized on a separate 
tab on the Excel spreadsheet, be sure to select the Add Summary Export check box 
as described in this procedure.

To configure the format for a registration custom export
1 After “Creating General Settings for a Registration Custom Export” on 

page 528, on the Registration Custom Exports page, click the name of a custom 
export.

2 To define Excel format settings for the export, click Configure Export.
The Configure Export page opens. The top part of the page is shown.

3 Under Export Options, select one of the radio buttons to indicate how you want 
to export multiple choice fields. You can export them as:

■ Individual Columns
■ Comma separated values in one cell

4 Under Summarize Fields (the bottom part of the page is shown), select the Add 
Summary Export check box if you want registration information to be 
summarized on a separate tab on the Excel spreadsheet.

Additional fields display. 
5 Do any of the following:
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■ In the summary, each field is displayed as a percentage. Optionally, choose 
the Show Count and Show Total check boxes if you want to include the 
count and/or total for the fields.

■ To select the fields by which you want to group the data, make selections 
from the Group by Field drop-down list. Click the + icon to add up to five 
groups.

■ To select how you want the information to be summarized, make a 
selection from the Summarize On drop-down list. If you select: 

■ Do Not Summarize—The registration summary information is not 
summarized.

■ Custom Fields (for example, # of Employees)—Add additional 
parameters to the export. Use the Type drop-down list and + icon to 
indicate additional parameters.

6 Click Save. 
The custom export settings are saved. You have completed the procedure.

7 To run the export, click Run.
8 When the Run Custom Export page opens, click Run again.

Note: Default file name: Custom_Export_Name_MM_DD_YYYY where 
MM_DD_YYYY represents the month, day, and year the export is run.

9 Open or save the file to your computer.

Running a Registration Custom Export
You can run a custom export you created previously (see “Creating General 
Settings for a Registration Custom Export” on page 528 and “Formatting a 
Registration Custom Export” on page 530). 
Note: If you have permission to view the data in a masked company custom field, 
the data displays. If you do not have permission to view the data, 10 asterisks 
display instead.

To run a registration custom export
1 Click Applications > Registration.

The Requests For My Approval page opens.
2 From the Actions drop-down list, click Custom Export.
3 Select the registration requests you want to include in the export. 

■ To include all requests, select All Search Results, then click OK.
■ To include specific requests, select the check boxes for the contacts you 

want to include in the export, select Selected Rows, and click OK.
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The Registration Custom Exports list page opens.

4 Click the name of the registration custom export you want to run. For example, 
click Registration Test.
The page that opens shows the saved export settings for the export.

5 Click Run.
The Run Summary dialog box opens. 

6 Change the filename, if needed, and then click Run.
7 Type a file name, and click Run.

Note: Default file name: Custom_Export_Name_MM_DD_YYYY where 
MM_DD_YYYY represents the month, day, and year the export is run.

8 Open or save the file to your computer.
Note: Large exports (processing times of more than 30-40 seconds) run in 
the background, and the generated export file is sent to you as a download link 
in an email. The link is available for 7 days. Smaller exports are downloaded 
instantly.

Editing a Registration Custom Export
You can change the settings in any custom export that you created. 
Note: You cannot edit a custom export created by other users.

To edit a registration custom export
1 Click Applications > Registration.

The Requests For My Approval page opens.
2 From the Actions drop-down list, click Custom Export.
3 Select All Search Results, then click OK.
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The Registration Custom Exports list page opens. It lists saved exports you 
created (Private Exports and Public Exports Created by Current User) and 
exports created by others (Public Exports Created by Others).

4 Click the name of the custom export you want to edit.
Note: You cannot edit a custom export created by other users.

5 Modify the export as described in “Creating General Settings for a Registration 
Custom Export” on page 528.

6 Click Save to save your changes.

Deleting a Registration Custom Export
Users who create a custom export, as well as Community Administrators, can 
delete the custom export. 

To delete a company custom export
1 Click Applications > Registration.

The Requests For My Approval page opens.
2 From the Actions drop-down list, click Custom Export.
3 Select All Search Results, then click OK.
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The Registration Custom Exports list page opens.

4 Click Delete for the export you want to delete.
A message asks you to confirm the deletion. 

5 Click OK.
The export is deleted.

Downloading a Registration Request History Report
The Registration Request History Report lists all auditable changes to registration 
requests in a hub community. The report is used for internal auditing of request 
information.
In the report, request changes are reflected in transaction rows. Each row names 
the contact who made the change, the time and date of the change, and the 
request information at the time of the change. Reasons for putting requests on 
hold and/or reactivating them are also available in the History Report.
Note: If you have permission to view the data in a masked company custom field, 
the data displays. If you do not have permission to view the data, 10 asterisks 
display instead.

To run and download a request history report
1 Click Applications > Registration > Registration Requests tab. 

The Requests For My Approval page opens.
2 Click History.
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The Opening Registration Requests History dialog box opens.

3 Do one of the following:
■ Click Open with, and select the program you want to use to open and 

display the report (for example, Microsoft Excel).
■ Click Save File, and navigate to a location on your computer where you 

want to save the file.
4 Click OK.

If you selected open with Microsoft Excel, the Excel file opens and displays 
the report.

Viewing and Exporting an EIN (Tax ID) Usage Report
Each time you attempt to verify a Tax ID (EIN), Active Community creates a log 
with the details of the verification attempts. The data in these logs, such as the 
Company name, the time and date of the verification, and whether or not the 
verification was successful comprises the EIN Usage Report. 
Note: Only the Community Administrator has access to this report.
There are two ways to obtain the usage report:
■ View the EIN usage data for a 6 month period. If a verification was successful, 

verified data is available in a pop-up window.
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■ Export the EIN usage data for a 12 month period. In the exported report, 
verification requests are reflected in transaction rows. Each row displays the 
person who requested the verification, the Company name, the EIN, the status 
of the verification (Fail or Success), and the time and date the EIN was verified. 

To view or export an EIN Usage Report
1 Click Applications > Admin > Usages Reports tab.

The Usage Reports window opens.

2 Click EIN verification usage logs.
The EIN Usage Report data for the last 60 days displays.

3 To export an EIN Usage Report with 12 months data, click Export EIN Usages 
Report.
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The Opening EIN Audits dialog box opens.

4 Do one of the following:
■ Click Open with, and select the program you want to use to open and 

display the report (for example, Microsoft Excel).
■ Click Save File, and navigate to a location on your computer where you 

want to save the file.
5 Click OK.

If you selected open with Microsoft Excel, the Excel file opens and displays the 
report.
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AIC Provisioning 15
Active Community AIC Provisioning is a process solution designed to help hubs 
implement application services such as Active Invoices with Compliance (AIC). 
Note: AIC Provisioning is available for TGO integrated communities only, and must 
be enabled for your community. Contact Support for assistance.
Topics include:
■ “Legal Profile Provisioning for AIC - Overview” on page 539

■ “Configuring the Hub for AIC” on page 540
■ “Trading Partner (Spoke) Requirements” on page 540

■ “AIC Provisioning - Legal Profile Forms” on page 540
■ “Creating a Legal Profile Form with AIC Custom Field Groups” on page 541
■ “Adding AIC Custom Fields to a Legal Profile Form” on page 543

■ “AIC Provisioning - Working with AIC Custom Fields” on page 547
■ “AIC Provisioning - Working with Legal Profile Forms” on page 556
■ “AIC Subscriptions - Legal Profiles for Trading Partners” on page 559 

■ “Submitting a Legal Profile” on page 560
■ “Editing a Legal Profile” on page 561
■ “Viewing a Legal Profile” on page 563
■ “Deleting a Legal Profile” on page 563

Legal Profile Provisioning for AIC - Overview
Active Invoices with Compliance (AIC) is a compliance service that takes an invoice 
sent by a trading partner (TP) and ensures that the invoice meets certain criteria. 
The invoice is officially signed, and is logged by a country for tax purposes. A 
trading partner must create and submit a legal profile to AIC so it can to use the 
AIC service.
Topic include:
■ “Configuring the Hub for AIC” on page 540
■ “Trading Partner (Spoke) Requirements” on page 540
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Configuring the Hub for AIC
From a hub or Community Administrator perspective, multiple components must 
be set up to implement the AIC service for TP use. They include:
■ Using a TGO invitation code specific to AIC provisioning (see “Managing TGO 

Invitation Codes” on page 434)
■ Creating legal profile forms for relevant countries and/or business units (see 

“Creating a Legal Profile Form with AIC Custom Field Groups” on page 541)
■ Publishing the legal profile form (see “Publishing a Legal Profile Form” on 

page 558)
For AIC Provisioning, OpenText Professional Services collaborates with an 
OpenText AIC integrator to create a legal profile form (Community Administrator 
permissions are required). The form consists of a name, a description, and the 
required AIC custom fields for a specific country and/or business units. The custom 
fields are those that can be accepted and used by the AIC API. After a legal profile 
form is created and published, the form can be used by a TP to create their legal 
profile as part of their AIC service (see “Creating a Legal Profile Form with AIC 
Custom Field Groups” on page 541 and “Publishing a Legal Profile Form” on 
page 558).

Trading Partner (Spoke) Requirements
From a Trading Partner or spoke perspective, TPs must meet two requirements 
before using the Active Invoice with Compliance (AIC) service. Trading partners 
must complete the registration process, and they must create and submit a legal 
profile as part of their AIC subscription.
Note: If the hub designed its registration process to collect legal profile 
information at the same time it collects company information, a trading partner 
does not need to create a legal profile manually.
For manual creation, the trading partner creates a legal profile by selecting the 
appropriate legal profile form for the country of interest, completes the required 
AIC custom fields, and submits the form to AIC (see “Submitting a Legal Profile” on 
page 560). The legal profile becomes a permanent part of the TP’s record. The TP 
can now use their AIC subscription.

AIC Provisioning - Legal Profile Forms
The AIC Provisioning process includes creating a legal profile form for a TP to use 
as the basis for a legal profile. 
The form consists of the following components:
■ Name and description of the form and whether it is based on another form or is 

being created from scratch.
■ AIC custom fields groups (for example, Legal Entity, Contact, or Delivery) and 

custom fields (for example, the Legal Entity custom field group might contain 
Unique ID, Name, and State custom fields).

Topics include:
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■ “Creating a Legal Profile Form with AIC Custom Field Groups” on page 541
■ “Adding AIC Custom Fields to a Legal Profile Form” on page 543

Creating a Legal Profile Form with AIC Custom Field Groups
Use this procedure to create a legal profile form and add AIC custom field groups 
to it.
Security role: Community Administrator

To create a legal profile form and add AIC custom field groups
1 Click Admin > Legal Profile tab. 

The Provisioning Configuration page opens.

2 Click Create Legal Profile Form.
The Create Legal Profile Form page opens.

3 Specify the following:
■ Choose whether to create a form from scratch or use an existing legal 

profile form as the basis for a new form. Do one of the following:
■ To create a new form from scratch, leave the default None in the drop-

down list.
■ To use an existing legal profile form as the basis for a new form, select 

the form you want to copy from the drop-down list.
■ Legal Profile Form Name—Required. Type the name by which you want to 

identify the legal profile form.
■ Description—Type a description of the form.
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4 Click Save. 
The AIC Provisioning page opens. 

Any AIC custom field groups that have been defined display as tabs. When a 
tab is selected, AIC custom fields that have been defined for the group display.

5 Click Add Custom Field Group. 
The New Custom Field Group section opens. You are replacing the “New 
Custom Field Group” name in step 7. 

6 Click Edit Group.
The Editing Custom Field Group section opens. 

7 In Name, type over “New Custom Field Group” and give the group a name, 
such as “Legal Entity” or “Delivery.”

8 In Description, type a general description of the custom group, such as the 
nature of the custom fields it contains.
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9 Select the appropriate check boxes at the bottom of the page to perform the 
actions described in the following table:

10 Click Done. 
You have created an AIC custom field group. At the top of the page, the name 
of the group refreshes with the name you typed in step 7.

11 Repeat steps 5-10 to add more AIC custom field groups.
12 To add AIC custom fields to the AIC custom field groups, go to step 4 in 

“Adding AIC Custom Fields to a Legal Profile Form” on page 543.

Adding AIC Custom Fields to a Legal Profile Form
Security role: Community Administrator
Use this procedure to add AIC custom fields to an AIC custom field group. Before 
you begin, be sure the AIC custom field group to which you want to add the 
custom fields has been created (see step 5 “Creating a Legal Profile Form with AIC 
Custom Field Groups” on page 541).
As part of this procedure, you are:
■ Selecting the options you want to apply to the custom field, and
■ Entering instructions to help users understand what to enter in the custom field. 

To add AIC custom fields to an AIC custom field group
1 Click Admin > Legal Profile tab. 

If you want custom fields in 
the group to... Do this:
Display as columns in a table ■ Select the “Display this Group as a table” check 

box (see “Creating AIC Custom Fields in Data 
Tables” on page 550).

Be conditional based on the 
answer to another custom field

■ Select the “Make Dependent on Another 
Custom Field (Optional)” check box (see 
“Creating Dependent AIC Custom Fields” on 
page 548).
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The Provisioning Configuration page opens.

2 Search for the legal profile form to which you want to add AIC custom fields.
3 Click Edit for the legal profile form.

The AIC Provisioning page opens.

Any AIC custom field groups that have been defined display as tabs. When a 
tab is selected, AIC custom fields that have been defined for the group display.

4 Select the tab for the AIC custom field group to which you want to add AIC 
custom fields.

5 Click Insert Custom Field Here. 
The Editing New Custom Field section opens at the selected location in the AIC 
custom field group.
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6 From the drop-down list, select the AIC custom field you want to add.
Note: Each AIC custom field can be added only once. Once the field is used, 
it is unavailable.

7 Click Next.
The AIC custom field displays in the text box.

Note: If needed, use the formatting icons to emphasize any text in the 
custom field, such as making a word bold or changing the font.

8 In Instructions, type the help text for the custom field. The text displays when 
contacts click the help icon for the custom field.
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9 Select options that you want to apply to the AIC custom field.
Important: Based on your selection, additional fields might display. The 
additional fields let you refine the custom field further.

10 Click Done.
You have added an AIC custom field to an AIC custom field group. 
Note: If an AIC custom field is required, an asterisk displays for the field. If 
an AIC custom field is dependent on another AIC custom field or is mandatory 
based on another AIC custom field, the details are displayed.

Option Description
Require Answer to Custom Field (Optional) Make the custom field mandatory.

Note: Selecting this option displays another option, “Mandatory 
based on.” This option is not applicable at this time.

Add Validation Rule (Optional) Specify a condition such as: 
■ Only Allow Numeric Values
■ Min Length” and “Max Length

If the same number is entered in both the Min Length and 
Max Length fields, the Append Leading Zeroes field displays.
Select this if you want zeroes to be appended in front of the 
entered data. 
For example, if the value in the min/max length is 8 and a 
custom field is answered as 123456, Active Community adds 
two zeroes in front of the answer so the total number of 
characters equals the min/max length (in this example, 
00123456). 
The Append Leading Zeroes check box can be used with or 
without the Only Allow Numeric Values check box; that is, you 
can append zeroes to both numeric and alphanumeric values.

Make Dependent on Another Custom Field (Optional) Make an AIC custom field conditional based on the answer to 
another AIC custom field. The other AIC custom field must have 
already been defined (see “Creating Dependent AIC Custom 
Fields” on page 548).

Set Default Answer (Optional) Type the default answer.
Selecting the check box displays an additional field that allows you 
to make the AIC custom field read-only.
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AIC Provisioning - Working with AIC Custom Fields
These topics describe how to tailor AIC custom field groups and AIC custom fields 
to meet your needs.
Topics include:
■ “Finding AIC Custom Field Groups” on page 547
■ “Creating Dependent AIC Custom Fields” on page 548
■ “Creating AIC Custom Fields in Data Tables” on page 550
■ “Re-Sequencing AIC Custom Field Group Tabs” on page 552
■ “Adding Instruction Text” on page 553
■ “Creating Help Icon Text” on page 553
■ “Deleting an AIC Custom Field Group” on page 554
■ “Deleting an AIC Custom Field” on page 555

Finding AIC Custom Field Groups
Use this procedure to search for and find AIC custom field groups so you can work 
with the AIC custom fields they contain.

To search for AIC custom field groups
1 Click Admin > Legal Profile tab. 

The Provisioning Configuration page opens.

2 Search for the legal profile form whose AIC custom field groups you want to 
work with.

3 Click Edit for the legal profile form.
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The AIC Provisioning page opens.

Any AIC custom field groups that have been defined display as tabs. 
4 In Search Group, start typing the name of the group you want to find.

The auto-fill feature lists the groups based on the letters you type.
5 Select the group you want to work with.

The AIC custom fields in the group display.

Creating Dependent AIC Custom Fields
Use this procedure to hide or display an AIC custom field group based on a 
contact’s answer to another AIC custom field. 
Dependent custom fields are defined when creating or editing an AIC custom field 
group.

To create an AIC custom field group that is dependent on an answer 
to another AIC custom field
1 Click Admin > Legal Profile tab. 

The Provisioning Configuration page opens.

2 Search for the legal profile form whose AIC custom field groups you want to 
work with.

3 Click Edit for the legal profile form.
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The AIC Provisioning page opens.

4 Do one of the following:
■ If you are adding a new AIC custom field group, click Add Custom Field 

Group. The New Custom Field Group section opens.
■ If you are editing an existing AIC custom field group, click the name of the 

group you want to edit. The Custom Field Group section for the AIC custom 
field group you selected opens. 

5 Click Edit Group.
The Editing Custom Field Group section opens. 

6 At the bottom of the page, select the “Make Dependent on Another Custom 
Field (Optional)” check box.
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Additional fields display.

7 In Custom Field Name, select the name of the AIC custom field on which you 
want this AIC custom field to depend, such as Reprocess of Others.

8 In Answer, select the answer on which you want this custom field to depend, 
such as True. 

9 Select the OR or AND button if you want to make the custom field dependent 
on one or more custom fields.
Note: If AND is selected and two options are highlighted, then both options 
must be selected for the dependent field to display.

10 Click Done.
Text that describes the dependency displays under the custom field group.

In the example, Active Community displays this AIC custom field group in a 
profile only if the answer to the Reprocess of Others custom field is True.

Creating AIC Custom Fields in Data Tables
To allow contacts to provide more than one answer to a custom field, most custom 
fields can be displayed as headings in a table. Each column heading in the table is 
a custom field.
Use this procedure to display all AIC custom fields in an AIC custom field group as 
column headings in a table.
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When adding AIC custom fields to the group, create one AIC custom field for each 
column you want to display in the table. Each column heading is an AIC custom 
field. 
Note: Data table custom fields are defined when creating an AIC custom field 
group. They cannot be defined when editing a group.

To create AIC custom fields in a data table
1 Click Admin > Legal Profile tab. 

The Provisioning Configuration page opens.

2 Search for the legal profile form whose AIC custom field groups you want to 
work with.

3 Click Edit for the legal profile form.
The AIC Provisioning page opens.

4 Click Add Custom Field Group. 
The New Custom Field Group section opens. You are replacing the “New 
Custom Field Group” name in step 7. 

5 Click Edit Group.
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The Editing Custom Field Group section opens. 

6 In Name, type over “New Custom Field Group” and give the group a name, 
such as “Legal Entity” or “Delivery.”

7 In Description, type a general description of the custom group, such as the 
nature of the custom fields it contains.

8 At the bottom of the page, select the “Display this Group as a table” check box. 

9 When adding AIC custom fields to the group, create one AIC custom field for 
each column you want to display in the table. 

10 Select the format that is appropriate for the column. 
Important: You add custom fields in data tables as described in “Adding AIC 
Custom Fields to a Legal Profile Form” on page 543. The table doesn’t display 
until contacts edit their profiles.

11 Define the custom field, then click Done.

Re-Sequencing AIC Custom Field Group Tabs
Use this procedure to change the display order of AIC custom field group tabs.

To change the sequence of AIC custom field group tabs
1 Click Admin > Legal Profile tab. 

The Provisioning Configuration page opens.
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2 Search for the legal profile form whose AIC custom field groups you want to 
work with.

3 Click Edit for the legal profile form.
The AIC Provisioning page opens.

4 Select the tab for the custom field group you want to re-sequence.
5 Click Move Up or Move Down to re-sequence the order in which the tab 

displays on this page and in the legal profile form. 

The tab order changes.
6 Click Done.

Adding Instruction Text
To add instruction text to a custom field
■ When defining an AIC custom field, use the Insert Text Here link to type any 

special instructions, such as descriptions, titles, or general information. 

The text displays in the body of the custom field.

Creating Help Icon Text
To add help icon text to an AIC custom field
■ When defining an AIC custom field, use the Instruction field to type help text for 

the custom field. 
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The text displays when the contact clicks the help icon for the custom field.

Deleting an AIC Custom Field Group
Use this procedure to delete AIC custom field groups, which deletes all AIC custom 
field in the group.
Note: You cannot delete AIC custom field groups or AIC custom fields that are 
dependent on other AIC groups or AIC custom fields. You must delete the 
dependent group or custom field before you can delete the AIC custom field group. 

To delete an AIC custom field group
1 Click Admin > Legal Profile tab. 

The Provisioning Configuration page opens.

2 Search for the legal profile form whose AIC custom field groups you want to 
work with.

3 Click Edit for the legal profile form.
The AIC Provisioning page opens.

4 Select the AIC custom field group you want to delete.
5 Click Delete.
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The group, and all custom fields in it, are deleted.

Deleting an AIC Custom Field
Use this procedure to delete AIC custom fields in an AIC custom field group.
Note: You cannot AIC delete custom field groups or AIC custom fields that are 
dependent on other AIC groups or AIC custom fields. Before starting this 
procedure, you must either:

■ Delete the dependent AIC custom field, or
■ Edit the AIC custom field group or AIC custom field and clear the “Make 

Dependent on Another Custom Field (Optional)” check box.

To delete an AIC custom field
1 Click Admin > Legal Profile tab. 

The Provisioning Configuration page opens.

2 Search for the legal profile form whose AIC custom field you want to delete.
3 Click Edit for the legal profile form.

The AIC Provisioning page opens.

4 Select the AIC custom field group that contains the AIC custom field you want 
to delete.
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5 Click Delete.

The AIC custom field is deleted from the group.

AIC Provisioning - Working with Legal Profile Forms
After a legal profile form has been created, you can edit, delete, publish, and 
unpublish the form.
Topics include:
■ “Editing a Legal Profile Form” on page 556
■ “Editing a Legal Profile Form Name or Description” on page 557
■ “Deleting a Legal Profile Form” on page 558
■ “Publishing a Legal Profile Form” on page 558
■ “Unpublishing a Legal Profile Form” on page 559

Editing a Legal Profile Form
Security role: Community Administrator

To edit a legal profile form
1 Click Admin > Legal Profile tab. 

The Provisioning Configuration page opens.

2 Click Edit for the legal profile form you want to edit.
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The AIC Provisioning page opens.

3 Edit the fields. See “Creating a Legal Profile Form with AIC Custom Field 
Groups” on page 541 for field descriptions.

4 Click Save.
5 The legal profile form is saved. A success message displays.
6 To edit legal profile form information such as the form name or description, see 

“Editing a Legal Profile Form Name or Description” on page 557.

Editing a Legal Profile Form Name or Description
Security role: Community Administrator

To edit a legal profile form name or description
1 Click Admin > Legal Profile tab. 

The Provisioning Configuration page opens.

2 Click Edit for the legal profile form you want to edit.
The Edit Legal Profile Form page opens.

3 Click Edit Form Information.
The AIC Provisioning page opens.

4 Edit the legal profile form name or description.
5 Click Done.
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Deleting a Legal Profile Form
Security role: Community Administrator

To delete a legal profile form
1 Click Admin > Legal Profile tab. 

The Provisioning Configuration page opens.

2 Click Delete for the form you want to delete.
A dialog box asks you to confirm that you want to delete the form.

3 Click OK.
The form is deleted.

Publishing a Legal Profile Form
Security role: Community Administrator

To publish a legal profile form
1 Click Admin > Legal Profile tab. 

The Provisioning Configuration page opens.

2 Search for the form you want to publish.
3 Click Publish. 

The legal profile form is published and can be used in an AIC subscription.
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Unpublishing a Legal Profile Form
Security role: Community Administrator
1 Click Admin > Legal Profile tab. 

The Provisioning Configuration page opens.

2 Search for the form you want to unpublish.
3 Click Unpublish. 

The legal profile form is unpublished and no longer available for use in an AIC 
subscription.

AIC Subscriptions - Legal Profiles for Trading Partners
From a Trading Partner or spoke perspective, TPs must meet two requirements 
before using the Active Invoice with Compliance (AIC) service. Trading partners 
must complete the registration process, and they must create and submit a legal 
profile to AIC as part of their AIC subscription.
Note: If the hub designed its registration process to collect legal profile 
information at the same time it collects company information, a trading partner 
does not need to create a legal profile manually.
For manual creation, the trading partner creates a legal profile by selecting the 
appropriate legal profile form for the country of interest, completes the required 
AIC custom fields, and submits the form to AIC. The legal profile becomes a 
permanent part of the TP’s record, and the TP can use their AIC subscription.
Topics include:
■ “Submitting a Legal Profile” on page 560
■ “Editing a Legal Profile” on page 561
■ “Viewing a Legal Profile” on page 563
■ “Deleting a Legal Profile” on page 563
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Submitting a Legal Profile
Security role: My Company Permissions > Edit My Company
If information about a legal profile was not collected as part of the registration 
process, a trading partner (TP) must create a legal profile for their company and 
submit it to AIC.

To create a legal profile
1 Click My Company > Legal Profile tab.

The Current Subscription list for your company displays.

2 Click Add Legal Profile.
The Creating Legal Profile page opens.

3 From the drop-down list, select the legal profile form you want to use to create 
the legal profile.

Note: Only legal profile forms that were created and published through 
Provisioning (Admin > Legal Profile tab) display in the list. See “Creating a 
Legal Profile Form with AIC Custom Field Groups” on page 541 and “Publishing 
a Legal Profile Form” on page 558).

4 Click Next.
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The Legal Profile Form page opens.

5 Answer the questions displayed in the form.
6 Do one of the following:

■ Click Save to save your responses, but not submit the legal form to AIC. 
You can return at another time to complete the form or change your 
responses.

■ Click Submit to AIC to send your completed form to AIC for subscription 
to the AIC application service. 

Note: Once a legal profile has been submitted to AIC, it can only be 
viewed. It cannot be edited or deleted.

■ Click Cancel to discard your changes and return to the Current 
Subscription list page.

Editing a Legal Profile
Security role: My Company Permissions > Edit My Company
A trading partner (TP) can edit a legal profile for their company.
Use this procedure if a legal profile was created as part of the registration process 
and it has a Saved status on the My Company > Legal Profile tab. Follow this 
procedure to modify the information on the form, and click Submit to AIC. The 
form’s status changes from Saved to Created.

To edit a legal profile
1 Click My Company > Legal Profile tab.
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The Current Subscription list for your company displays.:

2 Do one of the following:
■ Click the name of the legal profile you want to edit.
■ Find the legal profile you want to edit and in the Actions column, click Edit 

for that profile.
The Legal Profile Form for the profile opens.

3 Modify the fields as needed. 
4 Do one of the following:

■ Click Save to save your responses, but not submit the form to AIC. You 
can return at another time to complete the form or change your responses.

■ Click Submit to AIC to send your completed form to AIC for subscription 
to the AIC application service.

Note: Once a legal profile has been submitted to AIC, it can only be 
viewed. It cannot be edited or deleted.

■ Click Cancel to discard your changes and return to the Current 
Subscription list page.
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Viewing a Legal Profile
Security role: My Company Permissions > Edit My Company
A trading partner (TP) can view a legal profile for their company.

To view a legal profile
1 Click My Company > Legal Profile tab.

The Current Subscription list for your company displays.:

2 Find the legal profile you want to view and in the Actions column, click View 
for that profile.
The Legal Profile Form for the profile opens.

Deleting a Legal Profile
Security role: My Company Permissions > Edit My Company
A trading partner (TP) can delete a legal profile for their company.

To delete a legal profile
1 Click My Company > Legal Profile tab.
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The Current Subscription list for your company displays.

2 Find the legal profile you want to delete and in the Actions column, click 
Delete for that profile.
A message asks you to confirm that you want to delete the profile.

3 Click OK.
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Item Management 16
This section describes Item Management, which allows you to monitor trading 
partner performance and risk by tracking product or part-level information. 
An item represents the product or custom information about a product in an Active 
Community community. Depending on your user permissions, you can add or 
search items in a community. 
All items including the product unique identifier and name are associated with a 
company in Active Community.

Topics include:
■ “Adding Items Manually” on page 565
■ “Importing Items” on page 566
■ “Importing a Data File” on page 568
■ “Deleting Items” on page 571
■ “Exporting Items” on page 571

Adding Items Manually
Depending on your user permissions, you can add items to your community. To do 
this, you can either import them automatically (see “Importing Items” on 
page 566) or add them manually using the pages. 
The following procedure describes how to add items manually.
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When you add items to a community, you must associate them with a company 
that already exists in Active Community. If the company does not exist yet, add the 
company first, and then add the item. An item added to a company is automatically 
viewable to users with view items access. For details, see “Editing Permissions for 
Community Security Roles” on page 56. 

To add an item
1 Click Profiles > Companies, and click the profile of the company to which the 

item will belong.
2 Select the Items tab, click the Manage Items link, and then select Add Item 

from the drop-down list.

3 On the New Item page, provide the item Name and any other required fields. 
All required fields are denoted by an asterisk.
Note: Active Community automatically generates the unique identifier for 
each new item added to the community.

4 Click Save. 
The item is added and automatically returns you to the Items tab for that 
company.

Importing Items
Depending on your user permissions, you can import new items into your 
community. 
During the importing process, you will be prompted to map each column from your 
data file to a field that exists in your community profiles. This can be a standard 
profile field (such as Item Name) or one specific to your community (such as 
Product Weight). After mapping your data, Active Community provides you a 
preview of the Item data to be imported to prevent you from importing incomplete 
or incorrect information. 
OpenText recommends that you import companies first into your community. This 
allows you to easily import items into existing companies.
Topics include:
■ “Data File Requirements” on page 567
■ “Data File Details” on page 568
■ “Importing a Data File” on page 568
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Data File Requirements
■ The file to be imported must be in comma delimited format and must have a 

filename extension of .csv. For example, ContactData.csv.
Note: In Excel, you can save a file in CSV format by clicking File > Save As 
and choosing CSV (Comma delimited) in the Save as type box.

■ If you have more than 1000 items to import, it is recommended that you create 
separate CSV files containing a maximum of 1000 records each to improve 
import performance. For example, if you have 7000 items to import, you should 
arrange the data in 7 CSV files containing 1000 items each.

■ The first row of the file must contain the column headings. For example, Item 
Name, Product Description, CompanyID, Quantity. The data values to be 
imported must start in the second row of the file. For example, Tissues, Soft 2-
Ply Tissues, Acme, 20.

■ Your file must not contain the # (pound) character, the : (colon) character, or 
paragraph returns (line breaks). These characters will cause errors during the 
importing process.

■ If you have date fields in your file, they must be formatted as follows: 
MM/DD/YYYY. For example, January 7, 2009 should be entered as 01/07/2009. If 
you do not format dates correctly, it will cause errors during the importing 
process.

■ Blank rows between data rows in the file should be eliminated before importing.
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Data File Details
If you are 
importing... Then you must...
Items

Custom Field Values

Importing a Data File
Important: Before importing a data file, be sure it meets the requirements 
outlined in “Data File Requirements” on page 567 and “Data File Details” on 
page 568.

To import a data file
1 Click Profiles > Companies, and click the profile of the company to which the 

item will belong.
2 Select the Items tab, and click the Manage Items link, and then select the 

Import Items option.
Note: You must ensure that each item in the file has a corresponding 
Company ID that already exists in Active Community. If the company does not 
exist in Active Community, you must import or manually create the company 
first, then import items.

■ Have at a minimum these fields in your data file: Item Name 
and CompanyID. These fields cannot be blank.

■ Have a Company ID value that matches a company in your 
community for each item in your file. If the Company ID does 
not exist in your community, you must import or create the 
company first, then import items. 
Note: If you are importing from a company profile directory 
rather than the Items list page, a companyID is NOT 
required. 

■ Create custom fields (for example, Material, Quality Testing) 
in items in your community before importing. For example, if 
you have a column in your import file called “Material” 
containing an item's material content, “Material” should be 
defined as a custom field in item profiles. In addition, custom 
field values are case-sensitive; that is, any values in your 
import file must exactly match those allowed your profiles. 

■ Separate multiple-choice answers with a single comma. In 
addition, you must use the multiple-choice Identifier for the 
values, not the Label. For an example, see importing 
multiple-choice custom fields in “Custom Field Requirements 
for Importing Data” on page 133.

■ Include columns for any required custom fields, and make 
sure that they are not blank. If they are missing, your data 
will not be imported. 
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3 On the Upload the File page, click Browse to specify the file to be imported.

4 Click Next.
The Map the Fields page opens.

5 Use the drop-down lists to map the fields in Active Community that correspond 
to the fields in the file to be imported. 
When importing items, you MUST specify a column that contains the Company 
ID (if importing from the Items list page). Keep in mind that the Active 
Community field you map to must match the data format of the imported 
column. For example, you should not map a Product Code (letters and 
numbers) to a Shipped Date (DD/MM/YYYY). 
If a field is not included in the .csv file, select IGNORE for that field. 
Note: If you do not have the security role of Community Administrator, 
custom fields contained in tabs to which you do not have View and Edit 
Question Group permissions are not available for mapping. For details, see 
“Editing Permissions for Community Security Roles” on page 56.

6 Click Next.
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The Preview Import page opens.

The first valid row of your file is shown with the Active Community fields that 
you mapped. (If you are importing data into tables, this does not display.)
If you have item information in your file that will overwrite an existing profile, 
the Before and After columns show how the profile will be changed after you 
import your file. 

7 Click Next.
The Import Queue page opens,

A message confirms that your import file has been added to the queue for 
processing.
You can continue to navigate to other parts of Active Community while the 
import file is processed. To do this, click the Go to Items link or one of the 
main menu options.
Once the file been processed, you will receive an email notification detailing the 
number of rows that have been successfully or unsuccessfully imported. For 
those rows that could not be imported due to validation errors, a link to the 
Download Reject CSV file is also provided.

8 To troubleshoot errors, click Download Reject CSV File and examine the 
Error Messages column for hints on fixing the invalid data. See the format 
requirements in “Data File Requirements” on page 567.

9 Go to the Items page to view your imported data.
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Deleting Items
Depending on your user permissions, you can delete items from your community. 
To do so you must know to which company the item record is related.

To delete an item 
1 Click Profiles > Companies, and click the profile of the company to which the 

item will belong.
1 Select the Items tab.
2 On the profile, click the ItemID of the item you would like to delete.
3 Select the Delete link.

4 Click DELETE to confirm deletion.

Exporting Items
You can export items from a community to a Microsoft® Excel file. 
■ The first row of the file contains the column headings that correspond to the 

fields that were exported; for example, Item Name, Product Description, 
CompanyID, Quantity. 

■ The second row and beyond contains the data for example, Tissues, Soft 2-Ply 
Tissues, Acme, 20.

All item fields are exported (including custom fields, even if there are no values in 
them). 
Important: If the user does not have the View Items permission, items cannot 
be exported for that user.

To export items to an Excel (XLS) file
1 Click Profiles > Companies or Contacts, and click the profile of the 

company or contact to which the item belongs.
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2 Select the Items tab, and display the list of results that you want to export.
Note: When you first display the Items page, all companies or contacts are 
listed. You can narrow that list by using Search to display a subset of 
companies or contacts. 

3 Click the Manage Items link, and select Export Items.
A dialog box opens prompting you to open or save the file. If you click Save 
File, you can customize the name of the file and select a destination on your 
hard disk. 

4 When you open the file in Excel, you should see all profile fields, including 
custom fields (regardless of whether they have values in them).
Note: If you do not have View Item permission you cannot export item 
information.
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Frequently Asked Questions17
This section explains some of the frequently asked questions (FAQs) about Active 
Community. It contains the following topics:
■ “Profiles” on page 573
■ “Projects” on page 574
■ “Activities” on page 574
■ “Custom Fields” on page 576
■ “Data Tables” on page 577
■ “Web Forms” on page 578
■ “Roles and Permissions” on page 579

Profiles
■ “What is a profile?” on page 573
■ “What are the sections of a profile?” on page 573
■ “Why is my profile photo distorted?” on page 573

What is a profile?
A profile represents you, another person, or a company in an Active Community 
community. It contains contact information, a photo, and any community-specific 
information in custom fields. For a profile to be considered 100% complete, most 
fields need to be filled in.

What are the sections of a profile?
The profile is divided into two main sections: core fields and custom fields (or 
credentials). Core fields include name, address, phone, and other contact 
information. The second section of the profile contains custom fields. You can 
customize the custom fields section according to the information you want to 
collect from your partners.

Why is my profile photo distorted?
If the profile photo you uploaded is larger than the recommended image size of 
114 pixels wide by 152 pixels high, it may be distorted. If your photo is wider than 
114 pixels, the width will be resized and scaled down. If your photo is more than 
152 pixels high, it may appear cropped at the bottom.
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Projects
■ “What are projects?” on page 574
■ “Why should I create a project?” on page 574

What are projects?
A project is a workspace to help you organize and track activities, files, web forms, 
and other items to be completed. Whenever you create an item (such as a 
message or web form), it is archived in the project.
There are two types of projects: regular and activity managed. 
■ Regular projects can be used for ongoing projects, such as updating your 

community directory. 
■ Activity managed projects are ideal for campaigns that have fixed start and end 

dates, and have steps to be completed in order. You can assign due dates to 
each step, so that if one step is incomplete, the remaining steps won't start. For 
details on activity managed projects, see “Activity Managed Projects” on 
page 277.

Why should I create a project?
A project is necessary to communicate or collaborate with your business contacts, 
partners, vendors, or suppliers. Each project contains activities which represent an 
action or step to be performed. For example, one activity might be to send a 
satisfaction survey to a specific group of your suppliers. Another activity might be 
to inform all of your trading partners about new policy changes. Depending on 
your user permissions, you may not be able to create a project directly; you may 
need to contact your Community Administrator to do so.

Activities
■ “What is an Activity?” on page 574
■ “What do I need before I create an activity?” on page 575
■ “What happens after I start an activity?” on page 575
■ “What is activity management?” on page 575
■ “How do I turn on activity management?” on page 575

What is an Activity?
An activity is any item that can be completed within a project. For example: 

Key Description
1 Project
2 Activity Managed Project

1

2



F RE Q U EN T L Y  A S K E D  Q U E S T I O N S
Activities

OpenText Active Community CE 21.2 User Guide  575

1 7

■ Send a survey to suppliers
■ Issue a letter to the entire community
■ Update a business contact's profile
An activity can be assigned to one or more contacts in your community. 

What do I need before I create an activity?
Before creating an activity, you must create a project. In addition, it is 
recommended that you create any web forms needed prior to creating an activity. 
This will improve activity creation. 
Example: Suppose you want to send a survey to a set of suppliers. After creating 
a project, you do the following:
■ Create a web form that contains the survey questions and possible answers
■ Create an activity and link it to the web form
■ Add suppliers as participants in the activity

What happens after I start an activity?
After starting an activity, communications are sent to the activity participants (the 
trading partners you selected to receive the survey or email message). For 
example, if you created an activity to send an email reminder to all participants to 
update their profile, the email is sent when you click Start on the activity in a 
regular project. (In an activity managed project, the activity is started when the 
project is started, or when the previous activity is complete.)
After an activity is started, you can add but not remove participants from it. 

What is activity management?
Activity management describes projects that contain activities with due dates and 
dependencies. These projects also have start and end dates. By enabling activity 
management for a project, you can:
■ Schedule a project to automatically start in the future
■ Have an activity automatically start after another activity is completed
■ Automatically send activity reminder email messages to participants 
Activity managed projects are identified by their icon in the project summary list. 

1

2

Key Description
1 Project
2 Activity Managed Project

How do I turn on activity management?
To use activity management, all you need to do is to check the Enable Activity 
Management check box when you create a project. After you do this, you can add 
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activities and set their due dates, dependencies, and reminder notifications. For 
details, see “Creating a Regular or Activity Managed Project” on page 287, “Adding 
an Activity to a Project” on page 290, and “Customizing Upcoming and Overdue 
Reminder Messages” on page 315.
Below is an example of an activity managed project with three activities. Note that 
Activity A (Send Email to Suppliers) is in progress; Activity B (Suppliers 
Acknowledge Email) will not begin until Activity A is complete.

Custom Fields
■ “What are custom fields?” on page 576
■ “When do I use a custom field?” on page 576
■ “Who can see and edit custom fields?” on page 576
■ “What is the difference between a custom field and a tag?” on page 576
■ “How do I get custom field values into Active Community?” on page 577
■ “How do I ensure my partners keep custom field data up-to-date?” on page 577

What are custom fields?
A custom field is a question or input field that allows you to gather and retain key 
information about your trading partners, customers, sales reps, or other contacts 
in your community. Custom fields are located on your partner's profile. 

When do I use a custom field?
Use a custom field to expand and tailor the information contained in the company 
and contact profiles in your community, thereby adding value and increasing 
usability. 

Who can see and edit custom fields?
Each custom field group has its own view and edit permissions. If you are a 
Community Administrator, you can control which community members can see 
particular custom field groups. If you have Active Community Registration enabled, 
any custom fields you create can display in your company registrations. 

What is the difference between a custom field and a tag?
Tags are intended for ad hoc grouping of companies or contacts by any user in 
your community. A tag is comprised of a single keyword or phrase and does not 
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contain detailed information. Tags are often used during the process of searching 
for a set of profiles in a community. 
Custom fields are more structured than tags, as they collect detailed information 
about your trading partners (including documents and images). In addition, only 
Community Administrators can (usually) create and modify custom fields.

How do I get custom field values into Active Community?
After creating a custom field, you need to complete it with information from your 
community. There are several ways you can do this:
■ Copy the custom field to a web form, then issue the web form as a survey. For 

details, see “Creating a Web Form for Inside Your Community” on page 355. 
■ Send an email message to your community, prompting them to update their 

profiles. For details, see “Adding an Activity to a Project” on page 290. 
■ Import custom field values from a text file. For details, see “Adding Custom Field 

Groups” on page 240. 
■ If you have Registration enabled, you can collect information for any custom field 

in your community via a Registration approval process. After final approval, 
Company will be created with collected values for the custom field.

How do I ensure my partners keep custom field data up-to-
date?

The easiest way is to have automatic email reminders sent to your partners when 
their contact or company profile becomes stale. For details, see “Setting Time 
Intervals for Profile Reminder Emails” on page 45.

Data Tables
■ “What is a data table?” on page 577
■ “How do I create a data table?” on page 577
■ “How do I add custom fields to a data table?” on page 578
■ “How do I fill in a data table?” on page 578

What is a data table?
A data table is one where all custom fields in the group are organized into a data 
table or grid. A data table allows for multiple answers to each question, and 
enables sharing of data. 

How do I create a data table?
To create a data table, you select the Display this group as a table option when 
creating the group. For example, you might have a data table called “Company 
Ownership” which will contain custom fields that indicate the company owners and 
their percentage of ownership in the business.
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How do I add custom fields to a data table?
After you create the group, you add custom fields that correspond to each column 
in the grid. For example, you might have custom fields to contain the names of the 
company owners, their citizenship, and their percentage of ownership in the 
company.“Custom Field Requirements for Data Tables” on page 134

How do I fill in a data table?
Working with a data table is similar to working with a spreadsheet in Microsoft 
Excel: there are rows, resizeable columns, and column headings. To fill in data, 
click Add Row and click on a cell in the table. Clicking the cell makes it editable. 
As you input data, you can press the TAB key to move from one cell to the next. 

Web Forms
■ “What is a web form?” on page 578
■ “How is a web form used?” on page 578
■ “How do I collect company-level responses?” on page 579
■ “Can my business contacts respond anonymously?” on page 579
■ “What is a public web form?” on page 579
■ “Why should I use a public web form?” on page 579
■ “How do I create a public web form?” on page 579

What is a web form?
A web form is an electronic form that allows you to gather or survey information 
about the trading partners, customers, sales reps, or other contacts in your 
community. The web form's questions and input fields can include text boxes, data 
tables, lists, buttons, and check boxes.

How is a web form used?
You can use a web form to quickly and conveniently prompt your business 
contacts, trading partners, suppliers, and other community members for 
information. For example, you can create a survey to issue to suppliers to ask 
whether they are compliant with an industry standard. Or, you can create a form to 
issue to trading partners to prompt for company information such as average sales 
volume and inventory.
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How do I collect company-level responses?
To collect company responses (instead of individual contact responses) to a survey, 
you can set a Complete by Company option in the activity.

Can my business contacts respond anonymously?
Yes. You can set the web form to Community (with anonymous responses) or 
Public which means that the First Name, Last Name, Company Name, and 
Company ID of the contact will not display in your web form results. Only the 
answers to questions will be shown.

What is a public web form?
A public web form is a form that can be sent to contacts outside the Active 
Community community. These contacts access the web form via a link (URL) which 
allows them to complete the web form without having to be part of the Active 
Community community. After they submit the web form, the results are recorded in 
Active Community as anonymous responses.

Why should I use a public web form?
You may want to use a public web form when you want to gather information 
about contacts that are not yet part of your Active Community community. For 
example, suppose you conducted a national sales meeting and you want to send a 
survey to registrants that are not yet part of your Active Community community. 
Later, you can easily add these people to your community by “Importing 
Companies and Contacts Using CSV Files” on page 128.

How do I create a public web form?
To create a public web form, you select the Public option when creating the form. 
Since respondents are unknown, you cannot add profile custom fields to be part of 
the form. After you save the public form, keep in mind that you cannot go back 
and make it accessible by contacts in Active Community unless:
■ You have not published it, and
■ You do not have any test responses 

After you create the form, all you need to distribute to your contacts is the URL of 
the public web form. You do not need to link the form to a project activity.

Roles and Permissions
■ “What is a role?” on page 580
■ “What is a permission?” on page 580
■ “What is a security role?” on page 580
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■ “How do I get a security role?” on page 580
■ “How do I change permissions for a security role?” on page 581

What is a role?
In Active Community, you can control user access through the use of security roles 
and permissions. As a Community Administrator, you can grant or deny access to 
all areas of Active Community, including contacts, companies, projects, and custom 
fields. You cannot grant or deny access to an individual user; you must control 
access via the user's role.
Note: A role is a set of permissions that control the actions the contact can 
perform in the Community and projects. For example, a Contact with a role of 
Project Administrator can add a new Project.

What is a permission?
A permission is a right that controls access to functionality in Active Community. In 
other words, it controls whether a user has the right to perform a specific action. 
For example, the right to edit a company profile, add an activity to a project, or 
view a custom field. 
A group of permissions comprise a security role.

What is a security role?
A security role consists of a set of permissions that control the amount of access 
the user has in the community. For example, a contact with a security role of 
Project Administrator can add a new project, import companies, and view custom 
fields. 

Key Description
1 Security Roles
2 Permissions

How do I get a security role?
Every Active Community user has a security role. The default security role for all 
contacts added to a community is Everyone.
By default, only Community Administrators can change roles for a user. To do so, 
the administrator edits the user's profile in Active Community. Some roles are 
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automatically assigned by virtue of performing an action in Active Community; for 
example, you become a Project Owner upon creating a project.

How do I change permissions for a security role?
By default, only Community Administrators can edit the permissions associated 
with a security role. For details, see “Editing Permissions for Community Security 
Roles” on page 56 or “Ensuring Contacts Respond to Custom Field Questions” on 
page 271.
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Glossary

This section contains definitions of various terms used within Active Community.

A
activity—An item that can be completed within a Project. For example, send a 
survey, issue a letter, update profile, etc. An Activity can be assigned to one or 
more contacts within a company.

C
community—Group of all Contacts and Companies.
company—An organization to which Contacts belong. A Company can be a parent 
organization or a division within another Company.
contact—A person who has a profile in Active Community. A Contact is always 
associated with a Company. The actions the Contact can perform are controlled by 
their role in the system. Examples of contacts include a supplier, vendor, distributor, 
customer, or employee.
custom field—A question or indicator that categorizes Companies or Contacts.
custom field group information specific to a community that uniquely identifies or 
categorizes Companies or Contacts.

F
freshness—The update status of a profile. 

O
owner—A Contact who is responsible for maintaining the community (name, logo, 
etc).

P
permission—A right that allows a user to perform an action in Active Community. 
For example, “Manage Community.” A set of permissions comprise a Role.
profile—profile represents you, another person, or a company in an Active 
Community community. It contains contact information, a photo, and any 
community-specific information in custom fields. 
project—A workspace for organizing a set of activities, files, web forms, and other 
items to be accomplished. A Project includes a specific group of Contacts (known 
as Participants). By default, Active Community provides a basic Project containing 
all Contacts as Participants (All Your Contacts).
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Q
question—Prompts the recipient for information within a web form. Usually 
comprised of question text and possible answers with check boxes, radio buttons, 
and lists.
question group—A logical group of questions in a web form, contained in a 
separate section with a name and description.

R
role—A set of permissions that control the actions the contact can perform in the 
Community and projects. For example, a Contact with a role of Project 
Administrator can add a new Project.

T
tag—A keyword or phrase specific to a community that uniquely identifies or 
groups Companies or Contacts.
title—A named role within an Organization (VP, etc)

W
web form—An electronic form that allows a user to gather Contact and Company 
data that will be stored in Active Community. The form may consist of question 
text, boxes, lists, buttons, and other prompts for information.
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A
accessing logs for impersonation 218
activities

activating participants 312
adding to projects 290
copying 310
customizing reminders 315
overview 574
setting company responses 287
setting dependencies 297
setting due dates 297
setting notification options 297
suspending participants 312
web form email notifications 287

activity management
options 277
overview 277
setting options 287

advanced searches
about 93
creating 100
examples of 94, 97
matching conditions 93
running 100
saving 102

AIC custom field groups
deleting 554
re-sequencing tabs 552
searching 547

AIC custom fields
adding instruction text 553
adding to AIC custom field groups 543
creating data tables 550
creating dependent 548
creating help icon text 553
deleting 555
leading zeroes 546

AIC provisioning
creating a legal profile form 541
deleting a legal profile form 558
editing a legal profile form 556
editing a legal profile form name or description 557
overview 539
publishing a legal profile form 558
unpublishing a legal profile form 559
working with custom fields 547
working with legal profile forms 556

AIC subscriptions 169
deleting legal profiles 563
editing legal profiles 561
submitting legal profile to AIC 560
viewing legal profiles 563

alert conditions, examples 383

alert configurations
and activities 387
components in 381
conditions, examples 383
creating 387
deleting 400
editing 399
and user actions 382
See also alert email templates

alert email templates
activating 396
creating 396
deleting 402
editing 401
enabling for new users 399
merge fields 386, 398

alert triggers 382
alerts

web form email notifications 287
anonymous requester URL, registration 473
audit data

companies 168
contacts 169

auto-fill 10

C
change management

activating a process 414
approval/rejection of changes overview 407
approving tasks 419
claiming tasks 419
company core and company custom fields 409
creating a process 409
deleting a process 416
editing a process 415
exporting report of instances 416
overview 405
process 406
rejecting tasks 419
releasing tasks 421
tasks tab 407
viewing instance details 421

changing division tab name 152
chart data report, ageing (registration) 525
cloud support services 2
community web forms

about 348
creating 355
distributing in project activity 373

companies 113, 114
adding manually 122
audit data 168
configuring custom export 206
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creating custom export 204
creation methods 112
deleting 153
deleting custom export 210
deleting summary export 196
disabling 155
downloading a profile PDF 164
downloading profile in PDF file 164
editing 9
editing custom export 208
enabling 157
exporting information to Excel 204, 206
importing 135
importing multiple 128
registering 159
registration audit data 168
re-registering 159
running custom export 207
send for TGO provisioning 166
subscription to AIC 169
viewing summary report 182

company and contact option table 118
company ID

set custom field as 233
company profile, updating 30
conditions, in alert emails 383
contact (business) roles 75

about 53
adding custom role 75
assigning to contacts 76
deleting 80
editing role names 79
internal hub use only 75

contact profiles
changing password 37
deleting photo 36
updating 31
updating photo 36

contacts 115, 116
adding manually 124
audit data 169
configuring custom export 213
creating custom export 211
creation methods 112
deleting 153
deleting custom export 218
deleting summary export 199
disabling 155
downloading a profile PDF 165
downloading profile in PDF file 164
editing custom export 217
enabling 157, 159
exporting information to Excel 211, 213
importing 135
importing multiple 128
running custom export 215

conversations
overview 340

replying to 344
starting 342

core fields
company 26
contact 28
defining for profiles 28
in registration requests 431

CSS 2
CSV files

company requirements 130
contact requirements 131
custom field requirements 133
data table requirements 134
general requirements 128
importing 135
importing requirements for items 566

custom export
configuring companies 206
configuring contact 213
configuring registration 527
creating company 204
creating contact 204, 211
deleting company 210
deleting contact 218
editing company 208
editing contact 217
running company 207
running contact 215

custom export, registration
configuring 530
creating 528
deleting 533
editing 532
running 531

custom field groups
adding 240
data tables, about 233
data tables, creating 262
deleting 269
permissions, setting 267
reminder emails 266
re-sequencing questions 265
re-sequencing tabs 264
searching 259

custom field planning 223
custom field question formats

company link 230
date 229
date formula 231
display image 230
drop list 227
file download 229
file upload 230
list of 226
multiple points 227
number 228
number formula 231
radio button 227
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specialized 230
text 228
text area 229
text formula 231
true/false 228
true/false formula 231
using 248
yes/no 228

custom field questions
adding 243
adding choices to 248
answering 271
copying 268
copying to web forms 269
deleting 270
dependent, about 231
dependent, creating 259
Email 230
formats for 226
formulas, about 253
formulas, adding 256
help icon text 267
in data tables 262
instruction text 267
permissions, setting 267
reminder emails 266
Tax ID (EIN) 230

custom fields
about 221
adding 240
choices and values 237
configuring the language 271
contact responses to 271
copying questions 268
copying to web forms 269
defining 27, 28
deleting 269, 270
groups 224
How Do I table 238
leading zeroes 236, 247
options 235
overview 576
planning 223
questions 226
in registration requests 435
set as company ID 233
updating 271

customer support 2, 11, 12
customizing

adding logo 14
dashboard 13
footer 15

customizing a message 12

D
dashboard

customizing 13
registration 523

data masking 248
data tables

web forms overview 579
distributing web forms, see community or public web forms 
372
divisions

changing tab name 152
moving between companies 151

E
EIN (Tax ID) usage report 535
email templates

inserting old/new values 398
merge field descriptions for project activities 297

emails
configuring the language 460

events
adding 325
deleting 330
editing 328
overview 325

exporting, items 571
exports

basic company and contact 201
company custom 204
configuring company summary 192
configuring contact summary 197
contact custom 211
deleting company summary 196
registration 527
running company summary 194
running contact summary 198

F
field group, editing company 9
file library

folders 323
versions 337

files
CSV importing requirements for items 566
previous versions 337
sharing workspace 335

footer, adding hyperlink 15
form field descriptions, for email templates 459

G
global support services 11
GSS 11

H
hiding data 248
https

//www.opentext.com/patents ii

I
impersonation access logs 218
importing
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company requirements 130
contact requirements 131
contact roles 132
CSV requirements for items 566
custom field requirements 133
custom field values 257
data table requirements 134
importing CSV files 135
items 566
mass file upload requirements 170
overview of 128
registration requests 493
requirements for 128
security roles 132
zip files 170

invitation codes, TGO integrated communities 434
IP address restriction 20
item management

adding items 565
deleting items 571
importing items 566

items, exporting 571

K
keywords, see tags

L
language

changing 11
configuring custom fields 271
configuring emails 460
supported 11

leading zeroes 236, 247
legal profile for a trading partner

submitting to AIC 559
legal profile form

creating AIC 541
deleting AIC 558
editing AIC 556
editing an name or description for AIC 557
publishing AIC 558
unpublishing AIC 559

logo, adding 14

M
masking data 248
merge field descriptions, for email templates 297
merge fields

about 284
and alert email templates 386
customizing email messages 295, 317, 319, 401
inserting old/new values 398
and recipient’s profile 284

N
navigation

auto-fill 10

P
participants, suspending/activating 312
password

changing 37
resetting for first-time log in 4
resetting forgotten 4

password, forgotten 3, 4
permissions

custom fields 267
overview 580

permissions for
community security roles 57
core company fields 63
custom fields 64
project security roles 62
registration roles 89
workspace roles 86

primary contact, default tab 90, 463
private searches, about 103
profiles

about comapny profiles 26
about contact profiles 27
company core fields 26
company, updating 30
contact core fields 28
contacts, updating 31
core fields, defining 28
importing custom field values 257
overview 573
responding to reminders 43
sending reminders 43
tagging search results 107
types 25
updating custom fields 271

projects
adding 287
adding activities 290
adding participants 299
adding team members 301
copying 309
copying activities 310
customizing reminders 315
editing kickoff message 318
overview 275, 574
setting activity dependencies 297
setting activity due dates 297
setting activity notifications 297
setting company responses 287
starting and scheduling 306

provisioning, profile with TGO 22
public searches, about 103
public web forms

about 348
creating 358
distributing URL 377
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Q
quick searches, running 92

R
registration 479
registration audit data,companies 168
registration dashboard 523
registration email templates

approval action 451
approval/pre-approval reminder 455
decline action 453
pre-approve action 450
primary contact reminder 454
registration request action 451
return action 452
submit action 450

registration emails
anonymous URL 473
reminder settings 470
to, from settings 472
undeliverable address settings 472

registration reports
ageing 525
and dashboard tab 523
custom exports 527
request history 534
viewing chart data in Excel 525

registration request approval process
about 479
approving 504
bulk approving 505
creating 484
declining 514
finding 499
putting a request on hold 508
putting requests on hold in bulk 509
reactivating a request 511
reactivating requests in bulk 512
recalling and resending 516
reopening 515
returning 515

registration request document title, configuring 473
registration requests

about 479
and contact profiles 504
asking questions 502
buttons, roles, and workflows 483
closing questions 503
and company profiles 504
correcting email addresses 521
defined 477
deleting 517
finding 499
holding 167
questions about 502
resending 520
responding to questions 502

roles 481
tabs in 482
TGO invitation codes 486
verifying a Tax ID 503

registration requests, creating
about 484
creating from URL 492
creating in active community 485
importing 493
including legal profiles 485
legal profile creation 540

registration roles 88
about 82, 425
administrator, assigning 464
approval 426, 481
default 82
defining permissions for 88
pre-approval 426, 481
primary contact 426, 481
renaming 90
requester 426, 481

registration setup
about 423
buttons, roles, and workflows 427
configuring workflow for 438
and registration requests 423
setup phases 429

registration setup, collecting data
business roles 437
core fields 431
custom fields 435
planning 431
TGO invitation codes 434

registration setup, configuring approvals
about 460
adding approval groups 463
assigning contacts to groups 464
bypassing levels 468
defining levels and names 461
mapping groups to levels 466

registration setup, email templates
about 427, 446
customizing reminder templates 458
customizing workflow templates 456
form field descriptions 459
and form fields 447
reminder templates 454
sample template 449
workflow templates 450

registration setup, misc. settings
anonymous URL 473
assigning administrator role 475
configuring anonymous gateways 473
configuring approval levels, groups 460
configuring email addresses 472
configuring registration request document title 473
reminder email settings 470
workflow email settings 445
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registration setup, workflow
configuring actions 443
configuring emails 445
registration process page, explained 439
and registration requests 439
roles and selected actions 427
simple example 440
typical example 442

reminders
customizing 44
discontinuing 47
profile 43
and profile freshness 43
responding to 43
time intervals, setting 45

report option table 177
report schedule

add company report 185
remove from company report 190

report types
company 176
summary exports 176

reports
add schedule to 185
ageing (registration) 525
availability of 176
copying 183
deleting 184
EIN (Tax ID) usage 535
example based on saved search 191
overview 175
public and private 176
registration 523
registration history 534
remove schedule for company 190
viewing company summary 182

request approval process 479
responding to web forms 379
restrict IP address 20
restricted characters for core fields 117
role guidelines

contact roles 54
registration roles 83
security roles 54
workspace roles 83

roles
contact 50
overview 580
registration 82, 88
security 50, 65
workspace 81

roles and permissions overview 49
roles, default

contact (business) 55
registration 83
security 55
workspace 83

S
saved searches

creating 103
deleting 105
private 103
public 103
renaming 105
running 104
viewing details of 105

search options
about 91
advanced 93
quick 91
tagging search results 106

search results
acting on 109
creating tags for 107
using tags 108

searches
advanced 100
quick 91, 92

security roles 55
adding custom roles 65
assigning core field permissions to 63
assigning custom field permissions to 64
assigning to contacts 73
community roles 51
editing permissions for 56, 60
overview 580
project roles 52

security, IP address restriction 20
single sign on (SSO) 21
specialized custom field formats

email 230
Tax ID (EIN) 230

sub-communities
adding companies to 144
assigning roles and contacts 141
creating a security role for 141
deleting inactive 150
editing 150
removing companies from 147
viewing contacts assigned to 149

summary export
deleting comapny 196

summary exports
configuring contact 197
configuring for company 192
running company 194
running contact 198

summary reports
viewing company 182

support
contacting 2, 11
customizing a message 12

surveys, see web forms 347
synchronizing, profile with TGO 22
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system requirements 1

T
tabs for individual 114, 116
tabs for list of 113, 115
tags

creating 107
finding profiles 107
for search results 106
types of 106
using 108

Tax ID (EIN)
specialized custom field format 230
usage report 535

technical support 2, 11
TGO

hold registration requests 167
integration with Active Community 21
invitation codes 434
provisioning 22
restricted characters for core fields 117
send companies for provisioning 166
single sign on 21
synchronizing 22

V
validation rules, leading zeroes 236, 247

W
web form question formats

about 350
formats shared with custom fields 350
formats unique to web forms 350

web form questions
adding choices to 362, 363
editing 375
question formats 350

web form response types
anonymous 348
by company 348
tracked 348

web forms
about 347
adding logo to 374

community, about 348
copying 367
creating community 355
creating public 358
data tables overview 579
deleting 379
distributing 372
editing 374
email notifications 287
exporting results 378
option table 353
overview 578
planning 352
and projects 348
public, about 348
publishing 370
question formats 350
responding to 379
testing 368
types of 348
viewing results 373

workflow, configuring registration 438
workspace

adding files to 336
adding people to 332
alerts to changes 338
deleting files 337
email notifications 330
file library folders 323
overview 321
restricting access to 85
roles for 81
sharing files 335

workspace roles
about 84
assigning to contacts 86
editing permissions for 85

Z
zeroes, leading 236, 247
zip files

about 170
exporting from custom fields 172
importing to custom fields 171
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